Vantage 7.1

Domain Management Guide
Copyrights and Trademark Notices

Copyright © 2018 Telestream, LLC. All rights reserved worldwide. No part of this publication may be reproduced, transmitted, transcribed, altered, or translated into any languages without the written permission of Telestream. Information and specifications in this document are subject to change without notice and do not represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, ScreenFlow, Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, MetaFlip, and Split-and-Stitch are registered trademarks and MacCaption, e-Captioning, Pipeline, Post Producer, Tempo, TrafficManager, VidChecker, and VOD Producer are trademarks of Telestream, LLC. All other trademarks are the property of their respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All right reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

Other brands, product names, and company names are trademarks of their respective holders, and are used for identification purpose only.
MPEG Disclaimers

MPEGLA MPEG2 Patent

ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEGLA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEGLA, LLC. SEE HTTP://WWW.MPEGLA.COM.

MPEGLA AVC

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEGLA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEGLA, LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
Limited Warranty and Disclaimers

Telestream, LLC (the “Company”) warrants to the original registered end user that the product will perform as stated below for a period of one (1) year from the date of shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment supplied but not manufactured by the Company but NOT including any third party equipment that has been substituted by the Distributor for such equipment (the “Hardware”), will be free from defects in materials and workmanship under normal operating conditions and use.

Warranty Remedies

Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any defective Hardware component or part, or Software Media, with new or like new Hardware components or Software Media. Components may not be necessarily the same, but will be of equivalent operation and quality.

Software Updates

Except as may be provided in a separate agreement between Telestream and You, if any, Telestream is under no obligation to maintain or support the Software and Telestream has no obligation to furnish you with any further assistance, technical support, documentation, software, update, upgrades, or information of any nature or kind.

Restrictions and Conditions of Limited Warranty

This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of service or modification by a party other than the Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, its distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF Telestream, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any Limited
Warranty by the Company shall be the recovery of reasonable damages which, in the aggregate, shall not exceed the total amount of the combined license fee and purchase price paid by you for the Product.

**Damages**

Telestream, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:

Telestream
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream, LLC via telephone at (530) 470-1300.

Part number: 241938

Date: March 2018

Version: 7.1
Contents

Vantage 7.1 Domain Management Guide 1
Copyrights and Trademark Notices 2
MPEG Disclaimers 4
MPEGLA MPEG2 Patent 4
MPEGLA MPEG4 VISUAL 4
MPEGLA AVC 4
MPEG4 SYSTEMS 4
Limited Warranty and Disclaimers 5
Warranty Remedies 5
Software Updates 5
Restrictions and Conditions of Limited Warranty 5
Limitations of Warranties 5
Damages 6

Preface to the Domain Management Guide 23
Included in This Guide 23
Contacting Telestream 24

Introduction to Vantage 25
Vantage Overview 26
Accessing Vantage Guides and Online Help 29
Vantage Domain Components 30
Vantage Domain Configurations 32
Vantage Elastic Domains 32
Vantage Programs and Options 33
Vantage Management Console 35
Vantage Workflow Designer 36
Open Workflows 36
Vantage Cloud Manager 37
Vantage VOD Portal 37
Vantage Tempo Portal 37
Vantage Workflow Portal 38
Vantage Web Applications 38
Vantage Workflow Portal Web Application 39
Vantage Dublist Portal Web Application 39
Vantage Job Status Views Web Application 39
Vantage Dashboard Web Application 39
Lightspeed Live Capture Web Portal 40
Vantage TrafficManager 40
Vantage Dublist Portal 41
Post Producer and Related Options 41
VOD Producer with Dynamic Ad Insertion 41
Vantage DPP Packager 41
Post Producer Titler Engine 42
Vantage Tempo 42
Lightspeed Server 43
Lightspeed Live Stream 43
Capturing Live Video and Tape Feeds 44
Lightspeed Live Capture 44
Lightspeed Tape Capture 44
Pipeline 44
Vantage Licenses 45
Transcoding Products 45
Transcoding Product Options 47
Workflow Products 49
Workflow Third Party Connectors 51
Vantage System Management Products 54
Vantage Post Producer 55
Titler Engine Option for Post Producer 55
VOD Producer 55
VOD Producer Dynamic Ad Insertion (DAI) 56
VOD Portal 56
Tempo Content Re-Timing Software 56
Lightspeed Servers 57
Lightspeed Options and Bundles 57
Lightspeed Live Capture 57

Before You Install Vantage 59
Server Hardware Requirements 60
Ensure Maximum Server Performance 60
Vantage Server Requirements 61
Database Server Requirements for SQL Standard 61
Operating System Requirements 62
Vantage Web Applications OS 62
Vantage Web Applications Browser Requirements 63
Vantage Client Software OS 64
Vantage Services, Domain Database, and MS SQL Server OS 65
Windows Server Configuration Requirements 65
Third-Party Software Requirements 68
QuickTime Requirements 68
QuickTime 7.7.9 for Workflow Portal Client 68
## Contents

- Prerequisites for Instance Installation 97
  - Configuring the Administrator Role 98
  - Configuring the Vantage User Role 99
- Installing the Vantage Domain Database 100
- Database Maintenance Topics 103
- Backing Up and Restoring the Vantage Database 104
  - Understanding Domain Backup and Restore 104
  - Backing Up the Domain 105
  - Restoring the Domain 106
- Shrinking a Full Database 107
- Moving the Vantage Domain Database to Another Database 108
  - Preparing for the Move 109
  - Backing up the Existing Database 110
  - Removing the Vantage Domain Database 110
  - Removing Microsoft SQL Server 111
  - Installing SQL Server Standard 112
  - Installing the Vantage Domain Database 112
  - Restoring the Vantage Domain Database Backup 113
  - Finishing the Move 113

## Installing Vantage 115

- Installation Prerequisites and Overview 116
  - Installation Prerequisites 116
  - Installation Overview 118
  - Extracting and Running the Installer 120
- Installing Vantage on a Single Node 122
  - Installation Notes 123
  - Quick Installation Check 124
- Creating a Vantage Elastic Domain 125
- Installing a Vantage Array 125
  - Setting Up SQL Server and the Vantage Domain Database 125
    - Installing SQL Server 2008/2012 Standard 126
    - Installing SQL Server 2014 Standard 128
    - Installing SQL Server 2016 Standard 129
    - Installing the Vantage Domain Database 130
    - Adding SQL 2008 Service Packs for Windows Server 2012 131
  - Installing Vantage Array Components 132
    - Installing Vantage Services, Transcode Engine, and Clients 132
    - Installation Notes 134
  - Adding Vantage Services 135
  - Setting the Vantage Windows Log On ID for Services 136
  - Quick Installation Check 137
- Post-Installation Steps for Single Nodes and Arrays 138
  - Setting Up a Vantage Store 139
  - Installing and Configuring Vantage Web Applications 140
    - Installing Vantage Web Applications 141
    - Using Web Apps with Active Directory 143
    - Managing Web Workflow Portal Client Alias Support 145
  - Enabling Vantage Licenses 148
Installing a Vantage License 148
Activated a Vantage License Offline 149
Troubleshooting License Installation Problems 150
Resolving a DEP Conflict 150
Installing Client Programs on Client Workstations 151
Updating VOD DAI Workflow Portal Configurations 151
Configuring Client DB Access and User Administration 152
Configuring Vantage DB Users 152
Configuring Client Login Connection Settings 153
Enabling User Administration 154
Creating Vantage Users 155
Verifying the Installation 156
Command Line Installation 157
Extracting and Installing 158
Open a Command Prompt 158
Run the Archive and the Installer 158
Self-Extracting Archive Commands 159
Help Command 159
Command List 159
Command Examples 160
Vantage Setup Installer Commands 160
Help Command 160
Command Syntax 160
Command Examples 160
Command List 161
Options 161
Parameters 161
Features 162

Upgrading and Modifying Vantage 165
Upgrading from a Previous Version 166
Upgrading Vantage 7.0 and Versions Prior to 6.0 166
Updating Vantage 169
Using ComponentPac Management to Update Actions 170
Installing ComponentPacs 171
Upgrading Actions and Workflows 173
Upgrading an Action 173
Upgrading a Workflow 174
Upgrading Workflow Batches 174
Locking Against Upgrades 174
Removing ComponentPacs 175
Updating Individual Components 176
Updating the Vantage Domain Database 177
Updating SQL 2008 Express to SQL 2014 Express (optional) 178
Updating Vantage Server Components 179
Updating Vantage Clients on Client Workstations 180
Using the Client Installer to Install or Update Clients 180
Using the Vantage Installer to Install or Update Clients 180
Updating Vantage Web Applications 181
Moving the Vantage Domain Database 182
Preparing for the Move 183
Backing up the Existing Database 184
Removing the Vantage Domain Database 184
Removing Microsoft SQL Server 185
Installing SQL Server Standard 185
Installing the Vantage Domain Database 185
Restoring the Vantage Domain Database Backup 187
Finishing the Move 187
Adding a Server to a Vantage Domain 188
Adding a Lightspeed Server to an Existing Vantage Domain 189
Moving Licenses to Another Domain 190
Moving Vantage Services to Another Domain 191
Setting the Vantage Windows Log On ID for a Service 191
Removing the Vantage Domain Database 192
Removing Microsoft SQL Server 193

Removing Vantage 195
Uninstalling Vantage from a Server 196
Uninstalling Vantage Clients from a Workstation 198
Removing ComponentPacs 199

Troubleshooting Vantage Installation 201
Troubleshooting Vantage Installation 202
Verifying DTC Service Settings 202
Verifying DTC Operation 203
Verifying the DTC Configuration 203
License Cannot Be Activated Offline 204
Troubleshooting Vantage Web Applications 206

Using the Vantage Management Console 209
Introduction 210
Starting the Vantage Management Console 211
Selecting a Domain 211
Entering a Username and Password 212
Managing the Vantage Domain Connection 214
Identifying the Selected Domain 214
Selecting a Different Domain 215
Using the Vantage Management Console Workspace 216
Components Panel 216
Details Panel 216
Managing Tips and Warnings 217
Using the Help System 217
Managing the Vantage Domain 227

Managing Settings and Options 228
  Making General Settings 229
  Configuring Vantage Email Notifications 230
  Specifying Authorization Credentials for Remote Folder Access 232
    Understanding Authorization Settings 232
    Displaying the Authorization Settings 233
    Refreshing the Authorization Record List 234
    Adding an Authorization Record 234
    Modifying an Authorization Credentials Record 235
    Deleting an Authorization Credentials Record 235
    Exporting and Importing Authorization Records 235
  Assigning Mapped Drives 237
  Configuring a Signiant Connection 239
    Signiant CA Certificate Instructions 240
    Use a Web Page to Get a Certificate 240
    Use the Command Line to Get a Certificate 240
    Deleting a Signiant Agent 240
    Exporting and Importing Signiant Agents 241
  Configuring an Agility ECS Connection 242
  Configuring Telestream Cloud Settings 244
    Deleting a Telestream Cloud Account 245
    Exporting and Importing Telestream Cloud Settings 245
  Configuring an Elastic Domain Billing Account 246
    Configuring and Testing Billing 246
    Checking Billing Log Information 247
    Reactivating a Suspended Elastic Domain 248
  Configuring Interplay Settings 249
    Exporting and Importing Interplay Settings 250
    Deleting an Interplay Account 250
  Creating Dashboard Links 251
    Exporting and Importing Dashboard Links 251
    Deleting Dashboard Links 252
  Managing Vantage File Storage 253
    Understanding Vantage Storage 253
    Understanding Path Specifications for Vantage Storage 254
    Managing Vantage Stores 255
Adding and Configuring Vantage Stores 256
Creating a Live Store 257
Viewing Files in a Vantage Store 257
Modifying a Vantage Store 257
Moving a Store Online or Offline 258
Identifying Workflows that Use a Store 259
Setting the Block Size 260
Duplicating a Vantage Store 261
Exporting and Importing Vantage Stores 261
Deleting a Vantage Store 261
Managing Vantage Folder Addresses 262
Adding Vantage Folder Addresses 263
Refreshing the List of Folders 264
Modifying Vantage Folder Addresses 264
Identifying Workflows that Use a Vantage Folder 265
Deleting a Vantage Folder Address 265
Setting the Block Size 265
Duplicating a Vantage Folder Address 266
Exporting and Importing Folder Addresses 266
Managing Services 267
Using the Services Details Panel 268
Grouping Services 270
Adding a Service to the Domain 270
Removing a Service from the Domain 270
Entering and Exiting Service Maintenance Mode 271
Resetting the Service Metrics History 271
Restarting a Service 271
Changing a Service Logon 272
Viewing Average Time Spent Waiting 272
Generating Reports 273
   Time of Day Report Example 274
   Historical Report Example 274
Configuring Vantage Services 275
   Setup 275
   Storage 277
   Variables 278
   Qualification Rules 279
Managing Licenses 282
Viewing Vantage Licenses 282
Adding a License 283
Deactivating a License 283
Searching Licenses 284
Portal Sessions 284
Cloud Billing 284
Enabling Open Workflows 285
Viewing Status 286
Viewing Active Actions 287
   Viewing Active Actions for a Service 287
Contents

Viewing Active Actions by Machine 287
Viewing Machine Metrics 288
Pre-Shutdown Notification 288
Viewing the Active Workflows in a Domain 289
Monitoring Utilization 290
Utilization Display Details 292
Using Support Utilities 293
Using the Data Collection Utility 293
Using the Change Log 294
Using the Error Log 296
Listing Actions By Service 298
Displaying Plug-in Versions 299
Displaying Software Versions by Machine 300
Managing Task Scheduling and Load Balancing 301
Enabling Task Scheduling/Load Balancing 301
Overview of Session and Cost Based (Legacy) Load Balancing 302
Session-Based Load Balancing 302
Cost Based Load Balancing (Legacy) 303
Examples of Cost Based Load Balancing (Legacy) 304
Overview of Task Based Load Balancing 305
Configuring Task Based Load Balancing 306
Task Scheduling Rules Panel 307
Task Capacity Manager Panel 308
Action Task Scheduling 309
Action Defaults for Task Scheduling 310
Checking Task Status 311
Managing Vantage Users 313
Enabling and Disabling User Administration 313
Managing Users with Vantage Management Console 314
Adding Users 315
Setting Passwords 316
Removing Users 316
Importing and Exporting Users 316
Managing Domains 317
Backing Up and Restoring the Vantage Domain Database 317
Understanding Domain Backup and Restore 317
Backing Up the Domain 318
Restoring the Domain 319
Shrinking a Full Database 319
Renaming a Vantage Domain 320
Renaming a Vantage Server 321
Managing ComponentPacs 324
Using the ComponentPac Management Panel 325
Installing ComponentPacs 326
Uninstalling ComponentPacs 328

Configuring Vantage Workflow Components 329
Managing Catalogs 330
Understanding Catalogs 330
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Catalogs with the Vantage Management Console</td>
<td>331</td>
</tr>
<tr>
<td>Creating and Deleting Catalogs</td>
<td>332</td>
</tr>
<tr>
<td>Creating and Deleting Catalog Folders</td>
<td>332</td>
</tr>
<tr>
<td>Configuring a Catalog or Folder Expiration Policy</td>
<td>333</td>
</tr>
<tr>
<td>Managing Binders</td>
<td>334</td>
</tr>
<tr>
<td>Understanding Binders</td>
<td>334</td>
</tr>
<tr>
<td>Managing Binders with the Vantage Management Console</td>
<td>336</td>
</tr>
<tr>
<td>Creating and Deleting Binders</td>
<td>337</td>
</tr>
<tr>
<td>Submitting Binders from the Vantage Management Console</td>
<td>338</td>
</tr>
<tr>
<td>Renaming a Binder</td>
<td>339</td>
</tr>
<tr>
<td>Configuring a Binder Expiration Policy</td>
<td>340</td>
</tr>
<tr>
<td>Managing Media Files in a Binder</td>
<td>340</td>
</tr>
<tr>
<td>Adding a Media File Reference</td>
<td>340</td>
</tr>
<tr>
<td>Removing a Media File Reference</td>
<td>341</td>
</tr>
<tr>
<td>Renaming a Media File Reference</td>
<td>341</td>
</tr>
<tr>
<td>Previewing a Media File</td>
<td>341</td>
</tr>
<tr>
<td>Managing Metadata Labels in Binders</td>
<td>342</td>
</tr>
<tr>
<td>Managing Binder Attachments</td>
<td>343</td>
</tr>
<tr>
<td>Capturing Inventory</td>
<td>344</td>
</tr>
<tr>
<td>Adding a Remote Source</td>
<td>345</td>
</tr>
<tr>
<td>Previewing a Capture Source</td>
<td>345</td>
</tr>
<tr>
<td>Renaming a Source</td>
<td>345</td>
</tr>
<tr>
<td>Finding Sources in Workflows</td>
<td>345</td>
</tr>
<tr>
<td>Deleting Sources</td>
<td>345</td>
</tr>
<tr>
<td>Exporting and Importing Sources</td>
<td>346</td>
</tr>
<tr>
<td>Managing Workflow Design Items</td>
<td>347</td>
</tr>
<tr>
<td>Managing Vantage Workflows</td>
<td>348</td>
</tr>
<tr>
<td>Opening Workflow Designer and a Workflow from the Vantage Management Console</td>
<td>349</td>
</tr>
<tr>
<td>Exporting Workflows</td>
<td>350</td>
</tr>
<tr>
<td>Importing Workflows</td>
<td>351</td>
</tr>
<tr>
<td>Refreshing the Workflow List</td>
<td>351</td>
</tr>
<tr>
<td>Enabling Lightspeed Fallback</td>
<td>352</td>
</tr>
<tr>
<td>Enabling and Disabling Expiration of Failed Jobs</td>
<td>352</td>
</tr>
<tr>
<td>Setting the Vantage Workflow Designer Grid Width/Height</td>
<td>353</td>
</tr>
<tr>
<td>Managing Workflow Categories</td>
<td>353</td>
</tr>
<tr>
<td>Managing Media Nicknames</td>
<td>356</td>
</tr>
<tr>
<td>Understanding Media Nicknames</td>
<td>356</td>
</tr>
<tr>
<td>Managing Media Nicknames with the Vantage Management Console</td>
<td>358</td>
</tr>
<tr>
<td>Creating Media Nicknames</td>
<td>358</td>
</tr>
<tr>
<td>Deleting Media Nicknames</td>
<td>359</td>
</tr>
<tr>
<td>Exporting and Importing Media Nicknames</td>
<td>359</td>
</tr>
<tr>
<td>Selecting All Unused Media Nicknames</td>
<td>359</td>
</tr>
<tr>
<td>Searching for Media Nicknames in Workflows</td>
<td>359</td>
</tr>
<tr>
<td>Managing Metadata Labels</td>
<td>360</td>
</tr>
<tr>
<td>Understanding Metadata Labels</td>
<td>361</td>
</tr>
<tr>
<td>Vantage Metadata Label Applications</td>
<td>362</td>
</tr>
<tr>
<td>Managing Metadata Labels with the Vantage Management Console</td>
<td>363</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Creating Metadata Labels</td>
<td>363</td>
</tr>
<tr>
<td>Adding Metadata Label Parameters</td>
<td>364</td>
</tr>
<tr>
<td>Duplicating a Parameter within a Metadata Label</td>
<td>365</td>
</tr>
<tr>
<td>Adding a Copy of a Metadata Label Parameter to Another Metadata Label</td>
<td>365</td>
</tr>
<tr>
<td>Deleting a Metadata Label Parameter</td>
<td>365</td>
</tr>
<tr>
<td>Modifying Metadata Labels and Parameters</td>
<td>366</td>
</tr>
<tr>
<td>Previewing Metadata Labels and Values</td>
<td>366</td>
</tr>
<tr>
<td>Sorting Metadata Label Parameters</td>
<td>366</td>
</tr>
<tr>
<td>Deleting Metadata Labels</td>
<td>366</td>
</tr>
<tr>
<td>Duplicating a Metadata Label</td>
<td>366</td>
</tr>
<tr>
<td>Exporting and Importing Metadata Labels</td>
<td>367</td>
</tr>
<tr>
<td>Searching for Metadata Labels in Workflows</td>
<td>367</td>
</tr>
<tr>
<td>Selecting All Unused Metadata Labels</td>
<td>367</td>
</tr>
<tr>
<td>Managing Attachment Nicknames</td>
<td>368</td>
</tr>
<tr>
<td>Understanding Attachment Nicknames</td>
<td>368</td>
</tr>
<tr>
<td>Managing Attachment Nicknames with the Vantage Management Console</td>
<td>369</td>
</tr>
<tr>
<td>Creating Attachment Nicknames</td>
<td>369</td>
</tr>
<tr>
<td>Deleting Attachment Nicknames</td>
<td>369</td>
</tr>
<tr>
<td>Exporting and Importing Attachment Nicknames</td>
<td>370</td>
</tr>
<tr>
<td>Searching for Attachment Nicknames in Workflows</td>
<td>370</td>
</tr>
<tr>
<td>Selecting All Unused Attachment Nicknames</td>
<td>370</td>
</tr>
<tr>
<td>Managing Variables</td>
<td>371</td>
</tr>
<tr>
<td>Understanding Variables</td>
<td>371</td>
</tr>
<tr>
<td>Managing Variables with the Vantage Management Console</td>
<td>372</td>
</tr>
<tr>
<td>Creating Variables</td>
<td>372</td>
</tr>
<tr>
<td>Modifying Variables</td>
<td>373</td>
</tr>
<tr>
<td>Deleting Variables</td>
<td>373</td>
</tr>
<tr>
<td>Duplicating a Variable</td>
<td>373</td>
</tr>
<tr>
<td>Exporting and Importing Variables</td>
<td>374</td>
</tr>
<tr>
<td>Searching for Variables in Workflows</td>
<td>375</td>
</tr>
<tr>
<td>Selecting All Unused Variables</td>
<td>375</td>
</tr>
<tr>
<td>Managing Scripts</td>
<td>376</td>
</tr>
<tr>
<td>Understanding Scripts</td>
<td>376</td>
</tr>
<tr>
<td>Managing Scripts with the Vantage Management Console</td>
<td>376</td>
</tr>
<tr>
<td>Adding a Script</td>
<td>377</td>
</tr>
<tr>
<td>Adding Inputs and Outputs</td>
<td>378</td>
</tr>
<tr>
<td>Renaming a Script</td>
<td>378</td>
</tr>
<tr>
<td>Deleting Scripts</td>
<td>378</td>
</tr>
<tr>
<td>Duplicating Scripts</td>
<td>378</td>
</tr>
<tr>
<td>Finding Affected Workflows</td>
<td>378</td>
</tr>
<tr>
<td>Exporting and Importing Scripts</td>
<td>379</td>
</tr>
<tr>
<td>Managing Style Sheets</td>
<td>380</td>
</tr>
<tr>
<td>Understanding Style Sheets</td>
<td>380</td>
</tr>
<tr>
<td>Managing Style Sheets with the Vantage Management Console</td>
<td>381</td>
</tr>
<tr>
<td>Adding a Style Sheet</td>
<td>381</td>
</tr>
<tr>
<td>Renaming a Style Sheet</td>
<td>382</td>
</tr>
<tr>
<td>Deleting Style Sheets</td>
<td>382</td>
</tr>
</tbody>
</table>
Duplicating Style Sheets  382
Finding Affected Workflows  382
Exporting and Importing Style Sheets  382
Managing Actions  383
Understanding Actions  383
Managing Action Default Settings  384
Configuring the Resource Cost  384
Configuring Task Scheduling  385
Configuring Retry Settings  385
Exporting and Importing Action Default Settings  386
Exporting and Importing Workflow Action Configurations  387
Related Action Management Topics  389
Managing Nexus Definitions  390
Understanding a Nexus  390
Managing Nexus Definitions  390
Creating Nexus Definitions  391
Modifying a Nexus Definition  391
Deleting a Nexus Definition  392
Duplicating a Nexus Definition  392
Exporting and Importing Nexus Definitions  392
Searching for Nexus Definitions in Workflows  393
Refreshing the Nexus Definitions List  393
Viewing Workflow and Action Analytics  394
Viewing Workflow Analytics  394
Viewing Action Analytics  397
Using Application Configurations  399
Configuring the Job Status Views  399
Configuring the Workflow Portal  399
Configuring the Dublist Portal  400
Creating Report Configurations  401
Job Reports  401
Managing Job Reports with the Vantage Management Console  402
Creating a New Job Report Format  403
Including and Excluding the Header Row  403
Choosing the Report Format Columns  403
Duplicating a Job Report Format  404
Deleting a Job Report Format  405
Refreshing the Format List  405
Exporting and Importing Job Report Formats  405
Service Reports  406
Managing Service Reports with the Vantage Management Console  407
Creating a New Service Report  407
Choosing the Report Type, Organization, and Options  408
Choosing the Report Mode  408
Duplicating a Service Report Configuration  409
Deleting a Service Report Configuration  409
Refreshing the Service Reports Configuration List  409
Exporting and Importing Service Report Configurations  410
Managing Fulfillment Schemes  411
  Workorder Schemes  411
    Displaying the Workorder Schemes Panel  412
    Creating a New Workorder Scheme  412
    Renaming a Scheme  413
    Duplicating a Scheme  413
    Deleting a Scheme  413
    Creating Workorder Scheme Fields  414
    Testing Schemes  416
    Duplicating a Workorder Scheme  417
    Refreshing the Workorder Schemes List  417
    Exporting and Importing Workorder Schemes  418
  Dublist Schemes  418
  Catch Schemes  418

Managing Syndication  419
  Creating Syndication Templates  419
    Displaying the Syndication Templates Panel  420
    Creating and Modifying a Syndication Template  420
    Renaming a Syndication Template  422
    Duplicating a Syndication Template  422
    Deleting a Syndication Template  422
    Exporting and Importing Syndication Templates  423
    Filtering the Templates list  423

Creating Dublist Portal Configurations and Dublist Schemes  425
  Creating Dublist Portal Configurations  426
    Displaying the Dublist Portal Configuration Panel  427
    Refreshing the Configuration List  427
    Creating a New Configuration  427
    Renaming a Configuration  428
    Duplicating a Configuration  428
    Deleting a Configuration  428
    Setting Options and Choosing Columns  429
      Setting Your Options  429
      Displaying Selected Columns  429
    Configuring Permitted Users  430
    Specifying Workflows  431
    Exporting and Importing Configurations  432
  Creating Dublist Schemes  433
    Displaying the Dublist Schemes Panel  434
    Creating a New Dublist Scheme  434
    Renaming a Scheme  435
    Duplicating a Scheme  435
    Deleting a Scheme  435
    Configuring Dublist Scheme Fields  436
      Creating a Field List  436
      Adding New Fields  436
      Testing Dublist Portal Schemes  438
Configuring Catch Server Schemes 441
Displaying the Catch Schemes Configuration Panel 442
Creating a New Configuration 443
Renaming a Configuration 443
Duplicating a Configuration 443
Deleting a Configuration 443
Setting Options and Defining Fields 444
Field Options 444
Testing Schemes 446
Refreshing the Catch Schemes List 447
Exporting and Importing Configurations 447

Configuring Job Status Views 449
Displaying the View Configuration Panel 450
Enabling and Disabling the All Workflows View 450
Creating a New View 451
Renaming a View 451
Duplicating a View 451
Deleting a View 452
Selecting and Changing the Workflow for a View 452
Displaying All Jobs or Only Jobs in Process 453
Enabling Options 453
Choosing the Display Columns 453
Configuring Permitted Users 454
Refreshing the View List 455
Exporting and Importing Views 455

Setting up Workflow Portal 457
Introduction to Vantage Workflow Portal 458
Vantage Workflow Portal Licensing 459
User-Based Licensing 459
Machine-Based Licensing 459
Viewing and Resetting Vantage Workflow Portal Sessions 459
Introduction to Vantage Workflow Portal Configurations 461
Managing Vantage Workflow Portal Configurations 462
Creating and Editing Vantage Workflow Portal Configurations 463
Selecting and Setting Up a Configuration Mode 464
Setting Dropframe or Non-dropframe Duration 464
Pass Username As 464
Choosing a Configuration 465
Browse Catalogs (Copy Binder) Mode 466
Browse Catalogs (Forward Binder) Mode 467
Browse Windows Network (Create Binder) Mode 469
Create EDLs from Catalogs (Create Binder) Mode 470
Catalog Mode Considerations 471
Using the Vantage Dashboard Web App 511

Overview 512
Managing Vantage Dashboard Sessions 512
  Vantage Web Applications Browser Requirements 513
Starting the Vantage Dashboard 514
  Connecting for the First Time 515
  Reconnecting to Vantage Dashboard 517
Understanding the Vantage Dashboard Display 518
Hiding and Displaying the Header Panel 518
 Managing the Menu Panel 519
Sorting Lists in the Status Panel 519
Logging Out 519
Changing Your Vantage User Password 519
Changing Vantage Domains 520
Displaying Product Version Information 520
Displaying Help 520
Returning to the Welcome Page 521
Troubleshooting Tip 521
Monitoring a Domain 522
  Displaying Domain Summary Status 522
    Vantage Server Health 524
    Vantage Service Health 525
Managing Domain Job Status 528
  Paging Through the Job List 529
  Filtering Jobs or Actions 529
  Highlighting Job or Action Status Rows 533
  Displaying Job Error Details 534
  Stopping Jobs 534
  Restarting Jobs 534
  Deleting Jobs 534
  Displaying Action Error Details 534
  Changing Action Priority 535
  Restarting Actions 535
Viewing Domain Monitor Status 536
Managing Health of a Domain 537
  Viewing Array Statistics 537
    Entering and Exiting Server Maintenance Mode 539
    Resetting Service Statistics on the Array Statistics Page 539
  Viewing Service Statistics 540
    Entering and Exiting Service Maintenance Mode 541
    Resetting Service Statistics on the Service Statistics Page 542
  Viewing Machine Metrics 543
  Administering the Domain 544
    Displaying Domain License Status 544

Glossary 545
Preface to the Domain Management Guide

Included in This Guide

The Vantage Domain Management Guide comprises a collection of guides for use by Vantage administrators. These guides are published separately and in this collection:

- **Introduction to Vantage**—an overview of Vantage software, options, and licenses.
- **Before You Install, Planning and Managing a Vantage Database, Vantage Installation, Upgrading Vantage, Uninstalling Vantage, and Installation Troubleshooting**—installation planning, including hardware, operating systems, software, database, and network requirements. Also covers installing, upgrading, and uninstalling Vantage and its options as well as installation troubleshooting.
- **Using the Vantage Management Console and Managing the Vantage Domain**—how to start and use the Vantage Management Console, including features such as licensing, user administration, managing services, load balancing, backing up the database, using various logs and utilities, and changing domain and server names.
- **Configuring Vantage Workflow Components**—how to use the Vantage Management Console to manage the Vantage components used by workflow designers. These components include workflows, media nicknames, binders, and workflow analytics.
- **Configuring Job Status Views**—how to configure and use the Vantage Job Status Views Web application, which lets you monitor Vantage jobs via the Web.
- **Configuring the Vantage Workflow Portal**—how to configure and use the Vantage Workflow Portal client, which allows operators to implement operator-intervention workflows, previewing media, creating clips, updating metadata, and submitting files to publishing workflows for final processing.
- **Configuring the Vantage Dublist Portal**—how to configure and use the Vantage Dublist Portal, which allows operators to manage dublists.
- **Using the Vantage Dashboard**—how to configure and use the Vantage Dashboard Web application, which allows monitoring and administering a domain via the Web.
- **Vantage Glossary** defines common Vantage terms and concepts.
## Contacting Telestream

To obtain product information, technical support, or provide comments on this guide set, contact us using our web site, email, or phone number as listed in the table below.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telestream Technical Support</td>
<td>Web Site: <a href="http://www.telestream.net/telestream-support">http://www.telestream.net/telestream-support</a></td>
</tr>
</tbody>
</table>
| Vantage Technical Support         | Web Site: [http://www.telestream.net/telestream-support/vantage/support.htm](http://www.telestream.net/telestream-support/vantage/support.htm)  
Support Web Mail: [http://www.telestream.net/telestream-support/vantage/contact-support.htm](http://www.telestream.net/telestream-support/vantage/contact-support.htm)  
US Enterprise Product Support: (877) 257-6245  
International Enterprise Support: +1 530-470-2036 |
| Telestream                        | Web Site: [www.telestream.net](http://www.telestream.net)  
Sales and Marketing Email: [info@telestream.net](mailto:info@telestream.net)  
Telestream  
848 Gold Flat Road  
Nevada City, CA. USA 95959 |
| International Distributor Support | Web Site: [www.telestream.net](http://www.telestream.net)  
See the Telestream Web site for your regional authorized Telestream distributor. |
| Telestream Technical Writers      | Email: [techwriter@telestream.net](mailto:techwriter@telestream.net)  
If you have comments or suggestions about improving this document, or other Telestream documents—or if you’ve discovered an error or omission, please email us. |
Introduction to Vantage

This chapter is intended for those who use Vantage for transcoding and processing digital media and for system administrators who must configure Vantage.

The following topics introduce Vantage, and the Vantage programs that you’ll use in the course of processing your media in Vantage workflows:

- Vantage Overview
- Accessing Vantage Guides and Online Help
- Vantage Domain Components
- Vantage Domain Configurations
- Vantage Programs and Options
- Lightspeed Server
- Capturing Live Video and Tape Feeds
- Vantage Licenses

**Note:** Vantage licenses enable specific features and programs in Vantage, including optional transcoding capabilities, Lightspeed server, advanced workflow features and system management.

Vantage licenses allow you to download and install Vantage software at your convenience and purchase only those features that you need. If you need additional features later, you can purchase the licenses you require at any time. Features for which you do not have a license may be disabled, or work only in demo mode. Topics which describe a feature that requires a license indicate that you need a license to use them.

You manage licenses in the Vantage Management Console. You can also add or update licenses directly in Workflow Designer. For a full discussion of licensing in Vantage, see the *Vantage Licenses*. 
At the simplest level, Vantage is a collection of customizable software programs that automate media processing via workflows. A Vantage workflow is a collection of actions that you design and configure to process media files in a specific manner.

The actions you can utilize in a workflow are controlled by the Vantage licenses you install. The following table lists some typical media processing objectives and the Vantage licenses that support them (these are not the only licenses you can use in Vantage—for a complete list, contact your Telestream representative).

<table>
<thead>
<tr>
<th>Workflow Objective (Vantage License)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File-to-file transcoding</td>
<td>Transcoding workflows automate the process of converting a video file from one media format to another. Vantage can open most video files, regardless of the encoding and packaging format, and create one or more new video files using one or more selections from an extensive list of encoder and packaging formats.</td>
</tr>
<tr>
<td>Live Capture</td>
<td>Lightspeed Live Capture operates as a standalone capture system and can also extend live encoding capability by providing live capture in a number of high quality mezzanine formats into the Vantage Media Processing Platform.</td>
</tr>
<tr>
<td>Commercial processing—local, regional, and national</td>
<td>TrafficManager streamlines commercial and syndicated content handling for TV stations and cable facilities. TrafficManager provides a complete solution for local/regional, and nationally syndicated and commercial media workflows, from ingest, review &amp; approval, transcoding, dub list reconciliation, delivery for ad insertion servers or broadcast servers, and automation system notification.</td>
</tr>
<tr>
<td>Adaptive streaming encoding</td>
<td>Transcode Multiscreen includes transcoding software specifically designed for adaptive bit rate encoding using both GPUs and CPUs. It simultaneously produces multiple bit-rate variants of H.264/HEVC (using x264/x265 codecs) video and containers for deployment to HTTP adaptive streaming players from Adobe, Apple, Microsoft, and players compatible with MPEG DASH.</td>
</tr>
<tr>
<td>Automated editing and composition of advertisements</td>
<td>Post Producer automates the repetitive editing of assets for distribution, promotion and cross promotion. Post Producer allows you to automatically re-purpose movies and episodic content directly from master format for international and domestic distribution.</td>
</tr>
<tr>
<td>Workflow Objective (Vantage License)</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>IPTV VOD Transcoding</td>
<td>Vantage Transcode IPTV VOD provides IPTV and Cable VOD transcoding with the highest possible quality at the lowest bit rates, reducing transmission costs. Additionally, Vantage provides sophisticated stream control and can automate the entire production process, including ingest, transcoding, packaging, delivery, and notification.</td>
</tr>
<tr>
<td>Moving media between devices (Vantage Transcode Pro Connect)</td>
<td>Media transport workflows use Vantage native connections to move media between a wide variety of broadcast servers, edit systems, and other professional video devices. System integration includes HTTP Post and Get, for RESTful API calls in workflows. Using these integrations, Vantage can automate the process of receiving media into, or moving media between, different devices—ensuring the right file format at any of many possible destinations.</td>
</tr>
<tr>
<td>Re-timing the running-time of media assets (Tempo)</td>
<td>Tempo is based on the Vantage platform, for re-timing file-based content and intelligently decreasing or increasing the running time of shows and segments.</td>
</tr>
<tr>
<td>DPP File Creation (DPP License)</td>
<td>Vantage simplifies the creation of DPP-compliant media for the UK market. Operators enter metadata and mark programme segments. After that, Vantage automatically assembles the timeline with slates, bars and tones in the correct places, and programme segments aligned accurately. Vantage also integrates with common QC systems to perform Harding FPA analysis. Vantage then encodes the output AS-11 file with full, 16-bit video processing and optional GPU acceleration, while simultaneously inserting the metadata.</td>
</tr>
<tr>
<td>VOD Producer and VOD Producer</td>
<td>VOD Producer and VOD Producer</td>
</tr>
<tr>
<td>Media analysis and media-dependent processing (Vantage Analysis)</td>
<td>Media analysis workflows use Vantage features to analyze media, compare the results to configured values, and make decisions about how media should be routed or processed.</td>
</tr>
</tbody>
</table>
With the appropriate licenses, Vantage workflows can incorporate the objectives listed in this table, as well as other workflow design and management features, which include the following:

<table>
<thead>
<tr>
<th>Workflow Objective (Vantage License)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing camera files</td>
<td>Vantage offers comprehensive monitoring of card readers and shared storage for camera shots. Spanned clips are automatically stitched to reconstruct camera shots, and shots across an entire camera can optionally be stitched or time-aligned for rushes or multi-camera shoots. Panasonic P2 DV5, AVC-Intra, and AVC-Ultra media are supported.</td>
</tr>
<tr>
<td>Third-party analysis and specialized media processing (third-party connectors)</td>
<td>Some workflows communicate with third-party products (such as MediaMate Screen or Digimetrics Aurora) to analyze or process media.</td>
</tr>
</tbody>
</table>

With the appropriate licenses, Vantage workflows can incorporate the objectives listed in this table, as well as other workflow design and management features, which include the following:

- **Workflow visualization**—Vantage offers a highly flexible process design interface, with visual components that help you see what the workflow will accomplish.
- **Notifications**—Vantage can send emails or notify external systems when media is available.
- **Intelligent branching**—Vantage workflows can be configured to evaluate variables, metadata, and the results of other workflow tasks, and to execute the appropriate workflow branch for further processing.
- **Workflow monitoring and control**—Vantage programs allow you to view the status of jobs that have been submitted to a workflow, and you can stop, cancel, and restart jobs.
- **Operator control**—Vantage provides tools for enabling operator management. Operators can submit files to workflows, view the results, and submit the results to yet another workflow. Operators can also view the status of workflow jobs and, if granted permission by a Vantage administrator, stop, cancel or restart jobs.
- **Scalability and Redundancy**—Vantage scales to thousands of jobs and dozens of servers in an enterprise environment, to implement high-volume processing.

Vantage also provides many system management features, allowing you to scale a Vantage system to many servers, manage user access, and optimize system performance and reliability. The system management features are described in topics throughout this guide.

Additionally, as your need for features grows, you can easily add (or remove) licenses to activate the services, actions, and other components you need, using the Vantage Management Console or the Vantage Workflow Designer.
Accessing Vantage Guides and Online Help

Vantage documentation consists of various guides, online help in the form of man pages, and application notes.

*Installation and Domain Management Guide*—You can access the Domain Management Guide from the Vantage Management Console Help menu.

*User Guides*—Guides are available from the Help menu of each Windows client and Web application.

*In-program, Context-based Help*—In each Windows client and Web application, click the ![question mark icon] in the upper right-corner to display a context-sensitive topic in the relevant user guide, if available. In Workflow Designer, when an action inspector is open, click the ![message icon] to display details about the panel you’re viewing for detailed help. Also hover over user interface controls to display brief tooltips.

*Application Notes*—Browse the Telestream Web site (at [www.telestream.net/telestream-support/vantage/support.htm](http://www.telestream.net/telestream-support/vantage/support.htm)) for application notes that may apply to your topic of interest.

*Vantage Web Library*—Click on the Vantage logo at [www.telestream.net/telestream-support/vantage/help.htm](http://www.telestream.net/telestream-support/vantage/help.htm) to display the entire Vantage documentation suite which includes all guides and man pages.
Vantage Domain Components

Each Vantage Domain is a collection of Vantage software components. You can install and use multiple Vantage domains within a business or other organization. For example, you might install a Vantage domain for the sports department and another for the news department. Domains do not interact with each other—each Vantage domain maintains its own database, and automates its own workflows, independently of other Vantage domains.
The work that you want Vantage to perform is defined in a workflow, which is created using the Vantage Workflow Designer program. Each workflow is made up of individual tasks called actions, which specify what task needs to be performed.

A typical workflow contains actions to do these kinds of tasks:

- Monitor folders for new media to ingest and process
- Analyze and transcode input media into new media files
- Assemble a media file from an edit decision list
- Process metadata
- Deliver finished media files and metadata files to specified locations

Once a workflow has been designed, you can activate it, and it will run continuously to process media provided through hot folders, the Vantage SDK, or other submission mechanisms.

For more information on the available actions and workflow design, see the Vantage User Guide.

The Vantage domain database is the control center of a Vantage domain. All workflows, user information, job history, and most configuration details for the domain are stored in the Vantage domain database. Also stored in the database are statistics and status information about the workflows processed by the domain and the services fulfilling them. Vantage domain administrators configure Vantage using the Management Console.

Working with the Vantage domain database, Vantage services execute workflow actions in a Vantage domain. Each service executes specific action types. For example, the Transcode Service executes the Flip action, which transcodes an input media file into a new file, based on the encoder and codecs you select.

Vantage workflow actions which access input files or publish output files must have read and write access to these storage locations the input and output storage locations shown in the figure. These locations can be folders that reside on a network server or workstation, a Network-Attached Storage (NAS), or a Storage Area Network (SAN). Or, they may be FTP or HTTP servers, or other media platforms.

A Vantage Store is a storage location designated during Vantage installation for storing temporary files that are created during workflow processing. Temporary files are automatically deleted by Vantage when they are no longer needed; you can control how long temporary files are retained by setting expiration rules for jobs and catalogs.

---

**Note:** When working with Vantage, be careful not to use these invalid characters in any file names, workflow names, variables, or data entry fields unless the tooltips or help indicate they are allowed: ` * | \ : ; " ' < > ? /`. For example, the asterisk (*) may be used as a wild card in some fields, and the colon (:) and semicolon (;) may be used in timecode, but none of them can be used in file names.
Vantage Domain Configurations

While Vantage supports many different physical configurations, there are only two types of domains:

- A single node, all-in-one computer domain
- A multiple-computer array, where the Vantage services and Vantage database are distributed among two or more servers.

A single-node all-in-one domain is a Vantage domain in which all the basic Vantage components shown in the figure are installed on a single server. An all-in-one domain is simpler to install and manage, but it has performance limitations which are described in the Before You Install Vantage chapter of the Vantage Domain Management Guide.

A multiple computer Vantage array (sometimes referred to as a distributed domain) is one in which the Vantage components are distributed among multiple servers or virtual machines. For example, you might install the Vantage database on one server, and install all Vantage services on an additional server, and a second Transcode service on the third server. This three-server Vantage domain separates database processing from Vantage service processing, which increases processing capacity for both the Vantage domain database and the Vantage services.

Hosting Vantage services on multiple servers also increases capacity and supports load-balancing and task scheduling, which leads to better throughput.

Vantage Elastic Domains

With the advent of Vantage Elastic Domains, it is possible to construct a Vantage domain that leverages flexible virtual or cloud instance infrastructure to allow for dynamic scaling of system capacity. Additional capacity can be added by instantiating a machine instance template specifically configured as a Vantage worker node. Vantage Elastic Domain deployment features streamline this process, eliminating the need to perform any Vantage configuration or licensing tasks when extra capacity is needed.

Specifically, a Vantage Elastic Domain consists of a permanent base installation of the Vantage database and worker nodes with subscription licensing that allows you to spin up extra Vantage Worker Nodes on Virtual Machines (VMs) anytime you need extra Vantage computing capacity. The VMs can reside in any of these environments:

- Unmanaged VM hosts
- Private data centers using managed virtualization
- Public cloud IAAS, such as Amazon AWS, Rackspace, Google GCE, MS Azure, etc.
- A hybrid environment, utilizing VPN tunneling
- On qualified GPU models in virtualization environments

An Elastic Billing dashboard hosted by Telestream’s cloud services enables you to monitor the billing for your extra capacity. On-demand licensing for nodes exceeding the capacity of your perpetual license is available. Please contact Telestream for more information on the hybrid burst licensing model available with Vantage Elastic Domain.
Introduction to Vantage

Vantage Programs and Options

Vantage programs allow you to manage and use the Vantage domain in various ways. The table below lists the Vantage programs according to the type of program and the Vantage management area they serve.

**Note:** Some Vantage programs are available only with particular Vantage product licenses. To ensure you get the programs you want, contact Telestream sales for the latest bundling and licensing information.

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Program Type</th>
<th>Client Applications</th>
<th>Web Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workflow Management</strong></td>
<td></td>
<td>Vantage Workflow Designer</td>
<td>Vantage Job Status Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vantage Workflow Portal</td>
<td>Vantage Workflow Portal</td>
</tr>
<tr>
<td><strong>Domain Management</strong></td>
<td></td>
<td>Vantage Management Console</td>
<td>Vantage Dashboard</td>
</tr>
<tr>
<td><strong>Live Capture</strong></td>
<td></td>
<td>Vantage Workflow Designer</td>
<td>Lightspeed Live Capture</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>web application</td>
</tr>
<tr>
<td><strong>Transcoding Workflow</strong></td>
<td>Vantage Workflow Designer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TrafficManager</strong></td>
<td>Workflow Portal</td>
<td></td>
<td>Workflow Portal</td>
</tr>
<tr>
<td><strong>Commercial &amp; Syndication</strong></td>
<td>Dublist Portal</td>
<td></td>
<td>Dublist Portal</td>
</tr>
<tr>
<td></td>
<td>Syndication Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cloud Management</strong></td>
<td>Vantage Cloud Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dynamic Ad Insertion</strong></td>
<td>DAI Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tempo Asset Re-timing</strong></td>
<td>Tempo Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VOD Producer</strong></td>
<td>VOD Producer Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Post Producer</strong></td>
<td>CML Portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DPP</strong></td>
<td>DPP Portal</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

From a management point of view, each Vantage program can be classified as a workflow management program or a domain management program. Workflow management programs allow you to design workflows, evaluate and forward the files saved by a job, and track the status of jobs. Domain management programs allow you to configure the Vantage domain, view status and statistics for the domain, and control domain operation.
Each Vantage program can also be classified by application type, which is either as a client program or a Web application. Client programs run on Microsoft Windows servers and workstations. Web applications are hosted by a Microsoft Internet Information Services (IIS) server and can be accessed from any computer with a compatible browser and a network or Internet connection to the IIS server hosting the Web applications.

This figure illustrates how Vantage programs fit into a Vantage domain.
The following topics introduce the Vantage programs and options:

- Vantage Management Console
- Vantage Workflow Designer
- Vantage Workflow Portal
- Vantage VOD Portal
- Vantage Tempo Portal
- Vantage Web Applications
- Vantage Traffic Manager
- Post Producer and Related Options
- Vantage Tempo
- Lightspeed Server
- Capturing Live Video and Tape Feeds

**Vantage Management Console**

The Vantage Management Console (VMC) enables domain administrators to configure and manage a Vantage domain, including specifying what features Vantage users can access. The following is a partial list of Vantage features that administrators can control with the Vantage Management Console:

- Vantage catalogs and stores
- Vantage users
- Vantage licenses
- Task scheduling rules
- Vantage services (including email on service failure for all license levels)
- Action and workflow status
- Import and export of Vantage configuration components
- Application configurations, including client windows, web applications, Job Status views, and various portals such as the Workflow, VOD, and Tempo Portals
- Report and workorder configurations
- Dublist and Fulfillment schemes
- Vantage domain settings, backup and restore, and other utilities

The Vantage Management Console also allows you to view a variety of status information, including information about jobs, service status, and catalog contents.

For information about using the Management Console, refer to the *Using the Vantage Management Console* chapter in the *Vantage User Guide*. 
Vantage Workflow Designer

Vantage Workflow Designer enables you to design and automate workflows to meet your organization’s transcoding and workflow automation requirements. With Workflow Designer, you can design workflows that do the following:

- Detect media files and related files that are ready for processing
- Evaluate the contents of media files and set variables that describe their contents
- Create decision trees that execute different branches based on variable values
- Generate email and other messages in response to workflow events
- Incorporate related metadata files or add metadata to the output
- Transcode media files to multi-screen formats, including package formats such as Apple HLS and Adobe HDS
- Transcode media files for use in IPTV/VOD/cable applications
- Generate new media based upon edit decision lists or editorial templates
- Perform comprehensive advertisement processing, from catch server to on-air server
- Perform file operations—save media output files and delete source files
- Combine any or all of the above features in hundreds of possible workflows.

A typical workflow design session requires that you pick the actions you want to execute, configure the sequence and settings of those actions, and then activate the workflow. When you activate the workflow, the Vantage domain database and Vantage services work together to process any source material that is submitted to the workflow. Each time source material is submitted, a Vantage job is started. A job represents a single execution of a workflow. For example, if 10 different media files are submitted to a workflow, 10 new jobs are executed.

The Vantage Workflow Designer also includes tools that allow you to monitor the status of workflows and jobs in the domain.

For detailed information on designing Vantage workflows, see the Vantage User Guide.

Open Workflows

An option to Vantage workflow functionality, Open Workflows enhance the processing speed of workflows by enabling most actions to begin processing before the previous action has completed. Specifically, Open Workflows are designed to remove the inherent latency that exists between actions within a workflow. For example, during execution of a Watch action when a new file is discovered, the next action—a Copy action—can begin to duplicate the file as the content is received and not wait for the entire file to be received. By reducing the latency between actions within a workflow, more jobs can be processed in the same period of time, improving domain productivity. See Vantage Licenses > Workflow Products in this chapter for license details.
**Vantage Cloud Manager**

The Vantage Cloud Manager enables domain administrators to configure and manage the cloud-based Vantage domain. The following is a list of key Vantage features that administrators can control with the Vantage Cloud Manager:

- Cloud service provider accounts
- Domain configuration
- Domain status (starting and stopping)
- Vantage Services
- Domain status

Vantage Cloud Manager is a separately purchased application that is not included in the main Vantage installer. For information about using the Vantage Cloud Manager, see the *Vantage Cloud User Guide*. Various options are available.

**Vantage VOD Portal**

The Video on Demand (VOD) Portal is a Vantage option that streamlines creating media assets. This portal allows specification of VOD-specific metadata, such as rating, V-Chip, and more, and allows trimming/stitching of clips to create finished media. The portal also allows marking of ad insertion points, allowing encoding and processing to support Dynamic Ad Insertion (DAI).

**Vantage Tempo Portal**

Tempo™ is a complete solution for re-timing file-based content and intelligently decreasing or increasing the running time of shows and segments. Tempo has the ability to re-time the complete asset but allows marking selected segments for inclusion or exclusion from the re-timing process when the overall program is re-timed.

Operator control of Tempo is provided through the Tempo Portal, which allows browsing catalogs and selecting media clips to drag and drop to a Segment List. In the Segment List, clips can be separated into program segments via a mark in/mark out process and configured for re-timing or left untouched. The operator then forwards the program, described in an XML composition file, to a Tempo workflow, which re-times the media accordingly.
Vantage Workflow Portal

The Vantage Workflow Portal, which is implemented both as a Windows client and as a web application, allows operators to manually review and update media and manually submit jobs to workflows. Workflow designers create the workflows, and workflow operators use Workflow Portal to do the following:

- Search catalogs and binders which contain media
- Preview proxy media and create clip sets—setting in and out points for trimming
- Review and edit variable values, metadata labels, and embedded metadata
- Update variable values
- Submit media to workflows for processing
- In TrafficManager, search, review, and submit commercials and syndicated content for processing
- Stitch multiple files together

The Workflow Portal’s user interface allows administrators to customize it using the Vantage Management Console, which controls the features and resources each operator can access. The desktop version of the Workflow Portal is installed on Windows workstations. A Web version is also provided, with a subset of features.

To process media in Workflow Portal, for most configurations you must also create an ingest workflow to pre-process the media and register it in a Vantage catalog.

For information about creating configurations for the Workflow Portal, see the Setting up Workflow Portal chapter of the Vantage Domain Management Guide. For information about using the Workflow Portal, refer to the Using Workflow Portal chapter of the Vantage User Guide.

Vantage Web Applications

The Vantage Web applications provide browser access to important Vantage functions. These are the Web Applications:

- Vantage Workflow Portal Web Application
- Vantage Dublist Portal Web Application
- Vantage Job Status Views Web Application
- Vantage Dashboard Web Application
- Lightspeed Live Capture Web Portal

Note: Vantage Web applications should be installed on a different server from the Telestream Transcode & Analysis engine. For this reason, Web applications are included only with the array installer and not with the single-node installer.
Vantage Workflow Portal Web Application
Workflow Portal is also implemented as a Web application, which is installed separately from Vantage. The Web version of Workflow Portal works with most configuration types and allows most of the features listed above, except for submitting media from Windows platforms, and stitching files.

The login requirements are the same as for other clients. For information about creating configurations for the Workflow Portal, see the Vantage Domain Management Guide, and for details about using portal configurations to perform media processing, see the Workflow Portal Guide.

Vantage Dublist Portal Web Application
The Dublist Portal Web Application enables you to display and manage TrafficManager dublists processed by Dublist monitor workflows. Filters allow you to narrow the list of dublists displayed based on various criteria. Dublist Portal also includes a tab for viewing and managing dublist expirations. For more information on using the Dublist Portal, see the TrafficManager User Guide.

Vantage Job Status Views Web Application
The Job Status Views Web Application, which is installed separately from Vantage, provides Vantage operators and managers with detailed job status information about jobs in the domain. Using the Vantage Management Console, Vantage administrators can configure custom job status views, which define what information an operator sees. When there is a large volume of jobs or when security policies dictate, you might want to create custom views for individual operators or departments.

You can access the Job Status Views at http://[server name]/Vantage/JobStatusViews/. The login is the same as for other Vantage applications.

For information about configuring the Vantage Job Status Views, see the Configuring Job Status Views chapter in the Vantage Domain Management Guide, and for information about using Job Status Views, see the Monitoring Workflows and Managing Jobs chapter in the Vantage User Guide.

Vantage Dashboard Web Application
The Vantage Dashboard Web Application, which is installed separately from Vantage, is designed to help domain administrators track the status and system health for the entire Vantage domain, as opposed to other tools which enable management of domain components.

The Vantage Dashboard pages help you quickly assess the health of the domain and progressively dig into deeper detail as needed. For example, the Summary Status page allows you to quickly see the workflow completion success rate and the error rate on servers in the domain. The information on the Summary Status page can help you determine if it is more appropriate to look for problems in a workflow or in a particular server.
Other Vantage Dashboard pages allow you to view the status of servers, services, and jobs. When troubleshooting, it can be very helpful to determine if problems are system wide or confined to a server, a service, or a particular workflow. Vantage Dashboard provides the Web pages that allow you to quickly assess your domain from any Web client that has connectivity to your domain.

For information on using Vantage Dashboard, see the *Using the Vantage Dashboard Web App* chapter in the *Vantage Domain Management Guide*.

**Lightspeed Live Capture Web Portal**

The Lightspeed Live Capture Web Portal allows control over Lightspeed Live capture channels configured within a Vantage workflow for manual start. Channels not configured for manual start are presented in the portal as status (read-only) views. Using the web application, you can select sources and control starting, pausing, and stopping of live video capture.

**Vantage TrafficManager**

TrafficManager™ streamlines content handling for TV stations and cable facilities. TrafficManager provides a complete solution for syndicated and commercial media workflows, from ingest, review and approval, transcoding, dub list reconciliation, delivery for ad insertion servers or broadcast servers, and automation system notification.

TrafficManager automates the entire workflow, using rules that you specify for how to find, process, and deliver media. When new assets arrive, TrafficManager will automatically identify them and execute all of the steps necessary to ensure timely availability for on-air, cable or web transmission. This happens without requiring manual labor, ensuring that media is prepared in the fastest possible manner, and without introducing human error.

For national ads, TrafficManager integrates with popular digital media delivery services including Javelin, ExtremeReach, the Comcast ADN (Radiance), and others.

TrafficManager integrates with select third-party playout automation systems to automate notification of incoming content and metadata.

TrafficManager dublist analysis tools let you quickly see the status of the assets you need. Your traffic and operations staff can see at a glance if any material has not yet arrived, narrowing their search to only the assets which need attention.

Operators use the Vantage Workflow Portal or Syndication Portal to manage and modify commercial and syndication media and metadata and submit them for workflow processing.
Vantage Dublist Portal

Dublist Portal is a TrafficManager-licensed program which allows users to manage dublist processing. It allows you to view a list of dublists for recently active Dublist Monitor workflow actions, manage dublist expiration, and test dublists to pre-qualify them for workflows. For more information on using the Dublist Portal, see the TrafficManager User Guide.

Post Producer and Related Options

Post Producer™ fully automates production processes by assembling multi-layered video deliverables from content sources and masters. With Post Producer you can construct finished, branded assets to automatically re-purpose media for today’s multi-language, multi-platform distribution.

Post Producer and related products and options are ideal for:

- Frame accurate clipping and montage assembly of video sources
- Dynamic assembly of composition visuals from video and graphics sources and creation of titles
- Selecting, mapping and combining audio channels to match output requirements
- Inserting ancillary metadata for closed captions, subtitles, Vchip and dynamic advertising

VOD Producer with Dynamic Ad Insertion

VOD Producer DAI is built on the Vantage platform. It automates the assembly of CableLabs VOD content and provisions it for Dynamic Ad Insertion. The VOD Portal enables operator-driven production, including viewing of clips and marking the ad insertion points. VOD Producer generates the necessary metadata files for Nielsen and Canoe, and encodes the media to support ad insertion during VOD playback.

Vantage DPP Packager

Vantage significantly simplifies the DPP file production process by offering a complete, automated and easy-to-use solution for creating DPP files quickly and effectively. Operators simply enter metadata and mark programme segments. After that, Vantage automatically assembles the timeline with slates, bars and tones in the correct places, and programme segments aligned accurately. Vantage also integrates with common QC systems to perform Harding FPA analysis. Vantage then encodes the output AS-11 file with its award-winning full 16-bit video processing and optional GPU acceleration, while simultaneously inserting the metadata.

Vantage can also automate delivery to the final destination, allowing you to quickly scale your DPP file production with a minimum of manual labor.

Vantage® offers a complete solution to perform these DPP functions:

- Allow data entry of DPP metadata, including automatic validation and administrator-defined data entry rules
• Assemble a DPP time line, generating bars, slates, tones, and aligning programme segments correctly
• Transcode to create a DPP-compatible AS-11 MXF file, including metadata and time code
• Automate delivery to multiple locations

Post Producer Titler Engine

The Vantage Post Producer™ Titler Engine, powered by NewBlueFX®, is an optional, licensed feature designed to automate versioned titling of video assets.

Titler Engine uses templates created in NewBlue's Titler Pro™ Editor, which is available as a Windows and Mac OS program, or as a plug-in for top non-linear editors including Adobe Premiere. Together with these powerful video editing tools, Titler Engine enables high-level titling capabilities, including animation, and scalable and flexible titling applications.

Vantage Tempo

Tempo™ is a complete solution built on the Vantage platform for re-timing file-based content, intelligently decreasing or increasing the running time of shows and segments.

Tempo utilizes new time compression algorithms that deliver superior quality and faster turn-around times because it is designed to leverage new methods of media analysis. It does not throw frames away. Rather, it intelligently interpolates the desired time change over the duration of the content in a way that produces no noticeable visual or audible artifacts.

Tempo has the ability to re-time the complete asset but allows marking selected segments for inclusion or exclusion from the re-timing process when the overall program is re-timed.

Operator control of Tempo is provided through the Tempo Portal, which allows browsing catalogs and selecting media clips to drag and drop to a Segment List. In the Segment List, clips can be separated into program segments via a mark in/mark out process and configured for re-timing or left untouched. The operator then forwards the program, described in an XML composition file, to a Tempo workflow, which re-times the media accordingly.
Lightspeed Server

The Telestream® Lightspeed Server can serve as the hardware platform for a Vantage domain or be added to any Vantage domain to accelerate video processing and x264 transcoding. Lightspeed Server accelerates processing with GPUs and multi-core CPUs to provide the best image quality in the least amount of time. Housed in an efficient 1-rack-unit server, Lightspeed Server reduces rack space, power and cooling requirements while meeting increased output capacity needs.

Lightspeed Server accelerates compute-intensive image processing in Vantage workflows, including scaling, deinterlacing, frame rate conversion, motion vector calculation, and other tasks that require computation and analysis to modify or create new video frames. Faster video preprocessing improves the output quality of all video output formats.

There are several Lightspeed Server models, each pre-configured to your order. You can order Lightspeed configured as an all-in-one single-node server containing a complete Vantage system and licenses, ready to run. You can also order multiple Lightspeed Servers with various Vantage components and licenses installed, ready to network together to create a Vantage array.

For more information about the Lightspeed Server, see Lightspeed Server on the Telestream Web site.

Lightspeed Live Stream

Lightspeed Live Stream delivers enterprise-class live streaming for media and entertainment companies, corporations, government agencies and educational facilities. Lightspeed Live Stream provides efficient and superior quality adaptive bit rate encoding for SD, HD and UHD sources into AVC and HEVC. This integrated hardware and software appliance combines multiple CPU and GPU cores as well as targeted ASIC CODEC acceleration to deliver flexible and efficient encoding performance. Input support is available for SDI as well as IP sources, offering future-proof operation as delivery mechanisms change. Output can be delivered via RTMP or as HTTP Live Streaming (HLS) and MPEG DASH packages.

Lightspeed™ Live Stream can be deployed as a stand-alone solution for live, multiscreen services or combined with the Vantage Media Processing Platform via the optional Lightspeed Live Capture product.
Capturing Live Video and Tape Feeds

Telestream offers the latest and fastest in live capture products for media and entertainment companies, corporations, government and education.

Lightspeed Live Capture

Lightspeed Live Capture offers a real-time, enterprise-class video capture system to answer the increased demand for news, sports, and special event broadcasters to simultaneously push live programs over the Internet.

Lightspeed Live Capture independently records multiple channels of SD, HD or a single UHD channel. By integrating parallel file-based open workflows in Telestream’s Vantage platform together with the combined CPU/GPU power of the Lightspeed Live server and applications, the fastest possible delivery of all assets is realized.

Lightspeed Live Capture can receive content via four 3G baseband SDI (1080p/60) channels or one 4K UHD channel via four SDI ports. Live Capture can supply a number of high quality mezzanine formats to Vantage, allowing simultaneous use of the full range of video manipulation that the Vantage Media Processing Platform offers.

Lightspeed Tape Capture

Lightspeed Tape Capture, a feature of Lightspeed Live Capture, supports tape log and capture functionality via 4 Sony standard RS422 machine interface ports, 4 SD/HD/UHD SDI inputs, and an HTML 5 browser client added to Vantage Web Apps. The client allows logging multiple tapes, marking clips to extract from tape, and capturing clips from tapes into output media files using a selectable container/codec. A Tape action added to Vantage enables Vantage workflows to fully take advantage of the tape interface.

Tape Capture supports metadata labels and variables, includes full VTR transport controls with keyboard shortcuts, and provides audio meters with 8 selectable stereo pairs. User accounts provide password protection to prevent unauthorized application access.

Pipeline

Using a Telestream Pipeline encoder as part of your Vantage system, Vantage can ingest live or tape feeds into Vantage workflows. Combining Pipeline’s baseband capture with a Vantage system, you can create high-quality real-time or near real-time output in any format supported by Vantage.

For example, you can simultaneously create high-res files for storage while creating a low-res proxy, or create any number of additional file formats in real-time or near real-time. Transcoding occurs simultaneously while ingesting the captured media, ensuring the fastest possible turnaround time for media processing. Pipeline also preserves important metadata, such as ancillary data, throughout your transcoding workflow. Pipeline encoder channels allows for a high degree of scalability and flexibility.

For more information about utilizing Pipeline in Vantage workflow see Using Vantage Publish within Pipeline Control on the Telestream Web site.
Vantage Licenses

Vantage licenses enable specific Vantage features or feature sets. All Vantage software is available on the Telestream web site. Vantage allows you to download and install Vantage software in demo mode without licenses. At your convenience you can purchase licenses and add them to Vantage for only those products you need. If you need additional products later, you can purchase licenses for additional options.

Note: Some Vantage programs and features are available only with particular Vantage product licenses. To ensure you get the features you want, contact Telestream sales for the latest bundling and licensing information.

Product licenses do not include maintenance and support, which must be ordered separately.

The following topics introduce the available licenses (see the Telestream web site for the latest licensing information):

- Transcoding Products
- Transcoding Product Options
- Workflow Products
- Workflow Third Party Connectors
- Vantage System Management Products
- Vantage Post Producer
- VOD Producer Dynamic Ad Insertion (DAI)
- VOD Portal
- Tempo Content Re-Timing Software
- Lightspeed Servers
- Lightspeed Options and Bundles
- Lightspeed Live Capture

Transcoding Products

The following are the transcoding license configurations:

- Vantage Transcode—Includes Vantage Workflow Designer, SD & HD New Media, Edit, VOD transcoding format support, FTP/network folder workflow support, and enhanced video processing. GPU acceleration is available for this product when running on a Lightspeed Server. This is a software only, single server license.

- Vantage Transcode Pro—Includes Vantage Workflow Designer, SD & HD New Media, Edit, VOD, Broadcast Server, IPTV and MXF transcoding format support, FTP/network folder workflow support, and enhanced video processing. GPU acceleration is
available for this product when running on a Lightspeed Server. This is a software only, single server license.

- **Vantage Transcode Connect**—Includes Vantage Workflow Designer, SD and HD New Media, Edit, Populate plug-in, Web Services Notify, and VOD Transcoding Format support. Provides broadcast server monitoring, XML metadata transformation and delivery, and Web Service notification. Also includes Amazon S3 File System support. GPU acceleration is available for this product when running on a Lightspeed Server. This is a software only, single server license.

- **Vantage Transcode Pro Connect**—Includes Vantage Workflow Designer, SD and HD New Media, Edit, Populate plug-in, Web Services Notify, VOD, Broadcast Server, IPTV and MXF transcoding format support. Includes broadcast server monitoring and delivery, Avid Send to Playback and Interplay delivery, AAF for MediaComposer and Interplay delivery via TransferEngine, XML metadata transformation and delivery, and Web Service notification. Includes enhanced video processing. Also includes Amazon S3 File System support. GPU acceleration is available for this product when running on a Lightspeed Server. This is a software only, single server license.

- **Vantage Generic Catch Monitor**—The Generic Catch Monitor for Vantage Transcode Pro and Transcode Pro Connect receives news clips from media delivery services, such as Extreme Reach Pathfire delivery service and transcodes to specified broadcast server or news system, and processes the XML sidecar into Vantage.
  - Requires Vantage Transcode Pro or Transcode Pro Connect
  - Automates ingest of content from media delivery system
  - Associated XML metadata is processed through Vantage
  - Files and metadata are delivered directly to on-air servers or newsroom production systems

- **Vantage Transcode IPTV VOD**—IPTV and cable VOD transcoding for HEVC, H.264, MPEG-2 and MPEG-1 Transport Stream files. Includes Manzanita Systems multiplexing and x265 HEVC and x264 H.264 encoding. Also includes Vantage Workflow Designer, enhanced video processing, and FTP/network folder workflow support. GPU acceleration is available for this product when running on a Lightspeed Server. This is a software only, single server license.

- **Vantage Transcode Multiscreen**—Multiscreen transcoding for Apple HLS, Adobe Dynamic Streaming, Microsoft Smooth Streaming, and MPEG DASH. Includes x265 HEVC and x264 H.264 encoding technologies, adaptive bit rate packaging, encryption for DRM and full workflow automation. Also includes Vantage Workflow Designer, enhanced video processing, TAR creation, FTP/network folder workflow support. This is a software only, single server license.

For information on the encoders and packagers provided with each license, refer to the Telestream Web site: http://www.telestream.net/telestream-support/vantage/support.htm.
Transcoding Product Options

Transcode options extend Vantage transcoding capabilities:

- **Avid Interplay Option**—Enables delivery of files and metadata into Avid Interplay using Vantage Transcode Pro Connect. Enables AAF/MXF media encoding, metadata insertion, and delivery via Avid TransferEngine and Avid Interplay Web Services. Metadata insertion includes ability to add timeline locators and descriptive metadata into Interplay. Also includes additional Avid Web Services features for updating existing metadata and adding multi-resolution encoded versions to existing assets. This option is available for Vantage Transcode Pro Connect only. A Transcode Pro Connect license is required. Does not include first year’s Annual Maintenance and Support, which must be ordered at time of purchase. Please include list price when calculating maintenance and support.

- **Cinnafilm Tachyon and Cinnafilm Dark Energy Options**—Tachyon® Video Processing Library (VPL) and Dark Energy from Cinnafilm® are available as separate or combined optional add-ons to Telestream Vantage Transcode and Transcode Pro. For professionals who deal in mixed standards and formats, the Tachyon option provides Vantage media workflows access to high-quality format and standards conversions tools. Tachyon and Dark Energy require Telestream K20 or better Lightspeed servers running Vantage. Dark Energy® can be used for removing unwanted noise/film grain, and for creating image upscaling and down-sampling. Down-samples are alias-free and up-res’d images are scaled with heavy consideration to the image texture at the new raster size.

- **Comprimato JPEG2000**—Enables GPU encoding and decoding of JPEG2000 video files. Available for the Transcode Pro option only, and requires a Lightspeed K20 server or better, both purchased separately.

- **Dolby E Decode Option for Vantage Transcoding**—Decodes Dolby E.

- **Dolby E Encode Option for Vantage Transcoding**—Enables encoding of DolbyE for Vantage Transcode and Transcode Pro. Contact Telestream for supported formats.

- **GraphicsFactory Upgrade**—Upgrade that can be added to any Vantage Transcode. Includes engine, template creator and submit tool.

- **GraphicsFactory Template Creator**—Provides node-locked seat of the Graphics Factory Template Creator, which can be run on a separate computer. Does not have to be run on a Vantage server.

- **Vantage Camera Ingest Option**—Offers significant time savings for post-production and news users by enabling hands-free batch ingest, processing, time-alignment, and stitching of camera media. Camera ingest software automates and simplifies camera ingest, transcoding and importing of shots in an editing system, freeing editors to focus on editing, instead of manually finding, importing and stitching clips.

- **Dublist Portal**—Dublist Portal for Vantage is a software option that provides the ability for Vantage users to monitor for incoming content, and compare that against a Dublist, which is a CSV file that includes media information. The Dublist Portal shows found and missing content and makes it easy for operators to identify missing files. Requires Vantage Transcode Pro or Transcode Pro Connect.
• **Nielsen Watermarking Option**—Allows insertion of Nielsen NAES2 and Nielsen Watermarking audio watermarks for measurement of D4 or D7 ratings for VOD content and also for commercial monitoring with Nielsen’s Sigma and KeepingTrac services. A single license allows up to four concurrent watermarking jobs to execute simultaneously. Requires use of the Vantage SDK or the Workflow Portal and Vantage Analysis; please see the Nielsen Application Note for more information.

• **Timed Text Flip**—Timed Text Flip is an optional module that can be accessed through the Vantage Workflow Designer. The option offers an automated subtitle and captioning service that runs on the Vantage Media Processing Platform, providing an interface to read, write, and adjust subtitle and caption data. Supports the import of data from multiple file types including EBU-STL, SRT, SCC, MCC, TTML (DFXP / SMPTE 2052), WebVTT, Lambda CAP, PAC, and source video files containing CEA-608/708 caption data. Supports the re-timing and frame rate conversion of caption and subtitle files with starting timecode, re-time rate percent, and timecode offset parameters to match source media file or transcode workflow. Exports from Timed Text Flip include TV and Internet caption and subtitle formats: SCC, MCC, SRT, Subtitle Overlay, TTML (DFXP / SMPTE 2052), WebVTT, and Same as Source outputs embeds CEA-608/708 caption data into video files. In addition, the Subtitle Overlay function generates graphics for burn-in subtitles in SD, HD, UHD, 4K, and custom resolutions. Subtitle Overlay output parameters include font style selector, text color, background color/opacity, text outline color/thickness. Also shows safe title margins. Timed Text Flip workflows require a transcoder to burn-in the subtitle graphics into a deliverable media file.
Workflow Products

The workflow licenses enable various features specific to automating media workflows:

- **Vantage Analysis**—Includes analysis for curtains, letterboxing, Telecine, black detection, slate/spot detection, macroblocking, loudness measurement with dialog detection and gating controls for compliance with CALM Act, ATSC A/85, BS-1770-3 and EBU R128, and more. Includes PSNR measurement for comparing two files. This is a software only, single server license.

- **Vantage Analysis Pro**—Includes all capabilities of Vantage Analysis, with additional capabilities for Dolby E audio detection and analysis, compliance checking, PDF reporting, and integration with MediaInfo for extended media properties. This is a software only, single server license.

- **Upgrade from Analysis to Analysis Pro**—Upgrades from Vantage Analysis to Vantage Analysis Pro. This is a single license upgrade.

- **Vantage Open Workflows**—The Open Workflows license enables workflows and actions to operate in open mode, which allows open-eligible actions to operate concurrently rather than serially. This feature greatly improves workflow processing speed and efficiency.

  The license must be installed before the feature can be enabled. Open Workflows are licensed on a per server basis. For example, if you have a 5 node array and 3 license seats of Open Workflows, then 3 out of the 5 servers will be Open-capable.

  If a user would like to release an Open Workflows license seat from a server in order to make it available to a different server, the user may put all the services on a machine that has an Open Workflows license seat in and out of maintenance mode. This will cause the license seat to be acquired by a different server that previously did not have an Open Workflows license seat.

  Lightspeed Live Servers include Open Workflows at no extra charge. However, Lightspeed Live servers are limited to a small subset of the Vantage services.

- **Vantage Workflow Portal**—The Vantage Workflow Portal allows operators to browse assets in the Vantage catalog, construct EDLs, enter metadata, and submit jobs to Vantage workflows. Each Vantage Workflow Portal license allows one instance of client access from any client machine; the total number of licenses in the Vantage database determines how many clients can connect simultaneously. This is a one client access floating license. **Note:** This product requires either a Metadata, Transcode Connect, or Transcode Pro Connect license.

- **Vantage Metadata Conversion**—Enables ability to transform XML files, create or populate metadata labels, and perform Web Services notification. Includes: Web Services notification, Populate, Transform, Gather and Archive actions. This is a software only, per server license.
• **Vantage TrafficManager™ for Broadcast**—Controls and automates the ingest, management and production of commercials and content. Includes the following:
  - Catch server integrations with Pitchblue, Pathfire, DG, Javelin, Extreme Reach, Hula MX and more
  - Syndication support for content from PitchBlue and Pathfire - includes syndicated template creation and management system and automated long-form content handling.
  - Customizable web page for local and regional submissions via web upload
  - Automated dub list processing to trigger commercial processing
  - Vantage Analysis for smart transcoding and ITU 1770.3 loudness correction
  - Vantage Workflow Portal for Windows client and web-based commercial and syndicated content inventory management (5 users included)
  - Vantage Transcode Pro Connect for transcoding & delivery to broadcast, edit, and web formats.

This is a software only, single server license. Requires 5 days on-site installation, purchased separately. N+1 Redundancy may be added with Vantage Array. Additional user accounts may be added with Vantage Workflow Portal. Fully compatible and extendable with all Vantage transcoding, workflow, partner integrations and system management products. GPU acceleration is available for this product when running on a Lightspeed Server.

• **Vantage TrafficManager™ for Cable/IPTV**—Controls and automates the ingest, management and production of commercials and content. Includes the following:
  - National catch server integrations with Pitchblue, Pathfire, DG, Javelin, Extreme Reach, Hula MX and more
  - Customizable web page for local and regional submissions via web upload
  - Automated dub list processing to trigger commercial processing
  - Syndication module for template-controlled ingest and processing of long-form content
  - Vantage Analysis for smart transcoding and ITU 1770.3 loudness correction
  - Vantage Workflow Portal for Windows client and web-based commercial and syndicated content inventory management (5 users included)
  - Vantage Transcode IPTV VOD for transcoding & delivery to IPTV and cable ad insertion
  - Vantage Transcode Connect for transcoding to web, edit and mobile formats, and XML transformations

This is a software only, single server license. Requires 5 to 7 days on-site commissioning, purchased separately. N+1 Redundancy may be added with Vantage Array. Additional user accounts may be added with Vantage Workflow Portal. Fully compatible and extendable with all Vantage transcoding, workflow, partner integrations and system management products. GPU Acceleration is available for this product when running on a Lightspeed server or a server utilizing Lightspeed technology.
• **Post Producer™**—Allows automated editing and assembly of finished content from one or more input media files. Includes media trimming, stitching, overlays, audio mixing and metadata insertion for a wide variety of formats (please see Post Producer data sheet for a full list of supported formats and features). Includes Conform action support for CML message submission and Compose action support for TSEDL and AN2 inputs. Includes Vantage Workflow Designer, and FTP/network folder workflow support. May be combined with any Transcode product, sold separately. GPU acceleration is available for this product when running on a Lightspeed Server. This is a software only, single server license.

• **Post Producer™ Titler Engine**, powered by NewBlueFX®, is an optional, licensed feature designed to automate versioned titling of video assets.

### Workflow Third Party Connectors

Connectors allow Vantage to submit and monitor jobs to third party systems. Except where noted, a Connector license allows four (4) concurrent jobs on the partner system. Additional Connector licenses may be purchased to allow additional jobs.

- **Vantage Agility ECS Connector**—Allows a Vantage server or array to submit jobs to an Agility ECS. License allows connection to one ECS.

- **Vantage Aspera faspex™ Delivery Connector**—Provides automated delivery of media and associated files directly to Aspera faspex™ Servers. Aspera fasp™ transport technology can achieve delivery speeds many times faster than standard FTP and HTTP to an address list or an Aspera drop box. Does not include Aspera Faspex server. This is a software-only license that allows up to four concurrent file transfers.

- **Vantage Aspera Enterprise Server Integration**—Enables Vantage to interactively browse, upload, and download media content with any Aspera server endpoint, whether that is a fully featured Enterprise Server system or a Point-to-Point node. Allows for automated high-speed transfer of files processed into and out of any Vantage workflow. Does not include Aspera Enterprise Server software.

- **Avid Interplay Option**—See Avid Interplay Option in *Transcoding Product Options*.

- **Vantage Minnetonka AudioTools Connector**—The Vantage AudioTools Connector integrates within Vantage’s file-based framework using AudioTools Server to support fundamental loudness control workflows and custom, predefined workflows for broadcasters. AudioTools Server (ATS) is a highly configurable and modular system and the Connector allows Vantage to drive audio processing workflows and jobs directly from the Vantage workflow designer.

- **Vantage Digimetrics Aurora Connector**—Allows integration of Digimetrics Aurora software with Vantage. This connector allows up to four (4) concurrent QC sessions to be triggered by, and monitored within Vantage. Does not include Digimetrics Aurora. **Note:** Aurora should not be run on the same machine as a Vantage Transcode or Analysis product. The Vantage Aurora Connector service must be installed on the Aurora machine.
• **Vantage Baton Connector**—Allows integration of Interra Baton software with Vantage. This connector allows up to four (4) concurrent QC sessions to be triggered and monitored by Vantage. **Note:** Baton cannot be run on the same machine as a Vantage Transcode or Analysis product. The Vantage Baton Connector service must be installed on the Baton machine. Does not include Baton software.

• **Vantage Cerify Connector**: Allows integration of Tektronix Cerify QC software with Vantage. This connector allows up to four (4) concurrent QC sessions to be triggered and monitored by Vantage. The Cerify software cannot be run on the same machine as a Vantage Transcode or Analysis product. The Vantage Cerify Connector service must be installed on the server running Cerify. This option does not include the Cerify software.

• **Vantage Connector for Civolution NexGuard Watermarking**—Enables Civolution NexGuard Pre-release Watermark Embedder capability within Transcode or Transcode Pro, allowing four (4) concurrent sessions. This license does not include the Civolution NexGuard license which must be purchased directly from Civolution. Requires Vantage Transcode or Transcode Pro.

• **Vantage Connector for Civolution NexGuard Manager Server**—Enables Vantage connection to Civolution NexGuard Manager Server, allowing updates of Civolution database as watermarking is performed. Only one license is required per Array. Requires Civolution NexGuard Manager Server, available from Civolution directly.

• **Vantage Dolby DP600 Connector**—Allows integration between Vantage and a Dolby DP600. One connector allows up to four (4) concurrent work sessions (jobs) on the DP600. **Note:** Does not include Dolby DP600.

• **Vantage Emotion Connector**—Allows integration of Emotion Systems software with Vantage. This connector allows up to four (4) concurrent Emotion sessions to be triggered and monitored by Vantage. **Note:** The Emotion Systems software cannot be run on the same machine as a Vantage Transcode or Analysis product. The Vantage Emotion Systems Connector service must be installed on the server running Emotion.

• **Vantage FileCatalyst Integration**—Allows integration of FileCatalyst for delivering files to FileCatalyst servers. This connector allows up to four (4) concurrent file transfers to be performed by Vantage. Does not include FileCatalyst server.

• **Kantar Watermarking Option**—Allows insertion of Kantar watermarks in IPTV VOD actions for audience measurement via compatible systems (such as Mediametrie).

• **Screen Open Subtitle Graphics Generation**—Open subtitling solution where the subtitle text is permanently burnt-in and visible in the video portion of the media. Only available within Transcode or Transcode Pro. **Note:** This option requires Vantage Transcode or Transcode Pro to burn in the subtitles.
• **Pitchblue Monitor for Vantage**—The Pitchblue Monitor for Vantage Transcode Pro and Transcode Pro Connect receives content from Pitchblue media delivery service and transcodes to a specified broadcast server, and processes available XML sidecar metadata into Vantage.
  – Requires Vantage Transcode Pro Connect
  – Automates ingest of content from Pitchblue media delivery system
  – Some associated metadata can be processed through Vantage
  – Files and metadata are delivered directly to on-air servers

• **Vantage Pulsar Connector**—Allows integration of Venera Pulsar software with Vantage. This connector allows up to four (4) concurrent QC sessions to be triggered and monitored by Vantage. **Note:** Pulsar cannot be run on the same machine as a Vantage Transcode or Analysis product. The Vantage Pulsar Connector service must be installed on the Pulsar machine. Does not include Pulsar software.

• **Nexidia QC Integration**—A Vantage Nexidia connector and action provide access to Nexidia QC functionality within Vantage workflows. Nexidia QC provides automated closed caption and video description verification, closed caption alignment, and language identification for broadcast and IP workflows.

• **Vantage Screen MediaMate Connector**—Allows Vantage to connect to external MediaMate systems. Allows up to four (4) concurrent jobs to be performed in MediaMate, managed by Vantage. **Note:** This option does not include Screen MediaMate. Use of this Connector requires the purchase and installation of custom MediaMate models, and a dongle from Screen. These models are purchased from and installed by Screen.

• **Vantage Signiant Integration**—Allows integration of Signiant for delivering files to Signiant Content Transfer Engine and Media Exchange server locations. This connector allows up to four (4) concurrent file transfers to be performed by Vantage. **Note:** This option does not include Signiant Content Transfer Engine or Media Exchange server software.

• **Vantage Social Media Connector**—Enables Vantage workflow to perform automated content packaging for distribution to social media sites. Automates formatting and upload for social media distribution to the Vantage Deploy action. One license includes all supported end points and 4 concurrent uploads. Also requires Vantage Workflow Portal, Vantage Metadata, Vantage Transcode, Vantage Multiscreen, and Vantage IPTV or Transcode encoder to produce video for distribution.

• **Vantage Social Media Pro Packaging**—Extends packaging capability with enhanced branding and captioning features. Includes Post Producer, Timed Text Flip, VOD/Social Media portal. Prerequisite: Vantage Social or Social Media Connector.

• **Vantage VidChecker Connector**—Allows integration of Vidchecker software with Vantage. **Note:** Vidchecker cannot be run on the same machine as a Vantage Transcode or Analysis product. The Vantage VidChecker Connector service must be installed on the Vidchecker machine. This connector allows up to four (4) concurrent QC sessions to be triggered and monitored by Vantage. Does not include VidChecker software.
Vantage System Management Products

The Vantage System Management license allows you to install Vantage services on multiple Windows or Telestream Lightspeed servers, increasing the capacity and reliability of your Vantage domain. Vantage array features include the following:

- **Redundancy**—Multiple Vantage array servers can host the same service, increasing the processing capacity of the Vantage domain.

- **Session-based load balancing**—When a Vantage service is enabled on multiple Vantage array servers, individual workflow actions can be executed by any Vantage array server that is configured for the supporting service. Action execution is scheduled based on CPU availability and priority.

- **Priority acceleration for transcoding actions**—Vantage servers, both single node and arrays, can pause lower priority actions hosted on the same service, execute the higher priority action, and then resume the lower priority action.

- **N+1 failover protection**—Vantage array servers communicate with each other and can redistribute the workload if a Vantage array server fails. If a job fails to complete due to a Vantage array server failure, another Vantage array server restarts the job.

- **Support for mirrored SQL Standard and SQL Enterprise with Clustering databases**—provides redundancy and failover protection for the Vantage domain database.

If the current domain is an all-in-one domain, the activation of a Vantage Array license changes the Vantage server to a Vantage array server. You can then create a distributed domain by adding Vantage array servers. In a Vantage array, every Vantage server is a Vantage array server and requires the Vantage Array license.

Additional System Management options to the Vantage Array license are:

- **Advanced Task Scheduling**—Adds advanced task scheduling to Vantage, including the new Task Based load balancing and the legacy Cost Based load balancing. Increases overall system throughput by optimizing server usage for all Actions across all services in a Vantage array while Cost Based load balancing provides optimization of Actions only across like services. Task Based load balancing is the new recommended load balancing methodology. Array is sold separately.

- **Vantage Reporting & Analytics**—Enables CSV reporting and workflow analytics in Vantage. Includes Populate and Web Services Notify. This is a software only, per array license (entire array).

- **Vantage System Dashboard**—Web dashboard enables remote visibility into overall system health and status for administrators, and allows remote maintenance of the Vantage Array. This is a software only license with options for per node or unlimited server licensing.

- **Vantage Elastic Domain**—Vantage Elastic Domain allows on-demand daily rentals of supplemental Vantage licenses as required for bursting. When combined with virtualized and/or cloud deployment models, Elastic Domain provides a rapidly scalable Vantage Domain that can be expanded temporarily during periods of peak demand. Burst license usage can be monitored via interactive console hosted by Telestream. Annual subscription enables program access. Daily burst license rentals are not included. Requires automated reporting of Vantage domain size to Telestream billing servers.
• **Vantage Elastic Domain Burst**—Daily rental of a domain-specific license set for use on supplemental Vantage instances. License set may only include licenses present elsewhere in the Vantage domain as standard perpetual licenses. Requires active V-ELASTIC annual subscription. Supplemental licenses are acquired on-demand when additional burst instances are deployed and can be monitored via interactive billing console. Minimum rental period is one day.

**Vantage Post Producer**

Vantage Post Producer™ allows automated editing and assembly of finished content from one or more input media files. Includes media trimming, stitching, overlays, audio mixing and metadata insertion for a wide variety of formats (please see Post Producer data sheet for a full list of supported formats and features). Includes Conform action support for CML message submission and Compose action support for TSEDL and AN2 inputs. Includes Vantage Workflow Designer, and FTP/network folder workflow support. May be combined with any Transcode product, sold separately. GPU Acceleration is available for this product when running on a Lightspeed Server.

**Titler Engine Option for Post Producer**

The Titler Engine option for Vantage Post Producer is a software installer intended for installation on one or more nodes of Vantage Post Producer. This option provides a means for creating rich, animated titles using the NewBlue Titler Creator tool (not included) to create templates that can be processed by Post Producer to create automated variations using a workorder and a Post Producer template.

The Titler Engine requires Post Producer and runs on Windows Server 2012 on Lightspeed servers. This option is sold per-node, it can run on one or more nodes of Post Producer.

**VOD Producer**

Automates the creation of VOD assets to simplify and scale the process of VOD asset creation. Assembles complex VOD compositions from video, audio, graphic and metadata elements. Accessible through a graphical user interface and automation interface. License includes:

- VOD/DAI Operator Portal Network license which enables all portals in a Vantage Domain (V-VOD-PORTALSW)
- 1 Operator portal seat license (V-PORTAL)
- 1 Post Producer Content Assembly Automation license (V-PRODUCER-SW)
- 1 IPTV/VOD Transport Stream Encoder license (V-XCODE-IPTV-SW)
- 1 Transcode license (V-XCODE-SW)
- 1 Metadata license (V-METADATA-SW)
- Vantage Workflow Designer
- Vantage Management Console

GPU Acceleration is available for this product when running on a Lightspeed Server. Does not include first year’s Software Annual Maintenance and Support which must be ordered at time of purchase.
VOD Producer Dynamic Ad Insertion (DAI)

DAI is a single server license software option to Vantage Post Producer. Provisions VOD content for Dynamic Ad Insertion and measurement during the creation process. User defined DAI ad breaks are inserted during the VOD assembly process. VOD Producer DAI creates multilayer video compositions with DAI ad breaks and Nielsen D4 audio watermarking and produces the metadata documents for DAI ecosystem partners, Canoe Ventures and Nielsen. Accessible through a graphical user interface and automation interface.

License Includes:
- VOD/DAI Operator Portal Network license which enables all portals in a Vantage Domain (V-VOD-PORTALSW)
- 1 Operator portal seat license (V-PORTAL)
- 1 Post Producer DAI Content Assembly Automation license (V-PRODUCER-DAI-SW)
- 1 IPTV/VOD Transport Stream Encoder license (V-XCODE-IPTV-SW)
- 1 Transcode license (V-XCODE-SW)
- 1 Metadata license (V-METADATA-SW)
- 1 Nielsen Watermarking license (V-NIELS)
- Vantage Workflow Designer
- Vantage Management Console

GPU Acceleration is available for this product when running on a Lightspeed Server.

Does not include first year's Software Annual Maintenance and Support which must be ordered at time of purchase.

VOD Portal

The VOD Portal is a paid option that allows creating VOD media assets supporting VOD metadata such as rating and V-Chip, stitching and trimming of clips, and DAI.

Tempo Content Re-Timing Software

Tempo is a solution for re-timing file-based content and intelligently decreasing or increasing the running time of shows and segments. Tempo utilizes sophisticated video and audio time compression algorithms that deliver superior quality and faster turn-around times. Tempo runs on the Vantage media processing platform and offers all of the benefits of complete integration with the world's best workflow management and transcoding system.

Tempo Software is an option for Vantage and includes:
- Tempo Content Re-timing software
- One (1) Workflow Portal seat (V-PORTAL-SW)
- Metadata option for Vantage (V-METADATA-SW)
The Tempo product requires Vantage Transcode or Transcode Pro in addition to Vantage Analysis or Analysis Pro. Also requires 2 days on-site installation, purchased separately. N+1 Redundancy may be added with Vantage Array license and compatible hardware. Fully compatible and extensible with all Vantage transcoding, workflow, partner integrations and system management products. Does not include first year’s Software Annual Maintenance and Support which must be ordered at time of purchase.

**Lightspeed Servers**

The Lightspeed servers are Windows machines designed to run Vantage at optimum speeds. Vantage comes pre-installed on the Lightspeed server and ready to run (software sold separately.) These servers accelerate video processing for all Vantage Transcode products (Transcode, Pro, and Pro Connect), Post Producer and TrafficManager. Vantage v4.0 or later is required. Multiple Lightspeed models offering different computing and GPU power are available. For details about model features and differences, please see the Telestream.net web site and the *Lightspeed Server Guide*.

Vantage automatically adds a *Lightspeed* system variable to any Lightspeed-aware services running on a Lightspeed server. Actions can use the variable to implement Run On rules or to report or record job information.

**Lightspeed Options and Bundles**

Lightspeed fallback rules are included in all models of Vantage. Various Lightspeed options are available, including Ethernet adapters, Fibre Channel HBA options, and SSD drive upgrades. Lightspeed bundles are available to combine Lightspeed servers with Transcode Multiscreen, Transcode IPTV VOD, Transcode Connect, and Transcode Pro Connect Vantage software combinations. Contact [Telestream Sales](#) for more information.

**Lightspeed Live Capture**

Lightspeed Live Capture uses a Lightspeed server with capture card and software to capture live media to files. Four input channels of SD/HD or 1 channel of 4K/UHD via SDI (1080p/60) with 4 ports 10Gb Ethernet in a GPU accelerated capture platform for ingesting multiple video formats, creating mezzanine and AVC MP4 or MXF RDD 25 proxy files simultaneously, and storing them locally or on external networked storage. Operates as a standalone device or as part of a Vantage domain with Capture as an Origin Action in Vantage. Supports SDI inputs and a broad range of file output formats.

Platform Specifications: 1RU rack mount chassis includes dual Intel multi-core processors, 4x 3Gb/s SDI inputs, 4x 10GigE ports, GPU acceleration, over 4TB internal storage, RAID 5 protected, for a total of over 3TB of usable storage. Option to add more than 3TB of additional storage. Hot swappable dual power supplies.
Before You Install Vantage

Use this topic to understand and plan for the hardware, software, database, and network requirements before performing an installation. You’ll also learn about Vantage installers, how to obtain a Vantage license, and some distributed Vantage domain planning advice – this topic is about what you need to know before you install a Vantage domain.

Installing Vantage is easiest when you plan carefully, and you have a working knowledge of Windows server administration, networking, Microsoft SQL Server, and installation and configuration of enterprise-level software. Consult your IT group for assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to browse the Vantage Web library, user guides, patches, application notes, and other documents.

The following topics provide information you should consider when planning a Vantage installation:

- Server Hardware Requirements
- Operating System Requirements
- Third-Party Software Requirements
- Network Requirements
- Database Selection and Configuration Guidelines
- Vantage Installers Overview
- Licensing Overview
- Planning for a Vantage Array Installation
Server Hardware Requirements

Vantage is optimized for multi-core processors that support Windows operating systems. The following topics provide more information on Vantage server hardware requirements:

- Ensure Maximum Server Performance
- Vantage Server Requirements
- Database Server Requirements for SQL Standard

Ensure Maximum Server Performance

To ensure maximum server performance for all servers in the Vantage domain, be sure to set the Control Panel Power Options as follows:

Set the **Power Options** to **High Performance** with **Sleep disabled**:

1. Navigate to Start > Control Panel > Power Options.
2. Select the **High Performance** plan.
3. Set Sleep mode to **Never** (never sleep).
4. Select **Change advanced power settings**, and set all critical functions so that they are always ON (this usually means setting them to **Never** turn OFF).

- Also disable any real-time processes that may interfere with performance, such as virus scanning of media files as they are being captured, automatic real-time software updates, and real-time file indexing.
Vantage Server Requirements

Vantage server requirements depend on which domain components (services, media files, and database) are installed on the server, as well as how much media you plan to store on the server. The following table lists the hardware requirements for servers that host Vantage and SQL Express database services.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>64-bit dual six-core processors or greater; 8 MB cache or greater recommended.</td>
</tr>
<tr>
<td>RAM</td>
<td>At least 16GB RAM or greater recommended, depending on the number of concurrent transcode sessions desired.</td>
</tr>
<tr>
<td>Disk space</td>
<td>All-in-one installations: 500 GB; approximately 1 GB for Vantage services and clients, approximately 500 MB for the Transcode and Analysis Engine, and approximately 400 GB for the Vantage store media and database. The initial database size is approximately 100 MB.</td>
</tr>
<tr>
<td>Ethernet/Fibre</td>
<td>All-in-one installations: Gigabit Ethernet (GbE / 1 GigE) minimum. (Dual Ethernet may be needed in some situations). Vantage arrays: Gigabit Ethernet (GbE / 1 GigE) minimum. Recommend dual bonded Ethernet or 10GigE. The Vantage domain database and all Vantage services should be on the same subnet.</td>
</tr>
<tr>
<td>Numeric Processing Instruction Set</td>
<td>MMX, SSE, and SSE2 enabled.</td>
</tr>
</tbody>
</table>

Database Server Requirements for SQL Standard

Correctly specifying the hardware and planning the database is crucial for optimal Vantage system operation. For hardware requirements and other guidelines for a SQL Standard database, please refer to the Planning and Managing a Vantage Database chapter and these specific topics before you install Vantage or the database:

- Operating System Requirements
- Database Server Requirements for SQL Standard
- Guidelines for Selecting SQL Express or SQL Standard
Operating System Requirements

The following topics describe the operating system requirements for Vantage components:

■ Vantage Web Applications OS
■ Vantage Client Software OS
■ Vantage Services, Domain Database, and MS SQL Server OS

Note: Automatic Windows and software updates and automatic restarts of Vantage servers should be disabled. Schedule update installations and system restarts only during planned maintenance periods to prevent disruption of Vantage operations.

Vantage Web Applications OS

Vantage Web Applications should be installed on an IIS server running on the same subnet as the Vantage domain database, so that the Web applications can auto-discover the Vantage domain. To improve the performance of Vantage Web Applications and Vantage services, place the Vantage Web Applications on a dedicated server, separate from the Vantage domain database and Vantage services. The following list ranks the possible Vantage Web Application configurations from most preferred (#1) to least preferred:

1. Dedicated Vantage Web Application server.
2. Vantage Web Applications installed on a Vantage domain database server that does not host Vantage services.
3. Vantage Web Applications installed with the Vantage domain database and Vantage services on the same server (includes all-in-one domains).

Vantage Web Applications should only be installed and operated on the following operating systems:

• Windows Server 2012 R1 (64-bit only)
• Windows Server 2012 R2 (64-bit only)
• Windows Server 2016 (64-bit) Standard or Data Center Edition


• Microsoft IIS 7.5 or later is required.
• .NET 4.6.2 is required.

Installation of the IIS and .NET components is covered as part of Web app installation in the next chapter: Installing and Configuring Vantage Web Applications. The Web Apps installer now installs .NET 4.6.2 for you automatically if it is not already present.
**Vantage Web Applications Browser Requirements**

Telestream supports the following browsers for use with the Vantage Web applications:

- Internet Explorer 11, 32-bit or 64-bit (Windows only)
- Chrome current version (Mac OS X & Windows)
- Safari current version (Mac OS X only)

**Note:** To use Vantage Web applications with Internet Explorer, you must configure Internet Explorer as described below. Also note that Firefox is not recommended because it does not allow previewing in the Web Workflow Portal on Windows Server systems.

To configure Internet Explorer for use with Vantage Web applications, do the following:

- Enable Active Scripting—Open Internet Explorer, select *Tools > Internet options*, select the Security tab, click *Custom level*, scroll down to *Scripting*, click the *Active scripting Enable* radio button, click OK, and click OK.
- If you are using Internet Explorer on a Windows Server operating system, disable Enhanced Security Configuration (ESC) using the Windows Server Manager (*Server Manager > Security Information > Configure Internet Explorer ESC*).
Vantage Client Software OS

Vantage client programs (Vantage Management Console, Vantage Workflow Designer, and Vantage Workflow Portal) may be installed and run directly on a Vantage server, or on client workstations.

Vantage client programs are supported on the following operating systems:

- Windows 7, 8.1, and 10 (all versions may be x86 or x64)
- Windows Server 2012 R1 and R2
- Windows Server 2016 (x64 with Desktop Experience) Standard or Data Center


**Note:** To effectively operate Vantage services and their client programs in an array, and with other networked systems, you must disable the Windows Firewall and upgrade all systems to the latest Microsoft service packs and security updates.

Vantage requires Windows Desktop Experience (see *Install the Desktop Experience*).

**Note:** Desktop Experience is required so that the Vantage transcoders, clients, and preview player can function correctly.

If you connect to the server using a Remote Desktop Protocol (RDP) product, you must also install the Desktop Composition role feature.

Once Desktop Composition is installed, you must also enable the Desktop Composition policy.

**Note:** If you cannot install or enable Desktop Composition because needed options are grayed out, group policies set by your IT administrator may be preventing access.
Vantage Services, Domain Database, and MS SQL Server OS

Vantage services, the Vantage Domain Database, and the MS SQL Server for Vantage should be installed and operated only on the following operating systems (64-bit recommended for performance):

• Windows Server 2012 R1 or R2 (x64 only)
• Windows Server 2016 (x64 with Desktop Experience) Standard or Data Center Edition


All Vantage services and Telestream core services have been qualified on Windows Server 2012 R1/R2 and Server 2016 except as noted below:

• Avid AAF Encoder—Qualified on Server 2012 R2 only.
• Screen MediaMate—Tested and deployed by Screen; see Screen's documentation.

For all third party Vantage services (besides Aspera), refer to the respective third party manufacturer's documentation for supported operating systems.

Windows Server Configuration Requirements

The following topics describe additional Windows requirements for Vantage:

■ Install the Desktop Experience
■ Windows Server 2012 R1/R2 Desktop Experience
■ Understand User Account Control Admin Approval Mode
■ Power Options Settings

Install the Desktop Experience

Prior to installing Vantage, the Microsoft Desktop Experience must be installed on Vantage servers (except dedicated database servers) for Vantage clients and services. The Desktop Experience feature provides Windows 7 features on your server and is required by several actions, including the Analyze, Conform, Timed Text, and various Flip actions as well as Vantage clients and the proxy preview player.

To install the Windows Desktop Experience follow the procedure below for your OS.

Windows Server 2016 Desktop Experience

When you install Windows Server 2016, you can choose “Windows Server (Server with Desktop Experience).” This installs the Desktop Experience along with the server OS. No additional installation steps are required.

Windows Server 2012 R1/R2 Desktop Experience

You can use either Windows PowerShell or the Server Manager to install Desktop Experience for Windows 2012, as explained below.
To install Desktop Experience on Windows Server 2012 R1/R2 using Windows PowerShell:

1. Press Start.
2. Type: PowerShell.
3. Right-click PowerShell.
4. Select Run as administrator.
5. Execute this command:
   
   ```
   Install-WindowsFeature Desktop-Experience
   ```

To install Desktop Experience on Windows Server 2012 R1/R2 using the Server Manager:

1. Launch Server Manager.
2. In the left-hand column, go to Local Server.
3. Scroll down to ROLES AND FEATURES.
4. Left-click the TASKS button and select Add Roles and Features (see the figure below). The Add Roles and Features Wizard window opens.
5. Click Next four times until you arrive at the Features page.
6. On the Select feature page, expand the User Interfaces and Infrastructure group and enable the Desktop Experience check box. Then click Install to complete the installation.
Understand User Account Control Admin Approval Mode

If User Account Control: Run all administrators in Admin Approval Mode is enabled, run the installers by right-clicking the installer and selecting Run as Administrator. If this feature is disabled, you can run the installer normally.

To verify the setting value (Enabled | Disabled):

1. Display the command window (Start > Command Prompt).
2. In the command window, type `secpol.msc` and press Enter.

Power Options Settings

All Vantage servers should be set to High Performance in the Power Options Control Panel. This ensures that the network interface cards never sleep, which is desirable to ensure all Vantage servers remain in communication with each other all the time.

1. In Windows, display the Control Panel folder.
2. Search for Power Options.
3. Click Power Options, and select High Performance.
4. Close the Control Panel.
Third-Party Software Requirements

The following topics describe Vantage software requirements and recommendations for third-party products:

- QuickTime Requirements
- .NET Framework Requirements
- Anti-Virus Software Recommendations

**CAUTION:** If you do not install/upgrade all required software, Vantage may not operate correctly.

QuickTime Requirements

The Telestream Media Transcode and Analysis engine requires QuickTime version 7.6.9 if you plan to transcode QuickTime files. Obtain the free QuickTime installer from Apple.com at this URL:


**Note:** The Vantage Setup installer checks for QuickTime, and if QuickTime is not present, the installer installs QuickTime 7.6.9 for you if you have an Internet connection. If there is no Internet connection or QuickTime is present but outdated, the installer displays a message advising you to install QuickTime manually. Please use the URL above to download the correct version. If QuickTime is installed and up-to-date, the installer leaves QuickTime untouched.

After installation, be sure to uncheck (disable) *Check for Updates*, so that version 7.6.9 is not updated without your knowledge; then restart the server.

If you do not install the correct QuickTime version, encoding some formats causes this error: “An error occurred during execution of the Transcode Task: RenderSession Configuration Error, message: Requested encoder | decoder not installed.”

**Note:** Because QuickTime for Windows has security vulnerabilities as stated by the US Department of Homeland Security (DHS), you may prefer not to install it on your computers. If QuickTime is not installed, a number of Vantage functions will not operate, such as portal proxy playback and several Flip action functions. For details about the QuickTime vulnerability and the effect of removing it from Vantage systems, see the *Telestream and QuickTime statement* on the Telestream.net web site.

QuickTime 7.7.9 for Workflow Portal Client

The Workflow Portal desktop client preview player works best with QuickTime 7.7.9. This is the recommended version to use on Vantage client machines.
.NET Framework Requirements

Microsoft .NET Framework 3.5.1 and .NET 4.6.2 are both required on all Vantage servers and client workstations. Vantage Web Apps require only .NET 4.6.2.

The Vantage installer may install these components for you, depending on the OS:
- .NET 4.6.2 is installed automatically by the Vantage or Web Apps installer on all operating systems, if not already present.
- .NET 3.5.1 is installed automatically by the Vantage installer on client operating systems, such as Windows 7, 8, or 10, if not already present.
- .NET 3.5.1 must be installed manually using Server Manager on Microsoft Server operating systems, if not already present.

Anti-Virus Software Recommendations

Telestream recommends that you do not use anti-virus software on Vantage servers. You should not enable real-time scanning. If you do use anti-virus software, you should identify Vantage as a safe or trusted application. Telestream recommends that you disable real-time file scanning, because it will impact performance and potentially lock files being processed, impacting Vantage’s ability to operate properly.

**Note:** Be sure to turn off anti-virus software during Vantage installation or install the anti-virus software after you install Vantage.
Network Requirements

The following topics provide information on Vantage network requirements and guidelines:

- IP Address and Subnet Recommendations
- Port Requirements
- Firewall Guidelines
- Windows Authentication Guidelines
- Time Synchronization Guidelines

IP Address and Subnet Recommendations

The following topics recommend best practices for configuring Vantage servers on your network. These are some principles governing Vantage operation on a network:

- Vantage Services communicate with each other (peer-to-peer) and require reliable communication to prevent services from being treated as offline or failed.
- Services require reliable communication with the database.
- UDP, which is used for database discovery and services, does not work across subnets. This affects domain setup but not day-to-day operation.
- Desktop client software applications require access to the SQL database.

Static IP Addresses Recommended

Telestream recommends using static IP addresses and/or a host file for all machines within a Vantage domain. This is especially important when the network does not have a DNS server. Static IP’s help ensure that there is an explicit machine name to host IP correlation, which has proven to be the most effective way to maintain a large cluster.

Single Subnet Recommended

In a Vantage array installation, Telestream recommends that you install the Vantage domain database, Vantage services, and client programs in the same subnet to avoid communication issues. Within Vantage client and web applications, the service discovery feature automatically discovers all Vantage domains within a subnet. If you must access a Vantage domain from outside the subnet that hosts the Vantage domain database, you can use a DNS host name or IP address to specify the domain.

Using Vantage Across Multiple Subnets

You can use Vantage across multiple subnets, provided you adhere to these requirements:

- The subnet must be reliable (not dropping significant numbers of packets); otherwise there will be sporadic communication between services.
Before You Install Vantage

Network Requirements

• DNS configurations must be set properly (for example, static host entries must be used if DHCP is used for dynamic IP addresses).
• Use host files to ensure that dynamic machine identities do not exist.
• Firewalls need to be disabled or have the appropriate ports open (see Firewall Guidelines later in this chapter).
• Check ALL subnets where services may be running to ensure that firewalls are configured correctly.
• Client software running on a different subnet generally works without issues.

Considerations When Using Vantage on Multiple Subnets

Vantage software cannot discover services across subnets; when building the Vantage Domain you will need to add services manually:

Open the Vantage Management Console and add services to the domain as follows:
1. Select Services in the left column.
2. Click the Add Services icon in the right panel Services tool bar.
3. Select My Service/Machine is not listed.
4. Enter the machine name or IP address, and click OK.
5. Select the services you wish to add.

Additionally, Vantage client software may not be able to discover the Vantage database across subnets. The first time you run the client software, do the following:
1. Select My Domain is not Listed.
2. Provide the host name for the database, and click OK.

Troubleshooting Network Issues

The following list provides common network issues and solutions:

Symptom—Jobs are stalled in the waiting (yellow) state and are not being assigned to services:
• Problems: (1) Services go offline and online arbitrarily. (2) Services of that type are not available due to firewall restrictions.
• Solution: Review firewall settings.
• Problem: Services are not available at all.
• Solution: Review services and ensure that they are running.

Symptom—Services toggle in the Management Console, arbitrarily going offline and back on again. Service logs show “Unable to communicate with service”:
• Problem: May be a DHCP problem where IP addresses are changing.
• Solution: Ensure host tables are updated so that every service machine has a fixed name or use static IP addresses.
• Problem: May be an unreliable network causing other services to think that the service has failed.

• Solution: Analyze packet loss on the network to locate points of unreliability

• Problem: May be asymmetrical firewall configurations where machine A can communicate with B, but not vice versa.

• Solution: Review firewalls between services and ensure parity in terms of which ports are open.

**Symptom—Services cannot be discovered in the Management Console, even when using explicit service names:**

• Problem: Firewall configuration is likely blocking network traffic.

• Solution: Update firewall information to reflect requirements (see *Firewall Guidelines* later in this chapter).
Port Requirements

Vantage services are pre-configured with default TCP port numbers for network communications. To enable communications between Vantage components, you must ensure that there are no port number conflicts between the applications on each Vantage server. The following table lists the default port numbers used by Vantage services. For additional port numbers, see Firewall Guidelines.

**Note:** For instructions on viewing or changing the default port settings, search for Configuring Vantage Services in the Vantage Domain Management Guide.

<table>
<thead>
<tr>
<th>Vantage Service</th>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agility</td>
<td>TCP: 8679, HTTP: 8678</td>
</tr>
<tr>
<td>Analysis</td>
<td>TCP: 8673, HTTP: 8672</td>
</tr>
<tr>
<td>Aspera</td>
<td>TCP: 8701, HTTP: 8700</td>
</tr>
<tr>
<td>AudioTools</td>
<td>TCP: 8713, HTTP: 8712</td>
</tr>
<tr>
<td>Aurora</td>
<td>TCP: 8689, HTTP: 8688</td>
</tr>
<tr>
<td>Avid</td>
<td>TCP: 8738, HTTP: 8738</td>
</tr>
<tr>
<td>Baton</td>
<td>TCP: 8703, HTTP: 8702</td>
</tr>
<tr>
<td>Catalog</td>
<td>TCP: 8665, HTTP: 8664</td>
</tr>
<tr>
<td>Cerify</td>
<td>TCP: 8727, HTTP: 8726</td>
</tr>
<tr>
<td>Cloud</td>
<td>TCP: 8737, HTTP: 8736</td>
</tr>
<tr>
<td>Communicate</td>
<td>TCP: 8663, HTTP: 8662</td>
</tr>
<tr>
<td>Edit</td>
<td>TCP: 8699, HTTP: 8698</td>
</tr>
<tr>
<td>emotion</td>
<td>TCP: 8733, HTTP: 8732</td>
</tr>
<tr>
<td>FileCatalyst</td>
<td>TCP: 8715, HTTP: 8714</td>
</tr>
<tr>
<td>IPTV VOD</td>
<td>TCP: 8697, HTTP: 8696</td>
</tr>
<tr>
<td>Live</td>
<td>TCP: 8721, HTTP: 8720</td>
</tr>
<tr>
<td>MediaMate</td>
<td>TCP: 8685, HTTP: 8684</td>
</tr>
<tr>
<td>Metadata</td>
<td>TCP: 8675, HTTP: 8674</td>
</tr>
<tr>
<td>Metric</td>
<td>TCP: 8719, HTTP: 8718</td>
</tr>
<tr>
<td>Monitor</td>
<td>TCP: 8659, HTTP: 8658</td>
</tr>
<tr>
<td>Multiscreen</td>
<td>TCP: 8683, HTTP: 8682</td>
</tr>
<tr>
<td>Nexidia</td>
<td>TCP: 8725, HTTP: 8724</td>
</tr>
<tr>
<td>Pulsar</td>
<td>TCP: 8717, HTTP: 8716</td>
</tr>
<tr>
<td>SDK</td>
<td>TCP: 8677, HTTP: 8676</td>
</tr>
<tr>
<td>Signiant</td>
<td>TCP: 8709, HTTP: 8708</td>
</tr>
<tr>
<td>Staging</td>
<td>TCP: 8687, HTTP: 8686</td>
</tr>
<tr>
<td>TimedText</td>
<td>TCP: 8735, HTTP: 8734</td>
</tr>
<tr>
<td>Traffic</td>
<td>TCP: 8681, HTTP: 8680</td>
</tr>
</tbody>
</table>
Firewall Guidelines

Telestream recommends that you disable the Windows Firewall on all computers that will communicate with or support Vantage services. The default Windows Firewall configuration will block access to a Vantage server from other Vantage components, such as other Vantage servers or workstations running Vantage client software.

If you must run a firewall, keep in mind that Vantage communicates with the following systems/component ports, which should be considered when configuring firewall settings:

- Agility ECS Connection—TCP: 80. Configured on Vantage servers as described in Configuring an Agility ECS Connection in the Vantage Domain Management Guide.
- Avid Interplay (Unity Client, Transfer Engine, Web Services)—Discovery: UDP port 8321. For other ports, see Avid documents including Interplay Admin Guide and Avid Interplay Software Installation and Configuration Guide.
- FTP (Passive mode)—TCP: 20, 21. Custom FTP port numbers can be entered in Vantage workflows. Also, FTP uses additional port numbers as specified in the protocol specifications. Refer to the protocol specifications for additional information.
- Grass Valley AMP—Port 3811 by default.
- Harris NEXIO—TCP: 2098.
- HTTP—TCP: 80.
- Microsoft Distributed Transaction Coordinator (DTC)—User configurable; default port: 3372 when TIP is enabled. See Microsoft documentation for details.
- Microsoft SQL Server—TCP ports: 1433 and 49150–49300, UDP port: 1434—see Microsoft documentation for details.
- SFTP—TCP: 22. Custom SFTP port numbers can be entered in Vantage workflows. Also, SFTP uses additional port numbers as specified in the protocol specifications. Refer to the protocol specifications for additional information.
- SMTP—TCP: 25. This default value is configured on Vantage servers as described in Configuring Vantage Email Notifications in the Vantage Domain Management Guide.
- Vantage service ports listed in the preceding table (under Port Requirements).

Note: Third-party port numbers listed above are provided for convenience, but the list is incomplete because of the many server products available. Third party product port numbers are subject to change and beyond Telestream’s control. Please contact product vendors for port usage details.
Windows Authentication Guidelines

By default, Vantage services use the Windows Local System account when accessing file space for media storage and delivery. When all Vantage services, clients, and delivery targets are on one server, the default configuration works well. When any Vantage service, client, or delivery target is on another computer, Windows authentication requirements must be met to enable communication between multiple computers.

The following topics provide additional authentication guidelines:

- About Vantage Windows Authentication
- Configuration Guidelines for the Vantage Windows User Account
- Configuring Folders for Vantage Access

About Vantage Windows Authentication

A Vantage domain requires authentication planning when workflows require Vantage to ingest media from or send media to another computer. For remote file access, use the following guidelines:

- Configure each Vantage service that accesses files on another server to use a Windows log in ID and password. For example: VantageWinUser.
- Configure each remote storage folder to support access from the log in ID for Vantage services.
- If the same service operates on multiple Vantage servers, and requires access to files at a remote location, configure the same log in ID and password for all instances of that service.

For example, if the Transcode service is running on three servers, it operates as one Transcode service with three instances or nodes. Vantage requires that every Vantage node within a service use the same log in ID.

**Note:** When a service is comprised of multiple nodes, the Local System account, which is the default log in ID for all-in-one installations, cannot be used because it represents a different user on each system.
Configuration Guidelines for the Vantage Windows User Account

To support Vantage service access to other Vantage servers and file folders on other computers, Telestream recommends that you create a Vantage user account within the Windows domain or workgroup. To distinguish the Vantage Windows user account from regular Vantage user accounts, use a name that indicates that this is a Windows user account. For example, VantageWinUser.

Your Windows domain or workgroup administrator can configure the Vantage Windows user account before Vantage installation. When configuring this account, consider the following guidelines:

- The Vantage Windows user account should be added to the local administrator group on each server so that Vantage has the proper authority to run Vantage services and install Vantage software.
- The Vantage Windows user account must be authorized to log in as a service (see your Windows domain or workgroup administrator), so that Vantage services can log in as the Vantage Windows user on each Vantage server.
- The Vantage Windows user account should have appropriate read and write permission to network locations that Vantage will access. These network locations include the Vantage store and input and output storage locations.
- You can use the Vantage Windows user account to install the Vantage software.

For instructions on configuring services to use the Vantage Windows user account, see Setting the Vantage Windows Log On ID for Services.

Configuring Folders for Vantage Access

Vantage servers and clients may need access to folders on other computers for any of the following:

- Input of files in Watch folders
- Manual submission of input files
- Storage of output files for future Vantage use
- Delivery of output files to remote destination folders

The following topics describe how to configure folders for Vantage use:

- Configuring Folder Access Within the Windows Domain or Workgroup
- Configuring Folder Access Outside of the Windows Domain or Workgroup
- Configuring Access to a SAN System

Note: Vantage cannot access network locations defined using a Windows mapped drive. You must use a universal naming convention (UNC) path to define network locations for Vantage use.
Configuring Folder Access Within the Windows Domain or Workgroup
If you create a Vantage Windows user account as described in *Configuration Guidelines for the Vantage Windows User Account*, granting Vantage access to any folder within the domain is as simple as granting access to the Vantage Windows user. If Vantage workflow designers, operators, or administrators also need access, grant folder access to their Windows user names.

Configuring Folder Access Outside of the Windows Domain or Workgroup
When Vantage needs to access computers in a different Windows domain or workgroup, the Windows log in ID from the current domain or workgroup is not accepted. To support Vantage service access, you can configure a Vantage authorization record as described in *Specifying Authorization Credentials for Remote Folder Access* in the Vantage Domain Management Guide.

Configuring Access to a SAN System
When you want to access files in a SAN system, be aware that some systems expose the shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of the SAN. Although Vantage cannot reference a Windows mapped drive, you can reference SAN drives via a drive letter, provided that each Vantage server is a client of the SAN and that all mount points use the same letter.

Time Synchronization Guidelines
When a Vantage domain includes multiple servers and workstations, you should verify that all the computers are set to the same regional settings and the correct time zone. Otherwise, the timestamps associated with Vantage events may display incorrectly and time-driven events might not occur on schedule. When checking the time configuration in the Vantage domain, be sure to check the configuration on the following:

- All servers with Vantage services
- All Vantage domain database servers
- All Vantage web hosts
- All file servers that support Vantage stores and folders
- All workstations that run Vantage Workflow Designer, Vantage Workflow Portal, and Vantage Management Console (VMC)

Network time protocols on your network should keep the time within tolerances, as long as you correctly configure the following:

- The time zone for each server or workstation should be correct for the respective time zone.
- Any adjustment for daylight savings time should be consistent on all servers and workstations within the same time zone.
Database Selection and Configuration Guidelines

The Vantage database has very specific requirements, and its configuration differs depending on your expected processing workload and whether you are installing Vantage in a Single-Node or Array configuration. For detailed database requirements, please see the following topics included in the Planning and Managing a Vantage Database chapter of this guide, in the Vantage Database Management Guide, or in the Vantage Domain Management Guide:

- Operating System Requirements
- Database Server Requirements for SQL Standard
- Database Selection and Configuration Guidelines
The following topics introduce the Vantage installers:

- Obtaining the Vantage Installer
- Vantage Installation Package

**Note:** The Vantage installer on a USB memory stick is available upon request. Contact sales@telestream.net to request the installer on a memory stick.

### Obtaining the Vantage Installer

The Vantage installer is available from Telestream's Web site. To locate and download the Vantage installer, follow these steps:

1. Use your Web browser to go to dynamic.telestream.net/downloads/download-vantage.asp?prodid=vantage.

2. If you do not have a Telestream account, click Create an Account to display the Create a Telestream Account page. Fill out the form and click Create Account. You can use your user name and password immediately. Telestream will send you a confirmation email.

3. On the login page, enter your authorized user name & password, then click Log In.

4. On the Downloads page, click Download Now to download the Vantage installer package.
   
   Select a folder (or desktop) destination and click Save to download and save the Vantage installer file on your computer.

5. The Download Progress window displays as the file is downloaded to your computer. When the download is complete, close the Web browser.

6. Right-click the Vantage installer zip and select Extract All. Follow the steps to extract the installers and related files.

The main Vantage installer is **Vantage_7.1.exe**, which is a self-extracting archive. When you run (double-click) the archive file, it extracts a **Vantage_7.1_Setup.exe** file and ComponentPacs to the C:\Vantage7.1 folder. After extraction, the setup file automatically runs and starts the installation.

Other installers may be provided to allow installing of individual components and patches.

**Note:** Installer files may include a build number in the file name, as indicated by the x's in this example: **Vantage_7.1_Setup_xx.xx.xx.xx.xx.exe**. These numbers are excluded in this guide for the sake of simplicity and clarity.

Later, in the **Installation** chapter, you'll use these installers to install Vantage as directed.
Vantage Installation Package

The installation package includes the following installers:

■ Vantage Setup Installer
■ Vantage Database Deployment Utility
■ Vantage Client Installer
■ Vantage Web Applications Installer

Vantage Setup Installer

The Vantage_7.1_Setup.exe installer (extracted to the C:\Vantage7.1 folder when you run the Vantage_7.1.exe archive file) is the main Vantage installation program. It installs all of the server software and all of the clients. When you use it to install Vantage programs and services, you can choose an all-in-one Single Node installation or an Array Node installation. Choose Single Node to install all components on a single server. Choose Array Node if you are installing selected components on a Vantage array server. You can also choose Install Products or Custom Install. Install Products lets you select licensed product groups, and Custom Install lets you select individual components.

The Vantage Setup installer is capable of installing everything needed for a complete Vantage installation. If you check all components, Vantage Setup installs these items:

• Creates a Telestream directory for Vantage and related files. For Single Nodes only, this directory includes Local Store, Default Catalog, and Samples workflow folders.
• Installs Intel Performance Primitives software for Intel processors
• Checks for QuickTime (used only by the Telestream Media Transcode and Analysis engine) and installs it if missing or advises if it is obsolete.
• Installs SQL Server 2014 Express IF Express or Standard are not already installed. If the installer detects an existing SQL Server installation, it skips installing Express
• Creates a SQL instance named VANTAGE (only for automatic Express installations)
• Creates the Vantage domain database on the VANTAGE instance
• Installs the Telestream Media Transcode and Analysis engine
• Installs Vantage services and client programs according to your selections, including Web Applications for arrays
• Creates Control Panel Programs and Features entries for Telestream Media Transcoding and Analysis and Vantage 7.1. Other Vantage installers may add list entries, such as Vantage Clients or Vantage Web Applications.
• Creates desktop shortcuts for Vantage client applications on the desktop
Vantage Database Deployment Utility

The Vantage Database Deployment Utility enables you to install or upgrade the Vantage domain database into an existing SQL installation, such as when installing the database as part of a Vantage Array database server installation. You must first install SQL. Then when you run the utility, it performs the following tasks:

- Creates a SQL instance named VANTAGE in the existing SQL installation
- Creates the Vantage domain database on the VANTAGE instance.

Note: If you run the database utility and a SQL instance named VANTAGE already exists, this utility will update the existing instance.

Vantage Client Installer

The Vantage Client installer (Vantage 7.1 Client Applications.msi) provides a convenient installer for quickly installing Vantage client applications on client workstations. The Client installer can install the Management Console, Workflow Designer, Workflow Portal, Dublist Portal, and Transcode User Interface.

Vantage Web Applications Installer

The Vantage Web Applications installer installs these Vantage Web Applications:

- Vantage Dashboard—allows administrators to view Vantage system information.
- Vantage Job Status Views—enables operators to view job status information, and if properly authorized, execute job controls.
- Vantage Workflow Portal (VWP)—allows operators to perform operator-intervention media processing tasks via an Internet connection.
- Vantage Dublist Portal—allows managing and processing of dublists for the Traffic-Manager option.
- Lightspeed Live Capture web application—manages live video capture as part of the Lightspeed Live Capture option.
- Vantage Tape Capture web application—manages the Lightspeed Tape Capture option to capture media from videotape.
- External Links—Provides access to a convenient “bookmarks page” for storing frequently used Internet links.
Licensing Overview

The following topics describe Vantage licensing:

- **Using Vantage in Demo Mode**
- **Obtaining a Vantage License**
- **Adding or Replacing License Files**

**Note:** A Vantage domain with more than one node requires one Vantage Array license per node.

Using Vantage in Demo Mode

When you install Vantage without a license, Vantage operates in demo mode. Demo mode allows you to design workflows, input Windows Media (WMV and AVI) files for transcoding (with a watermark), and analyze a few seconds of video and audio. Some features that are not available in demo mode include:

- Support for monitoring and delivering to broadcast servers
- Support for conversion of XML files and third party integrations

**Note:** If you'd like to unlock the entire set of features in Vantage for a time-limited trial, please contact your Telestream sales representative, or contact the Telestream sales team at sales@telestream.net. Demonstration mode is limited to all-in-one single node domains.
Obtaining a Vantage License

You must obtain, install, and activate a license to:

- Test a Vantage array in demo mode
- Operate Vantage in production
- Upgrade Vantage from one version to another
- Add more Vantage services (more Transcode services, for example)
- Add licensed features (the Advanced Avid option, for example).

Please contact your Telestream sales representative or contact the Telestream sales team at sales@telestream.net to determine your Vantage requirements and obtain or update your license. When your license has been prepared, Telestream will email you the license as an attachment.

For Telestream contact details, go to www.telestream.net/company/contact-telestream.htm.

When you receive the license (an XML file), save it in a safe place for installation and activation at the end of the installation process.

Adding or Replacing License Files

Depending on your requirements, you may obtain a new license file or you may obtain updated files. Contact Telestream Sales or Customer Service, and follow their instructions for adding or updating license files.

**Note:** You can evaluate an All-in-One Single Node Vantage installation without installing a license. Demo mode allows you to design workflows, perform transcoding with a watermark, and analyze short video or audio clips. However, in demo mode (no license is installed), some features (such as broadcast server protocols) are disabled, and Vantage can only read Windows Media (WMV and AVI) files for transcoding or analysis. You cannot operate a Vantage array without a license.
Prior to installing a Vantage array, Telestream recommends that you develop a system diagram, indicating each server and the Vantage services and client programs it should host, plus the database server (and optional mirror and witness server).

The diagram should also identify which computers host client programs (Vantage Management Console, Vantage Workflow Designer, and Vantage Workflow Portal). Additionally, document all network resources utilized by the Vantage domain (file sources and destinations).

When adding Vantage services to scale performance, Telestream generally recommends adding one or more Vantage transcoding servers, which is typically the first service to max out server capacity. Multiple transcode servers improves load balancing and speeds overall job throughput. Secondly, if you use the Vantage Analysis service heavily, consider hosting it on a dedicated server as well.

**Note:** Each server hosting Vantage services requires a Vantage Array or Vantage Enterprise System Management license. Dedicated database servers do not require a special license.

**Note:** When naming servers, do not use underscores in the names. Underscores are not valid URL characters and will prevent the Web Applications from connecting to the Vantage domain.
Planning and Managing a Vantage Database

This guide lists Vantage database requirements and explains how to install and manage the Vantage Database.

Installing a database in preparation for Vantage is easiest when you plan carefully, and you have a working knowledge of Windows server administration, Microsoft SQL Server, and installation and configuration of enterprise-level software. Consult your IT group for assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to browse the Vantage Web library, user guides, patches, application notes, and other documents.

The following topics provide information for planning, installing, and maintaining a Vantage database:

- Operating System Requirements
- Database Server Requirements for SQL Standard
- Database Selection and Configuration Guidelines
- Installing MS SQL Server
- Installing the Vantage Database
- Backing Up and Restoring the Vantage Database
- Shrinking a Full Database
- Moving the Vantage Domain Database to Another Database
Operating System Requirements

The Vantage Domain Database and the MS SQL Server for Vantage should be installed and operated only on the following operating systems (64-bit only):

- Windows Server 2012 R1 or R2
- Windows Server 2016 Standard or Data Center Edition


**Note:** If you are running Windows Server 2008 Vantage nodes, you will not be able to upgrade to SQL 2016 as it is not compatible with Server 2008.

Database Server Requirements for SQL Standard

The following recommendations are for customers running SQL Standard. To determine which version of SQL to use, please refer to the *Guidelines for Selecting SQL Express or SQL Standard*.

Telestream recommends using “per core” SQL Standard licensing when using Vantage. In this licensing scenario, all physical cores on the server (or virtual machine) must be licensed. Please contact your IT department or Microsoft for more information about SQL Standard licensing options. For Microsoft’s discussion of licensing by cores, refer to this URL: http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-cores.aspx.

Telestream recommends the following hardware for dedicated database servers:

**SQL Standard: 4-Core Server Recommendations**

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>64-bit, 4 physical cores, 8 MB cache, 3.0 GHz or greater. For example, Intel E3-1230 v2.</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB DDR minimum required, 32 GB or more recommended for high job volumes; 1600 MHz recommended</td>
</tr>
<tr>
<td>OS/Software HDD</td>
<td>RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred</td>
</tr>
<tr>
<td>Database HDD</td>
<td>RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 RPM</td>
</tr>
<tr>
<td>Network</td>
<td>Dual 1 GbE or greater NICs</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows Server 2012 (R2 recommended for best performance) or Windows Server 2016</td>
</tr>
</tbody>
</table>
SQL Standard: 8-Core Server Recommendations

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>64-bit, 8 physical core processors, 2.0 GHz or greater. For example, Intel ES-2640 v2.</td>
</tr>
<tr>
<td>RAM</td>
<td>24 GB DDR minimum required, 32 GB or more recommended for high job volumes; 1600 MHz recommended</td>
</tr>
<tr>
<td>OS/Software HDD</td>
<td>RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred</td>
</tr>
<tr>
<td>Database HDD</td>
<td>RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 RPM</td>
</tr>
<tr>
<td>Network</td>
<td>Dual 1 GbE or greater NICs</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows Server 2012 (R2 recommended for best performance) or Windows Server 2016</td>
</tr>
</tbody>
</table>

Please see the following page and table for additional guidelines.

When choosing your database server, the primary consideration is how many clients will access job status views simultaneously. Real-time job status views are the largest consumer of database CPU resources.

The following table can guide you in selecting a server and configuring the system.

<table>
<thead>
<tr>
<th>Job Status View Clients</th>
<th>Database Server</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or 2 clients</td>
<td>4-core server</td>
<td>IIS and the Workflow Designer may run on the DB server.</td>
</tr>
<tr>
<td>3-8 clients</td>
<td>4-core server</td>
<td>IIS and Workflow Designer must run on a separate server.</td>
</tr>
<tr>
<td>More than 8 clients</td>
<td>8-core server (or more)</td>
<td>Contact Telestream for guidance if you plan to have more than 20 clients.</td>
</tr>
</tbody>
</table>

**Note:** The recommendations above ensure sufficient CPU headroom for activities such as Workflow Portal operation, running large arrays, deleting jobs, etc.

For additional guidelines on database installation in a Vantage domain, see *Database Selection and Configuration Guidelines.*
Database Selection and Configuration Guidelines

If no other Microsoft SQL database version is already installed, Vantage automatically installs Microsoft SQL 2014 Express. If a Microsoft SQL database is already installed, Vantage detects it and does not install the default Express version.

Vantage is supported on the following database systems:

- Microsoft SQL Server 2008 Express, Standard, or Enterprise
- Microsoft SQL Server 2012 Express, Standard, or Enterprise
- Microsoft SQL Server 2014 Express, Standard, or Enterprise
- Microsoft SQL Server 2016 Express, Standard, or Enterprise


The MS SQL Server for Vantage should be installed and operated only on the following operating systems (64-bit recommended for performance):

- Windows Server 2012 R1 or R2
- Windows Server 2016 Standard or Data Center Edition


**Note:** If you are running Windows Server 2008 Vantage nodes, you will not be able to upgrade to SQL 2016, as it is not compatible with Server 2008.

The following topics provide guidelines for choosing and implementing a database:

- Guidelines for Selecting SQL Express or SQL Standard
- Guidelines for an Array Installation with SQL Standard
- Other Database Configurations
- Improving Uptime with Mirroring or Availability Groups
- Installing the Vantage Database

**Note:** SQL database tools must not be used to move a Vantage domain database of one version to a later version of Vantage. To upgrade Vantage, only use Vantage installers or the Vantage Database Deployment Utility.
Guidelines for Selecting SQL Express or SQL Standard

The decision about whether to use SQL Standard or Express depends on your planned maximum database size and the expected average volume of database traffic. The following topics provide information to help you choose which database to use:

- Comparing SQL Express and SQL Standard
- Vantage Guidelines for SQL 2014 Express

Comparing SQL Express and SQL Standard

SQL Express and SQL Standard database limitations are compared in this table:

<table>
<thead>
<tr>
<th>SQL 2014 Express</th>
<th>SQL 2014 Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. Cores: 4</td>
<td>Max. Cores: 16</td>
</tr>
<tr>
<td>Max. DB RAM: 1 GB</td>
<td>Max. DB RAM: 64 GB</td>
</tr>
<tr>
<td>Database Size: 10 GB</td>
<td>Max. Database Size: Unlimited</td>
</tr>
</tbody>
</table>


Vantage ships with SQL 2014 Express, which is suitable for single-node installations or Array installations up to four nodes. For very large installations, SQL Standard may be required.

Vantage Guidelines for SQL 2014 Express

Vantage installs SQL 2014 Express, which allows up to 10GB of database storage. Due to this storage limitation, SQL Express is not suitable for every Vantage installation.

The following guidelines indicate the maximums for using Vantage with SQL 2014 Express:

- **Transcoding**: SQL 2014 Express can support up to 15,000 Vantage jobs in the database at a time. **Note**: This assumes that each job contains 10 actions. More actions in a job require more storage, allowing fewer jobs.

- **TrafficManager**: SQL 2014 Express can support up to 1,500 TrafficManager commercials in inventory at a time.

- **Vantage Array**: Up to four (4) Vantage servers can simultaneously connect to SQL 2014 Express as part of a Vantage Array. This includes any redundant or backup machines.

Database Shutoff Feature for SQL Express

If a Vantage single-node or Array installation using SQL Express nears the SQL Express database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually launches a warning dialog indicating that the database is at or near capacity. To release space in the database, see the procedure in the Managing a Vantage Domain chapter: *Shrinking a Full Database* in the Vantage Domain Management Guide.
Guidelines for an Array Installation with SQL Standard

For high traffic installations, Vantage performance improves when you use SQL Standard and separate the database from other services such as the operating system and Vantage services. The following guidelines provide increasing levels of performance improvement:

- Always place SQL Standard and the database on a dedicated server, separate from Vantage services, the Vantage store, and the input and output files. This approach provides the largest increase in performance.
- Place the Vantage database files on a dedicated physical drive or RAID array, separate from the operating system.

**Note:** Installing a Vantage domain database on a separate server does not require an extra Vantage license for that server.

When installing a Vantage array with SQL Standard, ensure that the server hardware meets the requirements described in *Operating System Requirements*. To improve database availability, see *Improving Uptime with Mirroring or Availability Groups*.

**Recommendations for Large Arrays**

For arrays containing 10 or more nodes, consider these additional recommendations:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server memory for DB &lt; 32 GB</td>
<td>64 GB</td>
</tr>
<tr>
<td>Server memory for DB &gt; 32 GB</td>
<td>128 GB</td>
</tr>
<tr>
<td>Cores</td>
<td>16 cores minimum, 24 cores recommended.</td>
</tr>
<tr>
<td>Partitioning</td>
<td>Create a dedicated partition for SQL Server data.</td>
</tr>
<tr>
<td>SSD or hard drives</td>
<td>SSDs may provide better performance but only in cases of high I/O. Use SQL to monitor I/O wait times and PERFMON to measure average disk I/O latency. Latency should be less than 0.020 seconds (20 ms).</td>
</tr>
</tbody>
</table>

**Other Database Configurations**

Vantage systems can work with other special database configurations:

- For a fully redundant system, you can use SQL Standard with Mirroring. This requires professional services from Telestream with machines and licenses for two SQL Standard databases, plus a third machine running the free SQL Express.
- Large volume systems can use SQL Enterprise.
- You can use SQL with Clustering.
Improving Uptime with Mirroring or Availability Groups

SQL Server Availability Groups or database mirroring can prevent Vantage domain interruption if a single database server fails. Telestream supports mirroring for SQL Standard 2012 and SQL Standard 2014 and Basic Availability Groups for SQL Standard 2016. SQL Enterprise with Clustering may also be used for high availability.

A mirrored database requires the following physical servers:
- A dedicated server to host the principal database
- A dedicated server (of similar capability to the principal database server) to host the mirror database
- An optional dedicated server to host the witness server.

The witness database is a lightweight service which can run effectively on a low-end server, but cannot be installed on a database server.

Basic Availability Groups require:
- A dedicated server to host the primary replica database
- A dedicated server (of similar capacity) to host the secondary replica database
- A reliable witness file share server.

**Note:** This guide does not provide instructions for installing or implementing a mirrored database or Availability Groups. Consult your database administrator or contact your Telestream representative regarding installation service options.

**Note:** Telestream strongly recommends using a dedicated server for the witness server to ensure uninterrupted operation in case of a database failover. If the witness server function is placed on a server with Vantage services, transcoding can consume too many resources and prevent timely database switchover.

**Note:** If a mirrored database fails over, the domain change is not reflected in Vantage client program title bars, which still show the original domain name. Users can correct this by using File > Change Vantage Domain in the clients to select the new domain.
Installing MS SQL Server

If you are creating or upgrading a Single-Node Vantage installation, pre-installing the database is not necessary. The Vantage Setup installer will install MS SQL Server Express and the Vantage database automatically on the single-node server with the Vantage applications and services.

However, if you are installing or upgrading an existing Vantage Array installation on multiple servers, you need to have MS SQL Server Standard (or better) installed before you install the Vantage product using the Vantage Setup installer. This procedure will guide you through the MS SQL Server Standard installation, and the procedure that follows (Installing the Vantage Database) will install or upgrade the Vantage database. After SQL Server and the Vantage database are installed, you can install the Vantage Array using the Vantage Setup installer.

This guide does not provide instructions for installing a mirrored database and implementing mirroring. Consult your database administrator or contact your Telestream representative regarding installation service options. To set up the Vantage domain database, follow these procedures in the order listed:

- Installing SQL Server 2008/2012 Standard
- Installing SQL Server 2014 Standard
- Installing SQL Server 2016 Standard
- Installing the Vantage Database

Installing SQL Server 2008/2012 Standard

The following procedure explains how to install SQL Server 2008/2012 Standard. If you are installing SQL Server 2014 or SQL Server 2016, please skip to that topic, Installing SQL Server 2014 Standard or Installing SQL Server 2016 Standard.

Follow these steps to install SQL Server 2008/2012 Standard on a server:

1. Log into the target server with a local administrator account.
2. Insert the SQL Server 2008 or 2012 Standard DVD into the server’s DVD drive and start the installer (setup.exe) if it does not run automatically.
3. SQL Server Installation Center—Click Installation in the left column, then select New installation or add features to an existing installation.
4. Setup Support Rules—Click OK.
5. Product Key—Enter your product key and click Next.
6. License Terms—Accept the license terms and click Next.
7. SQL Server Updates—Click Next after updates have completed. (2012 only)
Note: Setup Support Files—Click Install, allow the installer to complete its actions, and click Next. If Restart computer... Failed displays in the report, this is caused by a bug in the SQL Server 2008 Standard R1 installer. To correct the problem, run Regedit and navigate to this key: Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\PendingFileRenameOperations. Clear the Value Data string. Then return to Setup Support Rules and click Re-run on the right by the status bar. The Setup Support Rules should complete successfully. Click OK to continue.

8. Feature Selection—Check Database Engine Services and Management Tools, and click Next.

9. Instance Configuration:
   a. Select Named instance.
   b. Enter VANTAGE in the Named instance field and the Instance ID field.
   c. Click Next to continue.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration:
   a. For SQL Server Agent, the Startup Type should be disabled. (If the Startup Type is set to automatic, the service must be stopped before running Vantage Setup.)
   b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
   c. Click Next to continue.

12. Database Engine Configuration:
   a. Click Add Current User.
   b. Select Mixed Mode.
   c. Enter the Vantage sa user password (vantage12!) in the Enter Password and Confirm Password fields.
   d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to complete installation.

14. Complete—Click Close to close the SQL Server installer.

15. Select Start > SQL Server Management Studio.

16. Connect to the Vantage domain database using the following information:
   Server type: Database Engine
   Server name: [hostname]\VANTAGE
   Authentication: SQL Server Authentication
   Login: sa
   Password: vantage12!

17. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

18. In the Server Properties window, go to the Memory page.

19. Set the Maximum server memory (in MB) to 75% of the system's memory. For example: If the system's memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).
20. Click OK.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: *Installing the Vantage Domain Database*. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.

### Installing SQL Server 2014 Standard

Follow these steps to install SQL Server 2014 Standard on a server (skip this topic if you already installed another version of SQL Server):

1. Launch setup from the SQL Server 2014 Standard installation media.
2. In the *SQL Server Installation Center*, go to *Installation* on the left.
3. Select *New SQL Server Stand-alone installation or add features to an existing installation*.
4. On the Product Key page, enter a product key and click Next.
5. Accept the license terms and click Next.
6. Click Next on the Microsoft Update page.
7. On the Setup Role page, select *SQL Server Feature Installation* and click Next.
8. On the Feature Selection page, enable *Database Engine Services, Management Tools – Complete* and click Next.
9. On the Instance Configuration page, select *Named instance*, enter *VANTAGE* and click Next.
10. On the Server Configuration page, click the cell for the account name of the *SQL Server Database Engine* service. After selecting the cell, click the drop-down list and select *<<Browse…>>*.
11. In the *Enter the object name to select* field, type *NETWORK SERVICE* and click OK. Then click Next on the Server Configuration page.
12. On the Database Engine Configuration page, select *Mixed Mode (SQL Server authentication and Windows authentication)*. Enter *vantage12!* for the password and click the *Add Current User* button.
13. (Optional) If you would like to specify a non-default location for the database files, go to the Database Engine Configuration page, select the Database Directories tab, and change the Data root directory path.
15. Click install on the Ready to Install page.
16. When installation completes, click Close and close the SQL Server Installation window.
17. From the Start menu, launch the SQL Server 2014 Management Studio.
18. In the *Server name* field, enter *\vantage* as the server name.
19. Set authentication to *SQL Server Authentication*.
20. Enter sa for the login and vantage12! for the password.

21. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and select Properties.

22. From the Select a page panel, go to Memory and set Maximum server memory (in MB) to 75% of the host system’s memory. For example, if the system’s memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

23. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: Installing the Vantage Domain Database. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.

**Installing SQL Server 2016 Standard**

Follow these steps to install SQL Server 2016 Standard on a server (skip this topic if you already installed SQL Server 2016 Standard):

1. Launch setup from the SQL Server 2016 Standard installation media.

2. In the SQL Server Installation Center, select Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page and the Install Rules page.

7. On the Feature Selection page, click Feature Selection on the left, enable Database Engine Services and click Next.

8. On the Instance Configuration page, select Named instance, enter VANTAGE and click Next.

9. Click the cell where the SQL Server Database Engine Row and Account Name column intersect. After selecting the cell, click the drop-down list and select <<Browse…>>.

10. In the Enter the object name to select field, type NETWORK SERVICE and click OK. Then click Next on the Server Configuration page.


12. (Optional) If you would like to specify a non-default location for the database files, go to the Database Engine Configuration page, select the Data Directories tab, and change the Data root directory path.

13. Click Next on the Database Engine Configuration page.

14. Click Install on the Ready to Install page.
15. When installation completes, click Close and close the SQL Server Installation window.

**Installing SQL Server 2016 Management Studio**

Management Studio is not automatically installed for SQL Server 2016. To install and configure it, follow these steps:

2. Click the link to “Download SQL Server Management Studio.” At the time this document was written, version 16.5.1 was used.
3. After the download completes, launch the setup and click Install.
4. Click Close when the installation completes.

After the SQL Server 2016 Management Studio has been installed, it must be used to set the maximum limit for SQL Server's memory consumption:

1. From the Start menu, launch the SQL Server 2016 Management Studio.
2. Connect to the instance using SQL Server Authentication:
   - Server name: .\VANTAGE
   - Authentication: SQL Server Authentication
   - Login: sa
   - Password: vantage12!
3. Right-click the hostname at the top of the Object Explorer tree and select Properties.
4. From the Select a page panel, go to Memory and set Maximum server memory (in MB) to 75% of the host system's memory. For example, if the system's memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).
5. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: *Installing the Vantage Domain Database*. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.
Installing the Vantage Database

If you have already installed MS SQL Server 2008, 2012, 2014, or 2016 the Vantage Installer allows you to install or upgrade a current Vantage database in the existing SQL installation. You can install in any of these MS SQL database versions:

• SQL Express
• SQL Standard, SQL Standard with Mirroring, SQL Standard with Clustering
• SQL Enterprise and SQL Enterprise with Clustering

Before you begin, follow the prerequisite procedure below.

Prerequisites for Instance Installation

It is assumed you have already created a SQL database instance into which a Vantage database instance can be deployed. The database instance must meet certain prerequisites before you can use the Vantage utility to deploy a Vantage database instance:

• The SQL instance must be deployed as a named instance.
• The SQL instance must include a SQL or active directory user account. The user can be sa or another account, and any password may be used.

The user account installing the Vantage database must have the sysadmin role assigned. The steps below explain how to assign a role.

• The user account running the Vantage database after it is installed can have the db_owner and dbcreator roles assigned instead of sysadmin, if you prefer the user to have lower privileges.
Configuring the Administrator Role

1. In the SQL Server Management Studio > Object Explorer panel, expand Security, and expand Logins.
2. Right-click the `sa` user or another user that you want to use as the administrator login, and select Properties.
3. Go to Server Roles and enable `public` and `sysadmin`. Click OK. This gives the user system administrator privileges for the database instance.
Configuring the Vantage User Role

1. Right-click the current Windows user and select Properties.

2. Click User Mapping. Check master or Vantage (if present) in the database column, and check db_owner. Click OK.

3. Right-click the Windows user and select Properties again.

4. Click Server Roles and check dbcreator to enable it. Click OK. This gives the current Windows user sufficient privileges to run the Vantage database instance after installation.
5. From the Select a page panel, go to Memory and set Maximum server memory (in MB) to 75% of the host system’s memory. For example, if the system’s memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

6. Click OK to close the Microsoft SQL Server Management Studio window.

Installing the Vantage Domain Database

This task installs a clean new Vantage domain database instance into the previously installed SQL database. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Launch the Vantage_7.1_Setup.exe installer (extracted to the C:\Vantage7.1 folder when you run the Vantage_7.1.exe archive file) and click Next.

4. Accept the license agreement and click Next.

5. Select Array (Multi-Node) Installation and click Next.

6. Select Custom Install, scroll down, and enable the check-box for Vantage Domain Database. Click Next.

7. Choose the installation base or use the default location and click Next.

8. Click Install.

9. When the Vantage Domain Database Setup Wizard appears, click Next to display the license agreement.

10. License Agreement—Read the Vantage Software License Terms and Conditions, then click I Accept if you agree to license terms. Click Next.

11. Database Install Mode—Click Install new database and click Next to continue.

12. Destination Folder—Accept the default folder or click Change to select an alternate folder. Click Next.

13. Ready to Install Vantage Domain Database—Click Install to begin database installation. This process takes a few minutes to complete.

14. Completed—When installation is complete, click Finish.

The SQL database has now been converted to a current Vantage database. After the SQL Server 2016 Management Studio has been installed, it must be used to set the maximum limit for SQL Server’s memory consumption:

15. Launch the SQL Server Management Studio.
16. Connect to the instance using SQL Server Authentication:
   Server name: .\VANTAGE
   Authentication: SQL Server Authentication
   Login: sa
   Password: vantage12!

17. Right-click the hostname at the top of the Object Explorer tree and select Properties.

18. Go to Memory on the left and set “Maximum server memory (in MB)” to 75% of the server’s memory. Click OK.

19. You are now ready to install or upgrade Vantage:

   **Note:** For detailed Vantage installation instructions, please refer to the Vantage Installation Guide, available as a standalone guide and also included in the Vantage Domain Management Guide.

   a. **New Vantage Installations:** If you are installing a new Vantage instance, run the Vantage_Setup.exe installer again, select Array (Multi-Node) Installation, select Custom, select the components you want, but do NOT select Database. This ensures Vantage installs, but the database is not touched.

   b. **Upgrading Vantage:** If you are upgrading an existing Vantage instance, use the Control Panel Programs and Features to remove only Vantage but leave MS SQL and the domain database in place. Then run the Vantage_Setup.exe installer, select Array (Multi-Node) Installation, select Custom, select the components you want, but do NOT select Database. This ensures Vantage installs, but the upgraded database is not touched.
20. After Vantage installation, use the Vantage Management Console > File > Change Vantage Domain (shown below) to find and connect your Vantage installation to the deployed database. Use the Search button to populate the list. If you installed a Vantage database with a custom name and password, you may need to select Specify Vantage Domain name/IP Address. Then enter the server name, the custom database name, expand the Connection settings, and enter the custom Login and Password. When you click OK, the Vantage Management Console should connect to the database and begin normal operation.

REMINDER: If you use Windows authentication, you must also set the SQL Server service Log On to the same Windows account that you will use for database authentication. To change the SQL Server service Log On, select Start > Administrative Tools > Services > SQL Server > Properties > Log On > This account.

21. If necessary (for a new installation), install Vantage licenses using the Vantage Management Console > Licenses panel and configure Vantage as described in the Vantage Domain Management Guide.

22. If you have deployed a new database or replaced an existing database with a new one, the domain will not have any ComponentPacs installed. When you run the Vantage Setup installer to install Vantage components and services after deploying the database, the major ComponentPacs will be installed. If you do not run the Vantage Setup installer after database deployment on the database server, or if you wish to install additional ComponentPacs, use the Vantage Management Console > ComponentPac Management feature to install the ComponentPacs.

23. Lastly, if you assigned the Vantage services to the host name of the database server before using the Database Deployment Utility, use the Microsoft Services Console to restart the Vantage services after the database is deployed. Also close and reopen the Vantage Management Console and Workflow Designer. These operations prevent a situation where Vantage action templates and fulfillment schemes do not deploy properly.
Database Maintenance Topics

The topics covered in the remainder of this guide explain how to perform typical database maintenance procedures:

- Backing Up and Restoring the Vantage Database
- Shrinking a Full Database
- Moving the Vantage Domain Database to Another Database
Backing Up and Restoring the Vantage Database

The Domain Backup feature allows you to save archival copies of the Vantage domain database in a separate file. The Domain Restore feature allows you to replace your current Vantage domain database with the contents of a previously-backed up domain. The domain backup and restore features are primarily used for the following:

- Returning the database to a previously backed-up state.
- Preparation for database mirroring.

**Note:** The domain backup and restore features are not designed for use during Vantage upgrades. If you back up the database from a specific version of Vantage, that backup can only be restored to the same Vantage software version. During a Vantage upgrade, the Vantage installers manage any required database updates as described in *Upgrading from a Previous Version* in the *Vantage Installation Guide* or the *Vantage Domain Management Guide*.

The following topics describe domain backup and restore:

- Understanding Domain Backup and Restore
- Backing Up the Domain
- Restoring the Domain

**Understanding Domain Backup and Restore**

During a domain backup, Vantage creates a single backup file that contains all workflows, all services, and all jobs registered in the domain. It is important to remember that the backup file contents reflect the domain contents as of the moment the backup file is created. To capture changes made after a backup, you must create another backup.

When you restore a domain, all services are stopped, the current database contents are irretrievably destroyed, and the backup file you specify is used to create the replacement database. The services defined in the backup file are started and the Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, Telestream recommends that you back up the current database before restoring a previous database. Backing up the current database captures all database changes made since the last backup, and it gives you a backup file that you can use to restore the current database if necessary.
Backing Up the Domain

To back up the Vantage domain database, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console in the Vantage System Administration Guide or the Vantage Domain Management Guide.

2. In the components panel, select Domain Management.

   Vantage displays the Domain Management details panel shown in this figure:

   ![Vantage Domain Management Console Screenshot](image)

3. Verify that all services in the Active Services list are hosting 0 sessions.

   Note: Although you can create a successful backup while services are executing workflow tasks, some job records may be lost. It is best to back up the domain when there is no activity in the domain.

4. Click the Backup... button.

5. In the Save the domain dialog, browse to the folder where you want to store the backup file, and click Save.

6. When the Backup Complete message appears, click OK.
Restoring the Domain

**CAUTION:** Telestream recommends that you restore a Vantage domain using the same machine that created the backup file. If you restore the domain from another machine, the services defined in the database must match the services installed on the other machine.

To restore a Vantage domain database, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console* in the *Vantage System Administration Guide* or the *Vantage Domain Management Guide*.

2. In the components panel, select Domain Management.

   Vantage displays the Domain Management panel shown in the previous figure.

3. To provide the option to return to the current Vantage domain database later, back up the current domain database as described in *Backing Up the Domain*.

**CAUTION:** Always back up your current database before restoring it to an earlier backup. Restoring your Vantage domain database overwrites the entire contents of the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

**Note:** When you restore a domain, all services are stopped, and all information related to any jobs in progress is lost. The restored database contains only the domain information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that appears, and click OK.

6. In the *Load the domain* dialog, browse to the backup file you want to restore, select the backup file, and click Open.

7. When the Restore Complete message appears, click OK.
Shrinking a Full Database

If a Vantage installation using SQL Express nears the SQL Express database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually launches a warning dialog indicating that the database is at or near capacity.

You may be able to resolve this issue using the Vantage Shrink Database feature, which applies the MS SQL DBCC SHRINKDATABASE command to the existing database to delete unused entries and reduce file size. The shrink process may take some time and may slow database performance, so it should be done only when the Vantage system is not busy.

Use this procedure to shrink the database:

1. Start the Vantage Management Console.
2. In the components panel, select Domain Management.
   Vantage displays the Domain Management details panel (see the preceding figure).
3. To protect against potential data loss, use the Backup... button to back up the current domain database as described in Backing Up the Domain.
4. Click the Shrink button to shrink the database.
   A dialog pops up to explain that the Shrink command may affect database performance and should be done only when Vantage is not busy.
   A Status message indicates progress.
   Current Size displays the database size next to the button, so you can see any changes immediately upon completion of the shrink command.
   Multiple presses of the button may shrink the database additionally each time.
Moving the Vantage Domain Database to Another Database

You might want to move the Vantage domain database because:

- You are upgrading SQL Server from Express to Standard
- You are upgrading SQL Server from an older version to a newer one
- You are moving the database from one server to another

**Note:** If you are moving the database in conjunction with a Vantage upgrade, you should complete the upgrade prior to moving the database.

**Note:** This guide does not provide instructions for moving a mirrored database. Consult your database administrator or contact your Telestream representative regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in the sequence presented:

1. Preparing for the Move
2. Backing up the Existing Database
3. Removing the Vantage Domain Database
4. Removing Microsoft SQL Server
5. Installing SQL Server Standard
6. Installing the Vantage Domain Database
7. Restoring the Vantage Domain Database Backup
8. Finishing the Move

**Note:** This procedure backs up the database, moves the database to a different SQL Server version and/or server, and restores the database. Vantage does not support a Vantage restore from a version 3 Vantage database to a version 4 domain.
Preparing for the Move

If you are upgrading SQL Server, it is recommended that you back up the Vantage domain database, but it is not required. However, if you are moving the Vantage domain database to a new server, you must backup the database, as the backup file will be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status Views web application, or Vantage Dashboard to either determine when all jobs are complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:
   a. Take note of any Storage, Variables, and/or Qualification Rules settings for each service. (In the Vantage Management Console, select Services. In the service panel, click each service and check the tabs at the bottom of the window.)
      When you move the Vantage domain database from one server to another, the Storage, Variable, and Qualification rule configuration for each service is lost. Write down any configuration that you want to transfer to the new server.

   Note: The service Storage, Variable, and Qualification Rule configuration is not lost when you change the SQL Server version on a server. Skip to Step 4 if you are not moving the Vantage domain database to a different server.

   b. In the Vantage Management Console, remove all services from the Vantage domain as described in Removing a Service from the Domain in the Vantage Domain Management Guide.

   Note: The default Vantage user account is Administrator with no password. This account has administrative privileges.

   c. In the Vantage Management Console, select Licenses in the components panel.
   d. On the Licenses tab, select all licenses and click the Delete button.

   Note: To add the licenses back at the end of this procedure, you will need access to the license files. If you do not know where these files are, locate them now before you delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the database to another server), place all services in Maintenance Mode as described in Entering and Exiting Service Maintenance Mode.
Backing up the Existing Database

If you are upgrading SQL Server, it is recommended that you back up the Vantage domain database. If you are moving the Vantage domain database to a new server, you must backup the database, as the backup file will be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select Domain Management in the components panel, click Backup..., and use the file save dialog to save the backup file to a safe location.
   
   You will need to access the backup file to restore the Vantage domain database after you move it. For more information, see Backing Up the Domain.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database

The Vantage Domain Database may or may not be present as a separate entry in the Windows Control Panel Programs and Features window, depending on how it was originally installed.

In either case, the Domain Database must be removed using one of the following procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage and click Change.
4. Deselect the check box for Vantage Domain Database and continue with removal.
Removing Microsoft SQL Server

When you are upgrading Microsoft SQL Server or moving the Vantage domain database to another server, you may want to remove the old version of SQL Server.

To remove Microsoft SQL Server, follow these steps:

1. Log into the server with a local administrator account.
2. Open the control panel tool for removing programs:
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Microsoft SQL Server and click Remove or Uninstall.

**Note:** If you are prompted to stop the SQL Server (VANTAGE) service, go to Start > Services and stop the service before clicking Retry to continue with uninstalling.

**Note:** If you have multiple instances (for example SQLEXPRESS and VANTAGE), you will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

**Note:** Uninstalling the SQL Server does not delete your Vantage workflows, resources, or transaction history. It leaves your domain database files intact in [Install_Drive]\Program Files\Telestream\Vantage\Database. For information on removing the database files, see Uninstalling Vantage from a Server in the Vantage Installation Guide or the Vantage Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services and clients that were installed on the server remain installed. The domain cannot resume operation until the SQL Server is reinstalled on this server or set up on another server.
Installing SQL Server Standard

Please see *Installing SQL Server 2008/2012 Standard*, *Installing SQL Server 2014 Standard*, or *Installing SQL Server 2016 Standard* earlier in this chapter. After installing SQL, continue with the next topic to install the Vantage database.

Installing the Vantage Domain Database

This task installs the Vantage domain database instance. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that virus-checking software and Windows Firewall is off.

   **Note:** To effectively operate Vantage services with other networked devices or systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Run the *Vantage_7.1_Setup.exe* installer (extracted to the C:\Vantage7.1 folder when you run the *Vantage_7.1.exe* archive file) and choose to install only the Domain Database for your single node or array installation.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display the license agreement.

5. License Agreement—Read the Vantage Software License Terms and Conditions, then click I Accept if you agree to license terms. Click Next.

6. Database Install Mode—Click *Install new database* and click Next to continue.

7. Destination Folder—Accept the default folder or click Change to select an alternate folder. Click Next.

8. Ready to Install Vantage Domain Database—Click Install to begin database installation. This process takes a few minutes to complete.

9. Completed—When installation is complete, click Finish.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. Vantage should have discovered the old database files. Now you need to finish the process as described in *Finishing the Move*.

If the old database files are not found, or if you are installing the Vantage domain database on a different server, restore the database from the backup file as described in *Restoring the Vantage Domain Database Backup*. 
Restoring the Vantage Domain Database Backup

To restore the Vantage domain database using the backup file you previously created, follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

   **Note:** If you have moved the Vantage domain database to a new server, the name of the Vantage domain changed to the name of the new host server.

2. In the Vantage Management Console, select the domain to modify, select Domain Management in the components panel, click Restore..., and select the file to restore. For more information, see Backing Up the Domain in the Vantage System Administration Guide or the Vantage Domain Management Guide.

Finishing the Move

To finish the move, you must enable the services you disabled when preparing for the move. If you moved the Vantage domain database to another server, you must also install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the database to another server), do the following:
   a. Remove all services from Maintenance Mode as described in Entering and Exiting Service Maintenance Mode in the Vantage System Administration Guide or the Vantage Domain Management Guide.
   b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage Domain licenses as follows:
   a. In the Vantage Management Console, open the domain you want to modify, and select Licenses in the components panel.
   b. On the Licenses tab, click the Add License button and use the open file dialog to select the license file.
      If your domain has multiple license files (for multiple features), repeat this step for additional licenses.

3. If you moved the database to another server, update the configuration of services as follows:
   a. In the Vantage Management Console, open the domain you want to modify, and select Services in the components panel.
   b. In the Services panel, click the Add Service button and use the dialog to select a service to add.
   c. If any Storage, Variables, and/or Qualification Rules settings were configured for the service, add them now.
   d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
Planning and Managing a Vantage Database
Moving the Vantage Domain Database to Another Database
Installing Vantage

Use this topic to perform a first-time installation and configuration of the Vantage and SQL Server software as well as supporting software.

If you are upgrading an existing Vantage version, skip this chapter and go to the chapter on Upgrading and Modifying Vantage.

Before launching into this chapter, please be sure you have reviewed and planned for all requirements presented in the Before You Install Vantage chapter.

Note: To obtain the Vantage software or browse the Vantage library of user’s guides, application notes, and other documents, go to www.telestream.net/telestream-support/vantage/support.htm.

The following topics are included in this chapter:
- Installation Prerequisites and Overview
- Installing Vantage on a Single Node
- Creating a Vantage Elastic Domain
- Installing a Vantage Array
- Post-Installation Steps for Single Nodes and Arrays
- Command Line Installation
Installing Vantage

Installation Prerequisites and Overview

The following topics summarize Vantage prerequisites and provide an overview of the installation steps.

- Installation Prerequisites
- Installation Overview
- Extracting and Running the Installer

Installation Prerequisites

These prerequisites are required by Vantage:

- Microsoft .NET Framework 3.5.1 and .NET 4.6.2 are both required on all Vantage servers and client workstations. Vantage Web Apps require only .NET 4.6.2. The Vantage installer may install these components for you, depending on the OS:
  - .NET 4.6.2 is installed automatically by the Vantage or Web Apps installer on all operating systems, if not already present.
  - .NET 3.5.1 is installed automatically by the Vantage installer on client operating systems, such as Windows 7, 8, or 10, if not already present.
  - .NET 3.5.1 must be installed manually using Server Manager on Microsoft Server operating systems, if not already present.
- QuickTime 7.6.9 from Apple.com is required by the Telestream Transcode & Analysis engine. If it is not present, the installer installs it. If it is outdated a message advises you to update it. You can use this link to download it: QuickTime version 7.6.9.

**Note:** If you prefer not to install QuickTime because of known security vulnerabilities, a number of Vantage functions will not operate, such as portal proxy playback and several Flip action functions. For details about QuickTime issues, see the Telestream and QuickTime statement on the Telestream.net web site.

- The Windows servers must be correctly configured, including these options:
  - Desktop Experience installed (required by clients and the Analyze, Conform, and various Flip actions)
  - UAC set as desired and correct privileges (admin or user) used to install Vantage
  - Power Options set to High Performance to prevent the server from sleeping
  
**Note:** Automatic Windows and software updates and automatic restarts of Vantage servers should be disabled. Schedule update installations and system restarts only during planned maintenance periods to prevent disruption of Vantage operations.
With the prerequisites installed, you’re ready to start the Vantage installation. Vantage can be installed in one of two ways:

1. A Single Node all-in-one domain installation (everything on one server)
2. An Array (Multi-Node) installation with distributed processing on multiple servers.

Differences between what’s installed for the two installation types are listed in the following table.

<table>
<thead>
<tr>
<th>Single Node Installation</th>
<th>Array Multi-Node Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Installs Intel Performance Primitives and checks for QuickTime and .NET versions.</td>
<td>• Installs Intel Performance Primitives and checks for QuickTime and .NET versions.</td>
</tr>
<tr>
<td>• Installs MS SQL 2014 Express unless deselected or MS SQL is detected as already installed.</td>
<td>• Does not install MS SQL 2014 Express unless selected. MS SQL Standard is preferred (customer supplied).</td>
</tr>
<tr>
<td>• Automatically installs or updates Domain Database and SQL, if present.</td>
<td>• Does not install or update Domain Database or SQL unless selected.</td>
</tr>
<tr>
<td>• Creates Vantage Store (C:\VantageStore), as well as Catalog (default), and Samples folders in C:\ Program Files (x86) \Telestream\Vantage.</td>
<td>• Does not create Store, Catalog, or Samples folders but does create C:\ Program Files (x86)\Telestream\Vantage folders.</td>
</tr>
<tr>
<td>• Installs the Vantage Media Transcode &amp; Analysis engine, if needed.</td>
<td>• Installs the Vantage Media Transcode &amp; Analysis engine, if needed.</td>
</tr>
<tr>
<td></td>
<td>• Installs Web Apps, if selected.</td>
</tr>
</tbody>
</table>

**Note:** A Vantage array requires one Vantage Array license per node. Installation for an array requires additional steps compared to installation on a single node.

**Note:** Use only the Vantage_7.1_Setup.exe installer (in C:\Vantage7.1) for installing client components on your Vantage servers. The Vantage_7.1_Client_Application.msi installer is provided only for installing software on client machines. On clients, you can use either the Vantage_7.1_Setup.exe installer or the client installer, but don’t switch installers if you later make installation changes on the client machine.
Installation Overview

The Vantage 7.1 installer consists of a self-extracting archive executable (.exe) file containing the Vantage Setup file and ComponentPacs. When you run the archive file, it extracts the installation files to a directory, and then automatically runs the Vantage Setup installer to install the product and ComponentPacs.

During extraction, you are prompted to select the directory where you want to extract the Vantage Setup installer and ComponentPacs. By default this directory is C:\Vantage7.1. After extraction the Vantage Setup installer starts automatically from the directory where you extracted it.

The following overview and flowchart (below) summarize the main Vantage installation steps with links to the detailed procedures. Be sure to follow all steps in this chapter carefully and in sequence from the beginning of the chapter to the end.

If you are upgrading an existing Vantage installation, skip this chapter and refer instead to this chapter: Upgrading and Modifying Vantage.

If you are creating a new installation, follow the steps and links below.

1. See the Before You Install Vantage chapter in this guide to ensure your hardware, OS, and software meet the Vantage installation requirements.

2. Download and run the Vantage_7.1.exe installer from the Telestream.net web site. The installer self-extracting archive runs and places installation files in the default C:\Vantage7.1 directory or the directory you specify. Then the Vantage_7.1_Setup.exe installer runs automatically and begins product installation.

3. Install the database and install all licensed Vantage components using the installer as explained in one of these two topics:
   - Single computer installation: Installing Vantage on a Single Node
   - Array installation: Installing a Vantage Array

   To install product feature groups (recommended) when you run the installer, select Install Product and select the product groups for which you have licenses, or to install individual components, select Custom Install and select specific components.

4. If installing a new Vantage array, set up database access for distributed services and Windows log on IDs:
   - Adding Vantage Services
   - Setting the Vantage Windows Log On ID for Services.

5. Continue post-installation tasks: Post-Installation Steps for Single Nodes and Arrays
   - Setting Up a Vantage Store
   - Installing and Configuring Vantage Web Applications
   - Enabling Vantage Licenses
   - Installing Client Programs on Client Workstations
   - Configuring Client DB Access and User Administration
   - Verifying the Installation

6. Install Vantage updates, if any. See Updating Vantage in the Upgrading and Modifying Vantage chapter.
Installing Vantage

Installation Prerequisites and Overview

1. Review Vantage Platform Requirements
2. Download and run Vantage_7.1.exe
3. Run Vantage Setup
4. Array:
   - Install MS SQL Server
   - Set up Vantage DB
   - Enable DB access for distributed services
   - Set Win Log on ID

5. Single or Array
6. SINGLE

7. Post-Install Tasks:
   - Set up Vantage Store
   - Configure Web Apps
   - Install Licenses
   - Install Clients
   - Install Upload Portal
   - Verify Installation
8. Install Vantage Updates
Extracting and Running the Installer

The following example shows how to run the archive and the installer. Additional installation details are presented after this topic.

1. Double-click the Vantage_7.1.exe self-extracting archive, which will extract the installation files to C:\Vantage7.1.

2. Browse or enter a new destination or use the default destination. Then press Install.

Extraction begins and a progress bar. When extraction completes, the Vantage_7.1_Setup.exe installer starts automatically.
3. Press Next to start the installation, then follow the prompts. Some typical screens are shown below.

4. When installation completes, the final screen shows “Installation was successful.” Click Done to close the installer.
Installing Vantage on a Single Node

An all-in-one Vantage domain is one in which all Vantage server components are installed and operate on a single server (node). The components include the Vantage software and services, the Vantage domain database, and Vantage client programs (Vantage Management Console, Vantage Workflow Designer, Vantage Workflow Portal, and Vantage Dublist Portal). Additional licensed client programs can also be installed separately on client workstations.

Note: A Vantage domain with more than one node is a Vantage Array and requires one Vantage Array license per node. Installation differs for an array. See Installing a Vantage Array and skip these single node instructions.

The fastest, easiest, and recommended way to install a new Vantage installation on a single node is to follow the steps below to install everything at once.

If you need to update or reinstall specific individual components, follow the instructions in the Upgrading and Modifying Vantage chapter.

To install all licensed Vantage components on a single server, follow these steps:

1. Log into the target server with a local administrator account, and make sure that virus-checking software and Windows Firewall are off.

2. Run the Vantage_7.1.exe archive. The archive extracts the installation files, and then automatically runs the Vantage_7.1_Setup.exe installer to install all components.

3. When the Welcome dialog appears, click Next to display the license agreement.

4. When the license agreement appears, click I accept the terms in the License Agreement (if you accept the terms), and click Next (or click Cancel).

5. Select Single Node Installation (the default) when the dialog instructs you to “Select the type of Vantage system you want to install on.” Then click Next.

6. Select the type of installation you want to perform: Install Product or Custom Install. Install Product lists products and options in licensed groups. Custom Install lists every Vantage component and option.

7. In the Install Product or Custom Install display, check the boxes by the components you want to install, and click Next.

   At a minimum, you should choose to install the Transcode/Transcode Pro selection. If licensed, you may choose multiple options that include additional services, the Workflow Designer, and the Workflow Portal. Be sure to check Vantage Domain Database at the bottom; if a database is already present, the installer will update it without removing the previous database contents.

8. Browse to Configure the installation locations for the Installation base and the default Vantage Store.

9. When the Ready to Install dialog appears, click Install to begin product installation. This process takes a few minutes to complete and shows progress and components being installed as it runs. See Installation Notes below for additional details.
10. During installation the database installer opens automatically and asks you to select *Install new database* or *Upgrade existing database*. Assuming this is a new installation, select *Install new database*.

*Install new database* replaces any existing Vantage database, erasing the data as it does so. Be sure you select this ONLY if you are installing a new database.

*Upgrade existing database* keeps any existing data and upgrades the database to the current version. If you’re upgrading and your MS SQL and Vantage files are intact, the installer should detect that and automatically set this selection to *Upgrade existing database*, but it’s wise to verify.

11. Assuming you are installing a new database, browse to the location you want to use for the Vantage domain database. The default location is recommended.

12. When installation is complete, the progress text displays *Finished*. Click Next.

13. The dialog displays Installation successful! Click Done to complete the installation.

This completes the initial Vantage installation. Vantage installs these components:

- Microsoft SQL Server 2014 Express, including Browser, Native Client, Support Files
- Telestream Media Transcoding and Analysis
- Vantage
- Vantage Domain Database
- Client shortcuts on the desktop: Workflow Designer, Management Console, Workflow Designer, and Dublist Portal.

If any components failed to install, you can run the installer again selecting a Custom Install and checking only the components you want to install again.

### Installation Notes

The following notes provide additional installation details:

**Note:** Telestream recommends that you do not use anti-virus software on Vantage servers. If you prefer to use anti-virus software, identify Vantage as a safe/trusted application. For additional information on using Vantage with anti-virus software, see *Anti-Virus Software Recommendations*. For more information on using Vantage with the Windows Firewall, see *Firewall Guidelines*.

**Note:** If Intel Performance Primitives (IPP) is not present, the Vantage installer installs it.

**Note:** If QuickTime is not installed, the installer downloads and installs it for you if you have an Internet connection. If an outdated version is present or there is no Internet connection, the installer displays a message advising you to install it manually. The Telestream Transcode and Analysis engine requires QuickTime version 7.6.9. You can use this link to download it: *QuickTime version 7.6.9*. If you install QuickTime manually, uncheck (disable) *Check for Updates*, so QuickTime is not updated automatically. Then restart the server and re-run *Vantage_7.1_Setup.exe* again to continue.
Note: Microsoft .NET Framework 3.5.1 and .NET 4.6.2 are both required on all Vantage servers and client workstations. Vantage Web Apps require only .NET 4.6.2.

The Vantage installer may install these components for you, depending on the OS:

- .NET 4.6.2 is installed automatically by the Vantage or Web Apps installer on all operating systems, if not already present.
- .NET 3.5.1 is installed automatically by the Vantage installer on client operating systems, such as Windows 7, 8, or 10, if not already present.
- .NET 3.5.1 must be installed manually using Server Manager on Microsoft Server operating systems, if not already present. After .NET is installed, open Server Manager > Roles > Server Roles, and check Web Server (IIS) to enable it. Then enable the services listed in the IIS Role Service Requirements table.

Quick Installation Check

At this point, the Vantage installation should be functioning, though not licensed. Vantage Management Console should be operational if you double-click the Vantage Management Console icon on the desktop. By default, no login is required. If you enable User Administration under Settings & Options > General to require a login, you can then log in with the user name “administrator” and no password.

Next, continue with the following post-installation tasks:

- Post-Installation Steps for Single Nodes and Arrays
  - Setting Up a Vantage Store
  - Installing and Configuring Vantage Web Applications
  - Enabling Vantage Licenses
  - Installing Client Programs on Client Workstations
  - Verifying the Installation
Creating a Vantage Elastic Domain

Setting up a Vantage Elastic Domain to achieve Vantage dynamic domain scaling requires special instructions beyond those required for a standard domain installation. Please refer to the Vantage Elastic Domain Guide for details, and follow the instructions given there in the order in which they are presented. That guide will direct you regarding how and when to use the following Installing a Vantage Array procedure to install your base Vantage Array and to create machine instance templates for scaling your Vantage domain.

Installing a Vantage Array

A Vantage array consists of two or more Vantage components distributed among two or more servers for optimum speed and efficiency. Typically a Vantage array implements the Vantage domain database on one server and the Vantage Services, Transcode Engine, Clients, and Vantage Web Applications on another server. It is even possible to split Vantage Services and the Vantage Transcode Engine across multiple servers for maximum throughput and to put the Web Applications on their own server.

To implement a Vantage domain across multiple servers, specific configurations must be applied to all computers that host any Vantage services or host the Vantage domain database for the array.

A Vantage array installation and configuration generally takes from one hour to several hours to install, depending on the complexity (number of servers). To install a Vantage array, perform the tasks in the specified order:

1. Setting Up SQL Server and the Vantage Domain Database
2. Installing Vantage Array Components
3. Adding Vantage Services
4. Setting the Vantage Windows Log On ID for Services

Note: Each Vantage domain requires one Vantage Array license per server.

Setting Up SQL Server and the Vantage Domain Database

If you are upgrading an existing Vantage installation, you will already have SQL Server installed. Skip this step and go on to the next step, Installing Vantage Array Components.

If the database is not installed, continue with this procedure.

Note: This guide does not provide instructions for installing a mirrored database and implementing mirroring. Consult your database administrator or contact your Telestream representative regarding installation service options.
Installing Vantage

Installing a Vantage Array

126

Although you can install and operate the Vantage domain database and Vantage services on the same server (as is done in an all-in-one, single node domain), Telestream recommends that you use a dedicated server for the Vantage array domain database and that you use Microsoft SQL Server Standard instead of the SQL Server Express used in single node installations.

To set up the Vantage domain database, follow these procedures in the order listed:

1. Installing SQL Server 2008/2012 Standard, or Installing SQL Server 2014 Standard, or Installing SQL Server 2016 Standard
2. Installing the Vantage Domain Database

Installing SQL Server 2008/2012 Standard

The following procedure explains how to install SQL Server 2008 or 2012 Standard. If you are installing SQL Server 2014 or SQL Server 2016, please skip to that topic, Installing SQL Server 2014 Standard or Installing SQL Server 2016 Standard.

Follow these steps to install SQL Server:

1. Log into the target server with a local administrator account.
2. Insert the SQL Server 2008 or 2012 Standard DVD into the server’s DVD drive and start the installer (setup.exe) if it does not run automatically.
3. SQL Server Installation Center—Click Installation in the left column, then select New installation or add features to an existing installation.
4. Setup Support Rules—Click OK.
5. Product Key—Enter your product key and click Next.
6. License Terms—Accept the license terms and click Next.
7. SQL Server Updates (2012 only)—Click Next after updates have completed.
8. Setup Support Files—Click Install, allow the installer to complete its actions, and click Next.

Note: If Restart computer... Failed displays in the report, this is caused by a bug in the SQL Server 2008 Standard R1 installer. To correct the problem, run Regedit and navigate to this key: Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\PendingFileRenameOperations. Clear the Value Data string. Then return to Setup Support Rules and click Re-run on the right by the status bar. The Setup Support Rules should complete successfully—click OK to continue.

10. Instance Configuration:
    a. Select Named instance.
    b. Enter VANTAGE in the Named instance field and the Instance ID field.
    c. Click Next to continue.
11. Disk Space Requirements—Click Next to continue.
12. Server Configuration:
   a. For SQL Server Agent, the Startup Type should be disabled. (If the Startup Type is set to automatic, the service must be stopped before running Vantage Setup.)
   b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
   c. Click Next to continue.

13. Database Engine Configuration:
   a. Click Add Current User.
   b. Select Mixed Mode.
   c. Enter the Vantage sa user password (vantage12!) in the Enter Password and Confirm Password fields.
   d. Click Next to continue.

14. Continue to click through the installer windows accepting the default settings to complete installation.

15. Complete—Click Close to close the SQL Server 2008/2012 Standard installer.


17. Connect to the Vantage domain database using the following information:
   - Server type: Database Engine
   - Server name: [hostname]\VANTAGE
   - Authentication: SQL Server Authentication
   - Login: sa
   - Password: vantage12!

18. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

19. In the Server Properties window, go to the Memory page.

20. Set the Maximum server memory (in MB) to 75% of the system's memory. For example: If the system's memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

21. Click OK.

22. Close the SQL Server Management Studio.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: *Installing the Vantage Domain Database*. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.
Installing SQL Server 2014 Standard

Follow these steps to install SQL Server 2014 Standard on a server (skip this topic if you already installed another version of SQL Server):

1. Launch setup from the SQL Server 2014 Standard installation media.
2. In the SQL Server Installation Center, go to Installation on the left.
3. Select New SQL Server Stand-alone installation or add features to an existing installation.
4. On the Product Key page, enter a product key and click Next.
5. Accept the license terms and click Next.
6. Click Next on the Microsoft Update page.
7. On the Setup Role page, select SQL Server Feature Installation and click Next.
9. On the Instance Configuration page, select Named instance, enter VANTAGE and click Next.
10. On the Server Configuration page, click the cell for the account name of the SQL Server Database Engine service. After selecting the cell, click the drop-down list and select <<Browse…>>.
11. In the Enter the object name to select field, type NETWORK SERVICE and click OK. Then click Next on the Server Configuration page.
13. (Optional) If you would like to specify a non-default location for the database files, go to the Database Engine Configuration page, select the Database Directories tab, and change the Data root directory path.
15. Click install on the Ready to Install page.
16. When installation completes, click Close and close the SQL Server Installation window.
17. From the Start menu, launch the SQL Server 2014 Management Studio.
18. In the Server name field, enter .\vantage as the server name.
19. Set authentication to SQL Server Authentication.
20. Enter sa for the login and vantage12! for the password.
21. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and select Properties.
22. From the Select a page panel, go to Memory and set Maximum server memory (in MB) to 75% of the host system’s memory. For example, if the system’s memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).
23. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: Installing the Vantage Domain Database. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.

**Installing SQL Server 2016 Standard**

Follow these steps to install SQL Server 2016 Standard on a server (skip this topic if you already installed SQL Server 2016 Standard):

1. Launch setup from the SQL Server 2016 Standard installation media.
2. In the SQL Server Installation Center, select Installation on the left.
3. Select New SQL Server Stand-alone installation or add features to an existing installation.
4. On the Product Key page, enter a product key and click Next.
5. Accept the license terms and click Next.
6. Click Next on the Microsoft Update page and the Install Rules page.
7. On the Feature Selection page, click Feature Selection on the left, enable Database Engine Services and click Next.
8. On the Instance Configuration page, select Named instance, enter VANTAGE and click Next.
9. Click the cell where the SQL Server Database Engine Row and Account Name column intersect. After selecting the cell, click the drop-down list and select <<Browse…>>.
10. In the Enter the object name to select field, type NETWORK SERVICE and click OK. Then click Next on the Server Configuration page.
12. (Optional) If you would like to specify a non-default location for the database files, go to the Database Engine Configuration page, select the Data Directories tab, and change the Data root directory path.
13. Click Next on the Database Engine Configuration page.
14. Click Install on the Ready to Install page.
15. When installation completes, click Close and close the SQL Server Installation window.

**Installing SQL Server 2016 Management Studio**

Management Studio is not automatically installed for SQL Server 2016. To install and configure it, follow these steps:

1. Launch setup from the SQL Server 2016 Standard installation media, if it is not still running after completing your SQL Server 2016 installation.
2. In the SQL Server Installation Center, select Installation on the left, and select Install SQL Server Management Tools on the right.

3. On the Welcome screen, click Install.

4. Click Restart when prompted to complete installation setup.

5. From the Start menu, launch the SQL Server 2016 Management Studio.

6. In the Server name field, enter \.vantage as the server name.

7. Set authentication to SQL Server Authentication.

8. Enter sa for the login and vantage12! for the password.

9. In the Object Explorer panel, right click \.vantage (SQL Server 12.0.2000 – sa) and select Properties.

10. From the Select a page panel, go to Memory and set Maximum server memory (in MB) to 75% of the host system's memory. For example, if the system's memory is 8 GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

11. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the Vantage domain database as explained in this topic: Installing the Vantage Domain Database. The Vantage installer will detect that SQL Standard is already installed, will not install SQL Express, and will attach to the installed instance.

**Installing the Vantage Domain Database**

This task installs the Vantage domain database instance.

Follow these steps:

1. Log into the database server with a local administrator account, and make sure that virus-checking software and Windows Firewall is off.

**Note:** To effectively operate Vantage services with other networked devices or systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Run the Vantage_7.1.exe file to extract and automatically run the Vantage _7.1_Setup installer. Select only Array Node and Domain Database to be installed.

**Note:** The setup program checks for an existing SQL Server installation, and if found, setup skips the installation of SQL Server 2014 Express. If not found, SQL Server 2014 Express will be installed.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display the license agreement.

5. License Agreement—Read the Vantage Software License Terms and Conditions, then click I Accept if you agree to license terms. Click Next.
6. Select whether to **Install new database** or **Upgrade existing database**.

   If there is no existing Vantage database on this server, select **Install new database**, and click Next.

   If there is a Vantage database on this server, select **Upgrade existing database**, and click Next to upgrade your database and preserve workflows, design items, job history, catalogs, stores, application configurations, user settings and licenses.

---

**Note:** Telestream recommends that you install the database on a different hard drive from the one allocated for temporary media storage. For more information, see *Database Selection and Configuration Guidelines* in the *Before You Install Vantage* chapter.

---

**Note:** Existing workflows do not require updating to run as they did on an earlier Vantage release. However, you can update actions and workflows to take advantage of new features. See the *Vantage User Guide* for details.

---

7. Destination Folder—Accept the default folder or click Change to select an alternate folder. Click Next.

8. Ready to Install Vantage Domain Database—Click Install to begin database installation. This process takes a few minutes to complete.

9. Completed—When installation is complete, click Finish.

---

**Adding SQL 2008 Service Packs for Windows Server 2012**

If you are using Microsoft SQL 2008 R2 Standard on Windows Server 2012, you must add the latest service packs to SQL after you install it. See this Microsoft topic for more information: [http://support.microsoft.com/kb/2528583](http://support.microsoft.com/kb/2528583).
Installing Vantage Array Components

Once you have your SQL database and Vantage Domain Database installed, you’re ready to install the Vantage Array components, including Vantage services, transcoders, and clients. Telestream recommends that you install these components on a different server than your database for maximum operating efficiency.

To install the Vantage components, follow these procedures in the order presented:

1. **Installing Vantage Services, Transcode Engine, and Clients**
2. **Adding Vantage Services**
3. **Setting the Vantage Windows Log On ID for Services**

**Installing Vantage Services, Transcode Engine, and Clients**

This procedure installs the Vantage services, Transcode & Analysis Engine, Vantage Management Console, and Vantage Workflow Designer on a server. If you prefer, you can divide these components among multiple servers for greater processing efficiency. To do so, select only the components you want to install on the current server when you perform step 7 below.

**Note:** Vantage installers modify Windows Distributed Transaction Coordinator (MSDTC) properties to meet Vantage services and database communication requirements. This modification is automatic, and requires no action on your part.

To install the Vantage components, do the following:

1. Log into the target server with a local administrator account. Make sure that virus-checking software and Windows Firewall are turned off.

**Note:** Telestream recommends not using anti-virus software on Vantage servers. If you use anti-virus software, you should identify Vantage as a safe/trusted application. Be sure to turn off anti-virus software during Vantage installation or install anti-virus software after installing Vantage.

2. Run the Vantage installation archive file, *Vantage_7.1.exe*, which you previously downloaded (see *Obtaining the Vantage Installer*). The archive extracts components, and runs the *Vantage_7.1_Setup.exe* installer to begin installation.

3. When the Welcome dialog appears, click Next to display the license agreement.

4. When the license agreement appears, click *I accept the terms in the License Agreement* (if you accept the terms), and click Next (or click Cancel).

5. Select **Array (Multi-Node)** Installation when the dialog instructs you to “Select the type of Vantage system you want to install.” Then click Next.

6. Select the type of installation you want to perform: **Install Product** or **Custom Install**. **Install Product** lists products and options in licensed groups. **Custom Install** lists every Vantage component and option.
7. In the Install Product or Custom Install display, check the boxes by the components you want to install, and click Next.

At a minimum, you should choose to install the Transcode/Transcode Pro selection. If licensed, you may choose multiple options that include additional services, the Workflow Designer, the Workflow Portal, and Web Applications.

**Note:** If Vantage Web Applications have never been installed and you are not installing them on a Lightspeed server, leave them unchecked in the installer and install them later as explained in *Installing and Configuring Vantage Web Applications*. If they have been installed before (and IIS is already configured), or you are installing on a Lightspeed server, you can check the installer to install them now.

8. Browse to Configure the installation location for the Installation base.

9. When the *Ready to Install* dialog appears, click *Install* to begin product installation.

This process takes a few minutes to complete and shows progress and components being installed as it runs. See *Installation Notes* below for additional details.

10. When installation is complete, the progress text displays *Finished*. Click Next.

11. The dialog displays Installation successful! Click Done.

This completes the initial Vantage installation. *Vantage 7.1* is now visible in the Control Panel > Programs and Features list, and Vantage should be functional, though not licensed. To test this, launch the Vantage Management Console from its desktop icon.

If any components failed to install, you can run the installer again selecting a Custom Install and checking only the components you want to install again.
Installation Notes

The following notes provide additional installation details:

**Note:** Telestream recommends that you do not use anti-virus software on Vantage servers. If you prefer to use anti-virus software, identify Vantage as a safe/trusted application. For additional information on using Vantage with anti-virus software, see Anti-Virus Software Recommendations. For more information on using Vantage with the Windows Firewall, see Firewall Guidelines.

**Note:** If Intel Performance Primitives (IPP) is not present, the Vantage installer installs it.

**Note:** If QuickTime is not installed, the installer downloads and installs it for you if you have an Internet connection. If an outdated version is present or there is no Internet connection, the installer displays a message advising you to install it manually. The Telestream Transcode and Analysis engine requires QuickTime version 7.6.9. You can use this link to download it: QuickTime version 7.6.9. If you install QuickTime manually, uncheck (disable) Check for Updates, so QuickTime is not updated automatically. Then restart the server and re-run Vantage_7.1_Setup.exe (in C:\Vantage) again to continue.

**Note:** Microsoft .NET Framework 3.5.1 and .NET 4.6.2 are both required on all Vantage servers and client workstations. Vantage Web Apps require only .NET 4.6.2.

The Vantage installer may install these components for you, depending on the OS:

- .NET 4.6.2 is installed automatically by the Vantage or Web Apps installer on all operating systems, if not already present.
- .NET 3.5.1 is installed automatically by the Vantage installer on client operating systems, such as Windows 7, 8, or 10, if not already present.
- .NET 3.5.1 must be installed manually using Server Manager on Microsoft Server operating systems, if not already present. After .NET is installed, open Server Manager > Roles > Server Roles, and check Web Server (IIS) to enable it. Then enable the services listed in the IIS Role Service Requirements table.

**Note:** When a service joins a domain, if it is unable to acquire an array license, it remains in maintenance mode and logs an error. See the Vantage Management Console > Support Utilities > Error Log.
Adding Vantage Services

When Vantage services are installed on a server, the installer looks for the Vantage domain database on the server. If the Vantage domain database is present, all services are configured to connect to that domain. If no Vantage domain database is present, the Vantage services are not configured, and you must configure each service to connect to the appropriate Vantage domain.

To add Vantage services to a Vantage domain, follow these steps:

1. Start the Vantage Management Console by double-clicking its desktop icon, select the domain to manage, and log in.

   **Note:** The default Vantage user account is *Administrator* with no password. This account has administrative privileges.

2. Select Services in the component (left) panel.
   The Services details (right) panel shows all services on all servers that are connected to the domain you selected.

3. Click the Add Service button to display the Select Service dialog.
   The Select Service dialog lists all Vantage services running in this subnet, and the list includes unassigned services and services running on other Vantage domains.

4. Select one or more services to add to this domain, and click OK to add them.
   Services are identified by name, machine or host, and Vantage domain. Make sure that you do not select services that are properly attached to another domain. To select multiple services, use shift-click to select a series of services, or use Ctrl-click to select individual services.

If you are moving a service from one domain to another, the Vantage Management Console displays the Reassign Services window. Click OK to add them to this domain.

Continue now with the next task: *Setting the Vantage Windows Log On ID for Services.*
Setting the Vantage Windows Log On ID for Services

After installation, the default log on ID for each Vantage service is the *Local System account*. This log on ID provides access to files on the local server only. If a service, such as Transcode, requires access to files on another server, the Local System account cannot provide that access. If Vantage services need access to input folders, output folders, or a Vantage store that is on another computer, you must do the following:

- Create a Vantage Windows user ID for the service
- Grant access to the Vantage Windows user ID on the other computers.

For more information, see *Windows Authentication Guidelines*.

Most Vantage services require a Vantage Windows user ID to access files on other computers.

For services of the same type, the Windows log on ID for that service must be the same on all Vantage servers in the domain. For example, all Analysis services within the domain must use the same log on ID. However, the Catalog service, which does not access files, can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each Vantage server in the array:

1. In the Vantage Management Console, click Services in the left panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
3. Click the Change Service Logon button or right-click and select Change Service Log On. A dialog opens, requesting the logon.
4. Select Local System account to use the account currently accessing Vantage from your local machine, or select *This account* and fill in the user name and password for the account that has access to the desired network location.
5. Click OK. A message confirms that the logon is changing.

---

**Note:** Changing a service logon restarts that service. Also note, when changing the logon for multiple services simultaneously, some services may not restart properly. If this occurs, go to Start > Services on the server, select the affected services, and click (or right-click) Restart to manually restart the services.

6. Grant file access to the new user on all Vantage servers that the service must access.
Quick Installation Check

At this point, the Vantage installation should be functioning, though not licensed. Vantage Management Console should be operational if you double-click the Vantage Management Console icon on the desktop. By default, no login is required. If you enable User Administration under Settings & Options > General to require a login, you can then log in with the user name “administrator” and no password.

Vantage Web Apps should also start if you enter the following URL in a browser on the server: http://[server name]/Vantage/.

Next, continue with the following post-installation tasks:

- Post-Installation Steps for Single Nodes and Arrays
  - Setting Up a Vantage Store
  - Installing and Configuring Vantage Web Applications
  - Enabling Vantage Licenses
  - Installing Client Programs on Client Workstations
  - Configuring Client DB Access and User Administration
  - Verifying the Installation
Post-Installation Steps for Single Nodes and Arrays

This section includes post-installation procedures common to both Vantage Single Node and Vantage Array installations. After the initial installation is finished, continue with these steps:

■ Setting Up a Vantage Store
■ Installing and Configuring Vantage Web Applications
■ Enabling Vantage Licenses
■ Installing Client Programs on Client Workstations
■ Configuring Client DB Access and User Administration
■ Command Line Installation
■ Verifying the Installation
Setting Up a Vantage Store

A Vantage store is a required folder that serves as a temporary location to store media files while Vantage processes them. It is used by the transcoders and the Workflow Portal (including Web Apps Workflow Portal) and must be in place before you use the domain. A Vantage array installation does not automatically set up a Vantage Store, so you will need to create one now. An all-in-one, single-node installation creates a default storage location at `C:\VantageStore\` and also creates a Vantage catalog. However, you may prefer to set up a more convenient location for processing your Vantage jobs.

To create a Vantage Store, follow these steps:

1. If you have not created a Windows share to serve as the Vantage store, create it now and make it available to the Vantage Windows user. For more information, see Configuring Folders for Vantage Access.
2. Open the Vantage Management Console.
3. Click Storage in the left panel to display the Vantage storage options.
4. Select Vantage Stores to display the Vantage Stores list in the details (right) panel.
5. Click the New Vantage Store toolbar button to open the Add New Store dialog.
6. Type a name for the store in the Name text box. The name that you enter here is the name that appears in Workflow Designer when an action is configured to access a media file or attachment.
7. To specify the store root directory, do the following:
   a. Click Modify to display the Browse for Folder dialog box.
   b. Open Network, open the computer name, and then select the root directory for the store.
   c. Click OK.
   You can also type a UNC path in the Location text box. For example, `\Computer-Name\Sharename`.
8. Click the Save button to save the new store.

Notes: If you use a local drive letter to specify a directory, only Vantage services and clients on the same computer can access the store. If the Vantage store is on a different computer, you must publish a share and grant access to the appropriate Windows users before it will appear in the Browse for Folder dialog. For more information, see Windows Authentication Guidelines in the Before You Install Vantage chapter.
Installing and Configuring Vantage Web Applications

Vantage Web Applications (for Vantage arrays only) provide convenient operator and administrator browser-based access to Vantage without the overhead of running the full Vantage clients. Functions include the Dashboard, Job Status Views, Workflow Portal, Dublist Portal and Live Capture. When planning Web Apps installation, it is recommended that you run them on a separate server from the Transcoder & Analysis Engine with the firewall enabled, since users may be accessing the Web Apps remotely.

If you are updating existing Web Apps, the server is already configured. See Updating Vantage Web Applications for an abbreviated procedure.

If you are installing Web Applications for the first time, use the following procedure.

The following topics explain Web Application installation and configuration:
- Installing Vantage Web Applications
- Managing Web Workflow Portal Client Alias Support
- Enabling Vantage Licenses
Installing Vantage Web Applications

When installing the Vantage Web Applications on a server for the first time, the procedure is different for Lightspeed servers and standard servers:

- **Standard servers**—You must set up IIS first. If IIS is already installed, you must create the configuration that supports Vantage Web Applications. Start at **Step 1** below.
- **Lightspeed servers**—Lightspeed servers ship with IIS properly installed. There is no need to set up IIS on a Lightspeed server. Skip the steps below and see **Updating Vantage Web Applications** for an abbreviated installation procedure.

To install IIS and the Vantage Web Applications, follow these steps:

1. Log on to the target server with a local administrator account.
2. If you are installing on a Lightspeed server, skip to **Step 5**.
3. Verify that your IIS server and .NET framework requirements are met (also see **Vantage Web Applications OS**):
   - IIS 7.5 or later is required
   - .NET 4.6.2 is required

   **Note:** .NET 4.6.2 is installed by the Web Apps installer if it is not already present.

4. Install and/or configure IIS on the target server:
   a. Open the Control Panel Administrative tools, and open the Server Manager.
   b. **For Server 2008**, make these selections (see next step for Server 2012):
      - **Install**—Roles > Add Roles > Server Roles > check Web Server (IIS) > Next > Next > check ASP.NET, IIS 6 Management, and all IIS 6 Management subcomponents > click Next > click Install.
      - **Configure**—Server Manager > Roles > select Web Server (IIS) > Enable the role services listed in the following table.
   c. **For Server 2012**, make these selections to install and configure:
      - **Install**—Server Manager > Local Server > Roles and Features > Add Roles & Features.
      - Server Selection: Select a server from the server pool > LOCAL SERVER > Next.
      - Features: Select .NET Framework 3.5 Features > Next.
      - **Configure**—Role Services: Enable services listed in the following table and press Next. Roles required for Server 2008 that are not required for Server 2012 are indicated in the table below by 2008 in parentheses (2008).
        - Confirmation: Click **Specify an alternate source path** and enter the path of the 5xS folder located in the Sources folder on the Server 2012/2016 installation disc (example: D:\sources\sxs).
        - Click Install, and after installation finishes, press Close.
IIS Role Service Requirements

<table>
<thead>
<tr>
<th>Service</th>
<th>Install/Select</th>
<th>Uninstall/Deselect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
<td>WebDAV Publishing</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
<td></td>
</tr>
<tr>
<td>Application Development</td>
<td>.NET Extensibility 4.6</td>
<td>.NET Extensibility 3.5</td>
</tr>
<tr>
<td></td>
<td>ASP.NET 4.6</td>
<td>Application Initialization</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
<td>ASP</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
<td>ASP.NET 3.5</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility</td>
<td>CGI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server Side Includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
<td>Logging Tools</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
<td>Tracing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Custom Logging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ODBC Logging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tracing (2016)</td>
</tr>
<tr>
<td>Security</td>
<td>Request Filtering</td>
<td>Basic Authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows Authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digest Authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client Certificate Mapping</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IIS Client Certificate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mapping Authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>URL Authorization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP and Domain Restrictions</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
<td>Dynamic Content Compression</td>
</tr>
<tr>
<td>Management Tools</td>
<td>IIS Management Console</td>
<td>IIS Management Scripts and Tools</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Management Compatibility</td>
<td>Management Service</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Metabase Compatibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IIS 6 WMI Compatibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IIS 6 Scripting Tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IIS 6 Mgmt. Console</td>
<td></td>
</tr>
<tr>
<td>FTP server</td>
<td>FTP server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP Extensibility</td>
<td></td>
</tr>
<tr>
<td>IIS Hostable Web Core</td>
<td>IIS Hostable Web Core</td>
<td></td>
</tr>
</tbody>
</table>

5. Run the `Vantage_7.1_Setup.exe` installer (in C:\Vantage7.1) to begin Web Apps installation. Choose an Array > Custom installation, and check the box to install only the Web Applications (all else unchecked).

Alternatively, you can run the separate `VantageWebApplicationsSetup.exe` installer.
**Note:** The Vantage Web apps should be installed on a different server from the Telestream Transcode & Analysis engine. Don't put both on a single node.

**Also note:** The Web Apps installer should only be used after you have used the `Vantage_7.1_Setup.exe` installer to install other Vantage components. Running the `Vantage_7.1_Setup.exe` installer after the Web Apps installer will remove the Web apps.

6. When the Welcome Window appears, click Next.

7. Click *I accept...* to accept the license terms after reading them, and click Next (or click Cancel if you do not agree to the license terms).

8. When the Select Installation Address dialog appears, click Next to accept the default configuration, or change the settings as required, and click Next.

**Note:** Ensure the Application Pool drop-down selection is set to *create Vantage Application Pool*.

9. Click Install to begin installation.

10. When the Installation Complete dialog appears, click Finish.

11. If Vantage services were running before the Vantage Web Applications installation, restart them using Microsoft Services (Start > Administrative Tools > Services).

12. Provide the Vantage Web Applications login requirements to each of your Vantage users, so that they know how to access them. The URL for the Vantage Web Applications is: `http://[hostname]/Vantage` where `[hostname]` is the server where you installed them.

**Note:** For information on the browser requirements for Vantage Web Applications, see [Vantage Web Applications Browser Requirements](#).

**Note:** If your installation uses the Workflow Portal Web application, configure support for this program as described in [Managing Web Workflow Portal Client Alias Support](#).

### Using Web Apps with Active Directory

If you are using Vantage with Active Directory enabled in Vantage Management Console Settings & Options, you may receive a server error message when you attempt to log into Vantage Web Apps. To resolve this issue, you must set up IIS for ASP.NET Impersonation.

ASP.NET Impersonation assigns one special account as the authentication account for Web Apps with all necessary privileges and allows Vantage users to log in using that account. For example, you might create the Windows account called `WebAppsUser` on the server where the Web Apps are installed. You then assign that user the desired Windows permissions, which must include assignment to the local administrators group. Finally, set up impersonation as described below. With impersonation operating, when
Vantage users access the IIS server to run the Web Apps, IIS substitutes the credentials from the special account to log them into IIS and allow access to the Web Apps.

To set up ASP.NET impersonation for the Web Apps, follow these steps:

1. Create a Windows Active Directory account with local administrator privileges to act as the impersonator on the IIS server where the Web Apps are installed.
2. Click Start and enter IIS in the Search Programs field. Then select Internet Information Services Manager from the list of search results.
3. In the IIS Connections panel, expand the top tier (hostname), expand Sites, Expand Default Web Site, and click Vantage.
4. In the IIS group under Vantage Home in the center panel, double-click Authentication. The Authentication panel opens (the ASP.NET Impersonation in IIS figure).
5. Right-click ASP.NET Impersonation, and select Enable. The state of this feature changes to Enabled.
6. Right-click ASP.NET Impersonation, and select Edit.
7. Select Specific User, and click Set....
8. Fill in the User Name and password for the Active Directory user created in step 1 to use for logging into the Web Apps, and click OK.

Now when authorized Vantage users log into the Web Apps, IIS impersonates the local admin user you specified and allows the Vantage users Web Apps access.

ASP.NET Impersonation in IIS
Managing Web Workflow Portal Client Alias Support

The Vantage Workflow Portal Web application requires HTTP access to Vantage stores for viewing of proxy media files using the automatically installed HTML5 Video Player on client computers. If your Vantage installation does not use the Workflow Portal Web client, or if operators will not be using the Workflow Portal Web client to view proxy files, you do not need to configure alias support.

Providing HTTP access to Vantage stores for proxy viewing requires the following:

- Create and configure a virtual directory on the IIS server that references the Vantage store. A virtual directory must be created for every store that will store proxy files for the Workflow Portal Web application.
- Create and configure a Vantage alias for the virtual directory.
- Create and configure a Workflow Portal configuration using the Vantage Management Console to support operator management.
- Install the HTML5 Video Player on computers that will view proxy media files using the Workflow Portal Web application. This happens automatically when you install the Vantage Web Applications including the Workflow Portal Web App.

The following topics describe how to manage an alias for a Vantage store:

- Creating an IIS Virtual Directory
- Creating an Alias for Each Vantage Store in the Vantage Management Console
- Modifying an Alias
- Deleting an Alias

Creating an IIS Virtual Directory

For detailed instructions to create an IIS virtual directory, refer to the Microsoft IIS product documentation. The following procedure provides an example of how to configure a virtual directory on an IIS server:

1. If not already installed, install the Vantage Web Applications as described in Installing and Configuring Vantage Web Applications.
2. On the server that hosts the Vantage Web Applications, select Start > Administrative Tools > Computer Management.
3. In the left panel of the Computer Management window, expand Services and Applications and select Internet Information Services (IIS) Manager.
4. In the Connections panel, expand the server entry, and expand the Sites entry.

**Note:** In some situations, adding or removing a virtual directory causes Web Dashboard sessions to close. This does not change the Web Dashboard configuration or operation. Web Dashboard users can simply restart the program.

5. Right click Default Web Site and select Add Virtual Directory.
6. Configure the virtual directory as follows:
   a. Enter an Alias name for the virtual directory.
      Consider using a name that is easy to associate with the Vantage store directory, and note this name, as you will need to use it to create a Vantage alias.
   b. Type the path to the Vantage store directory in the Physical path text box, or click the browse button to the right of the text box and select a directory.
      For an all-in-one domain, the path to the default Local Store is C:\VantageStore. The default path works only when the store and the Vantage Web Applications are located on the same server.
      If your Vantage store is located on a network attached storage device or other network accessible location, enter the UNC path to the location (for example, //myserver/myStore/).
   c. Click Connect as, click Specific user, and click Set.
   d. Enter user name and password information for a Windows user with access to the Vantage store directory, and click OK twice.
      If required, the user name should include a domain name. For example, user@domain.net or VantageGuru@MyCompany.net. You can also enter <domain>\user.

   **Note:** If you are operating in a Windows workgroup, the IIS 7 server machine name and the machine name of the file share for the Vantage store should have the same local account name (VantageUser, for example) and password. This allows for easy authentication from IIS to the Vantage store location. In this case, the user name in the Set Credentials window can be specified simply as VantageUser.

   e. Click Test Settings.
      The Test Connection dialog should show that the Authentication and Authorization tests passed.
   f. Click Close.
   g. Click OK to complete the virtual directory configuration.
      The virtual directory should now display in the Computer Management window as a folder below the Web site you modified.
   h. Repeat this procedure for all Vantage stores that will store proxy files for use with the Workflow Portal Web application.
Creating an Alias for Each Vantage Store in the Vantage Management Console

After you create virtual directories for your Vantage stores, you need to create a Vantage alias in the Vantage Management Console for each Vantage store that will store proxy files:

1. Start the Vantage Management Console, select the domain to manage, and log on.

   **Note:** The default Vantage user account is *administrator* with no password. This account has administrative privileges.

2. Select Storage in the left panel, and Vantage Stores in the main panel.
3. Create a new store or click an existing store in the Vantage Stores list.
4. In the Alias field, enter the virtual directory alias you created in the previous procedure: `http://IIShostname/Virtual Directory`.
5. Click the Save button to save the changes.
6. Repeat this procedure for all Vantage stores that will store proxy files for use with the Workflow Portal Web application.

**Modifying an Alias**

After you have created an alias, you can modify the alias path by simply typing in the Alias field and saving the changes.

**Deleting an Alias**

To delete an alias, select the alias path in the Alias text box, press Delete, and save.
Enabling Vantage Licenses

If you are implementing Vantage in a new production environment or you did not back up your previous database, enable your new licenses now using this procedure. If you have not yet obtained a license or if you need additional licenses, contact Telestream.

The following topics describe Vantage license installation:

- Installing a Vantage License
- Activating a Vantage License Offline
- Troubleshooting License Installation Problems
- Resolving a DEP Conflict

Note: A Vantage domain with two or more nodes requires one Vantage Array license for each node. Additional licenses are required to activate optional features.

Installing a Vantage License

Note: You should remove a license from one domain before you use it in another domain—you cannot use the same license in more than one domain at a time.

Also note that you can install demo licenses as described below or by using the Workflow Designer File > Add/Update Demo License... menu selection. See the Vantage User Guide for details.

When you receive a license (an XML file), install it using these steps:

1. Store a copy of the license file in a safe place.
   Always keep a backup in case you need to move the database later.
2. Store a copy of the license file in a location that is accessible to the server where you are installing the license, and note the directory where the file is stored.
3. Start the Vantage Management Console by double-clicking its desktop icon.
4. In the left panel, select Licenses.
5. In the right panel, click the Add/Update a license button in the toolbar to display the Add/Update License dialog.
6. Navigate to the folder containing the licenses, select the licenses, and click Open.
   If this computer has an Internet connection, Vantage prompts you to accept the license agreement. If an error message appears, see Troubleshooting License Installation Problems.
7. Click I Accept... if you agree to the license terms, and click OK.
8. When the Licensing Changed dialog appears, read the message and click OK.
9. Repeat this procedure to install additional licenses.

When installation is complete, the license is stored in the Vantage domain database for use by all Vantage services and clients in the domain. Telestream recommends that you archive a copy, in case you need to move the license to another Vantage domain later.
Activating a Vantage License Offline

If the computer has no Internet connection, an error message displays, indicating the problem. The Vantage Management Console might not have access to the Internet, or the network firewall might be prohibiting Web server (HTTP) traffic.

You can activate the Vantage license yourself using a different computer, or you can call Telestream Customer Service and they will assist you to activate your license.

To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the product activation dialog.
2. Click the option to activate using a different computer and click Next.
   Vantage displays a dialog to activate using another computer, including the installation ID for your license.
3. Click Save and create a text file that contains the activation key.
4. Save this file locally and copy this file to a computer with Internet access or save it directly to a share on (or accessible to) a computer which has Internet access.
   After saving the file, leave the dialog open and proceed to the computer with Internet access to validate the Installation ID.
5. On the computer with Internet access, open a web browser and navigate to the URL listed in the Offline Activation Required dialog.
6. Open the installation ID text file and copy and paste the Installation ID into the Installation ID field on the web page.
7. Click Submit – Vantage connects to the licensing server.
   The licensing server validates the installation ID and returns a page displaying your unique activation key composed of ten groups of numbers and letters.
8. If your Vantage server is not immediately adjacent, print this page or write down the activation key.
9. Return to the Vantage server you wish to activate, enter the activation key in the licensing dialog, and activate the license.
   The activation key should be accepted and the Vantage license activated, as confirmed by a dialog.
Troubleshooting License Installation Problems

These are common problems that might occur during license installation:

- General licensing engine failure—the licensing server may be momentarily unavailable; wait one to two minutes, and then repeat the license procedure.
- No Internet connection—see Activating a Vantage License Offline.
- Data Execution Prevention (DEP) conflict—see Resolving a DEP Conflict.

Resolving a DEP Conflict

If Vantage displays an error saying that licensing cannot run with Data Execution Prevention enabled, follow these steps:

1. Right-click My Computer to display the System Properties dialog.
2. On the Advanced tab, click the Performance Settings button to display the Performance Options window.
3. On the Data Execution Prevention tab, check Turn on DEP for all programs and services except those I select.
4. Click Add and navigate to the Vantage Management Console executable: (C:\Program Files (x86)\Telestream\Vantage\VantageManagementConsole.exe).
5. Click Open, and click OK to apply this change.
6. Click OK to restart the computer and activate the license.

The activated license is stored in the Vantage domain database for use by Vantage services in this domain.

Note: If you move your Vantage domain database to another server, remove your license to deactivate it, and then import it and activate it again in the new database. Be sure to keep your license file (XML) as a backup.
Installing Client Programs on Client Workstations

The available Vantage Client programs include the Vantage Management Console, the Vantage Workflow Designer, the Workflow Portal, and the Dublist Portal. These are installed on the Vantage server during initial installation, but they may also be installed on client workstations for use by administrators and workflow designers.

To install the Vantage client programs on a workstation, do the following:
1. Log into the target workstation with a local administrator account, and make sure that virus-checking software and Windows Firewall is off.
2. Copy the Vantage 7.1 Client Application.msi installer or the Vantage_7.1_Setup.exe installer (in C:\Vantage7.1) to the workstation where you want to install the clients, or make the installer available on a network share.

**Note:** Installers should not be mixed. Whether you use the Vantage installer or the client installer to install the clients, use the same installer for all subsequent client installation changes. Mixing installers may produce unexpected results.

3. Double-click the installer program to run it.
4. When the Welcome dialog appears, click Next to display the license agreement.
5. Read the Vantage Software License Terms and Conditions, click I Accept... if you agree to license terms, and click Next.
6. If using Vantage_7.1_Client_Application.msi select which client apps to install.
7. If using Vantage_7.1_Setup.exe, select Single Node or Array Node installation and click Next.
8. If using Vantage_7.1_Setup.exe, select Custom Install, Client Applications, and click Next.
9. If using Vantage_7.1_Client_Application.msi, select where to install and click Next.
10. When the Ready to Install dialog appears, click Install.
11. When installation is done, click Finish to close the installer.

Updating VOD DAI Workflow Portal Configurations

In Vantage 7.1, the VOD DAI Workflow Portal has been improved to provide new variables for Group Contiguous Ads and Enable Local Column Headers. Local Ad Descriptors have also been added, and available combinations of ad insertion types and descriptors have changed.

To make use of these new features, portal configurations created with prior Vantage versions must be recreated in Vantage 7.1. VOD Workflow Portal project files should also be recreated with Vantage 7.1 (if the Vantage 6.3 customer-only VOD DAI Local Ad Portal patch has not been applied) to make use of Local ad descriptors.

If configurations and project files are not recreated in Vantage 7.1, existing portal configurations and project files will continue to operate as before, but the new features will not be available.
Configuring Client DB Access and User Administration

The Vantage client and web applications connect to the Vantage database using the system administrator (sa) role by default. To provide greater security, you may want to create additional SQL roles for users that have a lower level of control. Additionally, you can restrict access to Vantage by enabling user administration and creating user accounts.

The following procedures explain how to set up client database roles and Vantage user accounts.

Configuring Vantage DB Users

To create a new user for logging into the Vantage database from clients, follow these steps:

1. Launch the SQL Server Management Studio on the Vantage database server.
2. In Object Explorer, access Databases > Vantage > Security.
3. Right-click New and select User.
4. In the new user dialog box General page, select a user type and enter a login, password, and select other options.
5. Click OK when finished.
   The new user will appear in the Users list.

7. Right-click the new user and select Properties.
8. In the Login Properties window, go to Server Roles and enable public. Click OK.

The next step is to move to the client host and save the same user login and password for the client apps to use when logging into the Vantage database.

**Configuring Client Login Connection Settings**

To configure client apps to use the new client login to the database, follow these steps:

1. Open a client or web app and select (File ->) Change Vantage Domain.
2. Click Search and select the Vantage domain from the list of domains.
3. Click the Connection Settings drop-down menu.
4. Enter the client database user and password in the Login and Password fields
5. Click OK.
6. Repeat these steps for each client application.
Enabling User Administration

The Vantage User Administration feature is disabled by default, so no login is required to use Vantage client apps. If you want to improve security by requiring a Vantage login, follow these steps:

1. Open the Vantage Management Console.
2. Select Settings and Options in the left panel.
3. Select the General tab.
4. Check Enable User Administration.
5. Check Use Windows Active Directory for Users if you want to use Windows logins for accessing Vantage. Leave this option unchecked to create unique Vantage user accounts for each user.

If Active Directory is enabled, ASP.NET Impersonation configuration is required, as documented earlier in this chapter under *Using Web Apps with Active Directory*.

See *Managing Users* in the Vantage Management Console Help system for more information.

Next, continue in the Vantage Management Console to create user accounts as explained in the next topic.
Creating Vantage Users

If you enabled Vantage User Administration, create users as follows:

1. Click the New User button or right-click and select New User.

2. For Windows Active Directory, search for and select a user. For a Vantage user account, enter the username and password (and confirm the password).

3. Check the Administrator check box if you want the new user to be an administrator.

4. For non-administrators, check User cannot change password, if you want to protect the password from being changed by the user.

5. Click OK or Add to add the user, and then click Save to save your changes.

6. Repeat this process to create as many Vantage users as you need.

This completes the process of setting up clients and web apps for database and user access. Now when you start a client or web app, the client app will log into the Vantage database with the database user account you created with public privileges. Then the app will ask the user to log into Vantage with their Vantage or Windows Active Directory user account. This configuration provides a better level of security than the default settings.
Verifying the Installation

At this point in the installation, you should have a fully installed, fully functioning Vantage domain. Before installing updates or doing further system configuration, do a thorough check of all domain components to verify they are fully operational.

Launch the following desktop shortcuts to make sure they are working:

- Vantage Management Console
- Vantage Workflow Designer
- Vantage Workflow Portal
- Vantage Dublist Portal
- Vantage Web Apps—use a browser to access this URL: http://[server name]/Vantage/

Testing the domain at this point assures you that everything has been installed correctly or allows you to pinpoint any components that need reinstalling or configuring.

Once your system is known to work correctly, you can proceed to the next topic, installing updates. If any problems develop after updating, you will know that the update caused the problem, and you can focus on resolving the problem with the update.

**Note:** Existing workflows do not require updating to run as they did on the earlier Vantage release. However, new options in actions do not display automatically and are not usable until you upgrade each action as described in the *Vantage User Guide*.

**Note:** Automatic Windows and software updates and automatic restarts of Vantage servers should be disabled. Schedule update installation and system restarts only during planned maintenance periods to prevent disruption of Vantage operations.
Command Line Installation

Vantage includes the capability of installing from the command line, either attended (full UI) or unattended (silent, no UI). For example, system administrators may wish to install Vantage on multiple servers of an array by using an unattended command line installation mode that does not require you to answer any questions or manually select any options. Alternatively, you can initiate an attended full UI installation from the command line as well.

**Note:** Unattended (silent) installation is intended for installing on array nodes that do not include the database or QuickTime, since the database and QuickTime cannot be installed using this mode.

The Vantage 7.1 installer consists of a self-extracting archive executable (.exe) file containing the Vantage Setup file and ComponentPacs. When you run the archive file, it extracts the installation files to a directory, and then automatically starts the Vantage Setup file to install the product and ComponentPacs. Alternatively, you can extract without installing, and then run a manual installation later.

During extraction, you are prompted to select the directory where you want to extract the Vantage Setup installer and ComponentPacs. By default this directory is C:\Vantage7.1. After extraction the Vantage Setup installer starts automatically from the directory where you extracted it (unless you issue an extract-only command).

The extracted directory contains Vantage Setup and ComponentPac files, such as these:

- C:\Vantage7.1\Vantage_Setup.exe
- C:\Vantage7.1\ComponentPacs\Analysis.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\Avid.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\Capture.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\Flip64.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\IPTV.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\Multiscreen.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\PostProducer.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\Tempo.7.1.nupkg
- C:\Vantage7.1\ComponentPacs\TimedText.7.1.nupkg

**Note:** If you extract the Vantage installation files, and then copy the Setup file away from the ComponentPacs Directory before running it, the installation will still succeed, but no ComponentPacs will be installed on the system. A pop-up dialog will advise you of this situation.
Extracting and Installing

The following example shows how to run the archive and the installer. Details about the commands are provided after this topic.

Open a Command Prompt

To start a command line extraction and installation, open a command prompt by typing `cmd` in the Start screen and selecting Command Prompt.

Run the Archive and the Installer

1. Enter a command to run the archive, which will extract the files to a directory and automatically start the installation:
   ```
c:\> Vantage_7.1.exe -sp"/install /passive InstallFeatures=ClientFeatures"
   ```
2. Extraction begins and the following dialog appears:

3. Browse or enter a new destination or use the default destination. Then press Install.

Extraction begins and the screen shows a progress bar. When extraction completes, the Vantage Setup installer starts and the Vantage Setup Wizard appears.
4. Press Next to start the installation, and follow the prompts to complete the installation. Refer to *Installing a Vantage Array* earlier in this chapter for installation details.

The topics that follow present all command line extraction and installation commands and options.

**Self-Extracting Archive Commands**

Commands, options, and parameters for the *Vantage_7.1.exe* self-extracting archive are presented here.

**Help Command**

To bring up the Vantage Setup command list at the command prompt, pass this example help command through the Vantage self-extractor:

```
C:\Vantage_7.1.exe -s -sp=?
```

**Command List**

The Vantage self-extracting executable file has its own commands and a command that passes parameters through to the Vantage Setup application:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d&lt;path&gt;</td>
<td>Sets the destination folder for unpacked files.</td>
</tr>
<tr>
<td>-sp&lt;param&gt;</td>
<td>Defines parameters to be passed to the Vantage Setup application.</td>
</tr>
<tr>
<td>-s</td>
<td>Sets silent mode. Both the self-extracting dialog and extraction progress will be hidden.</td>
</tr>
</tbody>
</table>
**Command Examples**

**Example 1.** Silently extract the Vantage Setup and ComponentPacs to C:\Installers\Vantage:

```cmd
C:\> Vantage_7.1.exe -dC:\Installers\Vantage -s
```

**Example 2.** Silently extract the Vantage Setup and ComponentPacs to the default extraction directory C:\Vantage\7.1.exe, then passively install the Vantage Client Applications:

```cmd
C:\> Vantage_7.1.exe -s -sp"/install /passive InstallFeatures=ClientFeatures"
```

**Example 3.** Silently extract the Vantage Setup and ComponentPacs to the default location, then silently install the Vantage Services with custom service credentials:

```cmd
C:\> Vantage_7.1.exe -s -sp="/install /quiet ServiceAccount=MyDomain\DomainUser ServicePassword=passphrase InstallFeatures=FacilityFeatures"
```

**Example 4.** Silently extract without running the Vantage Setup:

```cmd
C:\> Vantage_7.1.exe -s -sp-NoOp
```

**Vantage Setup Installer Commands**

Commands, options, and parameters for the `Vantage_7.1_Setup.exe` installer are presented here. You can also see the list at the command prompt by using the help command. You can pass these commands through the archive executable so that extraction and installation run automatically, or you can extract the Setup installer and then issue these commands manually to control installation separately from extraction.

**Help Command**

To bring up the Vantage Setup command list after extraction, use this example help command:

```cmd
C:\<Vantage_7.1_Setup.exe> /?
```

**Command Syntax**

Commands follow this pattern:

```cmd
<path><Vantage_Setup_Filename> /<Option> <Parameter=Value> <parameter=Value;Value>
```

The path to the executable file is first, followed by no space and the executable name. Next comes a space and a slash, followed by no space and an option. After the option come any parameters, separated by spaces. Multiple features (Values) for a single parameter are separated by a semicolon.

**Command Examples**

**Example 1.** Unattended installation of all Vantage services but no client apps:

```cmd
C:\Vantage_7.1_Setup.exe /quiet InstallFeatures=FacilityFeatures
```

**Example 2.** Start attended full UI installation with customer service credentials:
Installing Vantage

Command Line Installation

Example 1. Command line installation of all services and clients:
C:\Vantage_7.1_Setup.exe /install ServiceAccount=MyDomain\DomainUser
ServicePassword=passphrase

Replace the ServiceAccount and ServicePassword credentials above with the local or
domain user account credentials that the services run under.

Example 3. Unattended installation of all services and clients:
C:\Vantage_7.1_Setup.exe /quiet InstallFeatures=VantageFeatures

Example 4. Unattended installation of clients only:
C:\Vantage_7.1_Setup.exe /quiet InstallFeatures=ClientFeatures

Example 5. Unattended installation of Web Applications:
C:\Vantage_7.1_Setup.exe /quiet InstallFeatures="Web Applications"

Note that quotation marks are required above and below because of the space
between words.

Example 6: Unattended installation of clients and Web Apps:
C:\Vantage_7.1_Setup.exe /quiet InstallFeatures="Web Applications;ClientFeatures"

Command List
Specify the operation to be performed. If no command is specified, /install is assumed.

/install - Install Vantage
/uninstall - Remove Vantage

Options
When using the unattended installation modes, the Vantage Database and QuickTime
will not be installed (as those components require user interaction).

When using an unattended mode, the return code returned by the setup application
should be checked to verify that the installation was successful.

The installer uses standard Windows system error codes as its return values. For
example, 0 indicates success; 3010 indicates that installation was successful, but a
reboot is required.

/passive - Perform the operation with no user interaction. A progress dialog will be
displayed.

/quiet - Perform the operation with no user interaction. To wait for the install process to
be completed, the command can be run using start /wait.

Parameters
Parameters are set using the form: ParameterName=Value with a space between each
parameter/value pair.

InstallRoot - Specify a directory where the installation will be deployed.
**DatabaseDir** - Specify a directory where the database files will reside (only applies when the database is selected). This defaults to a subdirectory of InstallRoot.

**StoreDir** - Specify a directory where the default Storage will be created (only applies to single-node installs).

**ServiceAccount** - Specify the user account that each service should be configured to run as. This should be in the form `domain\user`.

**ServicePassword** - Specify the password for the ServiceAccount user.

**InstallFeatures** - A semi-colon delimited list of features to install. This list is tree-structured, and specifying a parent feature will cause all child features to be installed. For example, including `FacilityFeatures;ThirdPartyFeatures` will cause all the Vantage services to be installed. See below for the available feature identifiers.

### Features

This list is tree-structured, and specifying a parent feature will cause all child features to be installed. For example, if you want ALL features installed, only `VantageFeatures` needs to be specified.

**VantageFeatures**
- **ClientFeatures**
  - WorkflowFeature
  - MmcFeature
  - DublistPortalFeature
  - SubmitApp
- **FacilityFeatures**
  - AnalysisFacility
  - AvidFacility
  - CableFactoryFacility
  - CatalogFacility
  - CloudFacility
  - FactoryFacility
  - LiveFacility
  - HeFactoryFacility
  - MessageFacility
  - MetadataFacility
  - MonitorFacility
  - PlaylistFacility
  - SdkFacility
  - StagingFacility
  - SubtitleFactoryFacility
  - TrafficFacility
  - TransportFacility
- **ThirdPartyFeatures**
  - AgilityFacility
  - AsperaFacility
  - AudioToolsFacility
  - CerifyFacility
BatonFacility
DigimetricsFacility
eMotionFacility
FileCatalystFacility
NexidiaFacility
PulsarFacility
ScreenFacility
SigniantFacility
ThirdPartyFacility
VidCheckerFacility
LiveFacility
VantageDomainDatabase
SingleNodeDatabase
WebApplications
Upgrading and Modifying Vantage

This chapter explains how to upgrade an existing Vantage installation from a prior version, how to update components, and how to modify an installation. These topics are discussed:
- Upgrading from a Previous Version
- Upgrading Vantage 7.0 and Versions Prior to 6.0
- Installing the Upgrade
- Updating Vantage
- Using ComponentPac Management to Update Actions
- Updating Individual Components
- Moving the Vantage Domain Database
- Adding a Server to a Vantage Domain
- Adding a Lightspeed Server to an Existing Vantage Domain
Upgrading from a Previous Version

If this is a new Vantage installation, skip this chapter and go to the Installing Vantage chapter.

If you are upgrading from Vantage 6.0-6.3 to Vantage 7.1, you do not need to remove the existing Vantage before you install 7.1. Version 7.1 will install over your existing installation, upgrading components automatically as necessary. To install the upgrade, go to Installing the Upgrade on the next page.

If you are upgrading from Vantage 7.0 or a Vantage version prior to 6.0 (such as 4.0 or 5.0), you must first uninstall Vantage using Programs and Features before upgrading to Vantage 7.1. See Upgrading Vantage 7.0 and Versions Prior to 6.0 below.

Upgrading Vantage 7.0 and Versions Prior to 6.0

If you are upgrading Vantage 7.0 or a Vantage version prior to 6.0 (such as 4.0 or 5.0), you must first uninstall all components except the domain database:

1. Back up your Vantage database by using the Domain Management/Backup feature in the Vantage Management Console. You may also want to export all workflows.
2. Log into Vantage Workflow Designer Domain Job Status and stop all jobs or allow all jobs to complete.
3. Close all Vantage client programs and Web applications using this domain.
4. For each computer with Vantage client programs installed in this domain, log in with a local administrator account and perform the following steps:
   a. Open Control Panel > Programs and Features > Uninstall Programs.
   b. Select Vantage Client Applications (if present) and click Remove or Uninstall.
   c. Uninstall all Vantage update packs that are installed: Select each Vantage update pack in reverse sequential order (latest to oldest), and click Remove or Uninstall. Perform this step for all installed update packs.
5. On the server hosting Vantage Web apps, use the Control Panel uninstall tool (see Step 4) to select Vantage Web Applications and click Remove or Uninstall.
6. On the servers hosting the Telestream Media Transcode and Analysis engine, log in with a local administrator account and follow these steps:
   a. Select Start > Administrative Tools > Services to display the Services window.
   b. Right-click and select Stop for the following services: Vantage Analysis service and the Vantage Transcode service.
   c. In the Control Panel uninstall tool (see Step 4), select Telestream Media Transcoding & Analysis Engine and click Remove or Uninstall.
7. On the Vantage database server log in with a local administrator account, and using the Control Panel uninstall tool (see Step 4), follow these steps:
Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage installation are not removed, and Vantage domain data and media you have created are not removed.

a. Select Vantage and click Remove or Uninstall. This removes Vantage, but your Telestream folder, including your Database folder and files, remain in place so your Vantage configuration is preserved.

b. Leave MS SQL Server in place—do not uninstall it.

Note: If you have SQL Server 2008 Express installed and you would like to upgrade to SQL Server 2014 Express, complete the Vantage installation, and then see Updating SQL 2008 Express to SQL 2014 Express (optional).

If you want to change the Microsoft SQL edition (for example, from Express to Standard), or if you want to move the Vantage domain database to a different server, complete the Vantage installation as presented in the next main topic, and then see Moving the Vantage Domain Database.

At this stage, the Vantage software has been removed, but your database contents and service configuration files and the SQL Server are still intact. When you install the latest Vantage, you can reuse these database files and let Vantage upgrade them. Continue now with the next topic, Installing the Upgrade.

Installing the Upgrade

The following procedure upgrades an older Vantage version to a new one.

CAUTION: Upgrade all components. Upgrading only selected components can result in component mismatches, causing a non-functioning Vantage system. If you have any questions, contact Telestream Vantage Support.

1. Log in to the Vantage server with a local administrator account, and make sure that virus-checking software and Windows Firewall are off. (See Anti-Virus Software Recommendations and Firewall Guidelines for details)

2. To protect your data, use the Vantage Management Console to back up your database using the Domain Management/Backup feature to create a backup file. (See Backing up the Existing Database for instructions.)

3. Stop any active jobs or allow them to complete. Workflows should be deactivated. Close any open Vantage apps.

4. Run the Vantage_7.1.exe installation archive to automatically extract and run the Vantage_7.1_Setup.exe installer.

5. When the Welcome dialog appears, click Next to display the license agreement. Click I Accept if you agree to the license terms, and then click Next.
6. Select *Upgrade existing database* when the Database install mode dialog appears, and click Next.

This instructs the Vantage installer to upgrade your database and preserve information for workflows, design items, job history, catalogs, stores, application configurations, user settings and licenses.

7. When the Destination Folder dialog appears, accept the default folder or click Change to select an alternate directory on another drive; then click Next.

8. When the Ready to Install Vantage Domain Database dialog appears, click **Install** to begin installation. This process takes a few minutes to complete.

9. When installation is complete, click Finish to quit. If you are upgrading a Vantage Array, you have just completed the database server upgrade. Next, upgrade any other servers in the next step.

10. Repeat these steps for any other servers in the Array, such as servers hosting the transcoding engine, services, and web applications. When you run the installer on each server, select the components to install corresponding to the components you are replacing on that server.

11. When all servers and components have been upgraded, the upgrade is complete. Test your workflows to make sure all required items to run the workflows are still present and the workflows still run as expected.

**Note:** Existing workflows do not require updating to run as they did on earlier Vantage releases. However, you might need to re-create some aspects of existing workflows to take advantage of new user interface components. For example, new options in Flip actions do not display automatically after upgrading. Refer to the *Vantage User Guide* for details about enabling new features in actions and workflows.

**Note:** If upgrading from Vantage 7.0 and your ComponentPacs reside in a custom location other than C:\Program Files (x86)\Telestream\Vantage\ComponentPacs, you may need to copy the 7.1 ComponentPacs from C:\Program Files (x86)\Telestream\Vantage\ComponentPacs to your custom location. Then you will need to use the ComponentPac Management in the Vantage Management Console to install the 7.1 ComponentPacs.

You can see or change the location in which ComponentPacs reside using ComponentPac Management > ComponentPac storage location in the Vantage Management Console.
Updating Vantage

Between version upgrades, Telestream may issue *update packs* for the current Vantage version to replace selected components for the purpose of adding small features, bug fixes or improving performance. The Update Pack installers are designed to install smoothly with minimal impact to the overall installation.

To locate and install Vantage update packs, do the following:

1. Go to the Telestream Vantage download Web site:
   

2. Review the Vantage download page to determine if there are any update packs that should be installed.

3. If there is an update pack to install, review the release notes that accompany the update and install the update pack according to your requirements and the instructions in the Release Notes.
Using ComponentPac Management to Update Actions

ComponentPacs are uniquely numbered and versioned software libraries that have replaced the component patches previously distributed for updating these specific transcoding-related actions:

- Analyze
- Capture
- Chronicle
- Compose
- Conform
- Flip 64
- IPTV Flip
- Multiscreen Flip
- Tape Capture
- Tempo
- Timed Text Flip

These libraries install into an existing Vantage Framework using the ComponentPac Management feature of the Vantage Management Console (below). They must be stored in a central location accessible to all machines in a Vantage Array.

Please note that if a change is required within the Vantage framework to non-transcoder service components, those updates are still made using a Vantage patch or update pack, not a ComponentPac. Note also that the Flip, Identify, and Examine actions are not managed by the ComponentPac feature.
Installing ComponentPacs

Installing new ComponentPacs as explained below makes them available for use but does not affect existing jobs, actions, or workflows until you explicitly upgrade them.

1. Obtain the new ComponentPac from Telestream.net or Telestream Support and place it in a folder accessible by the Vantage Management Console.

2. Open the Vantage Management Console, and click ComponentPac Management in the left column. Installed ComponentPacs, if any, are listed in the Installed ComponentPacs list on the right.

3. In the right panel Storage Location field, enter or browse to specify a path to a central ComponentPac storage location. This is where new downloaded packages will be stored and installed from. If you do not specify a path, the default location is used: C:\Program Files (x86)\Telestream\Vantage\ComponentPacs\.

   **Note:** For an all-in-one (single node) installation, the ComponentPac storage location can be a local path. For a multi-node installation (Vantage array), the ComponentPac storage location must be accessible to the Vantage services on all Vantage servers (via a UNC path or a SAN drive letter with appropriate permissions).

   One convenient way to securely install ComponentPacs from a share is to use Vantage Authorization credentials. To do this, create a share for a single user which is a different login than the logins to Windows or Vantage. (Shares can be created for single or multiple users or groups, and the user can be the same or different from the Windows user login.) Then in the Vantage Management Console, go to Settings & Options > Authorization and add the credentials for the share user. Next, restart the services to recognize the new credentials, and then test share access. You can now use the share as your ComponentPac central storage location.

4. Click the Install new package button.

5. Browse to where you downloaded the ComponentPac. Click on the ComponentPac to install, and click Open. (Skip if the ComponentPac is already present.)

6. Check the desired ComponentPac in the Install ComponentPacs window, and click Install to install and register the package with the domain.

7. When installation finishes and the package appears in the Installed ComponentPacs list, restart all affected services on all nodes to deploy the pacs. ComponentPacs are unpacked and made ready for use when the Vantage services targeted by the ComponentPac are restarted. Unpacked pacs are stored in C:\Program Files (x86)\Telestream\Vantage\Components\ on each Vantage service node.
Notes:

1. New actions and workflows created in the Workflow Designer use the latest installed ComponentPac. However, existing actions and workflows must be selected and upgraded to use the latest ComponentPac. If they are not upgraded, they will continue to use the ComponentPac with which they were created. See the Vantage User Guide for detailed action and workflow upgrade instructions.

2. In Vantage version 7.0, existing actions and workflows will use the latest installed ComponentPac if the ComponentPac used to create them is no longer present. You may need to recreate the action if the latest ComponentPac does not support the action's outdated settings. If the missing ComponentPac is reinstalled, the actions will resume use of that ComponentPac.

3. Starting with Vantage 7.0 Update Pack 1, workflows created with a previous version of Vantage (such as Vantage 6.3) will use the earliest ComponentPac installed. When you upgrade a workflow created with an older Vantage version to Vantage 7.0 or later, the actions will be tied to the latest ComponentPacs currently installed.

4. The Session Log available in the Workflow Designer Job Status or Domain Job Status panel lists which ComponentPac was used for a completed job.

5. If a Vantage service is unable to unpack a ComponentPac (such as when the Vantage service does not have the appropriate user credentials to access the file location of where the ComponentPac file resides), an entry is added to the service trace log to record the issue.

6. If you convert a single-node Vantage domain to a multi-node Vantage domain and if the installed ComponentPacs reside in a local path, the ComponentPacs must be copied or moved to a shared folder location and re-installed or re-registered.

7. If you have deployed a new database or replaced an existing database with a new one using the Database Deployment Utility, the domain will not have any ComponentPacs installed. When you run the Vantage Setup installer to install Vantage components and services after deploying the database, the major ComponentPacs will be installed. If you do not run the Vantage Setup installer after database deployment on the database server, or if you wish to install additional ComponentPacs, use the Vantage Management Console > ComponentPac Management feature to install the ComponentPacs as described in the preceding steps.

8. Upgrading Vantage via an update pack, such as 7.0 UP1, may cause ComponentPac actions to be shown as eligible for upgrade even though a new ComponentPac has not been installed. This is normal behavior for update packs. You can upgrade the ComponentPac actions or not, as you prefer.

9. Attempting to install a future ComponentPac that doesn’t match the current Vantage version fails to install the ComponentPac and displays an error message: “ComponentPacs built for a future release of Vantage are not supported, and will not be installed.”
Upgrading and Modifying Vantage

Using ComponentPac Management to Update Actions

173

Upgrading Actions and Workflows

When upgraded, existing actions and workflows can use the latest installed ComponentPacs, framework upgrades, or component patches. These instructions briefly explain how to upgrade existing actions and workflows. See the Vantage User Guide for detailed action and workflow upgrade instructions.

**Note:** Once an action is upgraded it can’t be directly downgraded. However, you can restore workflows to their pre-upgraded state by importing the automatic backup copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the upgrades is also included in that directory.

**Note:** If you want to change the location of automatic ComponentPac backups, open the Vantage Management Console, select Settings and Options, and browse for a new Location for workflow backups.

Upgrading an Action

To upgrade an action in Workflow Designer, right-click the action in its workflow and select Upgrade from the context menu.
Upgrading and Modifying Vantage

Using ComponentPac Management to Update Actions

Upgrading a Workflow

To upgrade a workflow in Workflow Designer, right-click the workflow in the workflow list on the left, and select Upgrade from the context menu.

![Upgrade workflow context menu](image)

Upgrading Workflow Batches

To upgrade workflows in batches, use the Batch Workflow Operations button in the upper right corner of the workflow list.

![Batch Workflow Operations](image)

Locking Against Upgrades

You can also lock workflows to protect against upgrades until you are ready, providing Secured Version Control. To do so in the Vantage Workflow Designer right-click the workflow in the workflow list and select Lock. You can also select Lock for multiple workflows using the Batch Workflow Operations dialog.
Removing ComponentPacs

To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in the left column. Installed ComponentPacs are listed in the Installed ComponentPacs list on the right.

2. Click the package you plan to uninstall and check the Actions panel for affected workflows and actions.

   Export all workflows that reference the ComponentPac you want to uninstall (to back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the package to be removed is selected.

   **Note:** The Uninstall button appears *only* when a package is not used by any actions.

4. After uninstallation completes, restart the affected Vantage services. If the Workflow Designer was open, close it and reopen so all the changes to take effect.

The selected old package is removed and no longer appears in the ComponentPac Management list.
Upgrading and Modifying Vantage

Updating Individual Components

At times, you may be instructed by Telestream Support to update specific components that are not handled by the ComponentPac feature.

**CAUTION:** Updating individual components should be done only as recommended by Telestream. Upgrading only selected components can result in component mismatches, causing a non-functioning Vantage system. If you have any questions, contact Telestream Vantage Support before updating.

The *Vantage_7.1_Setup.exe* installer (extracted to the C:\Vantage7.1 folder when you run the *Vantage_7.1.exe* archive file) allows you to add (or re-install) individual Vantage components (services, clients, T&A Engine) as your needs change. You can rerun the installer, select *Modify* at the first screen, and check the components you want to add.

The following instructions explain how to install individual components:

- Updating the Vantage Domain Database
- Updating SQL 2008 Express to SQL 2014 Express (optional)
- Updating Vantage Server Components
- Updating Vantage Clients on Client Workstations
- Updating Vantage Web Applications
- Moving the Vantage Domain Database
### Updating the Vantage Domain Database

The following procedure guides you in updating your Vantage database without removing or changing your SQL Server version.

To update the Vantage domain database, follow these steps:

1. Log in to the target server with a local administrator account, and make sure that virus-checking software and Windows Firewall are off.

   **Note:** For additional information on Vantage use with anti-virus software, see *Anti-Virus Software Recommendations*. For more information on Vantage use with the Windows Firewall, see *Firewall Guidelines*.

2. To protect your data, open the Vantage Management Console and back up your database using the Domain Management/Backup feature to create a backup file. See *Backing up the Existing Database* if you need detailed instructions.


4. When the Welcome dialog appears, click Next to display the license agreement. Click *I Accept* if you agree to the license terms, and then click Next.

5. Select *Upgrade existing database* when the Database install mode dialog appears, and click Next.

   This instructs the Vantage installer to upgrade your database and preserve information for workflows, design items, job history, catalogs, stores, application configurations, user settings and licenses.

6. When the Destination Folder dialog appears, accept the default folder or click Change to select an alternate directory on another drive; then click Next.

7. When the Ready to Install Vantage Domain Database dialog appears, click *Install* to begin database installation. This process takes a few minutes to complete.

   The Vantage installer upgrades your database and preserves information for workflows, design items, job history, catalogs, stores, application configurations, user settings and licenses.

   **Note:** Existing workflows do not require updating to run as they did on earlier Vantage releases. However, you might need to re-create some aspects of existing workflows to take advantage of new user interface components. For example, new options in Flip actions do not display automatically after upgrading. Refer to the *Vantage User Guide* for details about enabling new features in actions and workflows.

8. When installation is complete, click Finish to quit.

After the database has been updated, if you wish, you can follow the next procedure: *Updating SQL 2008 Express to SQL 2014 Express (optional)* to move from an older version of SQL Server to a newer one.
Updating SQL 2008 Express to SQL 2014 Express (optional)

After installing Vantage and updating the database schema and contents to 7.1, you may also want to update SQL Server 2008 Express to SQL Server 2014 Express to take advantage of its larger capacity. The update requires a two-step process: first update SQL Server 2008 Express to version SP3; then update to SQL Server 2014 Express.

To update SQL Server 2008 Express to SQL Server 2014 Express, follow these steps:

1. In the Vantage Workflow Designer, stop all jobs.
2. In the Vantage Management Console, enter all Vantage services into Maintenance mode.
3. Close all Vantage clients.
5. Run the SP3 update installer to update SQL Server 2008 Express.
7. Run the SQLEXPR_x86_ENU installer, and select Upgrade from SQL Server 2008. Accept all default options and features, and complete the installation.

**Note:** Microsoft does not allow updating a 32-bit installation to a 64-bit installation. If you have 32-bit SQL 2008, choose a 32-bit installation in the SQL 2014 installer.

8. Use the Vantage Management Console to exit maintenance mode for all Vantage services. Vantage is now ready to use.
Updating Vantage Server Components

The following procedure updates or modifies the existing Vantage installation to add or remove components. If you are upgrading from one version of Vantage to another, do not use this procedure; instead see Upgrading from a Previous Version.

**Note:** If you plan to update Vantage and Vantage Web Applications on the same server, you can avoid a Vantage service restart by first updating Vantage Web Applications. See Updating Vantage Web Applications. After installing the Web Apps, return here and continue this procedure.

1. Log in to the target server with a local administrator account, and make sure that virus-checking software and Windows Firewall are off.

**Note:** Telestream recommends not using anti-virus software on Vantage servers. If you use anti-virus software, you should identify Vantage as a safe/trusted application. See Anti-Virus Software Recommendations and Firewall Guidelines.

2. Run the Vantage_7.1_Setup.exe installer extracted previously to the C:\Vantage7.1 folder.
3. Select *Modify which products and features are installed*. (This option is presented only if you use the installer originally used to install Vantage, which you should be careful to do. You should not use a newer installer unless instructed by Telestream.)
4. Select *Custom Install*.
5. Check the boxes for all Vantage components on this server that you want to install, and uncheck any you want to remove, and click Next.
6. When the *Ready to Install* dialog appears, click *Install* to begin installation. This process takes a few minutes and shows progress as it runs.
   - If Intel Performance Primitives (IPP) is not present, it is installed. For existing installations, it should already be present.
   - If QuickTime is not installed (it should be), the installer installs it for you. If you need to install it manually, use this link to download it: QuickTime version 7.6.9.
7. When installation is complete, click Finish to close the installer.

**Note:** For an All-in-One Single Node installation, Vantage creates a temporary storage area on the local hard drive, and creates a default Vantage catalog in the database.

8. Open the Vantage Management Console, select Services in the left panel, and verify that the services you installed are Online and those you removed are Offline.
9. If you changed the clients, verify that the icons on the desktop changed accordingly.
Updating Vantage Clients on Client Workstations

The following procedure explains how to update Vantage clients installed on client machines. To update clients on Vantage Servers, see Upgrading Vantage Server Components. These client programs can be updated:

- Vantage Management Console (VMC)
- Vantage Workflow Designer
- Vantage Dublist Portal
- Vantage Workflow Portal

You can use either the Vantage 7.1 Client Applications.msi installer or the Vantage_7.1_Setup.exe installer (extracted to the C:\Vantage7.1 folder when you run the Vantage_7.1.exe archive file) to update clients on client machines. When installing on client machines, the client installer is recommended because it downloads faster and takes up less space during installation than the Vantage installer.

Note: Do not mix installers. Whether you use the Vantage installer or the client installer to install the clients, use the same installer for all subsequent client installation changes on that machine. Mixing installers may produce unexpected results.

Using the Client Installer to Install or Update Clients

Install or update Vantage clients using the Vantage 7.1 Client Applications.msi installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.
2. Run the Vantage 7.1 Client Applications.msi installer as an administrator.
3. Accept the license, and select the installation location.
4. Check the clients you want to install and uncheck those you want to remove.
5. Follow the installer steps to complete the installation.

Note: If you simply want to add or remove existing applications, the client installer allows you to Change, Repair, or Remove. These options are presented if you leave the applications in place before running the installer. If you choose Change, applications you check will be installed, and applications you uncheck will be removed.

Using the Vantage Installer to Install or Update Clients

Install or update Vantage clients as follows using the Vantage_7.1_Setup.exe installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.
2. Run the Vantage 7.1 Setup.exe installer as an administrator.
4. Select Custom Install.
5. Check the clients you want to install and uncheck those you want to remove.
6. Browse to select where to install the clients.
7. Follow the installer steps to complete the installation.
Upgrading and Modifying Vantage

Updating Individual Components

181

Updating Vantage Web Applications

Vantage Web Applications may be installed as part of a Vantage Array and may be updated separately or as part of an array upgrade.

**Note:** If you are updating the Vantage Web Applications on a server that also hosts Vantage services, the Vantage Web Applications upgrade will stop those services, which will interrupt Vantage operation. Plan to upgrade the Vantage Web Applications when the upgrade will cause the least interruption to Vantage users. This is not an issue when the Vantage Web Applications are installed on a dedicated server.

If you are updating the Vantage Web Applications from version 3.0 or later to 7.1, you do not need to repeat the IIS and .NET server preparation described for new installations. To update Vantage Web Applications, do the following:

1. Uninstall the Web Apps using the Windows Programs and Features Control Panel.
2. Download and run one of these installers as an administrator:
   - Vantage main installer: *Vantage_7.1_Setup.exe* (extracted to the *C:\Vantage7.1* folder when you run the *Vantage_7.1.exe* archive file).
   - Vantage Web Applications installer *VantageWebApplicationsSetup.exe*
   To run the EXE as an administrator, right-click and choose “Run as Administrator”.
   **Note:** The *Vantage_7.1_Setup.exe* will remove the Web apps if you run it after installing them. Finish installing all Vantage components on the server before you install the Web Apps.
3. When the Welcome Window appears, click Next.
4. Read the license agreement, and if you accept the terms, click *I Agree*, and Next.
5. If using the *Vantage_7.1_Setup.exe* installer, select Array Installation, select Custom Install, scroll the list, and select Web Applications.
6. When the Select Installation Address dialog appears, set the Application Pool selection to .NET 4.5 for Server 2012, and click Next.
7. Click Install to start the installation.
8. When the Installation Complete dialog appears, click Finish.
9. If Vantage services were running before the Vantage Web Applications upgrade, restart those services using Vantage Management Console > Services or the Microsoft Services tool (Start > Administrative Tools > Services).

**Note:** If you experience any problems with the upgrade, refer to *Troubleshooting Vantage Installation*. For information on the browser requirements for Vantage Web Applications, see *Vantage Web Applications Browser Requirements* in *Before You Install Vantage*. 
Moving the Vantage Domain Database

You might want to move the Vantage domain database because:

- You are upgrading SQL Server from Express to Standard
- You are upgrading SQL Server from an older version to a newer one
- You are moving the database from one server to another

**Note:** If you are moving the database in conjunction with a Vantage upgrade, you should complete the upgrade prior to moving the database.

**Note:** This guide does not provide instructions for moving a mirrored database. Consult your database administrator or contact your Telestream representative regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in the sequence presented:

1. Preparing for the Move
2. Backing up the Existing Database
3. Removing the Vantage Domain Database
4. Removing Microsoft SQL Server
5. Installing SQL Server Standard
6. Installing the Vantage Domain Database
7. Restoring the Vantage Domain Database Backup
8. Finishing the Move

**Note:** This procedure backs up the database, moves the database to a different SQL Server version and/or server, and restores the database. Vantage does not support a Vantage restore from a version 3 Vantage database to a version 4 domain.
Preparing for the Move

If you are upgrading SQL Server, it is recommended that you back up the Vantage domain database, but it is not required. However, if you are moving the Vantage domain database to a new server, you must backup the database, as the backup file will be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status Views web application, or Vantage Dashboard to either determine when all jobs are complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:
   a. Take note of any Storage, Variables, and/or Qualification Rules settings for each service. (In the Vantage Management Console, select Services. In the service panel, click each service and check the tabs at the bottom of the window.) When you move the Vantage domain database from one server to another, the Storage, Variable, and Qualification rule configuration for each service is lost. Write down any configuration that you want to transfer to the new server.

   **Note:** The service Storage, Variable, and Qualification Rule configuration is not lost when you change the SQL Server version on a server. Skip to Step 4 if you are not moving the Vantage domain database to a different server.

   b. In the Vantage Management Console, remove all services from the Vantage domain (refer to Managing Services in the Domain Management Guide for details).

   **Note:** The default Vantage user account is Administrator with no password. This account has administrative privileges.

   c. In the Vantage Management Console, select Licenses in the components panel.

   d. On the Licenses tab, select all licenses and click the Delete button .

   **Note:** To add the licenses back at the end of this procedure, you will need access to the license files. If you do not know where these files are, locate them now before you delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the database to another server), place all services in Maintenance Mode (refer to Managing Services in the Domain Management Guide for details).
Back up the Existing Database

If you are upgrading SQL Server, it is recommended that you back up the Vantage domain database. If you are moving the Vantage domain database to a new server, you must backup the database, as the backup file will be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select Domain Management in the components panel, click Backup, and use the file save dialog to save the backup file to a safe location.
   
   You will need to access the backup file to restore the Vantage domain database after you move it.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database

The Vantage Domain Database may or may not be present as a separate entry in the Windows Control Panel Programs and Features window, depending on how it was originally installed.

In either case, the Domain Database must be removed using one of the following procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log in to the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage and click Change.
4. Deselect the check box for Vantage Domain Database and continue with removal.
Removing Microsoft SQL Server

When you are upgrading Microsoft SQL Server or moving the Vantage domain database to another server, you may want to remove the old version of SQL Server.

To remove Microsoft SQL Server, follow these steps:

1. Log in to the server with a local administrator account.
2. Open the control panel tool for removing programs:
   Control Panel > Programs and Features > Uninstall Programs.
3. Select Microsoft SQL Server and click Remove or Uninstall.

   **Note:** If you are prompted to stop the SQL Server (VANTAGE) service, go to Start > Services and stop the service before clicking Retry to continue with uninstalling.

   **Note:** If you have multiple instances (for example SQLEXPRESS and VANTAGE), you will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

   **Note:** Uninstalling the SQL Server does not delete your Vantage workflows, resources, or transaction history. It leaves your domain database files intact in [Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on removing the database files, see Uninstalling Vantage from a Server in the Removing Vantage chapter of the Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services and clients that were installed on the server remain installed. The domain cannot resume operation until the SQL Server is reinstalled on this server or set up on another server.

Installing SQL Server Standard

Please see Installing SQL Server Standard in the Vantage Installation Guide or the Vantage Domain Management Guide. After installing SQL, continue with the next topic below.

Installing the Vantage Domain Database

This task installs the Vantage domain database instance. Follow these steps:

1. Log in to the database server with a local administrator account, and make sure that virus-checking software and Windows Firewall is off.

   **Note:** To effectively operate Vantage services with other networked devices or systems, you must turn off Windows Firewall.
2. Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Run the Vantage_7.1_Setup.exe installer (extracted to the C:\Vantage7.1 folder when you run the Vantage_7.1.exe archive file) and choose to install only the Domain Database for your single node or array installation.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display the license agreement.

5. License Agreement—Read the Vantage Software License Terms and Conditions, then click I Accept if you agree to license terms. Click Next.

6. Database Install Mode—Click Install new database and click Next to continue.

7. Destination Folder—Accept the default folder or click Change to select an alternate folder. Click Next.

8. Ready to Install Vantage Domain Database—Click Install to begin database installation. This process takes a few minutes to complete.

9. Completed—When installation is complete, click Finish.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. Vantage should have discovered the old database files. Now you need to finish the process as described in Finishing the Move.

If the old database files are not found, or if you are installing the Vantage domain database on a different server, restore the database from the backup file as described in Restoring the Vantage Domain Database Backup.
Restoring the Vantage Domain Database Backup

To restore the Vantage domain database using the backup file you previously created, follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

   **Note:** If you have moved the Vantage domain database to a new server, the name of the Vantage domain changed to the name of the new host server.

2. In the Vantage Management Console, select the domain to modify (File > Change Vantage Domain), select Domain Management in the left components panel, click Restore..., and select the file to restore. For more information, refer to the Database chapter of the Domain Management Guide.

Finishing the Move

To finish the move, you must enable the services you disabled when preparing for the move. If you moved the Vantage domain database to another server, you must also install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the database to another server), do the following:
   a. Remove all services from Maintenance Mode. (In the Management Console, select Services in the left panel, Ctrl-click to select all services in the right panel, right-click to select Exit Maintenance Mode, and click OK.)
   b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage Domain licenses as follows:
   a. In the Vantage Management Console, open the domain you want to modify, and select Licenses in the components panel.
   b. On the Licenses tab, click the Add License button and use the open file dialog to select the license file.
      If your domain has multiple license files (for multiple features), repeat this step for additional licenses.

3. If you moved the database to another server, update the configuration of services as follows:
   a. In the Vantage Management Console, open the domain you want to modify, and select Services in the components panel.
   b. In the Services panel, click the Add Service button and use the dialog to select a service to add.
   c. If any Storage, Variables, and/or Qualification Rules settings were configured for the service, add them now.
   d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
# Adding a Server to a Vantage Domain

The table below lists the types of servers you might want to add to a Vantage domain and shows where you can find instructions for adding these servers.

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vantage Lightspeed server</td>
<td>A Vantage Lightspeed server can be added to a Vantage domain that uses Vantage version 4.0 or later. When you add a Vantage Lightspeed server to a Vantage domain, the Lightspeed server must be running the same Vantage version as the Vantage domain. The Vantage Lightspeed server ships with an installed Vantage domain database, and all Vantage services on the Lightspeed server are assigned to that Vantage domain database. To add the Vantage services on the Lightspeed server to the existing domain, use the Vantage Management Console to reassign the services. After you reassign the Vantage services, Telestream recommends that you remove the Vantage domain database on the Lightspeed server so that the old Vantage domain is no longer advertised to Vantage client programs and Web applications. To remove the Vantage domain database from the Lightspeed server and reassign services, see <em>Adding a Lightspeed Server to an Existing Vantage Domain</em>.</td>
</tr>
</tbody>
</table>
| Vantage domain database server | A Vantage domain can host one Vantage domain database, which can be installed on a single or mirrored database server. If your Vantage domain has a Vantage domain database on a single database server, you can do the following:  
  - Move the Vantage domain database to another server as described in *Moving the Vantage Domain Database*.  
  - Add a database server to mirror the current server.  
  This guide does not provide instructions on setting up a mirrored database server. Consult your database administrator or contact your Telestream representative regarding installation service options. |
| Vantage array server          | Additional Vantage array servers add more throughput capacity to your Vantage domain. When you add a Vantage array server to a Vantage domain, the server must be running the same Vantage version as the Vantage domain. For instructions on adding a Vantage array server, see *Installing Vantage Array Components* in the *Domain Management Guide*. |
Adding a Lightspeed Server to an Existing Vantage Domain

This topic describes how to add a Lightspeed server to an existing Vantage domain. A Vantage domain can host just one Vantage domain database. When you add a Lightspeed server to an existing domain, Telestream recommends that you remove the Vantage domain database and SQL Server on the Lightspeed server so that Vantage does not advertise the unused Vantage domain on the Lightspeed server, and so that memory used by the SQL Server becomes available for Vantage use.

**Note:** The Lightspeed server and the existing Vantage domain must be using the same Vantage release, which must be Vantage 4.0 or later.

To add a Lightspeed server to an existing Vantage domain, follow the procedures in the following topics in the sequence presented:

1. Moving Licenses to Another Domain
2. Moving Vantage Services to Another Domain
3. Setting the Vantage Windows Log On ID for a Service
4. Removing the Vantage Domain Database
5. Removing Microsoft SQL Server

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vantage Web Applications server</td>
<td>For instructions on adding a Vantage Web Applications server, see <a href="#">Installing and Configuring Vantage Web Applications</a> in the Domain Management Guide.</td>
</tr>
<tr>
<td>Vantage store</td>
<td>You can add multiple Vantage stores to a domain. A Vantage store can reside on a dedicated server or with Vantage services. For instructions on setting up a Vantage store, see <a href="#">Setting Up a Vantage Store</a> in the Domain Management Guide.</td>
</tr>
</tbody>
</table>
Moving Licenses to Another Domain

Any purchased licenses that have been added to the Lightspeed server should be removed from the Lightspeed server so they can be added to the existing domain. Most Vantage domains have a single license that contains multiple license options. However, Vantage can accept and combine license options in multiple license files. In most cases, you need to remove the license from the Lightspeed server and contact Telestream to arrange a Lightspeed server update to the license for the existing domain.

To delete licenses from the Lightspeed server and add them to the existing Vantage domain, do the following:

1. In the Vantage Management Console, open the domain for the Lightspeed server, and select Licenses in the components panel.

Note: The default Vantage user account is Administrator with no password. This account has administrative privileges.

2. Place all services in Maintenance Mode. (In the Management Console, select Services in the left panel, Ctrl-click to select all services in the right panel, right-click to select Enter Maintenance Mode, and click OK.)

3. On the Licenses tab, select all licenses and click the Delete button ×.

Note: To add licenses to the other domain, you will need access to any license files sent from Telestream or an updated license file for the other domain.

4. In the Vantage Management Console, open the domain to which you want to add the licenses, and select Licenses in the components panel.

5. If you are updating the license for the existing domain, do the following:
   a. Select the license you are updating and click the Delete button ×.
   b. Click the Add License button † and use the open file dialog to select the updated license file.

6. If you are adding licenses to the existing domain, click the Add License button † and use the open file dialog to select a license file. Repeat this step for additional licenses.

7. Take all services out of Maintenance Mode. (In the Management Console, select Services in the left panel, Ctrl-click to select all services in the right panel, right-click to select Exit Maintenance Mode, and click OK.)
Moving Vantage Services to Another Domain

To move services from the Lightspeed server domain to the existing Vantage domain, do the following:

1. In the Vantage Management Console, open the existing domain to which you want to add the Lightspeed server services.
2. Select Services in the component (left) panel.
3. Click the Add Service button to display the Select Service dialog.
   - The Select Service dialog lists all Vantage services running in this subnet, and the list includes unassigned services and services running on other Vantage domains.
4. Select one or more Lightspeed server services to add to this domain, and click OK to add them.
   - Services are identified by name, machine, and Vantage domain. Use the machine name to identify the services on the Lightspeed server. To select multiple services, use shift-click to select a series of services, or use option-click to select individual services.
5. If you are moving a service from one domain to another, the Vantage Management Console displays the Reassign Services window. Click OK to add them to this domain.

Setting the Vantage Windows Log On ID for a Service

On the Lightspeed server, the default log on ID for each Vantage service is the Local System account. This log on ID provides access to files on the local server only. If a service requires access to files on another server, the Local System account cannot provide that access; rather, the service must be able to log onto the other server with an account the other server recognizes and grants privileges to.

To give Vantage services access to input folders, output folders, Vantage stores or other files on another computer, you must do the following:

- Create a Vantage Windows user ID for the service
- Grant access on the target servers to the Vantage Windows user ID for the service.

For more information, see Windows Authentication Guidelines in the Domain Management Guide.

Within a single service, the Windows log on ID for that service must be the same on all Vantage servers in the domain. For example, all Analysis services within the domain must use the same log on ID. However, the Catalog service, which does not access files, can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each Vantage server in the array:

1. In the Vantage Management Console, click Services in the left panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
3. Click the Change Service Logon button or right-click and select Change Service Log On. A dialog opens, requesting the logon.

4. Select Local System account to use the account currently accessing Vantage from your local machine, or select This account and fill in the user name and password for the account that has access to the desired network location.

5. Click OK. A message confirms that the logon is changing.

**Note:** Changing a service logon restarts that service. Also note, when changing the logon for multiple services simultaneously, some services may not restart properly. If this occurs, go to Start > Services on the server, select the affected services, and click (or right-click) Restart to manually restart the services.

6. Grant file access to the new user on all Vantage servers that the service must access.

### Removing the Vantage Domain Database

The Vantage Domain Database may or may not be present as a separate entry in the Windows Control Panel Programs and Features window, depending on how it was originally installed.

In either case, the Domain Database can be removed using one of the following procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:
1. Log on to the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   - Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:
1. Log onto the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
   - Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage and click Change.
4. Deselect the check box for Vantage Domain Database and continue with removal.
Removing Microsoft SQL Server

To remove Microsoft SQL Server, follow these steps:

1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs (Control Panel > Programs and Features > Uninstall Programs).
3. Remove Microsoft SQL Server as follows:
   a. Select Microsoft SQL Standard and click Remove or Uninstall.
   b. Click Remove.
   c. Click OK.
   d. Select the Vantage instance, and click Next.
   e. Click Select All, and click Next.
   f. Click Next.
   g. Click Remove.
   h. Click Next.
   i. Click Close.

**Note:** If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so in the Services control panel, before proceeding by pressing Retry.

**Note:** If you have multiple instances (SQLSTANDARD and VANTAGE for example), you will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

**Note:** Uninstalling the Vantage Domain Database or the SQL Server does not delete your Vantage domain database files containing your workflows, resources, and transaction history. It leaves those files intact in \Install_Drive\Program Files\Telestream\Vantage\Database. If you reinstall SQL and the Domain Database application later, you can attach these files and restore your previous Vantage domain.
Upgrading and Modifying Vantage
Adding a Lightspeed Server to an Existing Vantage Domain
Removing Vantage

The following topics describe how to remove the Vantage software and associated third party software:

- Uninstalling Vantage from a Server
- Uninstalling Vantage Clients from a Workstation
- Removing ComponentPacs
Uninstalling Vantage from a Server

Each Vantage server may host some or all of the software components listed in the following procedure. You can use this procedure whether you are removing all of Vantage or individual components.

To completely uninstall Vantage or to uninstall specific components, follow these steps:

1. Log into the server with a local administrator account.
2. In the Vantage Workflow Designer, stop all jobs.
3. In the Vantage Management Console, stop all services. Also if you intend to reinstall or upgrade Vantage, use the Backup function to save your domain database to a backup file. This protects your data in the event of a problem with re-installation. (You can skip this step if you are only removing the Web Applications.)
4. Open the Windows Control Panel and start the Uninstall Programs tool.
5. Using the Control Panel, right-click each of the following Vantage programs in the order listed below and select Uninstall to remove them:
   - Vantage Web Applications
   - Vantage update packs in reverse sequential order
   - Telestream Media Transcode and Analysis engine
   - Vantage
   - Vantage Domain Database

**Note:** Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage installation are not removed, and Vantage domain data and media you have created are not removed.

**Note:** If your domain has a mirrored database server, be sure to disable mirroring and stop the SQL Server Agent service, before proceeding.

6. Use the Control Panel tool to remove Microsoft SQL Server Express or Standard:
   a. Select Microsoft SQL Express or Microsoft SQL Standard and click Remove or Uninstall.
   b. Follow the prompts until removal is complete.
   c. Optional step—Click the refresh button in the Control Panel to update the display, which will clear some of the SQL Server components from the display.
7. In the Control Panel tool, select Microsoft SQL Server Native Client and click Remove or Uninstall.

**Note:** Uninstalling the database does not delete your Vantage workflows, resources, or transaction history. It leaves your database files intact in [Install_Drive]\Program Files\Telestream\Vantage\Database. This allows you to re-attach a Vantage domain.
database and return Vantage to a previous state when re-installing or upgrading Vantage. In the event of any problems, you also have the backup you created earlier.

8. To permanently delete all Vantage files, use Windows Explorer to delete the following directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage

**CAUTION:** Deleting these files permanently destroys the Vantage domain database including the domain configuration, workflows, and history. If you created a backup file earlier using the Vantage Management Console or if you create one now, you can preserve the domain for re-installation later.
Uninstalling Vantage Clients from a Workstation

On workstations, the Vantage client programs are the Vantage Management Console and Vantage Workflow Designer. Vantage Workflow Portal (VWP) and Vantage Dublist Portal can also be installed on a workstation.

To completely uninstall Vantage from a workstation, follow these steps:

1. Open the Control Panel Uninstall Programs tool in your operating system:
2. If the Vantage client software is installed, select Vantage Client and click Remove or Uninstall.
3. If the Vantage Workflow Portal is installed, select Vantage Workflow Portal and click Remove or Uninstall.
Removing ComponentPacs

To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in the left column. Installed ComponentPacs are listed in the Installed ComponentPacs list on the right.

2. Click the package you plan to uninstall and check the Actions panel for affected workflows and actions.
   
   Export all workflows that reference the ComponentPac you want to uninstall (to back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the package to be removed is selected.

   Note: The Uninstall button appears only when a package is not used by any actions.

4. After uninstallation completes, restart the affected Vantage services. If the Workflow Designer was open, close it and reopen to all the changes to take effect.

The selected old package is removed and no longer appears in the ComponentPac Management list.
Removing Vantage
Removing ComponentPacs
Troubleshooting Vantage Installation

Use this topic to install, upgrade, or scale Vantage, and configure it for operation.

Note: To obtain the Vantage installation software, go to www.telestream.net/telestream-support/vantage/support.htm. At this same location, you can browse the Vantage Web library, user's guides, application notes, and other documents.

The following topics describe how to install and upgrade Vantage components:

- Troubleshooting Vantage Installation
- Troubleshooting Vantage Web Applications
Troubleshooting Vantage Installation

Possible installation issues and solutions are explained in the following topics.

Database Deployment Utility

Action Templates and Schemes Do Not Work Correctly

If Vantage action templates and fulfillment schemes do not deploy properly, it may be because you assigned the Vantage services to the host name of the database server before using the Database Deployment Utility.

To resolve this issue, use the Microsoft Services Console to restart the Vantage services after the database is deployed. Also close and reopen the Vantage Management Console and Workflow Designer.

Verifying DTC Service Settings

During installation, Vantage configures and starts the Distributed Transaction Coordinator (DTC) Windows service. There is no need to verify DTC configuration and operation after the install, but if you suspect that the DTC service has stopped or the DTC configuration has changed, you can use the information in this topic to verify the DTC status and configuration.

Vantage uses DTC for communication between services and the SQL Server database to guarantee that messages are processed as atomic messages (that is, the entire message is successfully processed or the database state is reverted to the pre-message state). This guarantees that services do not duplicate jobs and that jobs do not register in a partial or incomplete state in the database.

In a Vantage domain, DTC must be running and correctly configured on each Vantage database server and Vantage server, or Vantage services cannot communicate with the Vantage domain database, and the domain stops operation.

To verify operation and configuration, use the procedures in the following topics:

- Verifying DTC Operation
- Verifying the DTC Configuration
Verifying DTC Operation

To verify that the DTC is running, do the following:

1. In Windows, select Start > Administrative Tools > Services.
2. Verify or set the startup type for Distributed Transaction Coordinator to Automatic.
3. If you need to change the startup type, do the following:
   a. Right-click on the Distributed Transaction Coordinator service and select Properties to display the Properties window.
   b. Select Automatic from the Startup Type dropdown and click OK.
4. If the DTC service is not running, right-click on the service name and select Start.

Verifying the DTC Configuration

To verify that DTC is configured correctly, do the following:

1. In Windows, select Start > Administrative Tools > Component Services.
2. In the left panel, navigate to Component Services > Computers > My Computer > Distributed Transaction Coordinator.
3. In the right panel, right-click Local DTC and select Properties.
4. Click the Security tab.
5. To enable transactions to properly flow from one machine to another, set the Security configuration settings as shown in the figure below, and click OK.

Note: You have to restart the database instance in order for SQL to receive notification of the changes to the DTC. You can restart the database by restarting the server that the database is on.
License Cannot Be Activated Offline

Occasionally the Vantage Management License console may not allow you to activate a license offline. You can defeat the online licensing process and force the offline licensing window to appear by setting the Internet Explorer proxy to a false address as shown below or physically disconnecting the Internet from the computer.

![Internet Explorer proxy settings](image)

Now when you attempt to activate a license, you will see a dialog showing that there is no Internet connection.

Click Cancel to open the product activation window.

Now you can follow the manual activation process on this computer using the Internet connection and browser of another computer. See the Vantage Installation Guide or the Vantage Domain Management Guide > Installation chapter > Activating a Vantage License Offline topic for details about activating without an Internet connection to the Vantage computer.
To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the Product Activation dialog:
Troubleshooting Vantage Web Applications

The following are some symptoms and remedies that apply to troubleshooting the installation of the Vantage Web Applications:

- VantageWebApplications.msi installer doesn’t work.
  You must run the MSI installer as an administrator from an elevated CMD prompt. From the Start menu, right-click CMD.exe, select Run As Administrator, and enter this command: “C:\Vantage\Web Applications.msi” (change the path to match the location of your MSI file).

- Web Apps can’t be accessed by the browser or not all applications show up.
  Refresh the Vantage domain by clicking Change Domain in the upper right corner and selecting the desired domain from the list.

- If you experience any of the following issues, run the ASP.NET registration tool (aspnet_regiis.exe) to fix the .Net installation:
  - HTTP 500.19 error appears in the browser when you attempt to access the Vantage Web Applications after a new install.
  - Your Web applications do not display correctly or do not allow you to log in.
  - When running Vantage Web Applications.msi, if the Select Installation Address page does not default to ASP.NET v4.0 for the Application Pool AND if .NET Framework 4.5/4.6 is already installed, run the aspnet_regiis.exe registration tool and then run Vantage Web Applications.msi again.

  This is the Windows Command Prompt command to run aspnet_regiis.exe:
  C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe –i
  Note that the path varies slightly depending on the Windows/.NET versions.
  For more information about using aspnet_regiis.exe, refer to the Microsoft MSDN Web site.

- In some browsers, the Web Workflow Portal preview player space bar may not function as expected to pause or play video. This functionality is part of the browser’s implementation of the media player. Try using different browsers to find the one that provides the best playback experience in your environment.

- The appearance of captions in the Web Workflow Portal preview player may vary depending on your browser. Try different browsers to find the one that best meets your needs.

- On occasion, when using the Web Workflow Portal preview player in Internet Explorer, if you jump to the end of a clip and then scrub backward followed by stepping forward, you may see a skew or jitter in the frame step capability. This is an artifact of the Internet Explorer HTML5 player.

- Telestream has occasionally observed the Web Workflow Portal media player displaying an incorrect frame number even though the frame position is correct when playing to the end of a clip in the Chrome browser. If this anomaly is problematic, Telestream suggests switching to another supported browser.
• The Web Workflow Portal HTML5 preview player requires Windows Desktop Experience in order to run. Ensure that Desktop Experience is enabled and up-to-date.

• When using the Web Workflow Portal in the Safari browser with the Copy Binder configuration, the Submit button does nothing when the user attempts to submit the portal configuration and a binder. Disabling Block Popup Windows in the Safari Preferences > Security > Web Content menu resolves this issue.
Using the Vantage Management Console

This chapter describes how to use the Vantage Management Console (VMC), which enables Vantage system administrators to configure their Vantage domain and to scale Vantage services across multiple servers (creating a Vantage array) to meet their operating requirements.

**Note:** Features in products for which you don’t have a license are disabled and indicate that you need a license to use them.

The following topics describe how to use the Vantage Management Console:

- Introduction
- Starting the Vantage Management Console
- Managing the Vantage Domain Connection
- Using the Vantage Management Console Workspace
- Managing Tips and Warnings
- Using the Help System
- Displaying Software and Database Versions
- Vantage Management Console Reference
Introduction

The Vantage Management Console is designed to facilitate centralized management of the software components and resources that comprise a Vantage domain, including settings and options, Vantage catalogs, Vantage stores, Vantage services, licenses, workflow design items, and client application configurations. The Vantage Management Console also provides real-time status details for services, machines, and the domain at large, plus a domain backup/restore utility and other support utilities.

The Vantage Management Console manages a single Vantage domain at a time.

CAUTION: Although the Vantage Management Console is a multi-user application, modifying a domain is intended to be done by one user on one domain at a time. Connecting multiple consoles to the same Vantage domain for any other purpose than viewing status and configuration details is not recommended and can lead to domain configuration problems.

Each Vantage domain includes a single Vantage domain database, which consists of a Microsoft SQL Server instance, Vantage domain database software, and database files. All configurations that you create with the Vantage Management Console are stored in the Vantage domain database.

Many organizations implement Vantage as a single domain. However, in large facilities, you may have several separate and independent Vantage domains for scaling to high-volume workflow processing or for specialization and departmentalization purposes.

In a facility with multiple Vantage domains, you can connect to any Vantage domain in the network from any Management Console in the network.
Starting the Vantage Management Console

To start the Management Console, do one of the following:

- Select Start > Programs > Telestream > Vantage > Vantage Management Console
- Double-click the Vantage Management Console shortcut on your desktop:

After you start the Vantage Management Console, your domain configuration may prompt you for additional information, which is described in the following topics:

- Selecting a Domain
- Entering a Username and Password

Selecting a Domain

Each time you start the Vantage Management Console, the program connects to the last domain to which it was connected. If you are starting the program for the first time, the Vantage Management Console polls the network for domains in the same subnet, and displays the domains that responded in a list, as depicted in this figure.

The name for each Vantage domain is the name of the computer that hosts the Vantage domain database. If you do not know which domain you should connect to, see your Vantage domain administrator.

To select a domain, do the following:

1. Click Search. Select the desired domain if it appears in the list (as shown in the figure above).
2. If the Vantage domain's SQL database default username and password were changed during installation, do the following:
   a. Click Connection Settings to display a dialog that you can use to specify the correct username and password for the MS SQL Server (see the figure, below).
   b. Enter the Vantage domain database SQL Server account username and password (obtained from your Vantage administrator).

3. If the domain you want is not in the list (not in your current subnet), do the following:
   a. Click Specify Vantage Domain name/IP address in the bottom left corner to display a dialog to manually enter the domain, as shown here:
   b. Enter the domain name or IP address of the server that hosts the Vantage domain database (for example, VantageServer203 or 192.168.1.1). If you do not know IP address of the server that hosts the Vantage domain database, see your Vantage domain administrator.

4. Click OK to continue.

**Entering a Username and Password**

User administration requiring login is disabled by default in Vantage. However, if it is enabled, when you start the Vantage Management Console and access a Vantage domain, you are asked to log in (the figure, below) by providing a Username and Password. The login is your Vantage user name and password, or if Active Directory is enabled, your Windows Active Directory user name and password. (See Managing Vantage Users for login details.)
If the dialog prompts for credentials to a domain you cannot or do not want to access, click Cancel and select the domain to which you want to connect as described in Selecting a Different Domain.

When the dialog displays the correct domain name, enter your username, and password, if required, and click OK to connect.

The default Vantage user is Administrator, with no password assigned, and this user has Administrator privileges. Only Vantage users who are administrators can log into the Vantage Management Console.

Note: All user passwords are encrypted in the Vantage domain database.
Managing the Vantage Domain Connection

Vantage Management Console connects to one domain at a time. You must connect to a domain before you can use the Vantage Management Console to manage that domain. In an environment where more than one Vantage domain is operating, you can use the same Management Console to connect to any single domain.

The following topics describe tasks for managing your domain connection:

- **Identifying the Selected Domain**
- **Selecting a Different Domain**

Identifying the Selected Domain

Each Vantage domain is identified by the name of the computer on which the Vantage domain database instance is running. To determine the domain to which the Management Console is currently connected, note the [Vantage domain name : user name] in the window title as shown in the figure below.

Current Vantage [Domain : User] shown in title area
Selecting a Different Domain

To select a different Vantage domain, do the following:

1. Select File > Recent Domains, and choose from the list of recently used domains. Click OK in the dialog shown below. (You can also enter a domain name or IP in the dialog shown and click OK.)

2. If the domain you want is not shown, click File > Change Vantage Domain.

3. Select a domain from the list and click OK. (For more details, see Selecting a Domain.)

When you change domains, the Vantage Management Console closes its connection to the current domain’s Vantage domain database and connects to the new domain’s database, refreshing the details of all of its components.
Using the Vantage Management Console Workspace

The Vantage Management Console window displays two panels that show Vantage configuration components and configuration settings as shown in this figure:

Components Panel
On the left is the Vantage components panel, which lists Vantage configuration components.

Details Panel
To the right of the components panel is the details panel, which lists the configuration settings for the Vantage component selected in the components panel.

For example, when you select the Settings & Options component, the details panel displays all the configuration options for this component as shown in the figure above. For the Settings and Options component, the details panel options are divided into four tabs. The details panel for other components is further divided into subpanels. These tabs and subpanels help to organize the configuration options.
Managing Tips and Warnings

To restore tip and warning messages that were previously disabled by clicking *Don’t show me this again*, select Options > Restore Tips & Warnings. When tips and warnings are restored, these tips and warnings display as you interact with the Vantage Management Console.

To disable all tip and warning messages select Options > Hide Tips & Warnings. These messages can also be individually disabled by clicking *Don’t show me this again* when they appear.

Using the Help System

The Vantage Management Console provides the following help documentation:

- Context-Sensitive Help
- The Vantage Domain Management Guide
- Tool Tips
- Online Help

Context-Sensitive Help

When you are using the Vantage Management Console, context-sensitive help displays the appropriate section of the Vantage Domain Management Guide (which is this guide). For example, if you select the Storage component in the components panel and open context-sensitive help, Vantage displays the Managing Vantage File Storage section of this guide. To start context-sensitive help, press F1 or click the ? button.
The Vantage Domain Management Guide

The Vantage Domain Management Guide is available in PDF and program help formats. When you use context-sensitive help, you are opening the program help version of this guide to a section appropriate for the configuration settings you are viewing. You can also open this guide by selecting one of the following:

- Help > Contents—Displays the table of contents of this guide.
- Help > Index—Displays an index for this guide.
- Help > Search—Displays a search panel that you can use to search for information.

The Favorites tab in the help program can be used to save and display topics you want to quickly access. While viewing a help topic, click the Add button to add the current topic to the favorites list. To remove a topic, select the topic and click Remove.

Tool Tips

Tool tips display information about buttons and configuration options in the Vantage Management Console. To display the tool tip for a button or option, hover the cursor over the button or option.

Online Help

The latest documentation is posted on the Telestream.net Web site. To quickly access the Telestream online documentation from within Vantage Management Console, select Help > Online Help.

Note: Access to the Vantage Online Help requires an Internet connection.
Displaying Software and Database Versions

The Vantage software version is listed in the Help menu of Vantage programs. To view the software version of a Vantage program, select Help > About....

The Vantage database version is listed in the Help menu of the Vantage Management Console and the Vantage Workflow Designer. To view the Vantage database version in those programs, select Help > Database Version.

You can also find versions listed in the Vantage Management Console > Support Utilities > Software Versions by Machine folder. Click on a machine name in the folder to display the Vantage version and Vantage services versions installed on that machine.
Vantage Management Console Reference

The following topics provide descriptions of Vantage Management Console controls:
- Vantage Management Console Menus
- Vantage Component Descriptions

Vantage Management Console Menus

This table describes the Vantage Management Console menus.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Change Vantage Domain</td>
<td>Displays a dialog that you can use to select another domain as described in Selecting a Domain.</td>
</tr>
<tr>
<td></td>
<td>Recent Domains</td>
<td>Lists recently accessed domains. Select one to open a dialog for accessing that domain.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Quits the Vantage Management Console Program.</td>
</tr>
<tr>
<td>Options</td>
<td>Restore Tips &amp; Warnings</td>
<td>Restores tip and warning messages after they have been disabled. See Managing Tips and Warnings.</td>
</tr>
<tr>
<td></td>
<td>Hide Tips &amp; Warnings</td>
<td>Hides tip and warning messages. See Managing Tips and Warnings.</td>
</tr>
<tr>
<td></td>
<td>Prompt for login next time application is launched.</td>
<td>When this selection is checked (enabled), a password is required for the next login. If unchecked, Vantage remembers the password and does not ask for it next time the user launches the Vantage Management Console application.</td>
</tr>
<tr>
<td>Help</td>
<td>Contents</td>
<td>Displays the contents of this guide in program help.</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>Displays an index of this guide in program help.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Displays a search panel that you can use to search for information in the program help.</td>
</tr>
<tr>
<td></td>
<td>Online Help</td>
<td>When you are connected to the Internet, this option opens the Vantage documentation Web page in your browser.</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Displays version information for the Vantage Management Console program.</td>
</tr>
<tr>
<td></td>
<td>Database Version</td>
<td>Displays the version number of the Vantage Domain Database.</td>
</tr>
</tbody>
</table>
Vantage Component Descriptions

This table describes the components in the Vantage Management Console components (left) panel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings &amp; Options</td>
<td>Use this panel to display settings that configure Vantage operation. Tabs include General for overall settings, Email for configuring automated notifications, Authorization for adding user accounts, Mapped Drives for mapping Windows drives to UNC paths, Signiant for configuring a Signiant server connection, Agility for configuring an Agility server connection, Telestream Cloud for adding account information used by the Cloud Flip action, Billing Account for Vantage Elastic Domain login, Interplay for server login for the Interplay actions, and Dashboard Links for adding your own URLs to the Web Aps panel. For details, see <em>Settings and Options</em> in this chapter and also <em>Managing Settings and Options</em> in the <em>Managing the Vantage Domain</em> chapter.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>The Catalogs panel allows you to manage catalogs and the binders they contain. For more information, see <em>Managing Catalogs with the Vantage Management Console</em> in the <em>Vantage Domain Management Guide</em> or the <em>Vantage Workflow Administration Guide</em>.</td>
</tr>
<tr>
<td>Storage</td>
<td>The Storage panel allows you to manage the Vantage Stores and Vantage Folders where Vantage files are stored. For more information, see <em>Managing Vantage File Storage</em> in the <em>Vantage Domain Management Guide</em> or the <em>Vantage System Administration Guide</em>.</td>
</tr>
<tr>
<td>Services</td>
<td>Use the Services panel to configure Vantage services. Using a right-click, you can put services in or out of Maintenance mode or restart them. Using the tabs at the bottom, you can manage various service settings. For details, see <em>Managing Services</em> in the <em>Vantage Domain Management Guide</em> or the <em>Vantage System Administration Guide</em>.</td>
</tr>
<tr>
<td>Licenses</td>
<td>Use the Licenses panel to view, add, delete, and deactivate licenses for Vantage features. For more information, see <em>Managing Licenses</em> in the <em>Vantage Domain Management Guide</em> or the <em>Vantage System Administration Guide</em>.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>The Status selections allow you to monitor and manage performance of actions, machines, and the domain. See Viewing Status in the Vantage Domain Management Guide or the Vantage Workflow Administration Guide.</td>
</tr>
<tr>
<td>Capture Inventory</td>
<td>The Capture Inventory panel is a Vantage Live Capture feature that shows live capture sources present in the domain. See the Vantage Live Capture Guide for details.</td>
</tr>
</tbody>
</table>
| Workflow Design Items  | See Managing Workflow Design Items in the Vantage Domain Management Guide or the Vantage Workflow Administration Guide for the following topics describing Workflow Design Items menu selections:  
  • Managing Vantage Workflows  
  • Managing Workflow Categories  
  • Managing Media Nicknames  
  • Managing Metadata Labels  
  • Managing Attachment Nicknames  
  • Managing Variables  
  • Managing Scripts  
  • Managing Style Sheets  
  • Managing Action Default Settings  
  • Managing Nexus Definitions |
| Domain Workflow Analytics | See Viewing Workflow and Action Analytics in the Vantage Domain Management Guide or the Vantage Workflow Administration Guide. |
| Utilization            | Shows a bar graph of the average demand for a selected service type over a specified time period across the entire Vantage domain. Waiting times for complete sessions are used to color-code the graph, adding a visual indication of the waiting times resulting from the demand. This graph can be viewed on a day-by-day or hour-by-hour basis. See Monitoring Utilization in the Vantage Domain Management Guide for details. |
| Support Utilities      | Use the Support Utilities panel to access Vantage utilities. Search the Vantage Domain Management Guide for the following topics for details:  
  • Using the Data Collection Utility  
  • Using the Change Log  
  • Using the Error Log  
  • Listing Actions By Service  
  • Displaying Plug-in Versions  
  • Displaying Software Versions by Machine |
Using the Vantage Management Console

Vantage Management Console Reference

223

Application Configurations

Use the Application Configurations panel to select a Vantage application to configure. For more information, see these topics in the Vantage Domain Management Guide:

- Configuring Job Status Views
- Setting up Workflow Portal
- Creating Dublist Portal Configurations and Dublist Schemes

Report Configurations


Fulfillment Schemes

See Creating Dublist Portal Configurations and Dublist Schemes in the Vantage Domain Management Guide. Also see Configuring Catch Server Schemes.

Syndication

Provides the capability of creating templates for use by the TrafficManager Syndication feature. See the Managing the Vantage Domain chapter in the Vantage Domain Management Guide, and see the TrafficManager User Guide.

Users

Use the Users panel to manage how Vantage users access and use Vantage features. For more information, see Managing Vantage Users in the Vantage Domain Management Guide or the Vantage System Administration Guide.

Task Rules

Allows creating multiple rules to govern machine and domain capacities under different operating circumstances. See Managing Task Scheduling and Load Balancing in the Vantage Domain Management Guide.

Domain Management

Use the Domain Management panel to back up and restore or shrink the Vantage domain database. For more information, see Backing Up and Restoring the Vantage Domain Database in the Vantage Domain Management Guide or the Vantage System Administration Guide.

ComponentPac Management

Allows installing and uninstalling updates to Vantage actions and services using ComponentPacs. This method makes smaller, more frequent Vantage updates possible. For details, see Managing ComponentPacs in the Vantage Domain Management Guide.
## Settings and Options

The table below provides descriptions and references for the Settings & Options parameters.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Check one of the following Task Scheduling modes:</td>
<td>Enables the selected method of task scheduling. For more information, see Managing Task Scheduling and Load Balancing in the Vantage System Administration Guide or the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td></td>
<td>- Session Based</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Cost Based</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Task Based</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable Open Workflows</td>
<td>Enables the Open Workflows option. To create Open Workflows, you must also enable them in specific workflows and actions. For details, see the Vantage User Guide.</td>
</tr>
<tr>
<td></td>
<td>Enable user administration</td>
<td>Enables or disables Vantage user management. Includes a check box to enable using Windows Active Directory, so your users can log in with their Windows credentials. See Managing Vantage Users in the Vantage System Administration Guide or the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td></td>
<td>Enable Lightspeed Fallback</td>
<td>Allows jobs to run on CPU-based servers when all Lightspeed GPU servers are unavailable.</td>
</tr>
<tr>
<td></td>
<td>Expire failed jobs</td>
<td>See Enabling and Disabling Expiration of Failed Jobs in the Vantage Workflow Administration Guide or the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td></td>
<td>Detailed job progress</td>
<td>When enabled, displays more detailed job progress information in the Workflow Designer Job Status table Progress column. When disabled, displays less detailed information. Enabling increases database activity, potentially reducing performance, especially on an all-in-one domain.</td>
</tr>
<tr>
<td></td>
<td>Include completed jobs in Domain Job Status</td>
<td>Disabled by default. When this feature is enabled, the Workflow Designer Domain Job Status tab shows all jobs in the Vantage domain, including completed jobs.</td>
</tr>
<tr>
<td>Tab</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vantage Workflow Designer Grid</td>
<td>See Setting the Vantage Workflow Designer Grid Width/Height in the Vantage Workflow Administration Guide or the Vantage Domain Management Guide.</td>
<td></td>
</tr>
<tr>
<td>Service Report Retention Time</td>
<td>Determines how many days of historical logging to retain (for use in historical Service Reports). The default is the past 30 days, and the range is 1 day to 730 days (2 years). See Service Reports in the Vantage Workflow Administration Guide or the Vantage Domain Management Guide.</td>
<td></td>
</tr>
<tr>
<td>Location for workflow backups</td>
<td>Browse to specify a UNC location where workflow backups can be saved when actions are upgraded. If not specified, backups are stored on the local drive in a VantageWorkflowBackup directory.</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>Credentials for sending email notifications about Vantage events</td>
<td>See Monitoring Utilization in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Mapped Drives</td>
<td>Map network drives to UNC path</td>
<td>See Assigning Mapped Drives in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Signiant</td>
<td>Credentials for remote login to Signiant</td>
<td>Allows saving credentials for connecting to Signiant servers from Vantage workflows. See Configuring a Signiant Connection in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Agility ECS</td>
<td>Credentials for remote login to Agility</td>
<td>Allows saving credentials for connecting to Agility servers from Vantage workflows. See Configuring an Agility ECS Connection in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Telestream Cloud</td>
<td>Credentials for logging into Telestream Cloud</td>
<td>Allows saving credentials for connecting to Telestream Cloud from Vantage workflows. See Configuring Telestream Cloud Settings in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Tab</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Billing Account</td>
<td>Credentials for logging into Telestream Cloud Billing server when using Vantage Elastic Domain.</td>
<td>Provides authorization and credentials for Vantage to report domain characteristics to the Elastic Domain billing service. See [Vantage Elastic Domains](Introduction to Vantage) for more information about Vantage Elastic Domain. See [Configuring an Elastic Domain Billing Account](Configuring an Elastic Domain Billing Account) for details about the Billing Account fields.</td>
</tr>
<tr>
<td>Interplay</td>
<td>All</td>
<td>Allows saving credentials for connecting to Interplay servers from Vantage workflows. See [Configuring Interplay Settings](Configuring Interplay Settings) in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Dashboard Links</td>
<td>Controls for creating, deleting, saving, importing, and exporting frequently used URLs.</td>
<td>Provides controls for entering and saving URLs that appear on the Vantage Web Apps page as “bookmarks” to frequently used links. See [Creating Dashboard Links](Creating Dashboard Links).</td>
</tr>
</tbody>
</table>
Managing the Vantage Domain

This chapter describes how to manage a Vantage domain. Topics are arranged in the order of the Management Console left panel.

Some topics are covered in the Vantage Workflow Components chapter of the Domain Management Guide because they are more closely related to workflow design than system administration. These include Catalogs, Workflow Design Items, Domain Workflow Analytics, Application Configurations, Report Configurations, and Fulfillment Schemes.

Note: Features in products for which you don’t have a license are disabled and indicate that you need a license to use them.

The following topics describe how to manage a Vantage domain:
- Managing Settings and Options
- Managing Vantage File Storage
- Managing Services
- Managing Licenses
- Viewing Status
- Monitoring Utilization
- Using Support Utilities
- Managing Task Scheduling and Load Balancing
- Managing Vantage Users
- Managing Domains
- Managing ComponentPacs
Managing Settings and Options

The Settings and Options left panel selection opens a set of tabbed panels on the right that control some of the overall features of Vantage.

- Making General Settings
- Configuring Vantage Email Notifications
- Specifying Authorization Credentials for Remote Folder Access
- Assigning Mapped Drives
- Configuring a Signiant Connection
- Configuring an Agility ECS Connection
- Configuring Telestream Cloud Settings
- Configuring an Elastic Domain Billing Account
- Configuring Interplay Settings
- Creating Dashboard Links
Making General Settings

The Settings and Options General panel includes the following selections:

- **Task Scheduling**—Enables task scheduling and load balancing. See *Monitoring Utilization* for details.

- **Open Workflows**—Enables the Open Workflows feature. This must be enabled and licensed before open workflows can be used in Workflow Designer. Refer to the *Vantage User Guide* for details about what open workflows are and how to use them.

- **User Administration**—Enables user administration, which allows an administrator to create user accounts and passwords for logging into Vantage clients. When disabled, no login is required to use the clients. If Active Directory is enabled, existing Windows user accounts are enabled, but the administrator still needs to add the specific users. To add users, select Users near the bottom of the left panel (see *Managing Vantage Users* for details about how to add users).

- **Enable Lightspeed fallback**—Check to allow Lightspeed actions to execute on a multicore server if a Lightspeed GPU server is not available when the action is ready to execute. Also see *Enabling Lightspeed Fallback* in the *Vantage Domain Management Guide*.

- **Expire failed jobs**—Check to allow failed jobs to be expired with other jobs. If disabled, failed jobs must be manually deleted. See also *Enabling and Disabling Expiration of Failed Jobs* in the *Vantage Domain Management Guide*.

- **Detailed job progress**—Check to include more details in job progress reporting. This feature may slow down overall system performance.

- **Include completed jobs in Domain Job Status**—Check to include completed jobs in the Workflow Designer Domain Job Status panel. Uncheck to exclude completed jobs.

- **Workflow Designer grid size** (visible only if Show Grid Lines is enabled in the WFD). See also *Setting the Vantage Workflow Designer Grid Width/Height* in the *Vantage Domain Management Guide*.

- **Service Report Retention Time**—deletes service report historical data after the number of days specified. See also *Generating Reports* later in this chapter.

- **Location for workflow backups**—Browse to specify a UNC path to the location where you want to store your workflow backups. See also *Back up and Restore the Vantage Domain Database* later in this chapter.
Configuring Vantage Email Notifications

Vantage can send email messages to announce workflow and service events.

Message actions in Vantage workflows can be configured to send email messages for workflow events. The configured email destination address can be for an individual, a system, or an alias for a group of Vantage users or administrators.

**Note:** Until you configure these settings, you will not be able to execute Message actions that utilize email in your workflows.

If a Vantage Service starts or stops running, or if a service fails, an email is sent to the administrator email address.

**Note:** An email is not sent when a Vantage Service enters or exits Maintenance Mode.

To manage email notifications, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console* in the Vantage Domain Management Guide.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Email tab.
4. Configure the email parameters, which are described in the table below.
5. Click the Save button.

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname or IP Address</td>
<td>Supply the computer’s host name or IP address of the SMTP server.</td>
</tr>
<tr>
<td>SMTP Port</td>
<td>Supply the port number of the SMTP server.</td>
</tr>
<tr>
<td>SMTP Host Requires Authentication</td>
<td>Check if the SMTP server is configured to require authentication.</td>
</tr>
<tr>
<td>Username and Password</td>
<td>Supply the user name and password if SMTP Host Requires Authentication is checked.</td>
</tr>
<tr>
<td>This server requires an encrypted connection (SSL)</td>
<td>Check this checkbox if SMTP server requires an encrypted connection.</td>
</tr>
<tr>
<td>Administrator Email Address</td>
<td>Supply the email address of the Vantage administrator. The email specified for this account can be an alias for a larger group, maintained by your IT department.</td>
</tr>
<tr>
<td>Send Test Email</td>
<td>Click to test your settings by sending an email to the administrator email address.</td>
</tr>
</tbody>
</table>
Email administrator upon service starting
Check to email the administrator when a service starts. For example, if a Vantage machine hosting an Analysis and a Monitor service is started without any problems, two emails are sent reporting the starting of each service.

Email administrator upon service stopping
Check this checkbox to email the administrator when a service stops.

Email administrator upon service failure
Check to email the administrator when this service fails (crashes or otherwise stops unexpectedly). For example, if a Vantage Analysis service is stopped from the Task Manager (forced termination), an email is sent to the administrator. Or, if a Vantage Analysis service crashes during start-up, an email is also sent to the administrator.
Specifying Authorization Credentials for Remote Folder Access

This feature allows you to specify credentials (username and password) for a folder that is not located in the Windows domain or workgroup for which the Vantage application is authorized. For example, if Vantage services are configured with a username and password for Domain A or Workgroup A, but output files must be saved to a folder in Domain B or Workgroup B, you can use this feature to specify the credentials to access the remote folder.

The following topics provide information on managing authorization settings:
- Understanding Authorization Settings
- Displaying the Authorization Settings
- Refreshing the Authorization Record List
- Adding an Authorization Record
- Modifying an Authorization Credentials Record
- Deleting an Authorization Credentials Record
- Exporting and Importing Authorization Records

Understanding Authorization Settings

Authorization settings are considered supplemental to Windows account and share settings, which should be your primary means of providing access and authentication to required storage for Vantage services. When accessing computers in workgroups, Vantage administrators should make sure that Vantage services are running under an account that has access to the locations that will be referenced. If this is done, then authorization records are unnecessary unless some computers must have unique accounts.

Use the Authorization Settings tab when Vantage services must access shares using an account different from the Vantage Windows logon account. Authorization Settings allow you to create, test, and manage multiple credentials for various Windows shares (on Windows computers) or UNC paths.

When each service starts, it reads all authorization records and stores them for use at runtime, as necessary. For example, the transport service may be called to execute a Copy action, which needs to write a file to a share or a non-domain server and directory, where the service is not authorized by its own account. The transport service will process the authorization records based on the path supplied, to determine if it can gain authority via one of its authorization records.

Note: Authorization settings should only be used when the normal Windows account and share settings do not provide access to necessary shares: for example, shares on other Windows domains, or on workgroups.
The purpose of entering authorization records is to enable Vantage to maintain this information for network locations—*independent of the authentication inherent with the logon account of a specific service*—the Vantage Monitor Service, for example. If you know that a specific service does not have the authorization to utilize a given network location, you can create an authorization record to provide credentials.

When you provide authorization records for a network location, any service in the domain can utilize it.

It is important to understand that when you access network locations via Workflow Designer, the locations you navigate to are accessed with Workflow Designer's logon account permissions—which may be different than the logon account for Vantage services.

However, these locations will ultimately be accessed by Vantage services during execution of your workflow—services which may have different users and permissions. Therefore, you need to take the extra step of ensuring that the service, which will be accessing this share at workflow runtime, has authenticated access to the location.

Additionally, authentication does not control sharing and security permissions (for example, access, and read/modify/delete/write permissions). Make sure that when you set up network locations, you have set each location with the proper permissions for the user accounts that will access it.

After you add, modify, or delete a record, click the Save button to update the records in the Vantage domain database as encrypted data.

**Displaying the Authorization Settings**

To display the authorization settings, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console*.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Authorization tab.
Vantage displays the Authorization tab shown in this figure.

Refresh the Authorization Record List

To refresh the list of authorization records, move a Vantage service in and out of maintenance mode as follows:

1. In the Vantage Management Console, click on Services in the details panel.
2. Right-click the target service and select Enter Maintenance Mode.
3. Right-click the service again and select Exit Maintenance Mode.

Adding an Authorization Record

Click the Add new credentials button in the toolbar (or right-click and select Add new credentials or Import credentials), and supply the details. Click Test to validate the record, and click the Save button to add this validated authorization record to the database for use by all Vantage services in the domain.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Enter the authorized username required to access the Windows share identified by the UNC path. If the user account is part of a Windows domain, the username must include the domain or computer name, in the format <em>domain\username</em> or <em>ComputerName\Username</em>. For example, <em>SierraVideo\Vantage</em> or <em>NewsServer\Bill</em>. If the username is part of a workgroup (a non-domain account), you must provide the machine name in addition to the user name. For example, if you want to use the account: <em>VantageUser</em> that exists on machine <em>FooServer1</em>, you should specify <em>FooServer1\VantageUser</em>.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the authorized password for the Windows share.</td>
</tr>
<tr>
<td>Folder</td>
<td>Click Browse and navigate to the Windows share you are authenticating. Or, enter it manually. The path must be in valid UNC form: <em>\ComputerName\Sharename</em>.</td>
</tr>
<tr>
<td>Test</td>
<td>Click Test to verify that your credentials are entered correctly for access to the specified Windows share.</td>
</tr>
</tbody>
</table>

**Modifying an Authorization Credentials Record**

Click on the record you want to modify. Make changes to the username, password, and folder and click the Save button in the toolbar.

**Deleting an Authorization Credentials Record**

Click on the record you want to delete, click the Delete button in the toolbar (or right-click and select Delete), and click OK to confirm.

**Exporting and Importing Authorization Records**

Vantage allows you to export an authorization record to an XML file, which you can then use to import the same record into another Vantage domain.

To export all authorization records, click the Export drop down menu and select Export All. Use the file system dialog to save the exported records.

To export selected authorization records, do the following:

1. Select the record to export. Shift-click or Ctrl-click to select multiple records.
2. Click the Export button (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported record.

The default file name is the record name, but you can change the file name.
**Note:** Changing the name of the XML file does not change the name of the record in the XML file.

To import an authorization record, do the following:

1. Click the Import button (or right-click and select Import credentials).
2. Use the file system dialog to locate and select the record to import, then click Open.

**Note:** If you try to import an authorization record that is already in this Vantage domain, Vantage prompts you to overwrite the record (click Yes) or cancel the import (click No).
Assigning Mapped Drives

The Mapped Drives tab under Settings and Options in the Management Console includes a panel that allows you to assign existing network drives with drive letters assigned in Windows to the same drive letters within Vantage and then map the letters to UNC paths. This feature supports generic Windows mapped drives, not special SAN mapped drives.

The Workflow Designer, for example can access a mapped drive by letter and have that mapping translated to a UNC path, saving the time and trouble of looking up and supplying a network path each time the drive is used in a Vantage action.

**Note:** The Vantage Mapped Drives feature maps drive letters to UNC paths. This feature makes data sharing easier among Vantage servers when some servers have a drive letter mapped directly to storage and others do not. Those that do not can be mapped in Vantage so that all Vantage servers can share data with that storage location. The feature should not be used when all Vantage servers already have a mapped connection, such as a fiber-channel connection to a SAN system. In such a case, the fiber connections are much faster than a UNC path connection, so using the Vantage mapped drive to a UNC path would result in a slower connection and a less efficient network.

To map a drive in the Mapped Drives panel, follow these steps:

1. Ensure the drive you want to map in Vantage has already been mapped to a drive letter in Windows > Tools > Map Network Drive. Arrays require all systems in the array to map the drive to the same drive letter.
2. Select Settings & Options in the Management Console left Components panel.
3. Select the Mapped Drives tab in the main panel (the figure).
4. Check the Enable mapped drives option.
5. Select the new drive icon in the top tool row. A drive is added to the drive list.
6. Select a drive letter matching the assigned Windows drive letter using the drop-down Drive menu near the bottom of the panel.
7. Enter a path to the drive using the UNC Path field. The form of the path is \machine\folder\subfolder\.
8. Click Save in the top tool row to save the mapping of the drive to the path.
   A dialog informs you to restart Vantage services to make the new drive available.
Once the drive letters are mapped to paths, when you specify a drive letter in a Vantage application, the UNC path is automatically used to access the desired drive.
Configuring a Signiant Connection

When you configure a Signiant connection, you enable the Vantage domain to communicate with the Signiant server by supplying required credentials. The optional Signiant Delivery action can then be used to deliver files to Signiant-enabled servers. The Vantage Signiant Delivery action uses the Signiant feature, which must be licensed on the Signiant server. A Signiant Agent must be configured in the Management Console before it can be used in a Vantage workflow.

To configure a Signiant Agent in Vantage and test its connection, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Signiant tab. Vantage displays the Signiant agent configuration panel.

4. Click the Add New Setting button in the toolbar (or right-click in the empty space below the button and select Add new setting).
5. In the Name field, enter a practical name for the Signiant server (for example, Signiant-Vantage Server).
6. In the Address field, enter the IP address or domain name of the Signiant server.
7. In the Certificate field, paste the CA Certificate text copied from the Signiant server. For instructions on obtaining a CA Certificate, see the following Signiant CA Certificate Instructions.
8. Click the Save icon to save the new agent.
9. To test the Vantage-Signiant connection, click Test at the bottom of the window.

You can add Agents as needed for each Signiant server.
Signiant CA Certificate Instructions

To get a CA Certificate to enable a Vantage-Signiant connection, follow the steps in either one of the two procedures that follow:

Use a Web Page to Get a Certificate

1. Use a Web browser to log into the Signiant server (e.g. signiant.sierrapost.com).
2. Navigate to Developer > CTE Test Configurations and click Add Configuration.
3. Enter a configuration name and configure settings for your system.
4. In the CA Certificate field (under Advanced Transfer Settings), select the certificate text and copy it (including the -----BEGIN CERTIFICATE----- and -----END CERTIFICATE----- lines).
5. Click Save at the bottom and close your Web browser.
6. Paste the certificate text into the Vantage Management Console > Settings and Options > Signiant > Certificate field as explained in the previous procedure (Configuring a Signiant Connection).

Use the Command Line to Get a Certificate

1. Log into the Signiant Manager host as an administrator.
2. In a terminal window, navigate to the Signiant bin directory.
3. Enter the command dds_cert extract to extract a certificate from the credentials store.
4. Open the text file named ddsCA_Cert.pem and copy the entire text (including the -----BEGIN CERTIFICATE----- and -----END CERTIFICATE----- lines).
5. Paste the certificate text into the Vantage Management Console > Settings and Options > Signiant > Certificate field as explained in the previous procedure (Configuring a Signiant Connection).

Deleting a Signiant Agent

To delete a configuration, do the following:

1. Display the Signiant configuration window.
2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiple configurations.)
3. Click the Delete button ✗ (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
Exporting and Importing Signiant Agents

Vantage allows you to export Signiant agents to files, which you can then use to import the same agents into another Vantage domain.

To export agents, do the following:

1. Select the agents to export. (Ctrl-click or Shift-click to select multiple views.)
2. Click the Export button to export selected agents (or right-click and select Export, or select Export all from the Export button drop down menu).
3. Use the file system dialog to save the exported agents.
   The default file name is the agent name, but you can change the file name.

**Note:** Changing the file name does not change the name of the agent in the file.

To import agents, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the agent file to import, then click Open.

**Note:** If you try to import an agent that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Configuring an Agility ECS Connection

When you configure an Agility ECS connection (requires the Agility ECS Connector license), you enable Vantage domain support for the following:

- Vantage client communications with Agility through the Agility service.
- Vantage Dashboard monitoring of Agility ECS server status and statistics.

To identify the Agility ECS server and test its connection, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Agility ECS tab. Vantage displays the Agility ECS tab shown below.

4. Enter the Agility server’s host name or IP address.
5. If the default HTTP port value (80), is not correct, enter a new port number.

**Note:** If the Agility IIS server is using a port other than 80, enter that port number here.

6. To test the connection to the specified Agility ECS server, click Test Connection.
If there is a network problem, or you have supplied an invalid hostname or IP address, or the Agility server is not in a state where it can respond to queries, Management Console displays the following error:

![Test Failed]

The connection to the Agility ECS server must be successful before you can use the action inspectors to configure Agility Job Profile and Agility Job XML actions in Vantage workflows and submit jobs.
Configuring Telestream Cloud Settings

The Telestream Cloud settings panel allows you to save Telestream Cloud account settings for use by the Cloud Flip action, which sends media to the cloud for transcoding using the credentials you enter here to gain access. Before you can enter account settings in this panel, you must create an account on the Telestream Cloud web site.

To create an account on the Telestream Cloud web site, point your browser to this URL: https://cloud.telestream.net/. You will be prompted to log in or create an account. When you create an account, the Cloud web site provides you with an Access Key and a Secret Access Key to use for logging in. Once logged in, you will need to set up your account for transcoding, including creating and configuring a “factory” for transcoding and storage. See the Telestream Cloud online documentation, tooltips, and live chat feature if you need help.

After your account is fully configured, you can enter your credentials in the Telestream Cloud panel. The Cloud Flip action in Vantage workflows uses the credentials to automate logging into the Cloud and sending media to your account for transcoding:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Telestream Cloud tab. Vantage displays the Telestream Cloud configuration panel.
4. Click the Add New Setting button in the toolbar (or right-click in the empty space below the button and select Add new setting).
5. In the Name field, enter a practical name for the Telestream Cloud account.
6. In the AccessKey field, enter the AccessKey you received when you signed up for an account at the Telestream Cloud web site.

7. In the SecretAccessKey field, enter the SecretAccessKey from the Cloud web site.

8. Click the Save icon to save the new account.

9. To test the Vantage-Telestream Cloud connection, click Test at the bottom of the window. A dialog pops up to confirm test success or failure at logging into the Cloud account.

You can add Accounts as needed for each Telestream Cloud account you create.

**Deleting a Telestream Cloud Account**

To delete a configuration, do the following:

1. Display the Telestream Cloud panel.

2. Select the account to delete. (Ctrl-click or Shift-click to select multiple accounts.)

3. Click the Delete button \( \times \) (or right-click and select Delete).

4. When the confirmation dialog appears, click OK.

   Note that deleting an account in Vantage does not delete the account on the Telestream Cloud web site.

**Exporting and Importing Telestream Cloud Settings**

Vantage allows you to export your Telestream Cloud settings to files, which you can then use to import the same accounts into the same or another Vantage domain.

To export, do the following:

1. Select the accounts to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button \( \rightarrow \) to export selected accounts (or right-click and select Export, or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported accounts.

   The default file name is the account name, but you can change the file name.

---

**Note:** Changing the file name does not change the name of the account in the file.

To import accounts from a previously exported file, do the following:

1. Click the Import button \( \leftarrow \).

2. Use the file system dialog to locate and select the file to import, then click Open.

---

**Note:** If you try to import an account that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Configuring an Elastic Domain Billing Account

The Billing Account panel enables you to set up billing for a Vantage Elastic Domain, which allows rapid scaling of a Vantage array. With an Elastic Domain system, you license and deploy a Vantage Array containing the number of nodes required to handle your average daily workload.

During periods of peak demand, the system capacity is expanded by spinning-up additional nodes. These additional nodes are typically powered by virtual machines or cloud IaaS (Infrastructure as a Service) instances, and their services join the Vantage domain as Transient Services. Your installed license specifies which features can be accessed by these additional nodes.

The Elastic Domain billing framework is created by linking to an Elastic Domain enabled Telestream Cloud Billing Account and entering the credentials in the Billing Account tab of the Vantage Management Console Settings and Options section.

Domain nodes and services are reported to the Telestream Cloud Elastic Domain billing service, which reconciles your actual domain scale against the scale allowed by your perpetual license to determine any additional license rental charges.

For more information about installing and operating an Elastic Domain, refer to the Vantage Elastic Domain Guide.

Configuring and Testing Billing

To configure a Billing Account, follow these steps:

1. In the Vantage Management Console, select Settings & Options in the left column. Then select the Billing Account tab as shown below.
2. Enter the Name used for your Telestream Cloud Billing Account.
3. Enter the Elastic Billing Account Access Key.
   You received your AccessKey and your Secret Access Key when you signed up for Elastic Billing in the Telestream Cloud. To see them again, log into https://cloud.telestream.net and select API Access in the left column.
5. Click Validate to test the ability to log into your billing account automatically. Vantage will pop up a note advising you of login success or failure.
6. Click Save to save your Elastic Billing Account details.

In addition to configuring Elastic Domain billing, at least one Vantage Metric Service must be configured to send reports to the Telestream Cloud Elastic Domain billing service:
1. Open the Vantage Management Console Services.
2. Right-click the Metric service, and select Enter Maintenance Mode.
3. With the Metric service still selected, click Setup.
4. Click Billing Reconciliation, and enable Allow Billing Reconciliation.
5. Right-click the Metric service and select Exit Maintenance Mode.

Checking Billing Log Information
Log information regarding Elastic Domain billing can be seen in the Vantage Management Console by selecting Licenses and the Cloud Billing tab. The log information includes details such as these:
• Whether a Metric service has not been enabled for billing reconciliation.
• The last time Vantage was able to report usage to Telestream Cloud.
• Whether Vantage is able to communicate with Telestream Cloud.
• Whether bursting has been suspended for the account.

Suspension can occur under these conditions:
• A user-configured cost limit has been exceeded.
• Vantage is not able to contact Telestream Cloud for 24 hours.
• Bursting is suspended by Telestream.

When an Elastic Domain becomes suspended, the Vantage Management Console > Licenses tab indicates:

    Domain License Mode: Elastic (Bursting Suspended)

See the next topic for how to reactivate a suspended Elastic Domain.
Reactivating a Suspended Elastic Domain

To reactivate a suspended Elastic Domain:

- If bursting was suspended because of an exceeded cost limit, the domain will reactivate when the cost limit expires. If you'd like to reactivate the domain sooner, you can delete the cost limit.

- If bursting was suspended because the Vantage Metric service was unable to communicate with Telestream Cloud for 24 hours, the domain will reactivate itself once connectivity is restored.

- If bursting was suspended by Telestream, a Telestream Support representative must re-activate the domain. While bursting is suspended, Vantage will only enable the number of nodes specified in the perpetual license Fallback notations. For example, if the number of fallback nodes is 1, Vantage will only process jobs on one node at a time.

After bursting is reactivated for the Vantage Elastic Domain, the Licenses tab of the Vantage Management Console will indicate:

Domain License Mode: Elastic

If bursting becomes suspended and then reactivated, waiting jobs at the time of reactivation may not use services licensed through bursting. Any new jobs will properly load balance across all services. Stopping and then restarting waiting jobs (via the Workflow Designer Job Status view) will enable those jobs to use all services.
Configuring Interplay Settings

The Settings & Options Interplay panel lets you create, save, export, delete and import Avid Interplay server connection settings. When you configure an Interplay connection, you enable the Vantage domain to communicate with the Interplay server by supplying required credentials. An Interplay connection must be configured in the Management Console before it can be used in a Vantage workflow.

To configure an Interplay account in Vantage and test its connection, follow these steps:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Interplay tab. Vantage displays the Interplay configuration panel.
4. Click the Add New Setting button in the toolbar (or right-click in the empty space below the button and select Add new setting).
5. In the Name field, enter a practical name for the Interplay server (for example, Interplay-Vantage Server).
6. In the Interplay Web Services Host field, enter the domain name of the Interplay server.
7. In the Interplay Web Services Port field, select or enter a port number (default 80).
8. In the Interplay Workgroup field, enter the work group name.
9. In the Interplay Username field, enter the user name expected by the Interplay server.
10. In the Interplay Password field, enter the Interplay user’s password.
11. Click the Save icon to save the new agent.
12. To test the Vantage-Interplay connection, click Test at the bottom of the window.
Exporting and Importing Interplay Settings

Vantage allows you to export your Interplay settings to files, which you can then use to import the same accounts into the same or another Vantage domain.

To export, do the following:
1. Select the accounts to export. (Ctrl-click or Shift-click to select multiple views.)
2. Click the Export button to export selected accounts (or right-click and select Export, or select Export all from the Export button drop down menu).
3. Use the file system dialog to save the exported accounts.
   The default file name is the account name, but you can change the file name.

   **Note:** Changing the file name does not change the name of the account in the file.

To import accounts from a previously exported file, do the following:
1. Click the Import button.
2. Use the file system dialog to locate and select the file to import, then click Open.

   **Note:** If you try to import an account that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.

Deleting an Interplay Account

To delete an Interplay settings configuration, do the following:
1. Display the Interplay panel.
2. Select the account to delete. (Ctrl-click or Shift-click to select multiple accounts.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
   Note that deleting an account in Vantage does not delete the account on the Interplay server but only deletes the account settings from Vantage.
Creating Dashboard Links

The Settings & Options Dashboard Links panel lets you create, save, export, delete and import URLs that appear as frequently used links on the Vantage Web Apps main page.

To configure an Interplay account in Vantage and test its connection, follow these steps:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings & Options.
3. In the Settings & Options details panel, select the Dashboard Links tab. Vantage displays the Dashboard Links configuration panel.
4. Click the Add New Dashboard Link button in the toolbar (or right-click in the empty space below the button and select Add new dashboard link).
5. In the Name field, enter a practical name for the link.
6. In the Address field, enter the URL for the link.
7. Click the Save icon to save the new dashboard link.
8. To test the new link, click the Test button. Your default browser should open to the web page you specified. Also open the Vantage Web Apps page and verify that the new link is present.

Exporting and Importing Dashboard Links

Vantage allows you to export your Dashboard links to files, which you can then use to import the same links into the same or another Vantage domain.

To export, do the following:

1. Select the links to export. (Ctrl-click or Shift-click to select multiple views.)
2. Click the Export menu (or right-click) and select Export Selected, or Export all.
3. Use the file system dialog to save the exported links file. The default file name is the base URL, but you can change the file name.

Note: Changing the file name does not change the URL in the file.
To import a previously exported file, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the file to import, then click Open.

**Note:** If you try to import a set of links that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.

---

**Deleting Dashboard Links**

To delete Dashboard links, do the following:

1. Display the Dashboard Links panel.
2. Select the link to delete. (Ctrl-click or Shift-click to select multiple accounts.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
Managing Vantage File Storage

Vantage storage is disk space that can be used to store files for Vantage processing. The following topics provide information on Vantage storage:

- Understanding Vantage Storage
- Understanding Path Specifications for Vantage Storage
- Managing Vantage Stores
- Managing Vantage Folder Addresses

Understanding Vantage Storage

Vantage storage is disk space that Vantage can use to store media files and attachments. Vantage storage is different from database storage, which stores data for Vantage configuration, job/binder status, and system status.

Vantage uses storage for purposes:

- **Vantage stores**—Managed disk space where media files and attachments are temporarily stored and automatically deleted when they are no longer referenced by a binder.
- **Vantage folder addresses**—Unmanaged disk space to which media files and attachments can be delivered, but from which files are not automatically deleted.

Vantage stores are defined in the Management Console. There are two types of stores that may be selected when created: Live Store and File Store. The two types are completely separate and cannot be used interchangeably. Live Stores are used by the Live Capture action for capture storage. File stores can be used in workflow actions that perform file operations (file stores).

Vantage file stores can also be associated with Vantage services for temporary storage (such as the location for a file that is being created during transcoding). Managed files remain in a Vantage store while either of the following is true:

- The files are referenced by a binder during job processing.
- The files are referenced by a binder that has been registered in a catalog, and the binder expiration date has not yet passed.

Vantage folders can be created in the console or in Vantage Workflow Designer. Like stores, Vantage folders can then be used in workflow actions that perform file operations.

Transport actions that are responsible for saving files can use both stores and folders as file access and delivery points.
Understanding Path Specifications for Vantage Storage

Vantage stores and folders can be specified using the following path forms:

- UNC form: `\ComputerName\Sharename`
- Physical drive-letter form: `C:\folder\folder`
- Mapped drive managed by SAN client software (for example, StorNext)

**Note:** Vantage cannot access network locations defined using a Windows mapped drive unless you specifically enable mapped drives and map each drive to a UNC path using the Settings & Options/Mapped Drives panel. For all network locations other than properly configured SAN locations, you must use a UNC path to define network locations for Vantage use.

If all your Vantage services, clients, and storage are on the same server, you can use either path form. However, Telestream recommends always using the UNC path form.

The disadvantage to using the drive-letter path form is that the drive letter is defined on the local machine, and the drive letter does not identify the computer that hosts the drive. For example, if you specify a Vantage store on drive C: using the drive-letter path form and a Vantage Workflow Portal operator tries to view files in that store on a different computer, the Vantage Workflow Portal will search for those files on drive C: on the operator's computer, not on the Vantage server.

When any Vantage service or client program uses Vantage storage from a different computer, you must specify the path using the UNC form. You should also use the UNC form if you think you might ever support Vantage services or clients on another computer. You can change the path form later, but it is easier to use the UNC path form now, and it can prevent troubleshooting issues in the future.

**Note:** When services or clients will access Vantage storage from another computer, the Vantage storage location must be published as a share, and access must be granted to the appropriate Windows users. For more information, see Windows Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of the SAN. You can utilize SAN drives via a letter drive reference, provided that each Vantage server is a client of the SAN and that all mount points use the same letter.

**Note:** When creating a store to hold proxy files viewed in Vantage Workflow Portal, reference the store with a UNC path. Some SAN clients do not allow frame-accurate representation of proxies using shared drives.

**Note:** The Microsoft User Account Control (UAC) feature may deny access to Vantage stores or folders that are placed in protected locations. If Vantage users report that access to a store or folder is denied, place the store or folder in a directory that is not protected by UAC on the machine where the store or folder resides.
Managing Vantage Stores

Vantage stores management is performed in the Management Console. When you install Vantage in all-in-one mode, a default store named *Local Store* is created so that you can use Workflow Designer and access at least one store. You can add other stores as necessary.

To manage your stores, start the Vantage Management Console and select Storage > Vantage Stores in the components panel. Vantage displays the Vantage Stores detail panel shown in this figure, which shows helpful information such as the name, description, offline indicator, type, location, and total and free disk space available for the store, as well as a spaced used.

Use the Vantage Stores details panel to view, add, and configure stores. You also use the details panel to modify and delete stores.

The following topics describe how to manage Vantage stores:

- Adding and Configuring Vantage Stores
- Viewing Files in a Vantage Store
- Modifying a Vantage Store
- Moving a Store Online or Offline
- Identifying Workflows that Use a Store
- Setting the Block Size
- Duplicating a Vantage Store
- Exporting and Importing Vantage Stores
- Deleting a Vantage Store

**Note:** The Alias feature (figure) supports the Web-based Vantage Workflow Portal application described in *Managing Web Workflow Portal Client Alias Support* in the
Adding and Configuring Vantage Stores

To add a new Vantage store, do the following:

1. Click the New Vantage Store button in the toolbar to display the Add New Store dialog (or right-click and select New Vantage Store).

2. Type a name for the store in the Name text box.
   The name that you enter here is the name that appears in Workflow Designer when an action is configured to access a media file or attachment.

3. To specify the store root directory with a UNC path (recommended), do the following:
   a. Click Modify to display the Browse for Folder dialog box.
   b. Open Network, open the computer name, and then select the root directory for the store.
   c. Click OK.
   You can also type a UNC path in the Location text box. For example, \Computer-Name\Sharename.

   **Note:** If the Vantage store is on a different computer, you must publish a share and grant access to the appropriate Windows users before it will appear in the Browse for Folder dialog. For more information, see *Windows Authentication Guidelines* in the *Vantage Domain Management Guide*.

4. To specify the store root directory with a drive letter path, do the following:
   a. Click Modify to display the Browse for Folder dialog box.
   b. Select a local folder.
   c. Click OK.
   You can also type a drive letter path in the Location text box. For example, C:\folder\folder.

   **Note:** If you use a physical drive letter to specify a directory, only Vantage services and clients on the same computer can access the store. For more information, see *Understanding Path Specifications for Vantage Storage*.

5. Click OK.
6. Click the Save button to save the new store.
Creating a Live Store

To make a Live Store for Lightspeed Live Capture, set the Type: to Live. For an ordinary Vantage Store to be used for non-Live workflows, set the Type: to File. The two types are completely separate and cannot be used interchangeably.

Viewing Files in a Vantage Store

The Files text box on the Vantage Stores page displays the files in the Vantage store. You can also use tools in the host file system (Windows Explorer, for example) to view the files in the store. To refresh the display of files, click the refresh button.

Modifying a Vantage Store

To modify a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.
2. To change the store name, type a new name in the Name text box.
3. To enter a description for the store, type a description in the Description text box.
4. To specify the store root directory with a UNC path (recommended), do the following:
   a. Click Modify to display the Browse for Folder dialog box.
   b. Open Network, open the computer name, and then select the root directory for the store.
   c. Click OK.

   You can also type a UNC path in the Location text box. For example, \Computer-Name\Sharename.

   **Note:** If the Vantage store is on a different computer, you must publish a share and grant access to the appropriate Windows users before it will appear in the Browse for Folder dialog. For more information, see *Windows Authentication Guidelines* in the *Vantage Domain Management Guide*.

5. To specify the store root directory with a drive letter path, do the following:
   a. Click Modify to display the Browse for Folder dialog box.
   b. Select a local folder.
   c. Click OK.

   You can also type a drive letter path in the Location field, such as C:\folder\folder.

   **Note:** If you use a local drive letter to specify a directory, only Vantage services and clients on the same computer can access the store. For more information, see *Understanding Path Specifications for Vantage Storage*. 
6. To specify a folder naming scheme for the store, select the scheme from the Folder Scheme drop down list.

When content is placed in a Vantage Store, Vantage creates a subfolder in the Store location to save the files in. If you select Identifier, the subfolder is named by auto-generating a GUID. Date uses the current time and date stamp, and Name+Date uses the content name plus the time and date. For example, a Name+Date sub-folder for a media file named *Butterfly* would be named something similar to: *Butterfly_2010-09-17_01-59-50-5785*.

7. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to bring the store back online.

For more information, see *Moving a Store Online or Offline*.

8. To set the block size used for the store access, click the Advanced button and follow the instructions in *Setting the Block Size*.

9. For information on managing aliases for the store, see *Managing Web Workflow Portal Client Alias Support* in the *Vantage Domain Management Guide*.

10. Click the Save button to save the changes.

### Moving a Store Online or Offline

There may be times when you want to move a Vantage store offline to perform maintenance. When a store is offline, the Offline column in the Vantage Stores list displays an X for all stores that are offline.

When you move a store offline, any jobs in progress that are using that store continue to run, but the offline store is no longer available for new jobs. A good practice is to take the store offline, let all jobs in progress for that store complete, and then perform the planned maintenance. If the store becomes inaccessible before the jobs in progress complete, the jobs in progress for that store fail.

To move a Vantage store offline or online, do the following:

1. Select an existing store in the Vantage Stores list.

2. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to bring the store back online.

   The Offline checkbox is disabled if the store is assigned to a Vantage service. To enable the offline checkbox in this situation, identify to which service the store is assigned, and place that service in maintenance mode. You can located which service is using the store by looking at the Storage tab for each service. For more information, see *Managing Services*.

3. Click the Save button to save the changes.
Identifying Workflows that Use a Store

Vantage allows you to search all workflows in a domain to see which workflows are using a store. This is very useful when you need to change or delete a store, and you want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the store for which you want to search.
2. Click the Search button in the toolbar.

   If the store is used by any workflows, Vantage displays a list of workflows that use the store. Double-click any workflow in the list to open that list in Vantage Workflow Designer. Click Done to dismiss the list.

   If the store is not used by any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.
Setting the Block Size

Vantage allows you to specify the block size used when writing data to and reading data from Vantage stores. The default setting works best for most storage systems, but some fiber attached storage systems support higher throughput with larger block sizes.

Note: The block size feature is only utilized by Vantage Transport related actions (Copy, Move, Deploy). It is not used by and does not affect Vantage Transcode Actions (Flip, IPTV, Conform, Multiscreen, etc.).

CAUTION: This is an advanced system feature, and misconfiguration can disable your Vantage store. Be sure you understand the block size requirements of the storage system before making changes, and consider making changes to a production system only when you know the system is idle.

To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog.

   **Figure 1. Advanced Stores Settings Dialog**

2. Check the *Specify desired block size* checkbox.

3. Use the up and down arrows to specify the new block size.

4. To test the new block size, do the following:
   a. Click Test.
   b. Use the file selection dialog to select a test file, and then click Open.
      The test does not open the test file or evaluate file content, so you can use any file, regardless of file content. Larger files usually give a more accurate average throughput result.
   c. Click OK.
      Vantage displays the test results.

5. Click OK to save the new setting and close the dialog.
Duplicating a Vantage Store

To duplicate a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.
2. Click the Duplicate button (or right-click and select Duplicate).
3. Select the new store and customize it as needed (see *Modifying a Vantage Store*).

Exporting and Importing Vantage Stores

Vantage allows you to export one or more Vantage stores to XML files, which you can then use to import the same stores into another Vantage domain.

To export all stores in the list, click the Export drop down menu and select Export All. Then use the file system dialog to save the exported stores.

To export selected stores, do the following:

1. Select the store to export. You can Shift-click or Ctrl-click to select multiple stores.
2. Click the Export button (or right-click and select Export, or click the Export drop down menu and choose Export Selected).
3. Use the file system dialog to save the exported stores.
   The default file name is the store name, but you can change the file name.

*Note:* Changing the name of the XML file does not change the name of the store in the XML file. Also note that exporting a Vantage store only exports the store path information, not the contents of the store.

To import a store, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the store to import, then click Open.

*Note:* If you try to import a store that is already in this Vantage domain, Vantage prompts you to either overwrite the existing store (click Yes) or cancel the import (click No).

Deleting a Vantage Store

Click on the store you want to delete, click the Delete button in the toolbar (or right-click and select Delete), and click OK to confirm.

*Note:* If there are any files in the store that are maintained by Vantage—such as those for unexpired jobs or binders in a catalog, you cannot delete the store. Deleting a store permanently removes the store from the domain. It does not delete directories, shares, or any files in them.
Managing Vantage Folder Addresses

Vantage folder address book management can be performed either directly in the Management Console or in Vantage Workflow Designer (in Copy or Move actions).

To manage your Vantage folder addresses in the Vantage Management Console, start the Vantage Management Console and select Storage > Vantage Folder Address Book in the components panel. Vantage displays the Vantage Folder Address Book detail panel shown in the figure below:

You can use the Vantage Folders Address Book details panel to add and configure Vantage folders. You also use the details panel to modify and delete Vantage folders.

The following topics provide information on managing Vantage folder addresses:

- Adding Vantage Folder Addresses
- Refreshing the List of Folders
- Modifying Vantage Folder Addresses
- Identifying Workflows that Use a Vantage Folder
- Deleting a Vantage Folder Address
- Setting the Block Size
- Duplicating a Vantage Folder Address
- Exporting and Importing Folder Addresses
Adding Vantage Folder Addresses

To add a new folder address, do the following:

1. Click the Add Folder button to display the Add New Folder dialog.
2. Enter a folder name in the Add New Folder dialog.
3. Click Modify to display the Folder Location Editor dialog.
4. Select the file system where the Vantage files will be stored, then click Next.
5. To specify the folder root directory with a UNC path (recommended), do the following:
   a. Click Browse to display the Browse for Folder dialog box.
   b. Open Network, open the computer name, and then select the root directory for the folder.
   c. Click OK.
   You can also type a UNC path in the Location text box. For example, `\\Computer-Name\Sharename`.
6. To specify the folder root directory with a drive letter path, do the following:
   a. Click Browse to display the Browse for Folder dialog box.
   b. Select a local folder.
   c. Click OK.
   You can also type a drive letter path in the Location text box. For example, `C:\folder\folder`.
7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on the local folder warning dialog.)
8. Click OK to save this new Vantage folder address to the domain and close the Add New Folder dialog.

Note: If the Vantage folder is on a different computer, you must publish a share and grant access to the appropriate Windows users before it will appear in the Browse for Folder dialog. For more information, see Windows Authentication Guidelines in the
**Vantage Domain Management Guide.** Also, if you use a drive letter to specify a folder, only Vantage services and clients on the same computer can access the folder. For more information, see *Understanding Path Specifications for Vantage Storage.*

---

**Note:** When using Amazon AWS S3 address locations in the Watch and Associate actions and when specifying a Vantage folder address, you must also configure specific AWS IAM policy settings for S3 access. These are the minimal IAM parameter settings for Vantage 6.x, 7.0, and 7.1:

Updated IAM permissions list for S3 with Vantage:

```
{
  "Statement": [
  ]
}
```

---

**Refreshing the List of Folders**

To refresh the folder list, click the refresh button 🔄.

**Modifying Vantage Folder Addresses**

To modify a folder address, do the following:

1. Select the folder in the Vantage Folder Address Book.
2. If you want to change the folder name, enter a new name for the Vantage folder.
   This name is displayed in Copy and Move action inspectors where you are specifying the location in which to save a file.
3. If you want to enter a description, enter the description, purpose, or use of this folder address.
4. To change the folder storage location, click Modify (or right-click the folder name in the list and select Modify) and specify the new location as described in *Adding Vantage Folder Addresses.*
5. To define what action Vantage takes when it saves a file and a file with the same name exists in the Vantage folder, select an action from the Collision Resolution drop down list:
   - Create Unique Name—Vantage creates the file with a unique name, leaving the other file intact.
   - Overwrite—Vantage overwrites the old file.
   - Set Failure State—Vantage does not save a new file and registers a failure with the action that attempted to create the file.
6. For instructions on using the Advanced features, see *Setting the Block Size.*
7. Click the Save button 🔄.
Identifying Workflows that Use a Vantage Folder

Vantage allows you to search all workflows in a domain to see which workflows are using a Vantage folder. This is very useful when you need to change or delete a store, and you want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the Vantage folder for which you want to search.
2. Click the Search button in the toolbar (or right-click and select Find Workflows).
   
   If the folder is used by any workflows, Vantage displays a list of workflows that use the folder. Double-click any workflow in the list to open that list in Vantage Workflow Designer. Click Done to dismiss the list.

   If the folder is not used by any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.

Deleting a Vantage Folder Address

Click on the folder you want to delete, click the Delete button in the toolbar (or right-click and select Delete), and click OK to confirm.

**Note:** Deleting a folder permanently removes the folder from the domain. It does not delete directories, shares, or any files in them.

Setting the Block Size

Vantage allows you to specify the block size used when writing data to and reading data from Vantage folders. You can also use Vantage to test the throughput of different settings. The default setting works best for most storage systems, but some fiber attached storage systems support higher throughput with larger block sizes.

**Note:** The block size feature is only utilized by Vantage Transport related actions (Copy, Move, Deploy). It is not used by and does not affect Vantage Transcode Actions (Flip, IPTV, Conform, Multiscreen, etc.).

**CAUTION:** This is an advanced system feature, and misconfiguration can disable your Vantage folder. Be sure you understand the block size requirements of the storage system before making changes, and consider making changes to a production system only when you know the system is idle.

To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog (see the Advanced Stores Settings Dialog figure).
2. Check the Specify desired block size checkbox.
3. Use the up and down arrows to specify the new block size.
4. To test the new block size, do the following:
   a. Click Test.
   b. Use the file selection dialog that appears to select a typical media file, and then click Open.
      Larger files will usually give a more accurate average throughput result.
   c. Click OK.
      Vantage displays the test results.
5. Click OK to keep the save the new setting and close the dialog.
6. Click the Save button.

**Duplicating a Vantage Folder Address**

Select the folder you want to duplicate, click the Duplicate button in the toolbar (or right-click and select Duplicate). Select the duplicated folder, make the necessary changes and save it.

**Exporting and Importing Folder Addresses**

Vantage allows you to export folder addresses to XML files, which you can then use to import the same addresses into another Vantage domain.

To export all folder addresses, click the Export drop down menu and select Export All. Then use the file system dialog to save the exported folder addresses.

To export selected folder addresses, do the following:
1. Select a folder in the list, or you can Shift-click or Ctrl-click to select multiple folders.
2. Click the Export button, right-click and select Export, or select Export Selected from the Export button drop down menu.
3. Use the file system dialog to save the exported folder addresses.
   The default file name is the folder address name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the folder address in the XML file.

To import a folder address, do the following:
1. Click the Import button.
2. Use the file system dialog to locate and select the folder address file to import, then click Open.

**Note:** If you try to import a folder address file that is already in this Vantage domain, Vantage prompts you to either overwrite the existing folder address (click Yes) or cancel the import (click No).
Managing Services

The term Services, as used in Vantage, refers to Vantage running as Windows services, which are required to perform a given action in a workflow. The term service refers to the specific instance of the Windows service on a particular computer that is responsible for actually executing the actions specified in a workflow when that workflow is executed as a result of a job submission to process a given media file.

Use the Services component of the Management Console to configure your Vantage services operating on various machines to function according to your requirements.

You can configure each service's program settings, storage requirements, variables, and qualification rules.

The following topics describe how to manage services:

- Using the Services Details Panel
- Grouping Services
- Adding a Service to the Domain
- Removing a Service from the Domain
- Entering and Exiting Service Maintenance Mode
- Resetting the Service Metrics History
- Restarting a Service
- Changing a Service Logon
- Viewing Average Time Spent Waiting
- Generating Reports
- Configuring Vantage Services
Using the Services Details Panel

To begin Vantage service management, start the Vantage Management Console and select Services in the components panel. Vantage displays the Services detail panel shown in this figure.

Note: If duplicate entries appear for services on a specific Vantage server, it could be that the server has multiple network interface cards and one of them has been disabled. This does not affect Vantage operation.

The columns in the Services panel are described in the Services Panel Column Descriptions table.

Clicking a column heading lists the services in order by that column type. Clicking the column heading again restores the Services display to the default view. For example, clicking the Service column heading organizes the services list alphabetically by service name; clicking the Machine column organizes the services alphabetically by machine name; clicking State organizes services by state, and so on.
## Services Panel Column Descriptions

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>Lists Vantage services by name.</td>
</tr>
<tr>
<td>Machine</td>
<td>Displays the machine name that hosts the service.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates whether a service is Permanent or Transient. Transient services automatically leave the Vantage domain when their host machine is powered off, whereas permanent services return. Transient services are a feature of Vantage Elastic Domain, designed to allow flexible computing instances to dynamically increase the capacity of a Vantage domain during periods of peak demand. For more information, please see the Vantage Elastic Domain Guide.</td>
</tr>
<tr>
<td>State</td>
<td>Displays the service state, which can be Online, Offline, Unreachable, or Maintenance.</td>
</tr>
<tr>
<td>Active Sessions</td>
<td>Displays the number of active sessions for the service. A service starts a session each time a workflow uses that service to process a job.</td>
</tr>
<tr>
<td>Queued Sessions</td>
<td>Displays the number of sessions that have been assigned to a service and are waiting for the service to become available.</td>
</tr>
<tr>
<td>Failed Sessions</td>
<td>Displays the number of sessions that did not complete successfully.</td>
</tr>
<tr>
<td>Total Sessions</td>
<td>Displays the total number of jobs that have used the related service since the metrics were last reset.</td>
</tr>
<tr>
<td>Session Limit</td>
<td>Displays the maximum number of concurrent sessions allowed for a service. This setting is made using the Setup tab, Service Limits selection. When cost based load balancing is enabled, this setting is disabled. For more information on load balancing, see Managing Task Scheduling and Load Balancing.</td>
</tr>
<tr>
<td>Average Wait Time</td>
<td>Displays the average time that all jobs spend waiting in the queue while the service is saturated and unable to take on new jobs. For example, if the service has processed 10 jobs and the waiting times were 0,0,0,0,0,0,0,0,0,10 (the last job waited 10 seconds), an average wait time of 1 second would be reported. This indicator helps to highlight ongoing load imbalances or the need for additional computing power to handle overloads.</td>
</tr>
<tr>
<td>License Failures</td>
<td>Displays the number of times users have requested a service and have been denied because no license was available for the session.</td>
</tr>
<tr>
<td>Lightspeed Fallback Count</td>
<td>For each service, indicates the number of jobs that could have run on a Lightspeed Server if one had been available.</td>
</tr>
</tbody>
</table>
Grouping Services

Services can be viewed in groups using the Show in Groups button. Once in group display mode, the groupings can be changed by clicking the column headings, allowing you to view groups by Service, Machine, State, etc. Clicking the Show in Groups button a second time restores the default view.

Adding a Service to the Domain

Before you can add a Vantage service to a domain, it must first have been installed and started on a computer on your network subnet.

To add a Vantage service to a domain, click the Add Service button in the toolbar. The Vantage Management Console scans the network for available services and displays those that are not currently part of this domain.

Select the service you want to add to the current domain and click OK.

Services cannot be part of more than one Vantage domain at a time. Be sure that adding a service to your Vantage domain will not harm another Vantage domain by removing that service from it.

Removing a Service from the Domain

To remove a Vantage service from a domain, select the service (Shift-click or Ctrl-click to select multiples) and click the Delete button in the toolbar.

Note: Removing a service does not stop or uninstall the service from any computer. It merely disengages it from the current domain.
Managing the Vantage Domain
Managing Services

Entering and Exiting Service Maintenance Mode

You can enter and exit maintenance mode by selecting a service and clicking the Enter or Exit button (or right-click the service and select Enter/Exit Maintenance Mode). When a service is in maintenance mode it will not process any transactions. Exit maintenance mode to re-activate the selected service and cause it to reload its resources from the database.

**Note:** Placing a service in maintenance mode erases the metrics for that service, which affects the Vantage Dashboard bar graphs for that service.

**Note:** The Tachyon Cinnafilm service is supported only on Lightspeed servers. On all other Vantage servers, this service stays in Maintenance Mode.

To move multiple or all services on a server in and out of maintenance mode, do the following.

1. Display the Services detail panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiples).
3. Click the Enter button to place the services in maintenance mode.
4. Click the Exit button to restart the services and exit maintenance mode.

**Note:** Placing all services in maintenance mode erases the metrics for all services, which affects the Vantage Dashboard bar graphs for those services.

Resetting the Service Metrics History

Click the Clear button (or right-click and select Clear) to reset the service metrics history. This also resets all failed service metrics for the selected services. You can do this for multiple or all services by Ctrl-clicking or Shift-clicking the services you want.

Restarting a Service

To restart one or more services, follow these steps:

1. Display the Services detail panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
3. Click the Restart button to restart the services.

**Note:** Restarting services erases the metrics for those services.
Changing a Service Logon

As part of a workflow, a Vantage service may need to access network folders shared only with a certain user account. In such cases, you may need to change the logon of that service to the permitted user. To change a service logon, follow these steps:

1. Display the Services detail panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
3. Click the Change Service Logon button or right-click and select Change Service Log On. A dialog opens, requesting the logon.
4. Select Local System account to use the account currently accessing Vantage from your local machine, or select This account and fill in the user name and password for the account that has access to the desired network location.
5. Click OK. A message confirms that the logon is changing.

Note: Changing a service logon restarts that service. Also note, when changing the logon for multiple services simultaneously, some services may not restart properly. If this occurs, go to Start > Services on the server, select the affected services, and click (or right-click) Restart to manually restart the services.

Viewing Average Time Spent Waiting

The Average Time Spent Waiting button opens a small dialog box that reports the average time spent waiting by a service, by an array node, or by the domain. This can be helpful in spotting processing bottlenecks at the action, server, and domain levels and helping administrators determine when more servers should be added to increase processing capabilities during peak load times.

To display the average time spent waiting, follow these steps:

1. Display the Services detail panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
3. Click the Average Time Spent Waiting button.
4. Select one of the viewing options in the dialog box:
   - By service type to see the average wait time for the service selected in the drop-down menu.
   - By array node to see the average wait time for the server selected in the drop-down menu.
   - Entire domain to see the average wait time for the whole domain.
5. Click Next. The dialog box displays a message showing how much time on average the selected item spent waiting (as opposed to actively processing).
Generating Reports

The Generating Report button initiates a report from a report format that you have already created using the Vantage Management Console Report Configurations > Service Reports feature (see the Vantage Domain Management Guide for information).

Note: This feature requires the Reporting & Analytics option.

To generate a report, follow these steps:

1. Display the Services detail panel.
2. Select a service in the list (Shift-click or Ctrl-click to select multiple services).
4. Select from the options in the dialog box:
   – The Report drop-down menu lets you select a report from the list of Service Reports you have created.
   – Start lets you specify a starting time (and date for historical reports) for gathering report data. Data that occurred before the Start time (and date) is not included.
   – End lets you specify an end time (and date for historical reports) for gathering report data. Data after the specified time (and date) is not included.
   In the Start and End fields, you can click on each item, including month, date, year, hours, minutes, seconds, and AM/PM, and use the selection arrows to set each item. You can also click the drop-down arrow to display a calendar and select a date.
   Note: For historical reports, the number of days of available historical information is determined by the Service Report Retention Time setting in the Settings and Options > General tab. This setting retains the past 30 days of information by default, or you can set it for a lesser or greater retention time.
5. Click OK, navigate to the location where you want to save the report file. You can change the report name to anything you prefer, or leave the default name, and then click Save.
   A message indicates that the report has been generated, and another message shows the location of the report and includes an Open Folder button providing access to the report.
6. To open the folder and access the report, click Open Folder.

Reports can be opened in a text editor or spreadsheet program. If you use a spreadsheet program, you can not only view the data in columns and rows, but you can also produce charts and graphs using the spreadsheet’s built-in graphing functions.
Time of Day Report Example

The following example shows a typical TOD Report for the Transcode service for a 24-hour period (abbreviated to 12 hours to save space). Data is shown at each hour.

This type of report helps you see which hours of the day may be over- or under-loaded.

![TOD_Report.csv](image)

Historical Report Example

The following example shows an excerpt from a typical historical report for all services on one node over multiple days.

This type of report helps you see service or machine loading trends over an extended period of time.

![Historical_Report.csv](image)
Configuring Vantage Services

Vantage services have a variety of configuration options; most of them with default settings. The following topics describe how to configure the settings on each tab:

- **Setup**
- **Storage**
- **Variables**
- **Qualification Rules**

**Setup**

The Setup tab includes Vantage domain database settings, service ports, instrumentation, time-out settings and log file options.

Changing settings in the Setup tab requires that you restart the service before they take effect. You can make changes to settings in the other tabs without restarting the service—they take effect immediately. To modify the settings in the Setup tab, select the service you want to modify and click the Enter Maintenance mode button in the toolbar (or right-click and select Enter). After making the changes, click the Exit Maintenance mode button in the toolbar (or right-click and select Exit). Exiting maintenance mode reactivates the selected service and causes it to reload its resources from the database so it can begin accepting jobs again.

Changes to these settings can only be made in maintenance mode.

Click on each category in the Setup tab to display its settings.

<table>
<thead>
<tr>
<th><strong>Vantage Domain Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host</strong></td>
</tr>
<tr>
<td><strong>Failover</strong></td>
</tr>
<tr>
<td><strong>Instance</strong></td>
</tr>
<tr>
<td><strong>Database</strong></td>
</tr>
<tr>
<td><strong>User</strong></td>
</tr>
<tr>
<td><strong>Password</strong></td>
</tr>
</tbody>
</table>
### Service Limits

<table>
<thead>
<tr>
<th>Service Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Limit</td>
<td>In sessions mode (which is the default mode), this configures the maximum number of concurrent sessions for a service. For CPU-intensive services—such the Transcode service—you should gate the maximum number of sessions to the power of the computer. For less demanding services, such as the Monitor service, a higher number is less likely to cause problems. When cost based load balancing is enabled, this setting is disabled. For more information on load balancing, see <em>Managing Task Scheduling and Load Balancing</em>.</td>
</tr>
<tr>
<td>Target Resource Usage</td>
<td>When cost based load balancing is enabled, this setting configures the target resource usage level for this service. Each service has a default value for this setting. If server performance permits, raise this value to support simultaneous processing of additional workflow actions. If the server is having performance issues, lower this value to reduce the number of actions that run at the same time. For more information on load balancing, see <em>Managing Task Scheduling and Load Balancing</em>.</td>
</tr>
</tbody>
</table>

### Service Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP Port</td>
<td>The TCP port is utilized for all intra-service traffic in the domain. If a certain port range is allowed by your IT infrastructure (given constraints such as routers and firewalls) an IT administrator can specify which port to use for intra-service communication to fit their environment. The default port settings are listed in the <em>Before You Install</em> chapter of the <em>Vantage Domain Management Guide</em>.</td>
</tr>
<tr>
<td>HTTP Port</td>
<td>The HTTP port is utilized for HTTP server traffic in the domain. An IT administrator can specify which port to use for intra-service communication to fit their environment. The default port settings are listed in the <em>Before You Install</em> chapter of the <em>Vantage Domain Management Guide</em>.</td>
</tr>
</tbody>
</table>

### Pause Limit

<table>
<thead>
<tr>
<th>Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause Session Limit</td>
<td>Allows specifying the number of sessions that may be paused for these services: Transcode, Multiscreen, IPTV, and Edit. Users may then pause multiple sessions up to that number. Note that the pause limit is independent of the session limit and may be set higher or lower than the session limit.</td>
</tr>
<tr>
<td>Allow Paused Actions</td>
<td>When unchecked, actions may not be paused. When checked, allows actions to be paused. Hierarchical Pausing allows jobs that have paused other jobs to themselves be paused. For example, if a low priority job is paused by a medium priority job, a high priority job may pause the medium job. This feature must be enabled by the administrator and will be set on a service-by-service basis in the session limit category for transcoding services.</td>
</tr>
</tbody>
</table>
Managing the Vantage Domain

Managing Services

277

Storage

The Storage tab enables you to specify stores for a service to provide a repository so that their actions can obtain storage if they require it. Certain actions require storage where they can create temporary files or perform other operations that involve writing files to disk.

For example, the Transcode service requires access to a store in order to produce the files that it creates as part of the transcode process.

The process of assigning a specific store to a service is made with performance in mind. If you know you want a particular Transcode service to utilize a specific store, you can assign it here. In the absence of an assigned store for Transcode service, service is free to utilize any Vantage store it chooses for managing temporary files. This may not be optimal based upon your network topology.

Adding Stores

To add a store to the selected service, click the Add Store button \( \text{Add Store} \), select the store from the Select Storage dialog and click OK.

**Note:** The Flip actions and other actions can also specify a store for output files. The selection of a store in an action is separate from stores attached to a service.

Removing Stores

To remove a store from the selected service, select the store and click the Delete button \( \text{Delete} \) in the toolbar.
Variables

Use the Variables tab to attach variables to a service. Variables attached to a service perform two functions. First, they dictate which services can perform tasks as set up by the Run On Rules in actions executing in the context of a workflow. Run On Rules allow you to target specific services to execute tasks, based upon whether or not a variable is set correctly for a Service.

**Note:** Run on rules examine service variable values, not job variable values.

Second, variables attached to a service allow workflows to examine their values in the context of a job. Variables (such as service hosts and action priority) can be passed to workflows to provide information about the service, and workflow actions can include this information in the output or make workflow processing decisions based on the variable values.

When you add a variable to a service, you supply a constant (or static) value—one that does not change from job to job. The value is static for the service instance. For example, you may want to implement email generation in the event of a transcode failure in a large domain with 20 concurrent Transcode services, each running on separate servers. This allows a user to receive an email when a transcode fails that identifies the server where the failure occurred.

To implement this, create a text variable named `EmailSubject` as described in Creating Variables. Next, add the `EmailSubject` variable to each Transcode service as described in Adding Variables to a Service, and set the value of `EmailSubject` for each service to a combination of the respective machine name and the service name by typing it in manually in the Value field. For example, one might be named `M-ORION-VantageTranscodeService`.

Finally, in each workflow, add a Message action and specify the email option, bind the Subject line with the `EmailSubject` variable, and set the Message action to only run on a Failure state.

Now, if a transcode failure occurs, the user receives an email indicating which server was transcoding the media when the failure occurred.

Adding Variables to a Service

To add a variable to the selected service, click the Add Variable button (or right-click and select Add Variable), select the variable from the Select Variable dialog and click OK. Next, enter the static value for this variable in the Value field. When you click away, the Save Variable dialog displays. Click Yes to save this variable and its value.

**Note:** If you are using any Lightspeed Server to host Lightspeed-aware services, Vantage automatically assigns a K20 or K80 system variable to that service, set to True. This variable is used for automated load balancing and can be tested by actions in a workflow for Run On rule processing or job reporting. Additionally, all Vantage services have an automatic system variable, `VantageMachineName`, set to the name of the host on which the service is running.
Removing Variables from a Service

To remove a variable from the selected service, select the variable and click the Delete button \(\times\) in the toolbar (or right-click and select Delete).

**CAUTION:** Deleting a variable may render workflows using the variable inoperable. When you delete a variable from a service, make sure that you modify any affected workflows as well.

---

Qualification Rules

Qualification rules give you control over which actions a service will process. Using these rules, a service compares variable values set by the workflow against a baseline value, generates a merit value based on the comparison, and uses that value in conjunction with other variables to determine if the service should process the job.

**Note:** Vantage also supports run on rules, which are defined in a workflow and allow a workflow designer to select a service based on Vantage variable values. Generally, run on rules are easier to configure if you want to specify that parts of a workflow execute on specific services. For more information, see the *Vantage User Guide*.

Qualification rules can be based on system variables (such as *Priority*, *K20*, and *K80*) and user-defined variables (for example, *HD Job* or *File Size*). You can create multiple qualification rules per service to fine-tune each service's fitness to perform certain tasks and improve over-all domain workflow and performance.

For example, suppose you have a large domain with 20 transcoding services on different machines. Your goal is to divide the transcoding services into groups: those that process the bulk of the jobs—those involving media of less than about 80MB in size. Another group is configured to optimally transcode media up to 2GB, another for long-form files, over 2GB.

To implement this, you create a variable named *FileSize* (Select Domain > Workflow Design Items > Variables).

Next, you select the service that you want to run short jobs here, in Services > Qualification Rules, and create a qualification rule.

Select the *FileSize* variable and click OK. Configure the rule to specify operator = less than or equal, merit = 100 (an arbitrary value), qualifier = required, and value = 80,000,000. This rule will pass the merit value of 100 to Vantage when a job being considered for execution has a *FileSize* variable with a value less than or equal to 80,000,000.

For each other transcoding service, add a similar rule (or rules) to qualify it appropriately.

Now, in each workflow, add an Identify action before each Flip action and configure it to update the *FileSize* variable with the File Size metric.

When a job starts, the Identify action updates the *FileSize* variable, and each transcoding service examines the variable against its comparison value to determine its fitness to
process the Flip action, and if true, submits its merit value, if false, submits merit value 0 to Vantage for final arbitration on which transcode service is assigned the job.

### Adding Qualification Rules

To add a qualification rule to the selected service, click the Add Qualification Rule button (or right-click and select Add Qualification Rules), select the variable from the Select Variable dialog and then configure the rule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Operator | Select an operator from the dropdown list to qualify the workflow variable value being compared against the baseline value specified in the rule.  
  For mathematical operators, if the equation is true, the merit value you supply is passed; if the equation is false, 0 is passed.  
  For the contains operator, the equation is true if the workflow variable contains the text specified in the baseline value. The merit value you supply is passed if the equation is true, and 0 is passed if the equation is false. |
| Merit | When an action meets the qualification rule requirements for multiple service instances, the action is assigned to the service with the highest merit value. For example, if a Flip action meets the qualification rule requirements for the Transcode service on both Server A and Server B, Vantage assigns action processing to the server that hosts the service qualification rule with the highest merit value.  
  Merit values should be consistent with a predetermined plan of implementation, so that each service is responding appropriately to influence the distribution of tasks. If you have few services and rules, values from 1 to 10 may provide enough granularity; for lots of services and/or rules, you may need values from 1 to 100 to provide enough granularity. |
| Qualifier | Choose Optional when workflows may or may not provide a value for comparison. If no value is provided, the comparison always is false, and 0 merit is provided. Choose Required when workflows must provide a value for comparison. If no value is provided, the service rejects the request to process the job without further analysis. |
| Value | Enter the baseline value against which the variable’s value is to be compared. (A null value is a valid value.) |
Deleting Qualification Rules

To remove a qualification rule from the selected service, select the rule and click the Delete button (or right-click and select Delete).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Wildcards</td>
<td>Enables or disables the use of wildcard characters in the Value field. When enabled (checked), you can use a question mark (?) to indicate a single character that can have any value, and you can use an asterisk (*) to indicate a variable number of characters that can have any value. For example, *.mov matches any value that ends in <code>.mov</code>. When disabled (unchecked), the * and ? characters are regular characters, not wildcard characters.</td>
</tr>
<tr>
<td>Ignore Case</td>
<td>Enables or disables case validation in the Value field. When enabled (checked), the case in the Value field is ignored when comparing the value to a value received from an action. For example, TEST1 and test1 are considered a match when the Ignore Case option is checked. When disabled (unchecked), the case in the Value field must exactly match that received from an action to be considered a match.</td>
</tr>
</tbody>
</table>
Managing Licenses

Telestream provides Vantage licenses to enable a specific set of capabilities in a Vantage domain database. A single license file activates capabilities for every server in the domain—functionality that was specified in your license request. Production licenses can only be used by one Vantage Domain at a time.

When you receive a license file from Telestream, you need to activate the license file. Activation locks the license in the Vantage domain database, and the license remains locked until deactivated. Once activated, the license file is no longer used by Vantage. However, you should keep the license file in case it needs to be reactivated later.

The following topics provide information on managing Vantage licenses:

- Viewing Vantage Licenses
- Adding a License
- Deactivating a License
- Searching Licenses
- Portal Sessions
- Cloud Billing

Note: For details about Vantage Workflow Portal session management, see Viewing and Resetting Vantage Workflow Portal Sessions in the Vantage Domain Management Guide.

Viewing Vantage Licenses

To view the Vantage licenses in your domain, start the Vantage Management Console and select Licenses in the components panel on the left.

You use the Licenses details panel to add a license to the domain and activate it. You also use the details panel to remove a license from the domain.
Select a license to open and view the policies in this license and the associated capabilities it enables.

The tool bar above the license indicates the type of license, such as Standard (a regular license) or Elastic (a license for an Elastic Domain). A license may also indicate status, such as (Elastic: Bursting Suspended); see Cloud Billing later in this section for details about suspended licenses.

Adding a License

Vantage licenses are normally installed when the domain is installed. For instructions on adding a license, see Enabling Vantage Licenses in the Vantage Domain Management Guide, Installing Vantage chapter.

Deactivating a License

**Note:** Before deactivating a license, all jobs using the license should be stopped, and all services using the license should be put into Maintenance Mode. Otherwise, the license will report being in use.

To deactivate a license in a domain, select the license and click the Remove license button \( \times \) in the toolbar (or right-click and select Delete). Click Yes to confirm.

When you remove a license, Vantage attempts to deactivate it. A license should only be removed if you intend to install the same license on a different Vantage domain. In this case, the removal process also attempts to deactivate the license. The deactivation process will indicate that the license may be loaded on a different domain. If a license is not deactivated prior to adding it to another Vantage Domain, an error occurs—indicating that the license is currently in use on a different Vantage domain and that it can not be activated a second time.
Searching Licenses

You can search installed licenses for a particular word or feature. For example, if you have forgotten whether you have bought a particular option, such as Aspera, you can enter Aspera in the search field, and any license containing that feature will be listed.

To perform a license search, click the binoculars button to open the search dialog. Then enter the feature you want to search for.

Portal Sessions

The Portal Sessions tab lists Workflow Portal status for any running Workflow Portal clients.

Cloud Billing

The Cloud Billing tab logs information such as if a Metric service has not been enabled for billing reconciliation, the last time Vantage was able to report usage to Telestream Cloud, whether Vantage is able to communicate with Telestream Cloud, and whether bursting has been suspended for the account.

Suspension can occur under these conditions:

- A user-configured cost limit has been exceeded.
- Vantage is not able to contact Telestream Cloud for 24 hours.
- Bursting is suspended by Telestream.

When an Elastic Domain becomes suspended, the Vantage Management Console > Licenses tab indicates:

Domain License Mode: Elastic (Bursting Suspended)

To reactivate a suspended Elastic Domain:
Managing the Vantage Domain

Enabling Open Workflows

- If bursting was suspended because of an exceeded cost limit, the domain will reactivate when the cost limit expires. If you'd like to reactivate the domain sooner, you can delete the cost limit.
- If bursting was suspended because the Vantage Metric service was unable to communicate with Telestream Cloud for 24 hours, the domain will reactivate itself once connectivity is restored.
- If bursting was suspended by Telestream, a Telestream Support representative must re-activate the domain. While bursting is suspended, Vantage will only enable the number of nodes specified in the perpetual license Fallback notations. For example, if the number of fallback nodes is 1, Vantage will only process jobs on one node at a time.

After bursting is reactivated for the Vantage Elastic Domain, the Licenses tab of the Vantage Management Console will indicate:

\[ \text{Domain License Mode: Elastic} \]

If bursting becomes suspended and then reactivated, waiting jobs at the time of reactivation may not use services licensed through bursting. Any new jobs will properly load balance across all services. Stopping and then restarting waiting jobs (via the Workflow Designer Job Status view) will enable those jobs to use all services.

Enabling Open Workflows

To enable or disable the Open Workflows option, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console in the Vantage Domain Management Guide.
2. In the components panel, select Settings and Options.
3. On the General tab in the details panel, check the Enable Open Workflows checkbox to enable this feature, or clear the checkbox to disable this feature.
4. Click the Save button.
5. Cycle the Vantage services into and out of maintenance mode so the change can take effect.

Note: Enabling Open Workflows requires enabling settings in three locations:
- The Vantage Management Console, Settings & Options, General tab, Enable Open Workflows
- The drop-down menu at the top of each specific workflow in Workflow Designer
- The context (right-click) menu for each action to be used in open mode

You must check to enable Open Workflows in each of the three locations. Additionally, the Open Workflows option license must be purchased and enabled. Not all actions are open-capable. For details, refer to the Tours topic in the Vantage User Guide, which includes an extensive tour of how to use Open Workflows.
Viewing Status

When monitoring Vantage or troubleshooting workflow issues, it can be helpful to see status information (as shown in the following figure) about which workflows and actions are active and view information about those workflows and actions. You can also view machine activity.

The following topics describe how to use Vantage Management Console to get information on the active workflows and actions:

- Viewing Active Actions
- Viewing Machine Metrics
- Viewing the Active Workflows in a Domain
- Checking Task Status
Viewing Active Actions

You can view the following information about active actions in the Vantage domain:

- Action name
- State
- Host Vantage server (machine)
- Host workflow
- Job name
- Date created
- Date updated
- Description

You can view the active actions for a specific service or a specific Vantage server:

- Viewing Active Actions for a Service
- Viewing Active Actions by Machine

Viewing Active Actions for a Service

To view the active actions for a service, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Status > Actions By Service.
3. Select the service that hosts the actions you want to view.

   Vantage displays a details panel for the service you selected, which lists all active actions for that service. You can sort action entries in ascending or descending order by clicking a column label.

Note: The Vantage Management Console might not display action list items the first time that the Vantage Management Console is started after installation. To resolve this issue, close and restart the Vantage Management Console.

Viewing Active Actions by Machine

To view the active actions for a Vantage server, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Status > Actions By Machine.
3. Select the Vantage server that hosts the actions you want to view. Vantage lists all active actions on that server.

You can sort action entries in ascending or descending order by clicking a column label.

Note: The Vantage Management Console might not display action list items the first time it is started after installation. To resolve this issue, close and restart the console.
Viewing Machine Metrics

Selecting Status > Machine Metrics displays key performance information for each Vantage server in the Vantage domain (see the figure, below). This can clarify workloads and bottlenecks at a glance. These are the measurements displayed in each column:

- **Machine**—Lists the name of the machine described by that display row
- **CPU Utilization**—Shows the percentage of CPU capacity in use
- **Network Utilization**—Shows the percentage of network throughput being used
- **RAM Utilization**—Shows the percentage of available memory being used
- **Total RAM**—Shows the total available memory
- **Model**—Identifies the Lightspeed server model or Vantage Server for non-Lightspeed
- **GPU Utilization**—Shows the percentage of total GPU capacity being used
- **GPU Memory Utilization**—Shows the percentage of total GPU memory in use
- **Total GPU Memory Per Card**—Shows total MB of GPU memory capacity per card
- **Current GPU Memory Per Card**—Shows in-use MB of GPU memory per card
- **GPU Utilization Per Card**—Shows percentage of GPU capacity in use per card
- **GPU Memory Per Card**—Shows percentage of GPU memory in use per card
- **Database Size**—Lists the size of the domain database in megabytes

You can sort the list order according to any measure by clicking the column title.

Pre-Shutdown Notification

In the Machine Metrics view, you can prepare to shut down a Vantage node by right-clicking the machine in the list and selecting Pre-Shutdown Notification. This places all services for the node in Pending Shutdown mode as seen in VMC Services. Queued sessions will migrate to other services in the domain, and the selected services will go offline when their active sessions finish. This prepares the node for Windows shutdown, which must be done separately.
Viewing the Active Workflows in a Domain

When you view the active workflows in the domain, you can view the following information about each workflow:

- Workflow name
- Type of workflow
- Category
- State
- Date and time started
- Date and time updated
- Scheduled expiration date and time

This information can help you discover the source of problems. For example, if a workflow was working until yesterday and you notice the workflow was updated today, you might want to investigate what change was made.

To view the active workflows, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Status > Active Workflows in Domain.

Vantage displays the Active Workflows in Domain panel:

You can sort the workflows in ascending or descending order by clicking a column title.
Monitoring Utilization

The Utilization feature selected in the Vantage Management Console left panel assists system administrators with capacity planning. The bar graph shown in the details panel on the right makes it easy to see when a Vantage domain is running under or over capacity for specified time periods. Bar heights below the Capacity line indicate available unused sessions, whereas bar heights above the line indicate session demand beyond capacity, causing session queuing. Bar colors are blue, orange, or red corresponding to sessions that had low, medium, or high wait times.

Specifically, utilization displays the following information:

- Graphs the aggregate of all sessions for a selected service and time period
- Shows all sessions or only successful sessions
- Displays utilization by days in a month or by hours in a day
- Conveys mean session wait time by color (blue, orange, red)
- Shows session capacity making over and under utilization plainly visible
- Intended for monitoring cumulative historical performance, not real-time data
Use the Utilization feature as follows:

1. In the top center, select Days or Hours. Days sets the bottom timeline to show all days in the selected month. Hours sets the timeline to show 24 hours in the selected day. **Note:** For the Utilization feature to work correctly, all Vantage computers must use the same NTP server for synchronized time.

2. In the top left, select a month or day.

3. In the top right, set the session qualifier to display All sessions or only Successful sessions.

4. Scroll the bottom service selector and click a service. The bar graph shows utilization for the selected service.

You can adjust the thresholds indicated by the bar colors as follows:

1. Click Modify in the lower right corner. The Wait Time Thresholds dialog opens.

2. Set the low threshold in seconds indicated by the blue part of the bar.

3. Set the high threshold in seconds indicated by the red part of the bar.

4. Click OK. The units shown in the color legend change to match your settings.
**Utilization Display Details**

<table>
<thead>
<tr>
<th>Button or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days/Hours</td>
<td>Selects whether the chart displays a month of days on the timeline or 24 hours.</td>
</tr>
<tr>
<td>Month/Date</td>
<td>Selects a month (if Days is selected) or a specific date (if Hours is selected).</td>
</tr>
<tr>
<td>Session qualifier</td>
<td>Sets the chart to display All sessions for the selected service or only Successful sessions.</td>
</tr>
<tr>
<td>Service Selector</td>
<td>Scrolls left or right to show all services. Click a service to display it on the bar graph.</td>
</tr>
<tr>
<td>Bar graph</td>
<td>Bar heights indicate the overall session demand for the selected service type. The bar height value is calculated using time-weighted averaging of all active and queued sessions for selected domain services over the indicated time period. Bar heights below the Capacity line (see Capacity line below) indicate available unused sessions for the time period. Bar heights above the Capacity line indicate that session demand exceeded capacity, causing session queuing. To prevent large session queues from going off-scale, values above the Capacity line are displayed using a log base 2 scale, as shown by exponential acceleration of the scale marks on the left side of the graph. Bar color coding presents a separate data set, visually overlaid on the utilization demand data described above. The proportion of a given blue, orange, or red bar corresponds to sessions completed within the time period that had low, medium, or high wait times. These wait time thresholds are configurable using the Modify button.</td>
</tr>
<tr>
<td>Modify</td>
<td>Opens a dialog that lets you set the number of seconds for the low threshold (blue) and the high threshold (red).</td>
</tr>
<tr>
<td>Capacity line</td>
<td>Shows session capacity for the selected service as a dotted yellow line. (Note: to change the session limit, select Services in the Management Console left column, select the service from the detail list and right-click it to choose Enter Maintenance Mode. Click the Setup tab, click Service Limits, and change the Session Limit. Then right-click the service to Exit Maintenance Mode. The capacity line in Utilization shows the new limit.)</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click the green refresh button in the upper left corner, or press F5 to refresh the Utilization display.</td>
</tr>
</tbody>
</table>
Using Support Utilities

The Support Utilities folder contains a collection of log generation and other utilities useful in monitoring and managing the domain:

- Using the Data Collection Utility
- Using the Change Log
- Using the Error Log
- Listing Actions By Service
- Displaying Plug-in Versions
- Displaying Software Versions by Machine

Using the Data Collection Utility

The Data collection utility enables you to collect relevant information about selected services for transmission to Telestream during a troubleshooting session. You can also log point-in-time details about a selected service into a log file for diagnostics purposes.

To open the Data Collection utility, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Support Utilities > Data Collection.

Vantage displays the Data Collection details panel, as shown here in this figure.

To collect data for one or more services

1. Select the service (Shift-click or Ctrl-click to select multiple services)
2. Click Collect Data.

Files named for each service are saved in the specified directory. Vantage writes the files out as `<ServiceType>.txt` and displays a dialog to notify you of the location of the file so that you can open and read the file or send it to others for analysis.

You can email these files to Telestream for assistance in solving problems during troubleshooting sessions.

### Using the Change Log

The Change Log utility captures changes to the Vantage domain configuration and operation and records the following for each change:

- Date and time of change
- Vantage user who made the change
- Host computer where the change occurred
- Change summary message

To open the Change Log utility, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console*.
2. In the components panel, select Support Utilities > Change Log.

Vantage displays the Change Log details panel shown below.

You can use the Change Log utility to copy, delete, and refresh the entries in the change log. You can also use filters to display only the log entries that meet your criteria. The following table describes the Change Log utility controls.
<table>
<thead>
<tr>
<th>Button or Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Delete button    | To delete one or more change log records, select the records to delete and do one of the following:  
  • Click the Delete button.  
  • Right-click a selected entry and select Delete. |
| Copy button      | To copy one or more change log records to the clipboard, select the records to copy and do one of the following:  
  • Click the Copy button.  
  • Right-click a selected entry and select Copy.  
  • Press Ctrl-C on the keyboard.  
  After you copy change log entries, you can paste the records into another application document, such as a spreadsheet or word processing document. |
| Refresh button   | Click to update the table from the database. |
| Filter By        | Check Filter by to enable the filtering controls. |
| Modify           | Click Modify to display a dialog that enables you to specify the maximum number of log items. |
| User contains    | Specifies change log entries that contain the specified text in the User field. |
| Host contains    | Specifies change log entries that contain the specified text in the Host field. |
| Message contains | Specifies change log entries that contain the specified text in the Message field. |
| Newer than       | Displays change log entries that are newer than the specified date. |
| Older than       | Displays change log entries that are older than the specified date. |
Using the Error Log

The Error Log utility captures Vantage errors and records the following for each error:

- Date and time of error
- Error source (Vantage service)
- Host computer where the error occurred
- Type of error (Info or Error)
- Error message

To open the Error Log utility, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Support Utilities > Error Log.

Vantage displays the Error Log details panel shown here:

![Error Log panel](image)

You can use the Error Log utility to copy, delete, and refresh the entries in the error log. You can also use filters to display only the log entries that meet your criteria. The Error Log utility controls are described in the following table.
<table>
<thead>
<tr>
<th>Button or Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Delete button | To delete one or more error log records, select the records to delete and do one of the following:  
  - Click the Delete button.  
  - Right-click a selected entry and select Delete. |
| Copy button | To copy one or more error log records to the clipboard, select the records to copy and do one of the following:  
  - Click the Copy button.  
  - Right-click a selected entry and select Copy.  
  - Press Ctrl-C on the keyboard.  
  After you copy error log entries, you can paste the records into another application document, such as a spreadsheet or word processing document. |
| Refresh button | Click to update the error log display. |
| Filter By | Check Filter by to enable the filtering controls. |
| Modify | Click Modify to display a dialog that enables you to specify the maximum number of log items. |
| User contains | Specifies error log entries containing the specified text in the User field. |
| Host contains | Specifies error log entries containing the specified text in the Host field. |
| Message contains | Specifies error log entries containing the specified text in the Message field. |
| Newer than | Displays error log entries that are new than the specified date. |
| Older than | Displays error log entries that are older than the specified date. |
Listing Actions By Service

To display a list of actions in the domain by service, open the Vantage Management Console and select Support Utilities > Actions By Service. Then click a service on the left to see its details on the right.

This feature lets you see many of the details about an action:

- Name of the action
- Description, including selected media format
- Date it was created
- Version with which it was created
- Workflow in which it resides
- Template used to create it

You can sort the list by clicking on any column heading.

The arrow buttons above the action list allow you to export the selected actions to an XML file. You can then import previously exported XML files. Using this feature, you can transfer configured actions between Vantage systems, or save them as backups.

The green Refresh button refreshes the list if you have made changes to any listed actions.
Displaying Plug-in Versions

Use the Plug-in Versions utility to display the list of plugins in the domain by service, including their version number. Plug-ins reside in the domain database and are available to perform functions required by multiple services.

To open the Plug-in Versions utility and display information for a service, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Support Utilities > Plug-in Versions By Service.
3. Click a service to display the details panel for that service.

Vantage displays the details panel for the service, which will be similar to the Metadata service details panel.
Displaying Software Versions by Machine

Use the Software Versions by Machine utility to display the list of machines in the domain and examine the versions of services and transcoding software components on each machine. This allows you to see which transcoding and analysis engine is installed on each machine, and which patches. All Vantage machines should use the same engine and patch versions.

To open the Software Versions by Machine utility and display version information, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Software Versions by Machine.

3. Click a machine icon to display the Vantage and services versions installed on that machine.
Managing Task Scheduling and Load Balancing

The following topics provide information on managing load balancing:

- Enabling Task Scheduling/Load Balancing
- Overview of Session and Cost Based (Legacy) Load Balancing
- Examples of Cost Based Load Balancing (Legacy)
- Overview of Task Based Load Balancing
- Configuring Task Based Load Balancing
- Enabling Task Scheduling/Load Balancing
- Examples of Task Scheduling

Enabling Task Scheduling/Load Balancing

Task Scheduling is an umbrella term that includes the default Session Based selection and the optional Cost Based and Task Based Load Balancing selections. The Advanced Task Scheduling license enables all three selections, so you can choose among them (they are mutually exclusive). Without the Advanced Task Scheduling license, only the Session Based selection is available.

To enable or disable any of the three Task Scheduling options, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console in the Vantage Domain Management Guide.

2. In the components (left) panel, select Settings and Options, and select the General tab in the details (right) panel.
3. Under Task Scheduling, check the Session Based, Cost Based Load Balancing, or Task Based Load Balancing checkbox to enable a load balancing feature.

4. Click the Save button above Task Scheduling.

5. When the Service Restart Required dialog appears, click OK.

6. Restart all Vantage services by clicking Services in the left panel and then right-clicking each service in the right panel and selecting Restart Service. (You can Ctrl-click or Shift-click to select multiple services.) As a quicker alternative to restarting, you can enter and exit all services into and out of maintenance mode.

Note that this merely enables the features. Using the features requires appropriate licensing and configuration in other panels, as explained below.

Overview of Session and Cost Based (Legacy) Load Balancing

The following topics explain Session and Cost Based Load Balancing; Task Based Load Balancing is covered later as a separate topic.

Session and Cost Based Load Balancing methods govern and balance the workload for each service on individual or multiple Vantage servers. For example, if you have the Transcode service running on three Vantage servers, the Flip action, which is processed by the Transcode service, can run on any of the servers. Load balancing determines which server receives the action to process.

Session-Based Load Balancing

Session-based load balancing, which is included with Vantage and does not require a license, allows you to distribute the processing of actions across multiple servers that support the same service. Session-based load balancing distributes action processing among the available servers up to the configured session limit for each server.

Note: A Lightspeed K20 Server can run a maximum of six concurrent Lightspeed jobs regardless of the capacity setting. (K80 Lightspeed servers have no such concurrency limit.) The default session limit setting for each transcode service is four. This helps ensure the server retains enough GPU memory to efficiently process all jobs. If Lightspeed jobs fail because they exceed memory limits, try a lower setting.

This load balancing is done by taking the CPU capacity and current utilization of each machine into account, as well as ensuring that any Run On rules are observed. (Run On rules allow tasks to be routed to specific machines. They are configured in the Management Console > Services > Variables and are set in the Workflow Designer by right-clicking on actions and selecting Run On Rules.)

When the configured session limit is reached on all servers, actions are queued until the workload drops below the configured session limit. (An exception to this is that some actions support the pause for priority feature in which an action pauses, yielding to a higher priority action of the same type.)
You set the Session Limit in the Vantage Management Console by selecting Services and selecting the service you want to change. The Session Limit is listed in the Setup panel below the services list. To change the limit for a service, you must first right-click and select Enter Maintenance Mode, which enables the Session Limit selection. After changing the Session Limit, right-click the service and select Exit Maintenance Mode.

**Cost Based Load Balancing (Legacy)**

Cost based load balancing is a legacy method that has been improved upon by Task Based Load Balancing. Cost based load balancing requires a Vantage Array license and the Advanced Task Scheduling license and allows you to do the following:

- Assign a default cost for each type of action used in workflows
- Define a target resource usage level for each service on a server
- Override the default resource cost in workflows as needed

**Note:** Session limits are ignored when cost based load balancing is enabled, and the target resource usage level is ignored when session-based load balancing is enabled.

To determine its available resources, each service monitors the total cost of all actions it is processing and compares that cost to the configured target resource usage level for that service. A service can accept an action for processing if the available resource usage is at least half the cost of the action.

Unless priority is used, actions are assigned to services in the order in which they are processed, which prevents low cost actions from consuming all service resources and starving higher-cost actions. Each action is forwarded to the service with the most available resources. If the action is forwarded to a service that does not have resources to immediately process the action, the action is queued for later processing.
To implement cost based load balancing, enable the feature (as described in Enabling Task Scheduling/Load Balancing) and monitor the following:

- The server performance using server monitoring tools.
- The Services panel in the Vantage Management Console, which displays a list of services, including the current and target resource usage levels. For more information, see Using the Services Details Panel.

If the server is under- or over-loaded, you might adjust the default target resource usage level for each service as described in Configuring Vantage Services.

To adjust the default resource cost of an action, search for Managing Actions in the Domain Management Guide. For information on overriding an action's default resource cost in a workflow, see the Vantage User Guide.

**Examples of Cost Based Load Balancing (Legacy)**

You can use the target resource usage setting to limit the total action cost that a service will simultaneously process. For example, if you configure the Transcode service for a target resource usage of 16 and you configure the default Flip action resource cost to 4, the Transcode service supports a maximum of 4 simultaneous Flip actions.

Some services support multiple actions, and you can set the action resource cost for each action to a different value to define the relative usage levels. For example, the Transport service supports the Copy, Delete, Deploy, and Move actions, which are assigned default resource costs of 2, 1, 1, and 2, respectively. Based on the default values, a Transport service can support twice as many Delete and Deploy actions as Copy and Move actions.

Different codecs require different levels of processing resources. Using Workflow Designer, you can override the default resource cost for specific actions within a workflow. For example, you might configure a Transcode service to target resource usage of 16, specify a resource cost of 1 for a 3GP Flip action, and a resource cost of 8 for an MPEG-2 HD Flip action. During load balancing, Vantage will ensure that:

- No more than two MPEG-2 HD jobs execute simultaneously
- Up to 16 3GP jobs can execute simultaneously
- One MPEG-2 HD and eight 3GP jobs can execute simultaneously in ideal situations
- MPEG-2 jobs are not starved by 3GP jobs which only require one slot

**Note:** Resource costs are integer values that have an ordinal relationship. You can implement any scale. Greater scales enable finer-grained control.
Overview of Task Based Load Balancing

Vantage Task Based load balancing is Vantage’s most advanced load balancing capability and augments the existing Vantage Session Based load balancing and the Vantage Cost Based load balancing. Task Based load balancing ensures that all Vantage servers remain fully utilized, maximizing server efficiency and increasing workflow throughput. Task Based load balancing also helps avoid the situation where some Vantage servers are over utilized and others are under-utilized.

The older session-based and cost based methods discussed previously are limited to a single service on a single machine. These methods can prevent a service from becoming overloaded, but they cannot effectively balance between different types of actions on a single machine, and they do not offer a global way of managing sessions across multiple machines.

Task based load balancing is a separately licensed option that provides a single set of metrics shared across all services for scheduling tasks and balancing workload on a single machine or all the machines in a domain.

These are the key features of task based load balancing:

- Each metric can be edited and has machine scope (across all services on the machine) or global scope (across all services on all machines).
- Each metric has two inputs: Cost (set for each action) and Capacity (set per machine, or globally). You can edit both on a per-machine basis (for per-machine metrics) or for the entire Vantage Domain (for global metrics).
- A default metric called System Resources is pre-configured to provide a per-machine metric. This metric cannot be deleted and must remain per-machine. However, you may set the capacity for this metric on each machine, and you may remove the metric from an individual action.
- You can create and name your own new metrics.
- By default, each metric has machine scope, but you can edit this after creation.
- The default capacity is 100 “units” for each machine, allowing each cost to indicate the resource percentage an action will use. The capacity can be changed.
- You can choose which metrics are relevant to an action, and you can set the cost for each action.
- When executing a task:
  - Vantage evaluates all metrics that you attach to the action. If a metric is not attached to an action, it is not considered.
  - Vantage tracks the aggregate cost of all executing actions on a machine, across all machine-based metrics, and will track the aggregate cost of executing actions across the entire system for global metrics.
  - Vantage only executes an action when the aggregate cost of executing current actions, plus the new task, does not exceed the capacity of any of the metrics attached to the task.
Vantage will never execute a task when the aggregate cost of executing actions, including the new task, would exceed the capacity of any of the metrics attached to the task.

- When tasks are queued, they may be pre-empted only by higher priority actions:
  - Certain high priority tasks will pause an appropriate number of low priority tasks (executing on the same service on the same machine) to free up sufficient resources across all metrics, to allow that high priority task to execute. If doing so would exceed the maximum number of paused jobs specified by the user, then the high priority task will wait until a different set of tasks are present which may be paused. Pauses will not occur across multiple machines; they occur only for actions hosted by the same service.

The new task based load balancing capability allows you to define custom task scheduling rules which allow jobs to be controlled/allocated based on criteria on a given machine or across an entire domain.

Vantage task based load balancing is enabled via the settings panel in the Vantage Management Console. As with other system level settings, when task based load balancing is enabled (or changed), services must be restarted to implement the new settings.

Task based load balancing includes capabilities that replace and extend the Cost based load balancing mode. The new capabilities replace the existing action cost mechanisms, and are used in-conjunction with the existing service capacity to provide more granularity on when and where an action may run.

**Configuring Task Based Load Balancing**

The following topics explain how to configure task based load balancing. The overall process consists of these steps:

1. Install the Advanced Task Scheduling license via the Vantage Management Console > Licenses panel.
2. Enable Task Based Load Balancing in Vantage Management Console > Settings & Options > General.
3. Put all Vantage services in Maintenance mode
4. Set Service and Session limits for each service in the Vantage Management Console > Services panel. This limits how many actions can run within a given service to prevent service overload.
5. Take the services out of Maintenance mode to restart them.
6. Create machine and domain rules in the Vantage Management Console > Task Rules > Task Scheduling Rules. You can create multiple rules to govern machine and domain capacities under different operating circumstances.
7. Adjust the capacity of rules for machines and domains using the Vantage Management Console > Task Rules > Task Capacity Manager.
8. Apply default costs and rules to actions using the Vantage Management Console > Workflow Design Items > Action Defaults. You can use the Configure Task Scheduling button to set default values and rules to apply to each action.

9. When creating workflows in the Workflow Designer, you can use the action defaults, or you can customize costs and rules for specific instances. To customize an action, right-click the action, and select Resource Cost > Configure Task Scheduling.

10. Monitor overall rule operation on machines and the domain using the Vantage Management Console > Status > Task Scheduling Status panel. Monitor workflow performance in the Workflow Designer Status panels, such as Domain Job Status.

Task Scheduling Rules Panel

The Task Scheduling Rules panel shown below provides a list of currently defined task scheduling rules. This panel allows machine or domain task scheduling rules to be added, configured, managed, and deleted. For the currently selected rule, you can set the default capacity for the rule and the Scope of the rule.

The System Resource rule is a system task scheduling rule that may not be deleted or changed and is assigned to any new machine added to a Vantage domain.

To add and configure a task scheduling rule, follow these steps:

1. Click Task Scheduling Rules in the left panel to open the Task Scheduling Rules panel on the right.
2. Click the Create a new rule button in the upper left corner of the panel.
3. In the Create New Rule dialog, select a Machine rule or a Domain rule and click OK. A Machine rule applies to a particular Vantage node, and a Domain rule applies to all nodes in the domain. The Scope you choose displays in the bottom panel.
4. In the bottom panel, name the rule, describe it, and if you wish change the Default Capacity. Capacity is the percentage of a machine or domain to devote to a service.

5. Click the Save button to save the rule. The new rule appears in the rule list.

These are the controls available in the Task Scheduling Rules panel:

**Create a new rule** — Adds a new machine or domain task rule.

**Delete a rule** — Deletes the selected rule from the rule list.

**Save a rule** — Saves a newly created or edited rule.

**Duplicate a rule** — Replicates the selected rule. Be sure to enter a new name.

**Show usage** — Lists actions and workflows where the selected rule is used. A rule must be located and deleted from all actions and workflows before you can delete it from the list.

**Import** — Imports rules previously exported as XML files.

**Export** — Exports rules as XML files that can be reimported using the Import function.

Note also that the above listed controls are also available in context menus. Right-click in the open space below rules to see a context menu containing the New Rule, Import Rules, and Export Rules functions. Right-click a particular rule to access Delete, Duplicate, Show usage, and Export functions.

### Task Capacity Manager Panel

The Task Capacity Manager panel lets you assign Task Scheduling Rules to particular machines or to the domain.

To apply a task scheduling rule to a machine or domain, follow these steps:
1. Click Task Capacity Manager in the left panel to open the Task Capacity Manager right panel.

2. Click the Machines tab to add rules to a machine, or click the Domain tab to add rules to the domain.

3. For machines, select the machine to which you want to apply a rule; for the domain, no selection is required.

4. Click the Add rule button, and select a rule from the list to apply to the domain or the selected machine.

5. At the bottom of the panel, set the Capacity that you want to apply.

6. Click the Save button to save your changes. Once saved, rules cannot be changed without putting Vantage services into maintenance mode.

These are the controls for the Task Capacity Manager Panel:

- **Refresh** — Refreshes the machine list to detect machines that have come online.
- **Add a rule** — Adds a rule to the selected machine or domain.
- **Delete a rule** — Deletes the selected rule from the rule list.
- **Save a rule** — Saves changes to added rules.
- **Capacity** — Changes the maximum percentage capacity allocated to a rule.

**Action Task Scheduling**

To add task scheduling rules to actions in a workflow, follow these steps in the Vantage Workflow Designer.

1. Right-click the action, and select Configure Task Scheduling.

2. In the Task Scheduling Rules dialog, select Custom or Default. Use Custom to apply rules you’ve created. Use Default to apply existing system rules.

3. Select the rule you wish to apply to the action from the Rule list.
4. You can also select Resource Cost Settings and specify custom costs.

**Action Defaults for Task Scheduling**

Action default costs and task scheduling rules apply to all actions of a specified type globally. These can be set up for each action in the Vantage Management Console > Workflow Design Items > Action Defaults. By setting up the default Resource cost and using Configure Task Scheduling to set up default rules, you can reduce the number of times you have to specify custom rules when you deploy individual actions.

For details about setting Action Defaults, see the *Vantage Domain Management Guide* > Configuring Vantage Workflow Components chapter > Managing Action Default Settings.
Checking Task Status

To check the status of running task rules, click Task Scheduling Status in the Vantage Management Console left panel. The state of machine and domain rules is displayed.

Examples of Task Scheduling

The following brief examples present scenarios where load balancing may be useful:

**Example:** The user sets the Transcode Service session limit to 6 and creates a new Rule called Transcode with a capacity of 100 associated with machine #1. The user then defines a Flip action and specifies a cost of 10. The user starts the workflow with this action and submits 10 jobs.

Because the session limit is explicitly set at 6, only 6 jobs execute despite the capacity of 100 specified in the rule and the fact that only 60 units of cost are used.

If the user stops the transcode service and changes the session limit to 12, restarts the workflow and re-submits 10 jobs, all 10 would execute (since the cost of each job is 10 and the machine has a capacity of 100). If the user submitted 2 additional jobs; these would queue (since the capacity of the machine is limited to 100 and there are 10 actions running (each with a cost of 10).

**Example:** The user installs Vantage and enables task based load balancing. By default, all Multiscreen and IPTV VOD transcodes have a System Resource cost of 25, and each machine has a capacity of 100. By default, only 4 transcoding jobs of any type will run on each machine.

**Example:** The user sets the System Resources cost of a Multiscreen action to 100 and the cost of another IPTV VOD action to 50. The capacity of each machine is the default (100). Now only one of the Multiscreen jobs, or two of the IPTV VOD jobs, can execute at a time.

**Example:** The user creates a machine-level rule called “FTP Sessions” and sets the machine capacity for “FTP Sessions” to 1. The user then adds “FTP Sessions” to a Transport action, and sets the cost to 1. This limits the number of FTP transfers from
that machine to one at a time, which is useful for FTP sites that can only allow one connection from a machine at a time.

**Example:** The user creates a rule called “Omneon Sessions” and sets it as a global rule, with a capacity of 1. The user then adds the metric “Omneon Sessions” to a Transport action, and sets the cost to 1. This limits the number of Omneon connections to one at a time across the entire system.

**Example:** Four tasks are running on one machine, each with a cost of 20. The aggregate cost of those running actions is 80. When a new task arrives with a cost of 25, it will not execute because doing so would exceed the capacity of the machine (100). Any tasks that arrive after that action will be queued behind the action (unless one has a higher priority).

**Example:** A high priority task (cost 50) pauses two low priority tasks (cost 25 each, total 50) to execute.

**Example:** A high priority task (cost 50) cannot execute because ten tasks are running, each with a cost of 10, and the pause session limit is set to 3; the high priority task would have to pause too many tasks. In this situation, the high priority task will wait until two jobs complete (so that it can pause three).
Managing Vantage Users

The user management feature determines which users have access to the following:

- Vantage Web Applications
- Vantage Workflow Portal configurations
- Workflow categories in the Vantage Workflow Designer client application
- Vantage Management Console

The Vantage administrator uses the Vantage Management Console to create, remove, and edit user profiles and Active Directory accounts. Vantage users are allowed to change their own passwords.

The following topics describe how to manage Vantage users:

- Enabling and Disabling User Administration
- Managing Users with Vantage Management Console
- Adding Users
- Setting Passwords
- Removing Users
- Importing and Exporting Users

Enabling and Disabling User Administration

User administration is disabled by default so a Vantage login is not required to use Vantage. If you enable user administration, Vantage users will be required to log in using a Vantage username and password that is assigned to them by the Vantage administrator or by using their Windows Active Directory login.

To enable or disable user management, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.
2. In the components panel, select Settings and Options.
3. On the General tab in the details panel, check the Enable user administration check box to enable this feature, or clear the check box to disable this feature.
4. Also check Use Windows Active Directory for Users if you would like to allow users to use their Windows login for logging into Vantage.
5. See Managing Users with Vantage Management Console for details about adding user accounts if you enabled user administration.

**Note:** When you disable user management, users do not need to enter a user name and password to log in to Vantage Management Console, Vantage Workflow Designer, or the Vantage Workflow Portal client application. To access most Vantage Web Applications, users must enter a user name and password. The exception for Vantage Web Applications is Job Status Views. When public access is configured for Job Status Views, users do not need to enter a user name and password.
Managing Users with Vantage Management Console

To start user management in the Vantage Management Console, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage Management Console.

2. In the Settings & Options > General panel, check Enable user administration, which must be enabled in order to manage users. You can also select Use Windows Active Directory for Users to allow logging in using Windows accounts.

3. In the components panel, select Users.

Vantage displays the Users detail panel shown in this figure:

The default user account is for the administrator. The account’s user name is “administrator” with no password. This account exists even if you do not add any users.
Adding Users

The procedure to add users differs slightly depending on whether you use Windows Active Directory or not. This figure shows the two different Add User windows.

Adding Users Without Windows Active Directory

To add a new user without using Windows Active Directory, follow these steps:

1. Click the **New User** button or right-click and select **New User**.
2. Enter the username and password (and confirm the password) in the dialog box.
3. Check the **Administrator** check box if you want the new user to be an administrator.
4. If the user is not an administrator, the **User cannot change password** checkbox is available. Check the box if you want to disable changing the password for the user.
5. Click **OK** to add the user, and then click **Save** to save your changes.

Adding Users With Windows Active Directory

The Vantage Active Directory feature allows you to create users and groups in Windows Active Directory and add them as users in Vantage. You can assign them a Vantage role either as regular users or administrators.

For example, if you add a group and choose to assign Administrator privileges to the group, each member of the group defined in Windows Active Directory will have Vantage administrator privileges. If you choose not to check the Administrator box when adding the group, users in that group are added as regular Vantage users without administrative privileges.

Note that individual user accounts take precedence over group accounts. For example, if user *johnk* is part of a group assigned as regular users, you can also add *johnk* as a separate user and set this account to be a Vantage Administrator. The separate account definition overrides the group settings for that user.

Also note that to use Active Directory, the machine must be logged on or joined to the Active Directory domain, and the administrator adding users must be an Active Directory user.

To add a new user or group using Windows Active Directory, follow these steps:

1. Click the **New User** button or right-click in the empty user list and select **New User**.
2. Enter part or all of the user name in the blank field and click Find Now to search for and list users whose names match the text you entered.

   The drop-down menu lets you select a filter for your search, and the Users and Groups check boxes allow searching for users, groups, or both (default).

3. Select a user in the displayed list.

4. Check the Administrator check box if you want the new user to be an administrator.

5. Click Add to add the user, and then click Save to save your changes.

**Setting Passwords**

To set the password of a user, click the Set Password button (or right-click the user in the list and click Set Password). When the dialog box displays, enter the password (and confirm the password) of the user. Click OK to close the dialog box, then click the Save button to save your changes.

**Removing Users**

Users can be removed by selecting the user in the Users list and clicking the Delete button at the top of the User Management panel (or right-click the user and select Delete). When requesting the removal of a user, a dialog box will display asking you to confirm this action. You cannot undo the removal of a user, thus to restore a user you must add him again as a new user.

**Importing and Exporting Users**

User lists can be imported and exported. To import a list of users, click the Import button, navigate to the XML file containing a list of users, and click the Open button. To export a list of users, click the Export button (or right-click the list and select Export), enter an XML filename for the list of users, and click the Save button.
Managing Domains

Managing a Vantage Domain includes backing up and restoring the domain database, shrinking the database, renaming a domain, and renaming a server.

- Backing Up and Restoring the Vantage Domain Database
- Understanding Domain Backup and Restore
- Backing Up the Domain
- Restoring the Domain
- Shrinking a Full Database
- Renaming a Vantage Domain
- Renaming a Vantage Server

Backing Up and Restoring the Vantage Domain Database

The domain backup feature allows you to save archival copies of the Vantage domain database in a separate file. The domain restore feature allows you to replace your current Vantage domain database with the contents of a previously-backed up domain. The domain backup and restore features are primarily used for the following:

- Returning the database to a previously backed-up state.
- Preparation for database mirroring.

**Note:** The domain backup and restore features are not designed for use during Vantage upgrades. If you back up the database from a specific version of Vantage, that backup can only be restored to the same Vantage software version. During a Vantage upgrade, the Vantage installers manage any required database updates as described in Upgrading from the Previous Version in the Vantage Domain Management Guide.

The following topics describe domain backup and restore:

- Understanding Domain Backup and Restore
- Backing Up the Domain
- Restoring the Domain

Understanding Domain Backup and Restore

During a domain backup, Vantage creates a single backup file that contains all workflows, all services, and all jobs registered in the domain. It is important to remember that the backup file contents reflect the domain contents as of the moment the backup file is created. To capture changes made after a backup, you must create another backup.

When you restore a domain, all services are stopped, the current database contents are irretrievably destroyed, and the backup file you specify is used to create the
replacement database. The services defined in the backup file are started and the Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, Telestream recommends that you back up the current database before restoring a previous database. Backing up the current database captures all database changes made since the last backup, and it gives you a backup file that you can use to restore the current database if necessary.

### Backing Up the Domain

To back up the Vantage domain database, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console*.

2. In the components panel, select Domain Management. Vantage displays the Domain Management details panel.

3. Verify that all services in the Active Services list are hosting 0 sessions.

**Note:** Although you can create a successful backup while services are executing workflow tasks, some job records may be lost. It is best to back up the domain when there is no activity in the domain.

4. Click the Backup... button.

5. In the *Save the domain* dialog, browse to the folder where you want to store the backup file, and click Save.

6. When the Backup Complete message appears, click OK.
Restoring the Domain

**CAUTION:** Telestream recommends that you restore a Vantage domain using the same machine that created the backup file. If you restore the domain from another machine, the services defined in the database must match the services installed on the other machine.

To restore a Vantage domain database, do the following:

1. Start the Vantage Management Console as described in *Starting the Vantage Management Console*.
2. In the components panel, select Domain Management. Vantage displays the Domain Management details panel.
3. To provide the option to return to the current Vantage domain database later, back up the current domain database as described in *Backing Up the Domain*.

**CAUTION:** Always back up your current database before restoring it to an earlier backup. Restoring your Vantage domain database overwrites the entire contents of the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

**Note:** When you restore a domain, all services are stopped, and all information related to any jobs in progress is lost. The restored database contains only the domain information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that appears, and click OK.
6. In the *Load the domain* dialog, browse to the backup file you want to restore, select the backup file, and click Open.
7. When the Restore Complete message appears, click OK.

Shrinking a Full Database

If a Vantage installation using SQL Express nears the SQL Express database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually launches a warning dialog indicating that the database is at or near capacity.

You may be able to resolve this issue using the Vantage Shrink Database feature, which applies the MS SQL DBCC SHRINKDATABASE command to the existing database to delete unused entries and reduce file size. The shrink process may take some time and may slow database performance, so it should be done only when the Vantage system is not busy.

Use this procedure to shrink the database:
1. Start the Vantage Management Console.
2. In the components panel, select Domain Management. Vantage displays the Domain Management details panel.
3. To protect against potential data loss, use the Backup... button to back up the current domain database as described in Backing Up the Domain.
4. Click the Shrink button to shrink the database.
   A dialog pops up to explain that the Shrink command may affect database performance and should be done only when Vantage is not busy.
   A Status message indicates progress.
   Current Size displays the database size next to the button, so you can see any changes immediately upon completion of the shrink command.
   Multiple presses of the button may shrink the database additionally each time.

**Renaming a Vantage Domain**

Each Vantage domain uses the name assigned to the Windows server that hosts the Vantage domain database. To rename a Vantage domain, you must complete the following tasks (which are described in more detail later in this topic):

- Remove all Vantage services from the Vantage domain.
- Rename the Windows server that hosts the Vantage domain database.
- Restart the renamed server and add all Vantage services to the renamed domain.

**Note:** If the Vantage domain database is a mirrored database, you must remove any Vantage licenses prior to renaming the Vantage domain. If you do not remove the licenses first, your licenses will become invalid after the rename is complete.

When you remove Vantage services from the domain, the Storage, Variable, and Qualification rule configuration for each service is lost. The rest of the Vantage domain configuration is retained. After the Vantage domain is renamed, all Vantage users and administrators will need to specify the new Vantage domain name when connecting to the domain with Vantage client or web applications.

**Note:** To complete this procedure, you must have permission in your Windows domain to rename the computer, or you must get assistance from your Windows domain administrator. Be sure to schedule the rename during a maintenance window, as renaming the Vantage domain interrupts all Vantage services in the domain and all Windows services on the server to be renamed.

Use the following procedure to rename a Vantage domain:

1. Start the Vantage Management Console, select the domain to manage, and log in as described in Starting the Vantage Management Console.
2. Select Services in the components panel.
3. Take note of any Storage, Variables, and/or Qualification Rules settings for each service.
   Write down any Storage, Variable, and/or Qualification Rule settings that you want to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button \(\times\) in the toolbar.

6. Click Start > Control Panel > System.

7. Click Change Settings in the right panel. The System Properties window opens.

8. Select the Computer Name tab and click Change.

9. Edit the computer name in the Computer Name text box and click OK.

10. If prompted to do so, enter a Windows user name and password for an account that has permission to rename this computer in the Windows domain.

   **Note:** If you do not have the appropriate permissions, contact the administrator for your Windows domain.

11. Restart the server.

12. Start the Vantage Management Console, select the new domain to manage, and log in.

13. Select Services in the components panel.

14. Click the Add Service button \(\oplus\) in the toolbar.

15. When the Select Service dialog appears, click Machine to sort the services by machine name.

16. To add Vantage services for a specific machine, select the services you want and click OK.

17. If any Storage, Variables, and/or Qualification Rules settings were configured for services, add them now.

18. Send the new Vantage domain name to all Vantage users and administrators so they can reconnect to the Vantage domain.

**Renaming a Vantage Server**

To rename a Vantage server, you must complete the following tasks (which are described in more detail later in this topic):

- Remove all Vantage services for the server to be renamed from the Vantage domain.
- Rename the Windows server.
- Restart the renamed server and add all Vantage services on the renamed server to the Vantage domain.
**Note:** Do not use this procedure to rename a server that hosts the Vantage domain database. Instead, see *Renaming a Vantage Domain*.

When you remove Vantage services from the domain, the Storage, Variable, and Qualification rule configuration for each service is lost. The rest of the server configuration is retained.

**Note:** To complete this procedure, you must have permission in your Windows domain to rename the computer, or you must get assistance from your Windows domain administrator. Be sure to schedule the rename during a maintenance window, as renaming the Vantage server interrupts all Vantage services and Windows services on the server to be renamed.

Use the following procedure to rename a Vantage server:

1. Start the Vantage Management Console, select the domain to manage, and log in as described in *Starting the Vantage Management Console*.
2. Select Services in the components panel.
3. Take note of any Storage, Variables, and/or Qualification Rules settings for the service node you want to rename.
   - Write down any Storage, Variable, and/or Qualification Rule settings that you want to reconfigure after the Vantage domain is renamed.
4. Click a service in the Services details panel, and enter Ctrl-A to select all services.
   - (NOTE: If renaming just a service node and not a domain database server, then only the service node's services need to be unassigned from the domain.)
5. Click the Remove Service button ✗ in the toolbar.
6. Click Start > Control Panel > System.
7. Click Change Settings in the right panel. The System Properties window opens.
8. Click Change System Properties in the right panel.
9. Select the Computer Name tab and click Change.
10. Edit the computer name in the Computer Name text box and click OK.
11. If prompted to do so, enter a Windows user name and password for an account that has permission to rename this computer in the Windows domain.

**Note:** If you do not have the appropriate permissions, contact the administrator for your Windows domain.

12. Restart the server.
13. Start the Vantage Management Console, select the domain to manage, and log in.
14. Select Services in the components panel.
15. Click the Add Service button 🌐 in the toolbar.
16. When the Select Service dialog appears, click Machine to sort the services by machine name.

17. To add Vantage services for the renamed server, select the services you want and click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for services, add them now.
Managing ComponentPacs

This topic describes the ComponentPac Management user interface in the Vantage Management Console. For additional details, see the Upgrade chapter.

ComponentPacs have replaced the component patches previously distributed for updating transcoding-related actions. ComponentPacs are uniquely numbered and versioned software libraries that contain these actions:

- Analyze
- Capture
- Chronicle
- Compose
- Conform
- Flip 64
- IPTV Flip
- Multiscreen Flip
- Tape Capture
- Tempo
- Timed Text Flip

These libraries are not installed or uninstalled using the Windows installer, but rather they are installed and managed separately from the Vantage framework. ComponentPacs are drop-in packages that you install into an existing Vantage Framework using the ComponentPac Management feature of the Vantage Management Console. Using the ComponentPac Management feature, you can install them from a central location of your choice or the default local cache. A central location accessible to all Vantage machines is required for a Vantage array or a Vantage domain having multiple client machines.

ComponentPac management provides secured version control for affected Vantage actions. ComponentPacs are managed and reconciled automatically on each node within a Vantage domain to ensure all nodes contain the same packages and versions. Each node is checked to ensure it has the correct packages installed, and if not, the correct packages are retrieved and installed from the central file location. Thus, if you move a node from one domain to another, the ComponentPac Management feature will reconcile the new node with the other nodes in the domain.

Please note that the Vantage framework is still installed and removed using a Windows-based installer from Telestream, and if a change is required within the Vantage framework, such as to non-transcoder service components, those updates are made using a Vantage patch or update pack, not a ComponentPac. Note also that the Flip, Identify, and Examine actions are not managed by the ComponentPac feature.

ComponentPac Management also includes features for managing which ComponentPacs are used by workflows and actions. You can upgrade ComponentPacs but continue to use old ComponentPacs for particular workflows and actions. You don't have to upgrade workflow and action functionality until you are ready. For details, see the Vantage User Guide topics on upgrading actions and workflows.
Using the ComponentPac Management Panel

The following figure shows the ComponentPac Management panel in the Vantage Management Console. To access this panel, select ComponentPac Management in the left menu.

- The **ComponentPac storage location** field allows you to enter or browse to a central location where ComponentPacs will be stored. If not specified, the default location is `C:\Program Files (x86)\Telestream\Vantage\ComponentPacs`.
- The **Install new package** button opens the **Install ComponentPacs** window, which enables you to select new downloaded ComponentPacs and install them by clicking the **Install** button.
- The **Installed ComponentPacs** list on the left side of the panel shows all installed ComponentPacs and allows you to select packages to manage.
- The **Summary** tab opens a panel that shows details about the package selected in the **Installed ComponentPacs** list.
- The **Actions** tab opens a panel listing workflows and actions that use the package selected in the **Installed ComponentPacs** list.
- Use the **Find actions referencing an absent ComponentPac** button to locate actions that need upgrading to use a new ComponentPac after a previous one has been removed.
Installing ComponentPacs

Installing new ComponentPacs as explained below makes them available for use but does not affect existing jobs, actions, or workflows until you explicitly upgrade them.

1. Obtain the new ComponentPac from Telestream.net or Telestream Support and place it in a folder accessible by the Vantage Management Console.

2. Open the Vantage Management Console, and click ComponentPac Management in the left column. Installed ComponentPacs, if any, are listed in the Installed ComponentPacs list on the right.

3. In the right panel Storage Location field, enter or browse to specify a path to a central ComponentPac storage location. This is where new downloaded packages will be stored and installed from. If you do not specify a path, the default location is used: C:\Program Files (x86)\Telestream\Vantage\ComponentPacs\.

   Note: For an all-in-one (single node) installation, the ComponentPac storage location can be a local path. For a multi-node installation (Vantage array), the ComponentPac storage location must be accessible to the Vantage services on all Vantage servers (via a UNC path or a SAN drive letter with appropriate permissions).

   One convenient way to securely install ComponentPacs from a share is to use Vantage Authorization credentials. To do this, create a share for a single user which is a different login than the logins to Windows or Vantage. (Shares can be created for single or multiple users or groups, and the user can be the same or different from the Windows user login.) Then in the Vantage Management Console, go to Settings & Options > Authorization and add the credentials for the share user. Next, restart the services to recognize the new credentials, and then test share access. You can now use the share as your ComponentPac central storage location.

4. Click the Install new package button.

5. Browse to the location where you downloaded the ComponentPac. Click on the ComponentPac file you want to install, and click Open. (Skip this step if the ComponentPac you are installing is already in the location specified in step 3.)

6. Check the desired ComponentPac in the Install ComponentPacs window, and click Install to install and register the package with the domain.
7. When installation finishes and the package appears in the Installed ComponentPacs list, restart all affected services on all nodes to deploy the pacs. ComponentPacs are unpacked and made ready for use when the Vantage services targeted by the ComponentPac are restarted. Unpacked pacs are stored in C:\Program Files (x86)\Telestream\Vantage\Components on each Vantage service node.

Notes:

1. New actions and workflows created in the Workflow Designer use the latest installed ComponentPac. However, existing actions and workflows must be selected and upgraded to use the latest ComponentPac. If they are not upgraded, they will continue to use the ComponentPac with which they were created. See the Vantage User Guide for detailed action and workflow upgrade instructions.

Once an action is upgraded it can’t be directly downgraded. However, you can restore workflows to their pre-upgraded state by importing the automatic backup copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the upgrades is also included in that directory.

If you want to change the location of automatic ComponentPac backups, open the Vantage Management Console, select Settings and Options, and browse for a new Location for workflow backups.

2. In Vantage version 7.0, existing actions and workflows will use the latest installed ComponentPac if the ComponentPac used to create them is no longer present. You may need to recreate the action if the latest ComponentPac does not support the action’s outdated settings. If the missing ComponentPac is reinstalled, the actions will resume use of that ComponentPac.

3. Starting with Vantage 7.0 Update Pack 1, workflows created with a previous version of Vantage (such as Vantage 6.3) will use the earliest ComponentPac installed. When you upgrade a workflow created with an older Vantage version to Vantage 7.0 or later, the actions will be tied to the latest ComponentPacs currently installed.

4. The Session Log available in the Workflow Designer Job Status or Domain Job Status panel lists which ComponentPac was used for a completed job.

5. If a Vantage service is unable to unpack a ComponentPac (such as when the Vantage service does not have the appropriate user credentials to access the file location of where the ComponentPac file resides), an entry is added to the service trace log to record the issue.

6. If you convert a single-node Vantage domain to a multi-node Vantage domain and if the installed ComponentPacs reside in a local path, the ComponentPacs must be copied or moved to a shared folder location and re-installed or re-registered.

7. Once workflows and actions have been upgraded to the latest ComponentPac they cannot be reverted back to previous versions.

8. Upgrading Vantage via an update pack, such as 7.0 UP1, may cause ComponentPac actions to be shown as eligible for upgrade even though a new ComponentPac has not been installed. This is normal behavior for update packs. You can upgrade the ComponentPac actions or not, as you prefer.
9. Attempting to install a future ComponentPac that doesn’t match the current Vantage version fails to install the ComponentPac and displays an error message: “ComponentPacs built for a future release of Vantage are not supported, and will not be installed.”

Uninstalling ComponentPacs

To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in the left column. Installed ComponentPacs are listed in the Installed ComponentPacs list on the right.

2. Click the package you plan to uninstall and check the Actions panel for affected workflows and actions.
   Export all workflows that reference the ComponentPac you want to uninstall (to back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the package to be removed is selected.

   **Note:** The Uninstall button appears *only* when a package is not used by any actions.

4. After uninstallation completes, restart the affected Vantage services. If the Workflow Designer was open, close it and reopen to all the changes to take effect.

The selected old package is removed and no longer appears in the ComponentPac Management list.
Configuring Vantage Workflow Components

This chapter describes how to use the Vantage Management Console (VMC) to manage Vantage features that support workflow designers and operators.

**Note:** Features for which you do not have a license are disabled and indicate that you need a license to use them.

The following topics describe how to manage the features and components that support workflow design and operation:

- Managing Catalogs
- Managing Binders
- Capturing Inventory
- Managing Workflow Design Items
- Viewing Workflow and Action Analytics
- Using Application Configurations
- Creating Report Configurations
- Managing Fulfillment Schemes
- Managing Syndication
Managing Catalogs

The following topics describe catalog management concepts and tasks:

- Understanding Catalogs
- Managing Catalogs with the Vantage Management Console
- Creating and Deleting Catalogs
- Creating and Deleting Catalog Folders
- Configuring a Catalog or Folder Expiration Policy

Understanding Catalogs

Vantage catalogs serve as containers for the binders created by workflows (see Managing Binders on page 334). You can use catalogs to organize binders, define a binder expiration policy at the catalog level, and control access to binders. Vantage provides a default catalog named Default Catalog.

Similar in concept to file folders that organize files, Vantage catalogs organize the binders that are created each time a workflow runs. A catalog folder serves as a subfolder for a catalog or a catalog folder. Catalog folders allow you to further organize and group associated content together. For example, you might have a National Parks catalog, with a Yellowstone and a Yosemite folder. You can make as many folders as you need to organize your content, and you can create catalog folders in catalog folders to create a hierarchy.

Each catalog and catalog folder has an expiration policy that you can use to define when binders within that catalog or folder expire. For more information, see Understanding Binders.

You can use catalogs to control operator access to binders. When configuring the Vantage Workflow Portal support (see Configuring the Vantage Workflow Portal in the Vantage Domain Management Guide), you can specify which operators can access a specific catalog or folder. For example, you can create catalogs for different organizations or departments, and then restrict operators to managing binders in the appropriate catalogs.
Managing Catalogs with the Vantage Management Console

To start catalog management using the Vantage Management Console, open the Catalogs details panel as follows:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Catalogs.

Vantage displays the Catalogs panel:

Hover over a toolbar button to display a description for the button. Right-click in the Catalogs details panel (on or away from an object) to display a context menu for available options, described in this table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Folder</td>
<td>Select to import a Windows directory of media, which is organized in the manner you want the catalog organized. Vantage replicates the directory structure, and creates a binder for each media file located in the folder hierarchy being imported.</td>
</tr>
<tr>
<td>New Binder</td>
<td>Select to create a new binder in the selected folder or catalog.</td>
</tr>
<tr>
<td>New Catalog</td>
<td>Select to create a new catalog.</td>
</tr>
<tr>
<td>New Folder</td>
<td>Select to create a new folder in the selected catalog.</td>
</tr>
<tr>
<td>Properties</td>
<td>Select to display and configure properties (including the expiration time) for the selected catalog/folder.</td>
</tr>
</tbody>
</table>
Creating and Deleting Catalogs

You can create as many catalogs as you need to meet the needs of your organization.

To create a new catalog, do the following:

1. Click the New Catalog button in the toolbar (or right-click in the empty catalog space and select New Catalog).
   - The Management Console displays a new catalog in the catalog tree, with the default text selected.
2. Type in the name of the new catalog and click away from the catalog.

To delete a catalog, do the following:

1. Select the catalog.
2. Click the Delete button (or right-click and select Remove) to permanently delete the catalog.

CAUTION: Removing a catalog permanently deletes binders and Vantage store files as described in Understanding Binders.

Creating and Deleting Catalog Folders

Inside each catalog, you can create as many folders as you need to organize the media in this catalog. Folders can be created in a hierarchy, and you can drag them around to re-organize them.

To create a new folder, do the following:

1. Click the catalog or folder where you want to create a new folder.
2. Click the Add Folder button in the toolbar (or right-click and select New Folder).
   - The Vantage Management Console displays a new folder in the catalog explorer panel and also in the Folders panel, with the default text selected.
3. Type in the name of the new folder and click away from the folder.

To delete a folder, do the following:

1. Select the folder.
2. Click the Delete button \( \times \) in the toolbar (or right-click and select Remove) to permanently remove the folder.

**CAUTION:** Removing a catalog folder permanently deletes binders and Vantage store files as described in *Understanding Binders*.

### Configuring a Catalog or Folder Expiration Policy

A catalog or folder expiration policy defines the default expiration policy for *all* binders in the catalog or folder. If you change the expiration for existing binders in a catalog or subfolder, the same policy applies to new binders added to that catalog or folder.

The catalog/folder expiration policy can be overridden by a binder expiration policy as described in *Configuring a Binder Expiration Policy*.

To configure the binder expiration policy, do the following:

1. Right-click a catalog or folder to configure, and select Properties (see the figure below).
2. Edit the binder expiration date or check the Never Expire checkbox. Checking *apply to subfolders* applies the expiration date to all folder levels in the catalog.
3. Check *Transient* if you want a catalog or folder to be deleted when all binders it contains expire, leaving it empty. If *Transient* is not checked, the catalog or folder is not deleted when empty.
4. Check *apply to subfolders* to apply the *Transient* attribute to all folder levels in the catalog, or leave it unchecked to apply the attribute only to the current level.
5. Click OK.

**Note:** The expiration policy can be set for individual binders when they are registered in a catalog; this is done using the workflow Register action.
Managing Binders

The following topics describe binder management concepts and tasks:

- Understanding Binders
- Managing Binders with the Vantage Management Console
- Creating and Deleting Binders
- Submitting Binders from the Vantage Management Console
- Renaming a Binder
- Configuring a Binder Expiration Policy
- Managing Media Files in a Binder
- Managing Metadata Labels in Binders
- Managing Binder Attachments

Understanding Binders

When a workflow executes, Vantage creates a job and a binder. A binder is not a physical entity like a folder but a temporary list or collection of information for a particular job that is created when a workflow runs. The binder points to input files, output files, temporary files, metadata labels, and other references used by that job. The references in a binder identify both media files and non-media attachment files such as XML or PDF files.

Vantage uses binders as follows:

- Records the locations of all media files, attachment files, temporary files, and output files for a job.
- Stores metadata labels for a job.
- Retains job information for evaluation by a Vantage Workflow Portal operator and submission to a new workflow.
- Determines which files can be deleted when Vantage is done with a binder.
- Allows you to return to a job after processing and locate or view the files.

To manage binders, you need to understand how the workflows in your Vantage domain use the binders. For example, one workflow might be designed to produce output to be evaluated by a Vantage operator for approval. If the operator approves the output, the operator might forward the output of the first workflow to a second workflow for processing. When the output is forwarded, what is actually forwarded is the binder, which contains all the file references and metadata needed for the next job.

In the preceding example, the binder must be retained long enough for the operator to become aware of job completion, evaluate the results, and make a decision. You might want to retain the binder for an extra day, week, or month, for auditing purposes. However, if your business creates many workflows, you will eventually want to delete the binder and related temporary files to conserve disk space.
Vantage stores binders in the Vantage domain database. By default, binders are deleted according to an expiration policy defined for each workflow in Vantage Workflow Designer. Workflow designers can also use Workflow Designer to manually delete jobs, which deletes the associated binders. This default setting places binder management under the control of Vantage workflow designers.

To extend binder management to support access from Vantage Management Console or Vantage Workflow Portal, you can use the Vantage Management Console to create catalogs (see Managing Catalogs). A catalog serves as a container or folder to which a binder can be associated. Because each catalog has its own expiration policy, some additional conditions must be met before a binder is deleted. Binders and the related temporary files are deleted only when all the following are true:

- The job expiration time is exceeded or an operator has deleted the job.
- The binder expiration defined in the catalog is exceeded or the binder is deleted.
- Temporary files to be deleted are not being used by any other unexpired binder.

**Note:** Only files in a Vantage Store are automatically deleted according to the above rules. By default, a Flip action output is saved to a Vantage store, so you should change the Flip output location or use a Copy, Deploy, or Move action to place files that you want to keep in an output directory. Files in an input or output folder can be deleted using a workflow Delete action, but such files are not automatically deleted when a job expires.

To associate a binder with a catalog, Workflow designers add a Register action to a workflow and configure it for the appropriate catalog. The Register action and catalog are required to retain a binder beyond the expiration period and keep it under the control of the Workflow Designer.

**Note:** TrafficManager workflows that use the Dublist action require that the binder name be set to match the ISCI code in the catalog. This ensures the binder and catalog are matched up when processed by the Workorder Monitor action.

As a Vantage administrator, you might need to manage binders as follows:

- Establish binder expiration times, so that the binders and related temporary files are deleted (to conserve disk space) at an appropriate time after job completion.
- View binder contents to evaluate or troubleshoot workflow operation.
- Submit a binder to a workflow to test workflow operation.
- Create, delete, rename, and modify binders as needed to support the development of workflows and manage Vantage resources.
Managing Binders with the Vantage Management Console

Vantage Management Console provides binder management only for binders that are associated with a catalog. The following tasks must be completed before you can manage binders with the Vantage Management Console:

1. You must create catalogs if you plan to use the Workflow Portal.
2. To use a catalog, you must create a workflow with a Register action that registers the binders containing your processed media files into catalogs.
3. Submitting a job to the Register workflow processes your media files, organizes them into binders, and registers the binders into catalogs.

When binders are associated with a catalog, you can manage binders as follows:

1. In the Management Console components panel, select Catalogs.
   Vantage displays the Catalogs details panel shown in the figure below.
2. In the Catalogs details panel, select a catalog in the list on the left; then select a binder from the list on the right.
Creating and Deleting Binders

In normal operations, binders are created when a new job starts, and they are deleted as described in *Understanding Binders*.

**Note:** The Vantage Management Console controls for creating and deleting binders are provided for testing and troubleshooting, not for regular maintenance.

To create a new binder, do the following:
1. Select the catalog to which you want to add the binder.
2. Click the New Binder button (or right-click the catalog and select New Binder).
   The Management Console displays a file system dialog so that you can navigate to and select the media you want to assign the binder.
3. Select the target media file and click Open to create the binder for this media file.

To delete a binder, do the following:
1. Select the catalog and folder in which the binder resides.
2. Select the binder to remove.
3. Click the Delete button.

**CAUTION:** Removing a binder permanently deletes Vantage store files as described in *Understanding Binders*. 
Submitting Binders from the Vantage Management Console

You can use the catalog feature in the Vantage Management Console to submit binders to workflows. Binder submission in the Vantage Management Console is intended as a test/diagnostic feature and is not recommended for regular use in production.

When submitting a binder, it is your responsibility to ensure that the binder contains the requisite items (source media, metadata labels and/or attachments) that the targeted workflow requires. If the binder specified does not contain all of the required items, the job will fail.

To submit a binder to a workflow from the Vantage Management Console:

1. Select the catalog and folder in which the binder resides.
2. Right-click a binder and select Submit To Workflow.
3. When the Submit To Workflow dialog appears, select a target workflow.
4. If you need to submit variables with the binder, do the following:
   a. Click the Variables button. The Management Console displays the Select Variable dialog:
      b. To add variables to the Variable list, click the Add Variable button, select one or more variables (control-click), and click OK.
**Configuring Vantage Workflow Components**

### Managing Binders

**c.** To change a variable value, select a variable and change the value (which appears below the list).

The Vantage Management Console displays the Variables dialog, with the selected variables listed, so you can update the values:

![Variables Dialog](image)

**d.** When all the variable values are set, click OK.

**5.** In the Submit To Workflow dialog, click Submit to process this binder using the selected workflow.

To view job processing, open Workflow Designer, select the workflow, and click the Job Status tab.

### Renaming a Binder

To rename a binder, do the following:

1. Select the catalog and folder in which the binder resides.
2. Right-click a binder and select Properties.
3. Edit the binder name and click OK.
Configuring a Binder Expiration Policy

The binder expiration policy overrides the binder configuration policy inherited from the parent catalog or folder.

To configure the binder expiration policy, do the following:

1. Select the catalog and folder in which the binder resides.
2. Right-click a binder and select Properties.
3. Edit the binder expiration date or check the Never Expire checkbox.
4. Click OK.

**Note:** The expiration policy can be set for individual binders when they are registered in a catalog; this is done using the workflow Register action.

Managing Media Files in a Binder

To view and manage the media files referenced in a binder, click the target binder in the binder list, then click the Media Files tab. You can add and delete media file references to a binder, and you can rename the media file names listed in the binder.

Each binder may also contain references to metadata and attachments. You can view and manage these items by clicking the appropriate tab. You can also right-click a binder and select Properties to change the binder name or expiration policy.

Adding a Media File Reference

When you add a media file to a binder, you select the file from a browse dialog, name the media file, and specify a *media nickname*.

Within a binder, each media and attachment file has a nickname; these nicknames are how Vantage workflows access the underlying files. Nicknames serve a dual purpose. First, because they are abstracted from the actual location of the underlying files, it allows workflows to be designed without worrying about the underlying file locations. Second, when a step in a workflow requires one or more input files, nicknames allow Vantage to pre-validate the workflow and availability of nicknames prior to execution.
However, binders may in fact be processed by more than one workflow simultaneously (either by using the Forward action or using the Vantage Workflow Portal). When this happens, Vantage cannot pre-detect which nicknames are necessary in each separate workflow. Administrators who build workflows in this way must take care to ensure that their design does not cause files necessary in one workflow to be deleted by another.

To add a media file reference, do the following:

1. Click the Add Media File button in the toolbar (or right-click in the empty list area and select Add Media File).
2. In the Select the Media Version text box, type a media nickname or select an existing media nickname from the drop down list.
3. Click the Browse button and use the browse dialog to select a media file.
4. In the Enter the Name text box, enter the media file name that appears in the binder.

**Note:** The filename you specify in this dialog applies only to the name displayed in the binder. The original media filename remains unchanged.

### Removing a Media File Reference

To remove a media file reference from a binder, select the file, and click the Remove button in the toolbar (or right-click and select Remove).

**Note:** Removing a file reference from a binder does not delete the source media file.

### Renaming a Media File Reference

To rename a media file reference, click the media file name, and enter a new name (or right-click and select Rename, and enter a new name).

**Note:** Renaming a media file does not rename the source media file.

### Previewing a Media File

To preview files in the Vantage Workflow Portal, use a workflow to create proxies in either the QuickTime H.264 or MP4 x264 format, and register the proxies into catalogs. Then use the portal to access the catalogs and preview the proxies.

You can use the Vantage Management Console to preview ASF, WMV, and MP4 media files. Select the media file on the Media Files tab, and use the playback controls below the media display area to the right of the Media Files tab.

**Note:** You can also preview ASF, WMV, and MP4 media directly in the Workflow Designer (right-click a job on the Job Status tab and select View Binder).
Managing Metadata Labels in Binders

Metadata labels in a binder are stored in the Vantage domain database. Only one of each type of metadata label can be part of a binder (for example, a binder may contain one Identify label and one Curtains label, but not two Identify labels). Some labels may contain information that is specific to one media file—for example, an Identify label will typically contain file properties for one of the media files in a binder, not necessarily all of them.

You can use the Vantage Management Console to view and manage the metadata labels assigned to a binder. To view, add, delete, or modify the labels assigned to a binder, start by clicking the target binder in the binder list, then click the Metadata Labels tab.

Note: This topic discusses metadata label use with binders. For additional metadata label management information, see Managing Metadata Labels.

Adding a New Label

To add a new label, click the Add Labels button in the toolbar (or right-click the empty file area and select Add Labels).

The Management Console displays a label list, so you can select the label you want to assign to the binder. Select the label and click OK to add the label to the binder.

Removing a Label

To remove a label reference from a binder, select the label to remove, and click the Remove Label button in the toolbar (or right-click and select Remove).

Note: This procedure removes the reference in the binder; it does not remove the metadata label from the Vantage domain.

Modifying Label Parameter Values

To modify a label parameter value for the binder, select the label to display the parameters and values in the parameter detail table on the right. Select the parameter to edit and make your changes. Click Save to update the Vantage domain database with your changes.
Managing Binder Attachments
To view and manage attachments—-independent files associated with this binder—
click the target binder in the binder list, then click the Attachments tab. Binders can
contain multiple attachments. You can add, delete and rename attachments.

Adding a New Attachment
To add a new attachment, click the Add Attachments button in the toolbar (or right-
click in the empty list space and select Add Attachment).

The Management Console displays a file system dialog so that you can navigate to and
select the file you want to assign the binder. Select the target attachment file, select an
attachment tag, enter a name, and click OK to add the file reference to the binder for
this media file.

Removing an Attachment
To remove an attachment, select the attachment to permanently remove, and click the
Delete button in the toolbar (or right-click and select Remove).

**Note:** Removing an attachment does not delete the underlying file.

Renaming an Attachment
To rename an attachment, select the attachment to rename, and enter the new name
(or right-click and select Rename to enter the new name).

**Note:** Renaming an attachment does not rename the underlying file.
Capturing Inventory

The Capture Inventory panel works only with the Lightspeed Live server. Refer to the *Lightspeed Live Capture Guide* for configuration details.

In general, the Capture Inventory panel allows assembling of an “address book” or a list of live sources available to this domain via Lightspeed Live servers.

Local SDI input sources are available when the Vantage Live service is added to the domain. You can click on a source to see the configuration panel and select configuration options. If you want to preview a source, click the Preview button 📋.

After sources are listed here, they become available to the Capture action for inclusion in Vantage workflows.

The right columns report the source Address and Status. You can use these columns as a quick way to verify source availability.
Adding a Remote Source

If a Vantage Capture service is running in the domain, remote sources associated with the service can be added to the Capture Inventory list. To add a new remote capture source to the domain, follow these steps:

1. Click the Add a new remote capture source button in the toolbar. Vantage displays a list of sources available.
2. Select the source you want to add, and click OK. The Vantage Management Console adds the new source to the inventory list.
3. Enter a Name, Description, and Address, and make selections in the Configuration panel (see the Lightspeed Live Capture Guide for details).
4. Click the Save button.

Previewing a Capture Source

To preview a capture video source, click the source in the list, and click the Preview button.

Renaming a Source

To rename a source definition, select it in the list, edit the details, and click the Save button.

**Note:** Once a source is given a name, the name may be changed only if the source is NOT in use (not referenced by an action). To rename a source that is in use, you must first update the actions that use it to stop using that source. You can then rename the source, and update the actions again to use the new source name.

Modifying the inventory list to add a NEW named source has NO effect on running actions. You must edit the actions before they can recognize the new named Source.

Finding Sources in Workflows

To locate workflows that use a particular capture source, select the source from the list and select the Find workflows using this capture source button. Affected workflows are listed.

Deleting Sources

To remove a source from the list, click the Delete button in the toolbar (or right-click and select Delete). Click Yes in the warning to confirm.

**Note:** Sources can be deleted only if they are not used anywhere. First update all actions that use the source to stop using it, then delete the source. When you remove a source from the list, the source is not disconnected—it is simply not available to Vantage workflows.
Exporting and Importing Sources

Vantage allows you to export capture source descriptions to XML files, which you can then use to import the source descriptions into another Vantage domain.

To export all sources, click the Export drop down menu and select Export All.

To export selected sources, follow these steps:

1. Select the source to export. Ctrl-click or Shift-click to select multiple sources.
2. Click the Export button to export a single source (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported source description.
   The default file name is the source name, but you can change the file name.

   **Note:** Changing the XML file name does not change the source name in the XML file.

To import a source description, follow these steps:

1. Click the Import button.
2. Navigate to locate and select the source description file to import, then click Open.
   You can only import sources that have been previously exported as XML files.

   **Note:** If you try to import a source description that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Managing Workflow Design Items

The workflow design items described in this topic are configuration options that support workflow design, operation, and management. Some of these configuration options can be set for individual workflows using the Vantage Workflow Designer, but some configuration options are only available in the Vantage Management Console.

The following topics describe how to configure workflow design items using the Vantage Management Console:

- Managing Vantage Workflows
- Enabling Lightspeed Fallback
- Enabling and Disabling Expiration of Failed Jobs
- Setting the Vantage Workflow Designer Grid Width/Height
- Managing Workflow Categories
- Managing Media Nicknames
- Managing Metadata Labels
- Managing Attachment Nicknames
- Managing Variables
- Managing Scripts
- Managing Style Sheets
- Managing Actions
- Managing Nexus Definitions
Managing Vantage Workflows

Typically, workflow designers manage workflows using Vantage Workflow Designer, and workflow operators manage the jobs that use workflows using Vantage Workflow Portal. The Vantage Management Console provides a limited set of workflow management options that allow you to do the following:

- View the workflows in a domain, sorted by category
- Select a workflow and open that workflow in Vantage Workflow Designer
- Export workflows to files for portability to other domains
- Import workflows previously exported to files

The following topics describe how to manage workflows with the Vantage Management Console:

- Managing Workflows with the Vantage Management Console
- Opening Workflow Designer and a Workflow from the Vantage Management Console
- Exporting Workflows
- Importing Workflows
- Refreshing the Workflow List
Managing Workflows with the Vantage Management Console

Access workflow management in the Vantage Management Console as follows:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Vantage Workflows.
   Vantage displays the Vantage Workflows details panel shown in the figure below.
3. Double-click the category folders to hide or display the workflows in the categories.

![Vantage Workflows Details Panel](image)

Opening Workflow Designer and a Workflow from the Vantage Management Console

You cannot edit a workflow with the Vantage Management Console, but you can select a workflow listed in the Vantage Management Console and open that workflow for management using the Vantage Workflow Designer. To launch Vantage Workflow Designer from Vantage Management Console and manage a workflow, select the workflow in Vantage Management Console and click the Workflow Designer button.

*Note:* If Vantage Workflow Designer is already open behind the Vantage Management Console, the Workflow Designer button flashes in the task bar. Click the task bar button to display the Workflow Designer in front of the Vantage Management Console.
Exporting Workflows

Exported workflows are saved as XML files which can be directly re-imported back into Vantage. Items exported with workflows include media nicknames, attachment nicknames, variables, metadata labels, stores, and output folders. Items not exported are style sheets and catalogs; however, these items can be exported separately.

To export a workflow or categories with workflows, follow these steps:

1. In the Vantage Workflows panel, double-click a category folder to open it, and select an individual workflow to export. Alternatively, you can select a category folder to export the category and all the workflows it contains.

2. Click the Export button or right-click and select Export. You can also click the Export button drop down list and select Export Workflows In Selected Category.

To export all or multiple categories and workflows together, click the Export button drop down list and select Export Workflows By Category. The Vantage Management Console displays a dialog with all categories listed. Check the ones you want to export, and click OK.

3. Use the file system dialog to save the workflows in the desired location.

If categories or workflow files having the same names already exist in the selected location, the Export dialog asks if you want to overwrite the existing file, rename it, or Cancel the operation. Additionally, a checkbox offers the option to “do this for all additional collisions” during the export. Check the box to apply your selection to all collisions, or uncheck to decide how to handle each collision individually.

The exported workflows are stored individually as XML files or in folders named for the workflow categories that contain the workflows. Each exported file and category folder is named the same in the file system as it is named in Vantage.

Note: Telestream recommends not changing exported file or category names.
Importing Workflows

To import one or more XML workflow files or categories and files, follow these steps:

1. Click the Import button . Alternatively, you can click the Import button drop-down menu or right-click in the workflows area, and select an option.

   If you use the drop-down or context menu, you can Import Workflow(s) individually, or you can Import Workflows by Category, which imports all or selected categories and their workflows from a containing folder.

2. Navigate to the individual XML file or to the folder containing the workflow categories. Select the workflow file and click Open, or click Select Folder if you chose Import Workflow By Category. An Import dialog box opens.

   ![Import Workflow(s) dialog box](image)

3. In the Import dialog box, select the category for the file you are importing from the drop-down menu (or leave Imported as the default category), or select multiple categories if you are importing by category. (Select All lets you check or uncheck all categories at once.)

4. For individually imported files, you have additional category options: You can select the *Use folder name* checkbox to use the name of the folder where the workflow is currently stored, or you can type a new category name.

5. Click OK to import the file or the categories and files.

**Note:** When an imported workflow includes a variable of the same name and type as a variable in the domain database into which you are importing, Vantage updates the imported workflow to use the existing domain variable. This eliminates the problem of duplicate variables in the database after an import. However, if the variables have the same name but different types, the imported variable is added to the domain database. In this case, two variables of the same name will exist in the domain database.

Refreshing the Workflow List

To refresh the list of Vantage workflows, click the Refresh button .
Enabling Lightspeed Fallback

To ensure your Lightspeed jobs are still processed even when no Lightspeed servers are available, you can check the Enable Lightspeed Fallback option in the Vantage Management Console Settings and Options under the General tab. This will allow Lightspeed actions to execute in CPU multi-core mode rather than GPU mode so that any available CPU-based server can pick up the job. The fallback option is enabled by default.

Enabling and Disabling Expiration of Failed Jobs

To use storage space efficiently, Vantage can regularly delete binders and any associated temporary files related to failed jobs.

**Note:** The feature only deletes binders and job-related files in a Vantage Store. By default, Flip action output is saved to a Vantage store, so you should use a Copy, Deploy, or Move action to place files that you want to keep in an output directory. Files in an input or output folder can be deleted using a workflow Delete action, but files in input and output folders are not automatically deleted when a job expires.

Each job has an expiration time and date, which can be disabled. If a job completes successfully and job expiration is enabled, the binder and all job-related files in the Vantage store are deleted when all the following are true:

- The job expiration time is exceeded or an operator has deleted the job.
- The binder expiration time for the catalog is exceeded or the binder is deleted.
- Temporary files to be deleted are not being used by any other unexpired binder.

If a job fails and the expiration period ends, the job is either retained or deleted, depending on configuration. When the Expire failed jobs feature is enabled, all job-related files in the Vantage store are deleted as described above for completed jobs. When Expire is disabled, the binder and job files are retained until manually deleted.

To enable or disable expiration of failed jobs, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Settings and Options.
3. Select the General tab.
4. To enable expiration of failed jobs, check the *Expire failed jobs* checkbox.
5. To retain failed jobs until manually deleted, clear the *Expire failed jobs* checkbox.
6. Click the Save button .
Setting the Vantage Workflow Designer Grid Width/Height

Vantage Management Console allows you to define the width and height values for the Vantage Workflow Designer grid. To define these values, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Settings and Options.
3. Select the General tab.
4. Enter the width and height values.
5. Click the Save button.

Managing Workflow Categories

Workflow categories are folders that contain workflows. These folders can be created or deleted in Vantage Workflow Designer or Vantage Management Console. When managing categories in the Vantage Management Console, you can also do the following:

- Duplicate categories
- Export and import category folders
- Define which Vantage users can access the workflows in a category

To configure categories with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Workflow Categories.
   - Vantage displays the Workflow Categories details panel shown in the figure, below.
3. Configure categories using the controls shown and listed in the following figure and table.
4. Configure user access to a category by selecting the category and clicking the Permitted Users tab. Select Everyone (the default) to allow all users access to the category. To restrict access, uncheck Everyone, and use the Add/Remove buttons to move users from the Available list on the left to the Permitted Users list on the right. This enables configuration access for only those users in the Permitted Users list.
5. Click the Save button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Click the Create button to create a new category (folder). Categories can also be created in the Workflow Designer.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete button to delete a category (folder). A warning about losing all workflows in this category is displayed to prevent accidental removal of workflows.</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save button to save changes made in user permissions. If changes are not saved, you will be prompted to save upon leaving that category.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Click the Duplicate button to duplicate a selected category. Only the category (folder) is duplicated. None of the workflows in the folder are duplicated. However, all of the user permissions are duplicated in the new folder.</td>
</tr>
</tbody>
</table>
Import

To Import Categories from previously exported category XML files, click the Import button. A file system dialog opens, allowing you to navigate to the category files you want to import. Select the desired category XML files (Shift-click or Ctrl-click to select multiples), and click OK.

**Note:** If you attempt to import a category that is already present in the domain, Vantage prompts you to overwrite the category (click Yes) or cancel the import (click No). Only categories are imported, not the workflows they contain. To import categories and workflows, select Vantage Workflows and Import Workflows By Category.

Export

To export selected categories to XML files, select the Categories (Shift-click or Ctrl-click to select multiples), and click the Export button or click the drop-down menu next to the Export button, and use Export Selected. To export all categories, use the drop-down Export All selection next to the Export button.

A file system dialog opens, allowing you to navigate to the server and directory where you want to save the XML files. You can save individual categories (Export Selected), or save all categories (Export All). The XML files by default are named the same as the category names, but can be changed before saving.

**Note:** Changing the name of the XML file does not change the name of the category in the XML file. Exporting categories does not export the workflows they contain. To export categories and their workflows, select Vantage Workflows and Import Workflows By Category.

Refresh

Click the Refresh button to update the list of categories.
Managing Media Nicknames

The following topics describe media nickname management concepts and tasks:

- Understanding Media Nicknames
- Managing Media Nicknames with the Vantage Management Console
- Creating Media Nicknames
- Deleting Media Nicknames
- Exporting and Importing Media Nicknames
- Selecting All Unused Media Nicknames
- Searching for Media Nicknames in Workflows

---

**Note:** Workflow designers can only define new media nicknames in Vantage Workflow Designer. Vantage administrators must perform all other nickname management tasks.

---

**Understanding Media Nicknames**

A media nickname serves as an alias for a media file within a workflow. Without media nicknames, workflow designers would need to refer to the full path and name of each file in every workflow action that uses a file. When a media nickname is assigned to a file, the workflow designer can simply refer to the nickname; Vantage associates the full path and file name of the actual file with the nickname.

Vantage requires that a workflow designer associate a media nickname with every unique media file that is processed by a workflow. This means that each input media file must be assigned a nickname, and every unique output media file must have a nickname.
Vantage provides the default media nicknames described in this table.

<table>
<thead>
<tr>
<th>Media Nickname</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPP CML</td>
<td>This media nickname is used by the DPP portal and identifies the CML created that will render a valid DPP timeline using Post Producer.</td>
</tr>
<tr>
<td>Original</td>
<td>This media nickname can be used to specify an input media file.</td>
</tr>
<tr>
<td>Vantage EDL</td>
<td>This media nickname identifies media than contains an Edit Decision List (EDL).</td>
</tr>
<tr>
<td>Vantage Proxy</td>
<td>The Vantage Proxy nickname identifies a file that is suitable for viewing in the preview panel in Vantage Workflow Portal, Vantage Workflow Designer, or Vantage Management Console.</td>
</tr>
<tr>
<td>Vantage Thumbnail</td>
<td>The Vantage Thumbnail nickname identifies a file that contains an image that can be used to visually represent the contents of a media file. Thumbnail images typically represent content when the media file appears in Windows Explorer or in the binder view in Vantage programs.</td>
</tr>
</tbody>
</table>

The media nicknames make it easier to manage files in a workflow. Consider the following:

- When a media file is input to a workflow, either manually or automatically from a watch folder, the workflow origin action immediately assigns a nickname (typically Original) to the file. The workflow designer does not need to know the name of the input file, so the same workflow can be used with any suitable media file, regardless of the media file name.

- When the workflow designer configures a Flip action to transcode the input file, the designer specifies the input file nickname (typically Original) and a different output file nickname. Selecting nicknames is as easy as selecting them from a dropdown list or entering a new nickname.

- Actions displayed in Vantage Workflow Designer display media nicknames on the action, which makes it easier to visualize how the workflow processes a file.
Managing Media Nicknames with the Vantage Management Console

To start managing media nicknames with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Media Nicknames.

Vantage displays the Media Nicknames details panel shown in this figure.

Creating Media Nicknames

To create a new nickname, click the Create Nickname button in the toolbar. The Vantage Management Console displays a Create Media Nickname dialog. Enter the name of this nickname and click OK.

The Vantage Management Console adds this nickname to the table. Optionally, add a description and click the Save button.

Note that you can’t rename media nicknames after you create them. To rename, create a new nickname and delete the old one, being sure to update all affected workflows.
Deleting Media Nicknames

To permanently remove a media nickname from the domain, select the nickname and click the Delete button \( \times \) in the toolbar (or right-click and select Delete). Click OK to confirm the deletion.

Exporting and Importing Media Nicknames

Vantage allows you to export media nicknames to XML files, which you can then use to import the same media nicknames into another Vantage domain.

To export a media nickname, do the following:

1. Select the media nickname to export.
2. Click the Export button \( \text{Export} \) (or drop-down menu, or right-click and select Export).
3. Use the file system dialog to save the exported media nickname.

   The default file name is the media nickname, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the media nickname in the XML file.

To import a media nickname, do the following:

1. Click the Import button \( \text{Import} \).
2. Locate and select the media nickname to import, and click Open.

**Note:** If you try to import a media nickname that is already in this Vantage domain, Vantage warns you that it will overwrite the existing media nickname.

Selecting All Unused Media Nicknames

To locate all unused media nicknames, click the Select All Unused icon \( \text{Select All Unused} \). If any unused items are found, they are highlighted. This is useful if you have deleted workflows and want to find and delete associated items that are no longer needed.

Searching for Media Nicknames in Workflows

Vantage allows you to search all workflows in a domain for a media nickname. This is very useful when you need to change or delete a nickname, and you want to know which workflows might be affected by the change.

To search for media nicknames, do the following:

1. Select the media nickname for which you want to search.
2. Click the Search button in the toolbar (or right-click and select Find Workflows). If the media nickname is used in any workflows, Vantage displays a list of workflows that use the nickname. Double-click any workflow in the list to open that list in Vantage Workflow Designer. Click Done to dismiss the list.

If the media nickname is not used in any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.

Managing Metadata Labels

The following topics describe Vantage metadata label concepts and management tasks:

- Understanding Metadata Labels
- Vantage Metadata Label Applications
- Managing Metadata Labels with the Vantage Management Console
- Creating Metadata Labels
- Adding Metadata Label Parameters
- Duplicating a Parameter within a Metadata Label
- Adding a Copy of a Metadata Label Parameter to Another Metadata Label
- Deleting a Metadata Label Parameter
- Modifying Metadata Labels and Parameters
- Previewing Metadata Labels and Values
- Sorting Metadata Label Parameters
- Exporting and Importing Metadata Labels
- Searching for Metadata Labels in Workflows
- Selecting All Unused Metadata Labels

Note: Workflow designers can use Vantage Workflow Designer to perform some metadata label management tasks. Operators can also edit metadata in Vantage Workflow Portal. Only Vantage administrators can use Vantage Management Console, where you can create, export, import, and delete metadata labels.
Understanding Metadata Labels

Vantage supports metadata attachments and metadata labels. Metadata attachments are separate files that contain data about associated media. Metadata labels are stored in the Vantage database and can be designed by an administrator to carry whatever metadata is needed in the workflow. In Vantage, metadata labels are defined using the Vantage Management Console and can be used to manage data within and between workflows.

Each metadata label has a name and is comprised of one or more parameters. Each parameter has a name and holds a data value that conforms to a data type, such as text, date, timecode, or integer.

Vantage provides a comprehensive list of metadata labels with parameters for use in Vantage workflows. You can also define custom labels with custom parameters.

During workflow processing, metadata labels can be populated with the following types of data:

- Data imported from metadata attachments
- Data from workflow analysis (Analysis, Examine, and Identify actions)
- Data from workflow variables (Metadata Populate action)
- Data from work orders
- Data from commercial providers (from catch servers)
- Data entered by Vantage Workflow Portal operators

During workflow processing, metadata label content can be used to do the following:

- Provide media information in the Workflow Portal to operators, who use the information to make media processing decisions
- Provide media information to workflow processes for automated decision processing
- Output media information to metadata attachments for use after workflow processing
- Add metadata labels to the output media (embedded in the media file)
Vantage Metadata Label Applications

The following are some examples of how metadata labels can be used with workflows:

- **Operator selection of distribution channels**—An ingest workflow can be used to collect data and populate metadata labels. When the ingest workflow completes, an operator examines the asset in the Workflow Portal, and sets where media should be sent within a metadata label that is used by a target workflow to choose a distribution channel.

- **Easier operator selection of trim points and thumbnails**—An ingest workflow can be used to generate a proxy media file, which the operator can use to review media. During review, the operator can use **hotkeys** to instantly transfer timecodes for the trim points and thumbnail to metadata labels, and the label timecode values can be used in the target workflow to trim the media and generate a thumbnail. Also, three timecode metadata parameters can be grouped together as a **Trim Group**, which automatically calculates and displays the difference between a **Mark In** and **Mark Out** point to show a duration. Once a trim group has been set in a label, the operator can submit the job, and the trim information can be applied during a transcode.

- **Metadata addition to media output files**—For media formats that support metadata, a workflow can be configured to collect metadata from operators or populate the metadata with default values.

- **Quicker location and evaluation of macroblocking**—An ingest workflow can be configured to detect the worst macroblocking in input media and store the frame timecode in a metadata label. An operator can then use the label timecode value to quickly locate the issue and evaluate the severity.

- **Flexible graphics and title insertion**—With the addition of a template for Post Producer, the same workflow and template can be reused for multiple applications by using metadata labels to define a graphic file to insert, title text to insert, and timecodes for placement.

- **Operator specification for automatic commercial insertion**—As with trim points and thumbnail selection, proxy media from an ingest workflow can be used with hotkeys and metadata labels to simplify operator specification for commercial insertion. After the metadata labels are populated, a target workflow can automatically insert commercial media at the point specified by the metadata labels.
Managing Metadata Labels with the Vantage Management Console

To start managing metadata labels with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Metadata Labels.
   Vantage displays the Metadata Labels details panel shown in the following figure.
   On the left of the panel, the Design area allows label designers to create, edit, sort and remove parameters. On the right, the Preview area shows the label designer what the label will look like within the Workflow Portal during data entry.

Creating Metadata Labels

To create a new metadata label, do the following:

1. Click the New Label button to create a new metadata label (far left) in the toolbar.
2. In the dialog that appears, enter a name for the new metadata label, and click OK.
   Metadata label names are case-sensitive. For example, FrameHeight and frame-height are different labels.
3. If desired, enter a description for the metadata label.
4. Add metadata label parameters as described in Adding Metadata Label Parameters.
5. Click the Save button .
Adding Metadata Label Parameters

To add a metadata label parameter, do the following:

1. Click an existing metadata label name, or create a new metadata label as described in Creating Metadata Labels.
2. Click the Create Parameter button ☐ in the design toolbar.
3. Enter a name for the new parameter.
4. If desired, do the following to configure the parameter:
   a. Enter a description for the new parameter.
   b. Enter a category name.
      Categories can be used to group logically related parameters. Parameters with the same category name are grouped together in the parameter list. If no category is specified, the parameter displays in the Misc category.
   c. Select a parameter value type from the dropdown list of values.
   d. Click the password option if you want the parameter value to be obscured by asterisk (*) characters. This option is only available for Text parameters.
   e. Click the Required option if a value for this parameter must be supplied.
   f. Optionally enter or select a Max Length to indicate the maximum length of a string for a label parameter whose type is text. Zero (0) = no length limit.
   g. To define a list of optional values for the parameter, click the Modify button, enter one value per line, and click OK. This option is only available for Text, Path, and Mail Address parameters.
      This feature can be used to create a dropdown list to reduce the chance of data entry errors. For example, you might create a Ratings parameter and specify the terms G, PG, PG-1, TV-14, and R. Operators can then use a dropdown list in the Vantage Workflow Portal to select one of these values, instead of typing the value.
   h. To limit the parameter value to one of the values defined with the Modify button, check the Exclusive checkbox.
      In the above example for a Ratings parameter, checking the Exclusive checkbox limits operators to selecting one of the specified ratings. Operators are not allowed to type in a rating.
   i. To define a default value for the parameter, enter the default value in the Default Value text box, or select a default value from the dropdown list.
      The entry options depend on the other parameter value option settings.
   j. To change the displayed order of parameters, select a parameter in the parameter list and use the green up ☐ and down arrow ☐ buttons to move the variable in the list. You can also Ctrl-click or Shift-click to select multiple parameters.
      The parameter list order that you define configures the order of parameters displayed in Vantage Workflow Portal.
**Configuring Vantage Workflow Components**

**Managing Workflow Design Items**

To view parameters organized by category or as a flat list without categories, toggle the Categorize button.

---

**Note:** The Categorize button affects only the display of label categories in this Preview/Test area and does not change the way label categories appear in any other Vantage display.

5. Click the Save button.

**Duplicating a Parameter within a Metadata Label**

To add a parameter that is a copy of another parameter in the same metadata label, do the following:

1. Select the parameter to copy. (Ctrl-click or Shift-click to select multiple parameters.)
2. Open the Copy button drop down list in the Design toolbar and select Duplicate selected (or right-click and select Duplicate).
3. Modify the parameter options and values as needed.
4. Click the Save button.

**Adding a Copy of a Metadata Label Parameter to Another Metadata Label**

To add a copy of one parameter to a different metadata label, do the following:

1. Select the parameter to copy. (Ctrl-click or Shift-click to select multiple parameters.)
2. Open the Copy button dropdown list in the Design toolbar and select Copy selected (or right-click and select Copy).
3. Select the metadata label to which you want to copy the parameter.
4. Click the Paste button in the Design toolbar.
5. Modify the new parameter options and values as needed.
6. Click the Save button.

**Deleting a Metadata Label Parameter**

To delete a parameter from a metadata label, do the following:

1. Select the parameter to delete. (Ctrl-click or Shift-click to select multiple parameters.)
2. Click the Delete button in the design toolbar (or right-click and select Delete).
3. Click the Save button.
Modifying Metadata Labels and Parameters

To modify a metadata label, do the following:

1. Click an existing metadata label name.
2. Make changes to the metadata label description as needed.
3. To modify a parameter, select the parameter and change the parameter settings.
4. Click the Save button.

Note that to rename labels, you must create a new label or duplicate and rename an existing label and delete the old one, being sure to update all affected workflows.

Previewing Metadata Labels and Values

To preview a metadata label and its values, select the label. All parameters for that label appear in the Preview/Test panel.

To toggle the display or to include or exclude category names, click the Categorize button. One display state displays parameters with the category headings, and the other display state displays parameters without the category headings.

Sorting Metadata Label Parameters

To change the order of the label parameters in the list, select a parameter (Ctrl-click or Shift-click to select multiple parameters) and click the green up and down arrow buttons on the right side of the label list. Categories will display according to the order of the first parameter in each category as seen in the Preview area.

Deleting Metadata Labels

To permanently remove a metadata label from the domain, select the label and click the Delete button in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: When you delete a metadata label, the deletion can render services and workflows inoperable. Be sure to update all actions and services that used the deleted label. For information on locating workflows that contain a specific metadata label, see Searching for Metadata Labels in Workflows.

Duplicating a Metadata Label

It can be easier to duplicate and rename a metadata label than it is to make a new one. To duplicate a metadata label, do the following:

1. Select the metadata label.
2. Click the Duplicate button in the toolbar (or right-click and select Duplicate).
3. Enter a new metadata label name.
4. Change additional metadata label settings as needed.
5. Click the Save button.
Exporting and Importing Metadata Labels

Vantage allows you to export metadata labels to XML files, which you can then use to import the same labels into another Vantage domain.

To export all metadata labels, click the Export drop down menu and select Export All.

To export one or selected metadata labels, do the following:

1. Select the metadata label to export. Ctrl-click or Shift-click to select multiple labels.
2. Click the Export button to export labels (or right-click and select Export, or select Export Selected from the Export button drop down menu).
3. Use the file system dialog to save the exported metadata labels.
   The default file name is the metadata label name, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the metadata label in the XML file.

To import a metadata label, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the metadata label to import, then click Open.

Note: If you try to import a metadata label that is already in this Vantage domain, Vantage prompts you to either overwrite the existing label (click Yes) or cancel the import (click No).

Searching for Metadata Labels in Workflows

Vantage allows you to search all workflows in a domain for a metadata label. This is very useful when you need to change or delete a metadata label, and you want to know which workflows might be affected by the change.

To search for metadata labels, do the following:

1. Select the metadata label for which you want to search.
2. Click the Search button in the toolbar (or right-click and select Find Workflows).
   If the metadata label name is used in any workflows, Vantage displays a list of workflows that use the label. Double-click any workflow in the list to open that workflow in Vantage Workflow Designer. Click Done to dismiss the list.
   If the metadata label name is not used in any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.

Selecting All Unused Metadata Labels

To locate all unused metadata labels, click the Select All Unused icon. If any unused items are found, they are highlighted. This is useful if you have deleted workflows and want to find and delete associated items that are no longer needed.
Managing Attachment Nicknames

Like media nicknames, an attachment nickname serves as an alias for an attachment file within a workflow. An attachment file might be an XML file, an SCC caption file, an STL subtitle file, a PDF, or any other type of file which does not contain video or audio media. Without attachment nicknames, workflow designers would need to refer to the full path and name of each file in every workflow action that uses a file. When an attachment nickname is assigned to a file, the workflow designer can simply refer to the nickname; Vantage associates the full path and file name of the actual file with the nickname.

Vantage administrators can use the Vantage Management Console to manage attachment nicknames. The following topics describe nickname management concepts and tasks:

- Understanding Attachment Nicknames
- Managing Attachment Nicknames with the Vantage Management Console
- Creating Attachment Nicknames
- Deleting Attachment Nicknames
- Exporting and Importing Attachment Nicknames
- Searching for Attachment Nicknames in Workflows
- Selecting All Unused Attachment Nicknames

**Note:** Workflow designers can only define new attachment nicknames in Vantage Workflow Designer. Vantage administrators must perform all other nickname management tasks.

Understanding Attachment Nicknames

Vantage requires that a workflow designer associate an attachment nickname with every unique attachment file that is processed by a workflow. This means that each input attachment file must be assigned a nickname, and every unique output attachment file must have a nickname. When a media nickname is assigned to an Attachment, the workflow designer can simply refer to the nickname. As an Alias the Nickname contains the file name and the file path to the original file.
Managing Attachment Nicknames with the Vantage Management Console

To start managing attachment nicknames with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Attachment Nicknames. Vantage displays the Attachment Nicknames details panel shown in this figure.

Creating Attachment Nicknames

To create a new nickname, click the Create Nickname button in the toolbar. The Vantage Management Console displays a Create Attachment Nickname dialog. Enter the name of this nickname and click OK.

The Vantage Management Console adds this nickname to the table. Optionally, add a description and click the Save button.

Note that you can't rename media nicknames after you create them. To rename, create a new nickname and delete the old one, being sure to update all affected workflows.

Deleting Attachment Nicknames

To permanently delete a nickname from the domain, click the Delete button in the toolbar (or right-click and select Delete). Click Yes in the warning to confirm.

Note: When you delete a nickname, it will render services and workflows inoperable if the nickname was used in it. Be sure to modify all actions and services that used the nickname you just deleted.
Exporting and Importing Attachment Nicknames

Vantage allows you to export attachment nicknames to XML files, which you can then use to import the same nicknames into another Vantage domain.

To export all attachment nicknames, select Export all from the Export button drop down menu.

To export one or selected attachment nicknames, do the following:

1. Select the attachment nickname to export. Ctrl-click or Shift-click to select multiple nicknames.
2. Click the Export button (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported attachment nicknames.
   The default file name is the attachment nickname, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the attachment nickname in the XML file.

To import an attachment nickname, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the attachment nickname file to import, then click Open.

Note: If you try to import an attachment nickname that is already in this Vantage domain, Vantage prompts you to either overwrite the existing attachment nickname (click Yes) or cancel the import (click No).

Searching for Attachment Nicknames in Workflows

Vantage allows you to search all workflows in a domain for an attachment nickname. This is very useful when you need to change or delete a nickname, and you want to know which workflows might be affected by the change.

To search workflows for an attachment nickname, select the attachment nickname, and click the Search button in the toolbar (or right-click and select Find Workflows).

Vantage displays a message that it is unused or presents a list of workflows using the nickname. Double-click any workflow in the list to open that workflow in Vantage Workflow Designer. Click Done to dismiss the list or OK to dismiss the message.

Selecting All Unused Attachment Nicknames

To locate all unused attachment nicknames, click the Select All Unused icon. If any unused items are found, they are highlighted. This is useful if you have deleted workflows and want to find and delete associated items that are no longer needed.
Managing Variables

The following topics describe variable management concepts and tasks:

- Understanding Variables
- Managing Variables with the Vantage Management Console
- Creating Variables
- Modifying Variables
- Deleting Variables
- Duplicating a Variable
- Exporting and Importing Variables
- Searching for Variables in Workflows
- Selecting All Unused Variables

Note: Workflow designers can create new variables and change variable values in Vantage Workflow Designer. With the proper permissions, operators can use Vantage Workflow Portal to change variable values. Vantage administrators must perform all other variable management tasks using the Vantage Management Console.

Understanding Variables

Variables in Vantage are similar to variables in programming languages. You can create a variable, name it, assign and change its value, and use the variable in workflow actions and services to automate decisions.

Each variable can be configured with a name, description, value type, and default value. The name and type are required, and the description and default value are optional.

The variable type describes what type of value the variable represents. Some supported types include text, date, integer number, and timecode.

The default value is only used by a workflow action when the variable has not been assigned a value earlier in the workflow.

For example, suppose you want a variable named Email that you can use to specify an email address for use in a Message action within a workflow. Also suppose that you want to send the email to a single address most of the time, but you want the option to override the email address in a workflow. To do this, create an Email variable in Vantage Workflow Designer or the Management Console, and set the default value to the email address you want to use most of the time.

During workflow execution, the Message action operates as follows:

- If no other instance of the Email variable is created earlier in the workflow, the email is sent to the address specified by the default value in the email variable.
- If the Email variable is set earlier in the workflow, before the Message action, the email is sent to the address specified by the earlier workflow action.
Managing Variables with the Vantage Management Console

To start managing variables with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Variables.
   
   Vantage displays the Variables details panel shown in this figure.

Creating Variables

Variables are typically created in Vantage Workflow Designer, but you can create variables in Vantage Management Console as follows:

1. Click the Create Variable button in the toolbar.
2. Provide a name for the variable.
   
   Variable names are case-sensitive. For example, FrameHeight and frameheight are different variables.
3. Select a variable type from the Value Type dropdown menu.

   Note: You cannot change a variable type after you save the variable configuration.
4. Enter a default value for the variable.
5. If needed, enter a description for the variable.
6. Click the Save button.
Modifying Variables

Exercise caution when modifying a variable that is already being used by a workflow. If you change the default value of a variable, existing workflows continue to use the older default value until you unbind and rebind the variables in the workflows.

To modify a variable, select the variable, make changes, and click the Save button  

Note: When you modify a variable, the change can render a service or workflow inoperable. Be sure to review all services/actions that use the modified variable. For information on locating workflows that contain a specific variable, see Searching for Variables in Workflows.

Deleting Variables

To permanently remove a variable from the domain, select the variable and click the Delete button  in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: When you delete a variable, the deletion can render services and workflows inoperable. Be sure to update all actions and services that used the deleted variable. For information on locating workflows that contain a specific variable, see Searching for Variables in Workflows.

Duplicating a Variable

It can be easier to duplicate and rename a variable than it is to make a new one. To duplicate a variable, do the following:

1. Select the variable.
2. Click the Duplicate button  in the toolbar (or right-click and select Duplicate).
3. Enter a new variable name.
4. Change additional variable settings as needed.
5. Click the Save button  

Exporting and Importing Variables

Vantage allows you to export variables to XML files, which you can then use to import the same variables into another Vantage domain.

To export all variables, click the Export drop down menu and select Export All.

To export one or selected variables, do the following:

1. Select the variable to export. Ctrl-click or Shift-click to select multiple variables.
2. Click the Export button (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported variable. The default file name is the variable name, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the variable in the XML file.

To import a variable, do the following:

1. Click the Import button .
2. Use the file system to locate and select the variable to import, then click Open.

Note: If you try to import a variable that already exists in the Vantage domain, Vantage prompts you to cancel or confirm replacement of the existing variable with the newly imported variable.
Searching for Variables in Workflows

Vantage allows you to search all workflows in a domain for a variable. This is very useful when you need to change or delete a variable, and you want to know which workflows might be affected by the change.

To search for variables, do the following:

1. Select the variable for which you want to search.
2. Click the Search button in the toolbar (or right-click and select Find Workflows).
   
   If the variable is used in any workflows, Vantage displays a list of workflows that use the variable. Double-click any workflow in the list to open that list in Vantage Workflow Designer. Click Done to dismiss the list.
   
   If the variable is not used in any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.

Note: It is possible to have multiple variables with the same name if a variable already exists and a workflow is imported having a different variable with the same name. This does not pose any problem for Vantage (which uses a GUID number behind the scenes to tell the variables apart), but you may have to search using both variable instances to find all workflows using that variable name. You may also want to change the name of one of the duplicates and update your workflows to prevent confusion.

Selecting All Unused Variables

To locate all unused variables, click the Select All Unused icon. If any unused items are found, they are highlighted. This is useful if you have deleted workflows and want to find and delete associated items that are no longer needed.
Managing Scripts

The following topics describe scripting concepts and tasks:

- Understanding Scripts
- Managing Scripts with the Vantage Management Console
- Adding a Script
- Adding Inputs and Outputs
- Renaming a Script
- Deleting Scripts
- Duplicating Scripts
- Finding Affected Workflows
- Exporting and Importing Scripts

Understanding Scripts

Note: The script feature in Workflow Design Items is limited to use by Telestream authorized personnel only. The license file prevents adding, importing, or modifying scripts by unauthorized users.

This feature allows authorized users to load or write scripts to intake and produce variables for Vantage actions. Management options for scripts include Save, Find in workflows, Export (as XML), Import (as XML), Test, and Delete.

Managing Scripts with the Vantage Management Console

To manage scripts, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Scripts.
   Vantage displays the Scripts panel shown below.
Vantage Management Console Scripts Panel

Adding a Script

**Note:** The license file limits adding or editing scripts to authorized users only. The *Add a new script* button is not available and the Definition panel is read only for unauthorized users.

To add a new script, follow these steps:

1. Click the *Definition* tab to select it, and click the *Add Script* button in the toolbar. Vantage displays a file system dialog, so you can select a script definition file.
2. Name the script.
3. Browse to and select the script file you want to import. (Note that you can also load a script file later by selecting the script name in the list and using the *Load script definition from file...* button at the top of the *Definition* panel to browse for a script.) The Vantage Management Console adds the new script to the table.
4. Select an *Interpreter*, and click OK.
5. Click the *Save* button.

Note that you must also follow the procedure below to specify inputs and outputs to be used in a script.
Adding Inputs and Outputs

Inputs and Outputs must be defined for each script and are used within scripts to specify values used by the Vantage actions.

To add inputs and outputs to a script, follow these steps:

1. Click the script to highlight it in the Scripts list.
2. Click the Input or Output tab to select it, and click the Add New Input/Output button in the toolbar.
   - Vantage displays a file system dialog, so you can select a script definition file.
3. Enter the Field Name and Description of the input or output.
4. Select the Value Type from the drop down menu.
5. Select Save to save the Inputs and Outputs associated with the selected script.

To delete an input or output, select the input or output in the list, and click Delete (red X).

Renaming a Script

To rename a script definition, select it in the table, edit the name to meet your requirements, and click the Save button.

Deleting Scripts

To permanently remove a script from the domain, click the Delete button in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: Removing a script will render services and workflows inoperable if they used that script. Be sure to update all actions and services accordingly. You can use the Find workflows button to find affected workflows.

Duplicating Scripts

To duplicate a script, select it in the list, click Duplicate, rename the copy, make any other desired changes, and click Save to save the duplicated script.

Finding Affected Workflows

If you plan to delete a script, you may want to find any affected workflows first.

To do so, click the script in the list, and click Find workflows using this script. A list of affected workflows is displayed (or a message saying no workflows use the script).
Exporting and Importing Scripts

Vantage allows you to export scripts to XML files, which you can then use to import the same scripts into another Vantage domain.

Exporting

To export all scripts, click the Export drop down menu and select Export All.

To export selected scripts, do the following:

1. Select the script to export. Ctrl-click or Shift-click to select multiple scripts.
2. Click the Export button to export a single script (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported script.
   The default file name is the script name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the script in the XML file.

Importing

**Note:** The license file limits imports to authorized users only. The Import buttons are not available to unauthorized users.

To import a script, do the following:

1. Click the Import button to import a previously exported script in XML format.
   To import a script directly in Powershell format, click *Load script definition from file*....
2. Browse to locate and select the script to import, then click Open.

**Note:** If you try to import a script that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Managing Style Sheets

The following topics describe style sheet management concepts and tasks:

■ Understanding Style Sheets
■ Managing Style Sheets with the Vantage Management Console
■ Adding a Style Sheet
■ Renaming a Style Sheet
■ Deleting Style Sheets
■ Duplicating Style Sheets
■ Finding Affected Workflows
■ Exporting and Importing Style Sheets

Understanding Style Sheets

A style sheet defines how an input metadata format is converted to an output metadata format. A style sheet does not change the metadata values; it changes the presentation of the metadata. The Transform action requires a style sheet, and style sheets can only be managed using the Vantage Management Console.

Style sheets (XSL files) are the keystone of the Transform action. Style sheets enable you to convert one attachment file (XML) into a different attachment (XML file) or to convert the contents of an attachment into a custom label schema and vice-versa. Each style sheet has a nickname to make it easy to assign style sheets in a workflow.

When you are processing media with metadata in a specific XML format and you are creating a workflow to convert the XML file into a different format or into a specific contextual metadata structure (for example, a label); you will need to provide a style sheet to perform the transformation.

When you add a new style sheet to your Vantage domain, the style sheet itself is wrapped in an XML file, providing a structure for the Vantage metadata: the name, description and identifying GUID.

Style sheets selected in the Vantage Management console can be edited directly in the console user interface. Changes affect all actions using that style sheet.

When you export style sheets, the entire XML file (the wrapper and the actual style sheet inside it) is saved. When you import a previously exported style sheet, you are importing an entire wrapper back into the domain.

Note: Style sheets and metadata transformation are advanced concepts. If you require assistance in implementing specific metadata transformations, please contact your customer service representative at Telestream.
Managing Style Sheets with the Vantage Management Console

To start style sheet management with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select *Workflow Design Items > Style Sheets*.

Vantage displays the Style Sheets details panel shown in the figure shown here.

The Management Console displays the Style Sheets details panel:

![Image of Style Sheets Details Panel]

Adding a Style Sheet

You can create a new style sheet from an existing template, as explained below. Alternatively, you can duplicate the Email HTML Example shown in the figure by right-clicking and selecting *Duplicate* to make the example available for editing.

To add a new style sheet to the domain, do the following:

1. Click the *Add Style Sheet* button in the toolbar.
   
   Vantage displays a file system dialog, so you can select a style sheet (XSL) file.
2. Navigate to the directory where the style sheet file is stored, select the file you want to import, and click OK.
   
   The Vantage Management Console adds the new style sheet to the table.
3. Name the style sheet and enter a description.
4. Click the *Save* button.

You can select the new or edited style sheet within a workflow action (such as Notify) in the Workflow Designer, to apply formatting to the action's metadata. Note that if you edit an existing style sheet, the changes affect all actions using that style sheet.
Renaming a Style Sheet
To rename a style sheet definition, select it in the table, edit the name to meet your requirements, and click the Save button.

Deleting Style Sheets
To permanently remove a style sheet from the domain, click the Delete button in the toolbar (or right-click and select Delete). Click Yes in the warning to confirm.

Note: When you remove a style sheet from the domain, the XSL file is not erased—its reference is removed from the Vantage domain database. Removing a style sheet will render services and workflows inoperable if the style sheet was used in them. Be sure to update all actions and services that used the style sheet you just deleted.

Duplicating Style Sheets
To duplicate a style sheet, select it in the list, click Duplicate, rename the copy, make any other desired changes, and click Save to save the duplicated style sheet.

Finding Affected Workflows
If you plan to delete a style sheet, you may want to find any affected workflows first.

To do so, click the style sheet in the list, and click Find workflows using this style sheet. A list of affected workflows is displayed (or a message saying no workflows use the style sheet).

Exporting and Importing Style Sheets
Vantage allows you to export style sheets to XML files, which you can then use to import the same style sheets into another Vantage domain.

To export all style sheets, click the Export drop down menu and select Export All.

To export selected style sheets, do the following:
1. Select the style sheet to export. Ctrl-click or Shift-click to select multiple style sheets.
2. Click the Export button to export a single style sheet (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported style sheet. The default file name is the style sheet name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the style sheet in the XML file.

To import a style sheet, do the following:
1. Click the Import button to import a previously exported XML style sheet. Alternatively, to import an XSL file, use Select Style Sheet Definition....

2. Browse to locate and select the style sheet to import, then click Open.

*Note:* If you try to import a style sheet that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.

## Managing Actions

The following topics describe action management tasks:

- Understanding Actions
- Managing Action Default Settings
- Configuring the Resource Cost
- Configuring Task Scheduling
- Configuring Retry Settings
- Exporting and Importing Action Default Settings
- Exporting and Importing Workflow Action Configurations
- Related Action Management Topics

### Understanding Actions

An action is the smallest unit of work that can be specified in a Vantage workflow. Actions are connected together in a workflow to perform a useful task. Each action must be configured to perform its subtask in the context of the workflow task.

Vantage services execute the actions within a workflow. Each service executes a specific set of actions, so the actions are often sorted by service in Vantage programs. For example, workflow designers select individual actions from action groups that are usually named for the service that executes the action.

*Note:* The Common group displayed in Vantage Workflow designer is an exception because it lists actions that can be executed by any service.
Managing Action Default Settings

The action default settings define the default resource cost and retry settings for Vantage workflow actions. You can export these settings for use in other domains, and you can import settings from exported files.

To start action default setting management with the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Action Defaults.

Vantage displays the Action Defaults details panel, as shown in this figure.

Configuring the Resource Cost

When cost based load balancing is enabled, the resource cost establishes a default cost for an action. A higher resource cost means that fewer actions can run at the same time, which reduces demand on server resources. A lower resource cost allows more actions to run simultaneously. For information on enabling cost based load balancing, see Managing Load Balancing in the Domain Management Guide.

Note: When cost based load balancing is disabled (which is the default setting), the resource cost for every action is 1 and any other setting is ignored.
Configuring Task Scheduling

The Configure Task Scheduling button opens a panel where you can select default Task Based Load Balancing rules that you created using the Vantage Management Console > Task Rules > Task Scheduling Rules panel. To add default task scheduling rules to actions, follow these steps:

1. Click an action to highlight it.
2. Click Configure Task Scheduling.
3. In the Action Default Task Scheduling Rules dialog, click Add rules.
4. Select the rule you wish to apply to the action from the Rule list.
5. Click OK and Done to close the rule lists.

For details about Task Based Load Balancing, see the Domain Management Guide or the System Administration Guide and search for the Task Scheduling topic.

Configuring Retry Settings

For some actions, Vantage allows you to configure a retry rule that defines how and when Vantage tries to execute an action that failed. Retry rules can be configured for an action type in the Vantage Management Console, and rules can be configured for specific actions in a workflow using Vantage Workflow Designer. When a retry rule is defined in a workflow for an action, that rule overrides any rule for that action type that is defined in Vantage Management Console.

The default retry rule for all action types defined in Vantage Management Console is No Retry. When an action type supports retry rules, you can specify a limited retry rule or a recurring retry rule.

A Limited Retry rule can specify up to 3 retries, each with a defined delay period and a priority. For example, you can specify (in the Vantage Management Console) that all Flip actions retry the first time after five minutes at priority 10, and that Flip actions retry a second time after 10 minutes at priority 20.

A Recurring Retry rule allows unlimited retries of failed actions of the specified type until the action executes. You can specify a retry interval (in seconds, minutes, hours, or days) and specify a relative priority. For example, you can set Vantage to retry failed Copy actions every 2 minutes (a 2-minute Delay) at Priority 30 until the Copy action executes successfully. You can also specify a Stop after a maximum number of iterations or leave Stop unchecked for unlimited retries.

It is important to keep in mind that individual action retry rules specified in Vantage Workflow Designer override the default retry rules specified in the Vantage Management Console. For example, if a workflow is configured to retry a Message action twice after failure and the Vantage Management console is configured for No Retry for Message actions, Vantage will retry the failed Message action twice, as specified in the workflow.
The following topics describe retry rule management:

- Viewing Action Retry Rules
- Configuring Action Retry Rules

**Viewing Action Retry Rules**

To view the retry configuration for any action, do the following:

1. In the Vantage Management Console components panel, open Workflow Design Items > Action Defaults.
2. Select an action in the Action Defaults details panel.
3. View the configuration in the Action panel.

**Note:** Not all actions support action retry rules.

**Configuring Action Retry Rules**

To configure a retry rule for any action, do the following:

1. In the Vantage Management Console components panel, open Workflow Design Items > Action Defaults.
2. Select an action in the Action Defaults details panel.
3. To disable retries, click No Retry.
4. To define a limited retry rule, click Limited Retry and complete the rule as follows:
   a. For the first retry, specify the delay period number and units and execution priority.
   b. For a second or third retry, check the appropriate checkbox and complete the rule configuration.
5. To define a recurring retry rule, click Recurring Retry and complete the rule as follows:
   a. Specify the delay period number and units and execution priority.
   b. Clear the *Stop after* checkbox to enable unlimited retries, or check the checkbox and specify a maximum number of retry iterations.
6. Click the Save button.

**Exporting and Importing Action Default Settings**

Vantage allows you to export action default settings to XML files, which you can then use to import the same default settings into another Vantage domain.

To export default settings for all actions, select Export All from the Export button drop down menu.

To export default settings for selected actions, do the following:

1. Select the action. Ctrl-click or Shift-click to select multiple actions.
2. Click the Export button to export settings (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported settings. The default file name is the action name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the action in the XML file.

To import settings for an action, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the file to import, then click Open.

**Note:** When you import settings for an action that is already in this Vantage domain, Vantage prompts you to confirm replacement of the current settings or cancel the import.

---

**Exporting and Importing Workflow Action Configurations**

Every workflow action and action template is stored in the Vantage domain database, and you can use the Vantage Management Console to view these actions and action templates. With the Vantage Management Console, you can view when an action was created, which workflow uses the action, and whether the action is a template or not. You can also export and import actions and action templates.

You might want to export an action so that you can import it to another domain, or you might want to export an action so that you can email it to Telestream for evaluation. When you import an exported action or action template from another domain, Vantage automatically makes the imported action a template in the new domain. Imported action templates make the imported action available to all workflow designers in the Vantage domain.

Actions are saved as XML files—one action per file. The following topics describe export and import tasks:

- **Displaying Actions for Export and Import**
- **Exporting Actions**
- **Importing Actions**

**Displaying Actions for Export and Import**

To display actions for export and import, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Support Utilities > Actions > By Service.
3. Select the service for which you want to display actions.

Vantage displays a service details panel that lists actions, similar to the Transport details panel shown here.

Exporting Actions

To export one or more actions, do the following:

1. Select the actions to export. (Ctrl-click to select multiple actions.)
2. Click the Export button (or right-click and select Export).
3. Use the file system dialog to save the exported actions.

The default file name is the action name, but you can change the file name.

**Note:** Changing the XML file name does not change the action name in the XML file.

Importing Actions

When you import an action into a domain, Vantage imports the action as a template, and the action template becomes available to all workflow designers in the Vantage domain. If a workflow designer creates a new action using the imported template, the new action uses all of the settings of the original action.
To import an action, do the following:

1. Click the Import button.
2. Browse the file system to locate and select the action file to import, and click Open.

**Related Action Management Topics**

For additional information on action management using Vantage Management Console, refer to the following topics:

- Viewing Active Actions
- Viewing Action Analytics

For information on action management using Vantage Dashboard, refer to the Dashboard chapter of the Domain Management Guide.
Managing Nexus Definitions

The following topics describe how to use Nexus Definitions:

- Understanding a Nexus
- Managing Nexus Definitions
- Creating Nexus Definitions
- Modifying a Nexus Definition
- Deleting a Nexus Definition
- Duplicating a Nexus Definition
- Exporting and Importing Nexus Definitions
- Searching for Nexus Definitions in Workflows
- Refreshing the Nexus Definitions List

Understanding a Nexus

A nexus is a group of video and audio channels associated with each other for convenience. The group can then be named using a Nexus Definition for quick and easy recognition and access. Nexus channel groups can be selected in the action inspectors (such as the Capture action) for use in Vantage workflows.

Managing Nexus Definitions

To start managing nexus definitions with the Vantage Management Console, follow these steps:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Workflow Design Items > Nexus Definitions.
   Vantage displays the Nexus Definitions details panel shown in this figure.
Creating Nexus Definitions

You can create nexus definitions in Vantage Management Console as follows:

1. Click the Create a New Nexus button in the toolbar.
2. Select the nexus type in the dialog that opens and click OK.
3. Enter a name for the nexus.
4. Enter a description of the nexus.
5. Assign Permitted Users (visible only if user admin is enabled) by clicking on a user in the left list, and clicking Add to move them to the right list.
   You can check Everyone to allow all users access to the Nexus Definitions feature.
   Use Remove to move a selected user on the right to the non-permitted list on the left. This disables that user’s access.
6. Click the Save button.

Modifying a Nexus Definition

To modify a nexus, select it in the list, make changes, and click the Save button.
Deleting a Nexus Definition

To permanently remove a nexus definition from the domain, select it in the list and click the Delete button \( \times \) in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: When you delete a nexus definition, affected workflows may no longer operate as expected. Be sure to update the affected workflows.

Duplicating a Nexus Definition

It can be easier to duplicate and rename a definition than it is to make a new one. To duplicate a definition, do the following:

1. Select the nexus definition.
2. Click the Duplicate button \( \square \) in the toolbar (or right-click and select Duplicate).
3. Enter a new name.
4. Change the description, if desired.
5. Click the Save button \( \square \).

Exporting and Importing Nexus Definitions

Vantage allows you to export nexus definitions to XML files, which you can then use to import the same definitions into another Vantage domain.

To export all nexus definitions, click the Export drop down menu and select Export All.

To export one or selected definitions, do the following:

1. Select the definition to export. Ctrl-click or Shift-click to select multiple definitions.
2. Click the Export button \( \square \) (or right-click and select Export, or click the Export drop down menu and select Export Selected).
3. Use the file system dialog to save the exported definition. The default file name is the definition name, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the nexus definition in the XML file.

To import a nexus definition, do the following:

1. Click the Import button \( \square \).
2. Use the file system to locate and select the definition to import, then click Open.
Searching for Nexus Definitions in Workflows

Vantage allows you to search all workflows in a domain for a nexus definition. This is very useful when you need to change or delete a definition, and you want to know which workflows might be affected by the change.

To search for nexus definitions, do the following:

1. Select the definition for which you want to search.
2. Click the Search button in the toolbar (or right-click and select Find Workflows).
   - If the definition is used in any workflows, Vantage displays a list of workflows that use the definition. Double-click any workflow in the list to open that list in Vantage Workflow Designer. Click Done to dismiss the list.
   - If the definition is not used in any workflows, Vantage displays a message to that effect. Click OK to dismiss the message.

Refreshing the Nexus Definitions List

Click the Refresh button to update the list of nexus definitions.
Viewing Workflow and Action Analytics

Workflow and Action Analytics is a licensed optional feature that calculates and displays key statistics and performance data about your Vantage domain. You can use analytics information to identify problems and improve overall system performance.

You can use Vantage Management Console to view analytics as described in the following topics:

- Viewing Workflow Analytics
- Viewing Action Analytics

**Note:** Analytics features in Vantage Workflow Designer display information on the actions in a workflow. For details about how to use Workflow Analytics in the Workflow Designer, click the Help button in the toolbar to display the Designer help system.

Viewing Workflow Analytics

You can use workflow analytics to collect information that will help you improve Vantage workflow design and domain performance and efficiency.

In the Vantage Management Console, the workflow analytics feature displays columns for the workflow data listed in this table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow</td>
<td>The name of the workflow as it was defined in Vantage Workflow Designer.</td>
</tr>
<tr>
<td>Category</td>
<td>The Category in which the workflow resides.</td>
</tr>
<tr>
<td>Total Jobs</td>
<td>The total number of jobs (in a selected group) that have run using the named workflow.</td>
</tr>
<tr>
<td>Cumulative Workflow Processing Time</td>
<td>The total execution time for all jobs that used the workflow.</td>
</tr>
<tr>
<td>Average Completion Time</td>
<td>Total Completion Time divided by Total Jobs.</td>
</tr>
<tr>
<td>Cumulative Action Execution Time</td>
<td>The total execution time of all actions in a workflow.</td>
</tr>
<tr>
<td>Average Action Execution Time</td>
<td>Total Action Execution Time divided by the number of actions in the workflow.</td>
</tr>
</tbody>
</table>
Configuring Vantage Workflow Components

Viewing Workflow and Action Analytics

Each analytic provides key information about your Vantage domain performance. For example, you can click on the Cumulative Workflow Processing Time column head to sort all the times in that column and quickly identify which workflows require the most processing time.

The bottleneck identification feature identifies the action within each workflow that requires the most time to process, while the Bottleneck Action Average Execution Time column shows how much time the bottleneck action requires. If the Bottleneck Action Average Execution Time value is insignificant, there is likely no issue with that action. However, if you identify a workflow that is consuming significant resources, knowing the bottleneck action for that workflow gives you an indication of where to look for issues.

To view workflow analytics in the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Domain Workflow Analytics > Workflow Analytics. Vantage displays the Workflow Analytics panel shown here:

You can sort all entries in ascending or descending order by clicking a column label.

You can right-click on any workflow and select Open Workflow to launch (or display, if already running) Workflow Designer and display the selected workflow.
Note: If Workflow Designer is already running and is hidden behind another window when a workflow is requested, the Windows task bar button will flash, indicating that the Workflow Designer has something new to display.

The set of workflows to be analyzed can be selected by checking the Only analyze jobs checkbox, checking other checkboxes that apply, and changing dates and times.

The options that you can use to filter workflows are described in this table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only analyze jobs</td>
<td>Enables filtering of the job list based on the other options specified.</td>
</tr>
<tr>
<td>Newer than and Older than</td>
<td>Workflows within a range of dates and times can be selected by checking Newer than and Older than checkboxes and setting the dates and times accordingly.</td>
</tr>
<tr>
<td>That ran between</td>
<td>Workflows between a beginning and end time can be selected by checking the That ran between checkbox and setting the times.</td>
</tr>
<tr>
<td>That ran after the last workflow layout change</td>
<td>Check the That ran after the last workflow layout change check box to select all workflows that ran after the last workflow layout change.</td>
</tr>
<tr>
<td>Whose state is</td>
<td>Check any combination of the four provided state checkboxes to select a set of workflows. (See the Vantage Workflow Designer User Guide for the definitions of these states).</td>
</tr>
</tbody>
</table>
Viewing Action Analytics

Action analytics displays the average execution time for each action in every workflow. The workflow analytics show the average execution time for all actions in a workflow and the bottleneck action execution time. Use workflow analytics to discover a workflow and bottleneck action that require a closer look; use the action analytics to display analytics for the other actions in workflows.

To view action analytics in the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Domain Workflow Analytics > Action Analytics.

   Vantage displays the Action Analytics details panel shown here:

   ![Action Analytics Panel](image)

The following table describes the data and controls in the Action Analytics details panel.

<table>
<thead>
<tr>
<th>Button or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Designer button</td>
<td>Click the Workflow Designer button to open the Workflow Designer. Note: If Workflow Designer is already open and positioned behind the Vantage Management Console, the Vantage Management Console remains in front of the Workflow Designer and the Workflow Designer button flashes in the task bar. Click the Workflow Designer button in the task bar to display the Workflow Designer in front of the Vantage Management Console.</td>
</tr>
<tr>
<td>Refresh button</td>
<td>Click the Refresh button to update the list of actions.</td>
</tr>
<tr>
<td>Action Name</td>
<td>This column displays all of the actions in the workflows.</td>
</tr>
<tr>
<td>Button or Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Action Description</td>
<td>This column displays the descriptions that are associated with each action.</td>
</tr>
<tr>
<td>Average Execution Time</td>
<td>This is the average execution time of the named action for all workflows.</td>
</tr>
<tr>
<td>Workflow</td>
<td>The name of the workflow that contains the named action. The set of workflows to be analyzed can be selected by checking the Only analyze jobs checkbox, checking other checkboxes that apply, and changing dates and times.</td>
</tr>
<tr>
<td>Category</td>
<td>The Category in which the workflow resides.</td>
</tr>
<tr>
<td>Newer than and Older than</td>
<td>Workflows within a range of dates and times can be selected by checking Newer than and Older than checkboxes and setting the dates and times accordingly.</td>
</tr>
<tr>
<td>That ran between</td>
<td>Workflows between a beginning and end time can be selected by checking the That ran between checkbox and setting the times.</td>
</tr>
<tr>
<td>That ran after the last workflow layout change</td>
<td>Check the That ran after the last workflow layout change check box to select all workflows that ran after the last workflow layout change.</td>
</tr>
</tbody>
</table>
Using Application Configurations

The Application Configurations folder contains the following configurators for use in monitoring job status and setting up operator applications:

- Configuring the Job Status Views
- Configuring the Workflow Portal
- Configuring the Dublist Portal

Configuring the Job Status Views

Job Status View configuration is covered in its own dedicated chapter, Configuring Job Status Views, in the Vantage Domain Management Guide.

Job Status Views is a Web application that provides operators and managers with information about the status of jobs in the domain. Using the Vantage Management Console, you can configure views, which define what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows. You can create additional views that represent a single workflow, and those views can be configured as public or private. Public views are available to all Vantage users, and private views are available only to approved users.

For details about operating the Job Status Views Web application, see the Vantage User Guide.

Configuring the Workflow Portal

Workflow Portal configuration is covered in its own dedicated chapter, Setting up Workflow Portal, in the Vantage Domain Management Guide.

The Workflow Portal is a Vantage client (implemented as a Windows program and a web application) which provides a customizable user interface allowing operators to process media using Vantage workflows and specialized portal controls.

The interface is configurable in the Vantage Management Console to set up panels according to the options you have bought and the media processing functions you need. Several Workflow Portal configurations can be selected to create multiple configurations and each configuration further refined by selecting check boxes to display desired functions and unchecking those functions that will not be displayed. Pull down menus and data entry fields allow you to select variables, labels, and other parameters to customize the operator’s view.

Once the configurations have been created, the portal operator can select the configuration needed for a specific task and use the portal view presented by that configuration.

For details about operating the Workflow Portal, see the Vantage User Guide.
Configuring the Dublist Portal

Dublist Portal configuration is covered in its own dedicated chapter, *Creating Dublist Portal Configurations and Dublist Schemes*, in the *Vantage Domain Management Guide*.

The Dublist Portal provides operators and managers with the ability to view and manage Vantage TrafficManager dublists. Using the Vantage Management Console’s Dublist Portal configuration panel, you create *configurations*, which define the features and information an operator uses and sees when operating the Dublist Portal. You can create as many configurations as needed to implement your dublist processing.

Once the configurations have been created, the portal operator can select the configuration needed for a specific task and use the portal view presented by that configuration.

For details about operating the Dublist Portal, see the *Vantage User Guide*. 
Creating Report Configurations

Report configurations (optional) define which data Vantage exports when a workflow designer uses Vantage Workflow Designer to export data. In the current release, Vantage supports custom report formats as described in these topics:

- Job Reports
- Service Reports

Job Reports

Job report configurations define which job status and metadata label data is exported when workflow designers generate reports using Vantage Workflow Designer. Exported data is saved to files using the comma separated value (CSV) format, which can be read by many programs, including word processor and spreadsheet programs.

**Note:** You choose the jobs to report on and generate reports in the Workflow Designer Job Status panels using the *Create a report for the selected jobs* tool. The jobs you see in the Domain Job Status list are controlled by the *Include completed jobs in Domain Job Status* selection in the Vantage Management Console Settings & Options General panel. When this selection is enabled, the Domain Job Status tab shows all jobs in the Vantage domain, including completed jobs.

The following topics describe how to view and manage job report formats:

- Managing Job Reports with the Vantage Management Console
- Creating a New Job Report Format
- Including and Excluding the Header Row
- Choosing the Report Format Columns
- Duplicating a Job Report Format
- Deleting a Job Report Format
- Refreshing the Format List
- Exporting and Importing Job Report Formats
Managing Job Reports with the Vantage Management Console

To view and manage job reports using the Vantage Management Console, do the following:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Report Configurations > Job Reports.

Vantage displays the Job Reports panel:
Creating a New Job Report Format
You can create job report formats in the Vantage Management Console and in Workflow Designer.

To create a new report format in the Vantage Management Console, do the following:
1. Display the Job Reports details panel (see the Vantage displays the Job Reports panel: figure).
2. Click the Create button, (or right-click the empty area of the Job Reports panel and select New Configuration).
   The Vantage Management Console adds a new report format to the list.
3. Select the new report format in the list.
4. Enter a new name in the Name text box.
5. If you want, enter a report format description in the Description text box (the description is optional).
6. Click the Save button.

Including and Excluding the Header Row
To include or exclude a header row in the report format, do the following:
1. Display the Job Reports details panel (see the Vantage displays the Job Reports panel: figure).
2. Select the report format to modify.
3. Check the Add Header Row check box to include the header row, or clear the checkbox to exclude the header row.
4. Click the Save button.

Choosing the Report Format Columns
You can configure report formats to include or exclude the following columns:
• Job ID
• Job Name
• State
• Progress
• Started
• Updated
• Expires
• Workflow Name
• Job Run Time (seconds)
• Job Queue Time (seconds)
• Media Duration (seconds)
• Additional columns for metadata label parameters
When you choose to display a column for a metadata label, the column displays the label value.

To define which columns appear in a report, do the following:

1. Display the Job Reports details panel.
2. Select the report format to modify.
3. In the Columns row (see the Vantage displays the Job Reports panel: figure), check (display) or clear (hide) the checkboxes for the columns you want to display.
4. To add or delete columns for metadata labels, do the following:
   a. Click the Column button.
   b. In the Labels panel, select a label for which you want to display parameters.
   c. In the Parameters panel, check the checkbox for any parameter you want to display, and clear the checkbox for any parameter you do not want to display.
   d. To toggle the display to include or exclude category names, click the Categorize button. One display state displays parameters with the category headings, and the other display state displays parameters without the category headings.
   e. Repeat parameter label selection until all labels are properly selected.
   f. Click OK.
5. To change the displayed order of parameter labels, select a label in the list (Ctrl-click or Shift-click to select multiple labels) and use the green up and down arrow buttons to move the label in the list.
   The top item in the list appears to the right of the columns listed in the Columns row, and to the left of all the other label columns. The last item in the list becomes the last column on the right.
6. Click the Save button.

**Duplicating a Job Report Format**

When you duplicate a job report format, a new format is created with a modified name. All other configuration settings in the duplicate format match those in the original format.

To duplicate a job report format, do the following:

1. Display the Job Reports details view.
2. Select the report format to duplicate. (Ctrl-click or Shift-click to select multiple formats.)

**Note:** You duplicate one report at a time.

3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate format.
5. In the Description text box, enter a description for the duplicate format.
6. Click the Save button.
Deleting a Job Report Format

To delete a job report format, do the following:

1. Display the Job Reports details view.
2. Select the format or formats to delete. (Ctrl-click or Shift-click to select multiple formats.)
3. Click the Delete button \(\text{\texttimes}\), (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.

Refreshing the Format List

When you open the Job Reports detail panel, the Vantage Management Console displays the current list of job report formats. If another administrator adds or changes formats, you must refresh the display to see those changes. To refresh the display, click the Refresh button \(\text{\texttimes}\).

Exporting and Importing Job Report Formats

Vantage allows you to export report formats to XML files, which you can then use to import the same reports into another Vantage domain.

To export one or all job report formats, do the following:

1. If you are exporting a single format, select the format to export.
2. Click the Export button \(\text{\texttimes}\) to export a single format, or select Export all from the Export button drop down menu. You can also right-click and select Export.
3. Use the file system dialog to save the exported formats.
   The default file name is the format name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the report format in the XML file.

To import a report format, do the following:

1. Click the Import button \(\text{\texttimes}\).
2. Use the file system dialog to locate and select the format file to import, then click Open.

**Note:** If you try to import a report format that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Service Reports

The Service Reports feature in the Vantage Management Console Report Configurations folder allows you to define configurations (formats) for reports showing wait times for selected services and servers (nodes). You can create reports from time-of-day or historical data. Exported data is saved to files using the comma separated value (CSV) format, which can be read by many programs, including word processor and spreadsheet programs.

Generating reports from the report configurations you’ve created is done using the Generate Report button in the Vantage Management Console Services detail panel. See Generating Reports for more information.

The following topics describe how to view and manage service report configurations:

- Managing Service Reports with the Vantage Management Console
- Creating a New Service Report
- Choosing the Report Type, Organization, and Options
- Choosing the Report Mode
- Duplicating a Service Report Configuration
- Deleting a Service Report Configuration
- Refreshing the Service Reports Configuration List
- Exporting and Importing Service Report Configurations
Managing Service Reports with the Vantage Management Console

Service reports are useful for revealing server and service overloads based on a historical average of loading and wait times or based on 24-hour peaks.

To view and manage service reports using the Vantage Management Console, follow these steps:

1. Start the Vantage Management Console by double-clicking the desktop icon.
2. In the components panel, select Report Configurations > Service Reports.
   Vantage displays the Service Reports panel shown below, which lists Service Reports that have already been created and provides tools for creating and modifying reports.
   See the following topics for details about creating and managing reports.

For instructions about generating reports using Service Reports configurations, please see Generating Reports in the Vantage Domain Management Guide.

Creating a New Service Report

To create a new report format in the Vantage Management Console, do the following:

1. Display the Service Reports details panel (see the preceding figure).
2. Click the Create button, (or right-click the empty area of the Service Reports panel and select New Configuration).
   The Vantage Management Console adds a new report format to the list.
3. Enter a new name in the Name text box.
4. If you want, enter a report format description in the Description text box (the description is optional).
5. Click the Save button.
Choosing the Report Type, Organization, and Options

To configure the type, organization, and options, follow these steps:

1. Display the Service Reports panel (see the preceding figure).
2. Select the Report Type from the drop-down menu; currently comma-separated (CSV is the only choice).
3. Choose to Organize by:
   - Service: lists raw metrics individually for each selected service; use this option to get information about a specific service.
   - Node: lists average metrics for each selected service on the specified server; use this option when multiple services from multiple nodes are selected and you want to view data on a per-node basis.
   - Service Type: lists aggregated metrics for each service type; for example, if five transcode services are selected, their metrics are averaged to produce a single data set for the Transcode service as a whole.
4. Check the Options:
   - Add Header Row—Adds heading information at the top of the document
   - Include Waiting Time—Lists how long in seconds sessions wait for processing
   - Include Utilization—Shows the percentage of utilization (active sessions divided by maximum possible sessions)
   - Include Queue Length—Shows length of the session processing queue
5. Click the Save button.

Choosing the Report Mode

You can configure report formats for the following modes:

- Time of Day—Shows processing over a 24-hour period, including which hours during a day are the peak processing time. This report averages the metric history and presents each hour’s average over 24 hours.
- Historical—Shows hourly information for the time range selected.

1. Select the Mode.
2. Click the Save button.

Once you save the report configurations you want to use, you can go to the Services panel and generate reports using the Generate Report button. See *Generating Reports* report generation instructions and examples.
Duplicating a Service Report Configuration

When you duplicate a service report configuration, a new format is created with a modified name. All other configuration settings in the duplicate format match those in the original format.

To duplicate a report format, do the following:
1. Display the Service Reports details view.
2. Select the report format to duplicate.

**Note:** You duplicate only one report at a time.

3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate format.
5. In the Description text box, enter a description for the duplicate format.
6. Select a Report Type (CSV is the default).
7. Select or de-select Options (Add Header Row) as you prefer.
8. Select a Mode.
9. Click the Save button.

Deleting a Service Report Configuration

To delete a service report configuration, do the following:
1. Display the Service Reports details view.
2. Select the configurations to delete. (Ctrl-click or Shift-click to select multiples.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.

Refreshing the Service Reports Configuration List

When you open the Service Reports detail panel, the Vantage Management Console displays the current list of service report configurations. If another administrator adds or changes configurations, you need to refresh the display to see those changes.

To refresh the display, click the Refresh button.
Exporting and Importing Service Report Configurations

Vantage allows you to export report configurations to XML files, which you can then use to import the same reports into another Vantage domain.

To export one or all service report configurations, do the following:

1. If you are exporting a single format, select the format to export.
2. Click the Export button to export a single format, or select Export all from the Export button drop down menu. You can also right-click and select Export.
3. Use the file system dialog to save the exported formats.
   The default file name is the format name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the report format in the XML file.

To import a report format, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the format file to import, then click Open.

**Note:** If you try to import a report format that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Managing Fulfillment Schemes

The Fulfillment Schemes folder of the Vantage Management Console contains templates or interfaces that pre-process information used by Vantage actions. These schemes are present in the folder:

- Workorder Schemes
- Dublist Schemes
- Catch Schemes

Workorder Schemes

Workorder schemes are configured in the Vantage Management Console within the Fulfillment Schemes folder. You configure workorder schemes to specify how each job in a workorder file will be formatted, and to enable the Workorder origin action to correctly parse incoming workorders and start corresponding jobs.

You can specify fields for workorder schemes using the Add Field button. Use the button to add fields, and then click on each field to specify its parameters. The Workorder Index assigned to each field lets you specify the order of the fields, which will appear in workorder files as values separated by commas (CSV format).

The Skip Lines selector lets you specify how many header rows, if any, to include.

Each field can be named, described, specified as a variable or UNC path value, and tagged with a qualifier to specify whether it consists of media, an attachment, or a variable.

The following topics explain Workorder Schemes:

- Displaying the Workorder Schemes Panel
- Creating a New Workorder Scheme
- Renaming a Scheme
- Duplicating a Scheme
- Deleting a Scheme
- Creating Workorder Scheme Fields

Note: Workorder Schemes topics are also explained in the Workorder action inspector Help pages in the Vantage Workflow Designer.
Displaying the Workorder Schemes Panel

To view the Workorder Schemes panel, open Fulfillment Schemes in the side panel and select Workorder Schemes. The Vantage Management Console displays the panel shown below.

The panel includes a default scheme named Simple Media Workorder, which is selected by default in the Workorder action inspector.

Creating a New Workorder Scheme

To create a new Workorder scheme, do the following:

1. Display the Workorder Scheme window.
2. Click the Create a new Workorder scheme button (or right-click in the empty schemes list space and select New Workorder Scheme).
3. Choose CSV in the dialog that appears to specify a Workorder scheme formatted in comma separated values (CSV).
4. Enter a scheme name in the Name field.
5. Enter a description of the scheme in the Description text box (this is optional).
6. Select Skip Lines to specify the number of lines to skip in parsing a workorder if you want to allow header text at the top of the workorder.
7. Click the Add Field button above the left corner of the Field Name. A New Field is created that you can modify later as explained in Creating Workorder Scheme Fields.
8. Click the Save button .
Renaming a Scheme
To rename a scheme, do the following:
1. Display the Workorder Schemes window.
2. Select the scheme to rename in the scheme list.
3. In the Name text box, enter a new name for the scheme.
4. Click the Save button.

Duplicating a Scheme
To duplicate a Workorder scheme, do the following:
1. Display the Workorder Schemes window.
2. Select the scheme to duplicate.
3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate scheme.
5. In the Description field, enter a description for the scheme (optional).
6. Click the Save button.

Deleting a Scheme
To delete a Workorder scheme, do the following:
1. Display the Workorder Schemes window.
2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiples.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
Creating Workorder Scheme Fields

You can set up Workorder Scheme field options below the field Name and Description. These options determine which data rows and fields in a particular type of Workorder are extracted and forwarded to the workflow and which are ignored. The following figure shows a typical Workorder with data arranged in columns, each of which will be described and extracted by a field in your Workorder scheme.

Example CSV Workorder
Title, File, Text, SCC file, CML File
Riddick, \machine\riddick.mov, Riddick, \machine\riddick.scc, \machine\promo.cml
Poppins, \machine\poppins.mov, Poppins, \machine\poppins.scc, \machine\promo.cml

Field List
The field list shows the fields you create as part of a scheme. You can add fields as needed. Each field in a scheme is created and configured to extract data from a particular column in the Workorder when a Workorder is parsed.

Skip Lines—Enter the number of header lines to skip at the top of a file before Workorder parsing starts.

Add New Field—Click Add Field to add a new data field to extract from Workorders.

Delete Field—Click Delete Field to delete the highlighted field from the field list.

Field Name—Enter or change the name of the field.

Description—Enter or change the description of the field.

Value Type—Select the type of value to search for and extract from the field. Available values are listed in the following table.

Qualifier—Set to the type of field being extracted: Media, Attachment, or Variable. If Media or Attachment, the field is a pointer to a media or attachment file name or location path. If Variable, the field contains a value to be used in the variable.

Extraction Criteria, Workorder Index—Set this to the number of the field in relation to the other fields. Counting from the left, the first field is 1, followed by a comma, and the next field is 2, followed by a comma, and the next field is 3, and so on.

After entering your selections for each item described previously, click the Save button to save the field and scheme.

The following table presents Value Type descriptions.
<table>
<thead>
<tr>
<th>Value Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>A true or false value</td>
</tr>
<tr>
<td>Integer Number</td>
<td>A signed 32-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Size</td>
<td>A signed 64-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Decimal Number</td>
<td>A double precision floating point decimal number</td>
</tr>
<tr>
<td>Date</td>
<td>A date specified according to local standards: MM/DD/YYYY or DD/MM/YYYY</td>
</tr>
<tr>
<td>Text</td>
<td>Any text string; use this when your data does not fit any other value type</td>
</tr>
<tr>
<td>Path</td>
<td>A valid Windows or UNC path. Must follow this pattern: {Drive Letter}\</td>
</tr>
<tr>
<td></td>
<td>Or this pattern: \{Device}{path}</td>
</tr>
<tr>
<td>Timecode</td>
<td>A video timecode value in this pattern: HH:MM:SS:FF@FR</td>
</tr>
<tr>
<td></td>
<td>HH is hours, MM is minutes, SS is seconds, FF is the frame number, and @FR</td>
</tr>
<tr>
<td></td>
<td>is the frame rate. Examples: 00:00:30:04 or 01:00:30:00@29.97 or 00:02:30:00@25. A frame rate of 29.97 is assumed if not specified.</td>
</tr>
<tr>
<td>Mail Address</td>
<td>A valid email address consisting of an @ sign with a string before and after—email@domain. Example: <a href="mailto:name@telestream.net">name@telestream.net</a></td>
</tr>
</tbody>
</table>
Testing Schemes

The Test button in the center of the Workorder Schemes window lets you test your schemes on actual Workorders to verify that the scheme works correctly. To test a scheme, do these steps:

1. Select a Workorder scheme in the scheme list. For this example, the Workorder shown in the Example CSV Workorder figure above, was used.
2. Press the Test button.
3. Examine the Test Results for a clean output. The following figures show an example.
4. Adjust each field of the scheme until a test produces a satisfactory output.

![Workorder Schemes window](image)

![Workorder Scheme Test Results](image)
Duplicating a Workorder Scheme

When you duplicate a workorder scheme, a new scheme is created with a modified name. All other configuration settings in the duplicate scheme match those in the original format.

To duplicate a workorder scheme, do the following:

1. Display the Workorder Schemes window.
2. Select the workorder scheme to duplicate.

**Note:** You can duplicate only one scheme at a time.

3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate scheme.
5. In the Description text box, enter a description for the duplicate scheme.
6. Make any other desired changes to the workorder scheme.
7. Click the Save button.

Refreshing the Workorder Schemes List

In the Workorder Schemes window, the Vantage Management Console displays the current list of workorder schemes. If another administrator adds or changes schemes, you need to refresh the display to see those changes.

To refresh the display, click the Refresh button.
Exporting and Importing Workorder Schemes

Vantage allows you to export workorder schemes to XML files, which you can then use to import again into the same or another Vantage domain.

To export one or all workorder schemes, do the following:

1. In the Workorder Schemes window, select the workorder scheme to export.
2. Click the Export button to export a single scheme, or select Export all from the Export button drop down menu. You can also right-click and select Export.
3. Use the file system dialog to save the exported schemes in the desired location.

   The default file name is the scheme name, but you can change the file name.

   **Note:** Changing the XML file name does not change the scheme name in the XML file.

To import a workorder scheme, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the workorder scheme file to import, and then click Open.

   **Note:** If you try to import a workorder scheme that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.

Dublist Schemes

Dublist Schemes are covered in their own chapter of the *Domain Management Guide, Creating Dublist Portal Configurations and Dublist Schemes*:

- Creating Dublist Schemes

This topic is also covered in the *Vantage TrafficManager Guide* and the *Vantage Dublist Portal Guide*.

Catch Schemes

Catch Schemes are described in the *Configuring Catch Server Schemes* chapter of the *Vantage Domain Management Guide*:

- Configuring Catch Server Schemes

This topic is also covered in the *Vantage TrafficManager Guide*.
Managing Syndication

Syndication is a feature of Vantage TrafficManager described in the TrafficManager User Guide. Using TrafficManager, you can ingest syndicated content with timing sidecar files from a source or catch server, display and adjust the segments described by the sidecar file, and output the transformed syndicated content with timing file to a broadcast or playout server.

In the Vantage Management Console, the Syndication folder in the left panel contains the Templates selection. This function allows you to turn syndicated sidecar timing files into reusable templates for reformatting syndicated shows that follow consistent formatting patterns. The topics that follow explain how to create and modify templates.

■ Creating Syndication Templates

Creating Syndication Templates

Syndication templates are used to transform the syndication timing sidecar files into reusable templates for formatting syndicated content. After syndicated content and associated timing sidecar files are ingested, you may want to modify them to trim or delete program, black, or commercial segments. Since most episodic shows follow a nearly identical organizational pattern, you can modify one show in the Syndication Portal and use it to create a template for future shows to speed up the modification process.

The following topics explain how to create and modify syndication templates:
Displaying the Syndication Templates Panel

To view the Syndication Templates panel, open the Syndication folder in the side panel and select Templates. The Vantage Management Console displays the panel below. The panel includes a default template, aptly named Template.

Creating and Modifying a Syndication Template

To create a new syndication template, do the following:

1. Display the Syndication Templates panel.
2. Click the **Add a new Syndication template** button (or right-click in the empty schemes list space and select New Syndication Template).
3. Change the template name in the **Name** field.
4. Enter a description in the **Description** text box (this is optional).
5. Check the **Locked** box if you want to prevent changes by other applications, such as the Syndication Portal.
6. Click *Populate from XML* and browse for an XML sidecar file to use as your template. Use Syndication type to select the type of syndication system. When you click OK, the template is populated and a segment list is displayed (below). You can scroll the segment list using the green arrows on the right.

7. Modify the template as needed by highlighting a segment line in the segment list and using the following controls:
   a. Click Add Segment or Delete to add or delete a show segment.
   b. Use Original to modify the numbering that was supplied in the original file. (Vantage retains both the original numbering and regrouped numbering after you have modified a file to add, remove, or change segments.)
   c. Use Regrouped to modify the numbering of the altered template file.
   d. Select a type for each segment: black (slate), part of the program, or a commercial.
   e. Add a description of the segment (optional).
   f. Click the Not included box if you want a segment excluded from program. For example, you may want to keep black segments, but you may not want them included in the final output, so you check Not included.

8. Click the Save button to save the template.

Note that when you view a show and modify its segments in the Syndication Portal, you can save the changes as a new template (or overwrite an existing one) using the Create new template... button in the Portal. This allows you to refine the templates made in the Console.
Renaming a Syndication Template

To rename a template, do the following:
1. Display the Syndication Templates window.
2. Select the template to rename in the templates list.
3. In the Name text box, enter a new name for the scheme.
4. Click the Save button.

Duplicating a Syndication Template

To duplicate a template, do the following:
1. Display the Syndication Templates window.
2. Select the template to duplicate.
3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate scheme.
5. In the Description field, enter a description for the scheme (optional).
6. Make changes to the segments as you prefer.
7. Click the Save button.

Deleting a Syndication Template

To delete a template, do the following:
1. Display the Syndication Templates window.
2. Select the template to delete. (Ctrl-click or Shift-click to select multiples.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
Exporting and Importing Syndication Templates

Vantage allows you to export templates to XML files, which you can then use to import the same templates into another Vantage domain.

To export one or all templates, do the following:

1. If you are exporting a single template, select the template to export from the list.
2. Click the Export button to export a single template, or select Export all from the Export button drop down menu. You can also right-click.
3. Use the file system dialog to save the exported templates in the desired location.
   The default file name is the template name, or you can change the template name.

**Note:** Changing the name of the XML file does not change the name of the template contained in the XML file.

To import a template, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the template XML file to import, then click Open.

**Note:** If you try to import a template that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.

Filtering the Templates list

If you have many templates and would like to hide the ones you’re not using in the list, use the filter feature. Enter the first few characters of the template you want to use in the filter blank, and only matching templates will show up in the list.
Creating Dublist Portal Configurations and Dublist Schemes

This chapter explains how to create Dublist Portal configurations, and create dublist schemes to use in TrafficManager. Both of these are created and set up in the Vantage Management Console.

**Note:** Features in products for which you don’t have a license are disabled and indicate that you need a license to use them.

The following topics are presented in this chapter:

- Creating Dublist Portal Configurations
- Creating Dublist Schemes
Creating Dublist Portal Configurations

The Dublist Portal provides operators and managers with the ability to view and manage TrafficManager dublists. Using the Vantage Management Console’s Dublist Portal configuration panel, you create configurations, which define the features and information an operator uses and sees when using the Dublist Portal.

You can create as many configurations as needed to implement your dublist processing. Before you can use the Portal, you must create at least one configuration.

Note: For a comprehensive overview of the Dublist Portal program, see Using Dublist Portal in the Vantage TrafficManager User Guide.

The following topics provide information on Dublist Portal configuration tasks:

- Displaying the Dublist Portal Configuration Panel
- Refreshing the Configuration List
- Creating a New Configuration
- Renaming a Configuration
- Duplicating a Configuration
- Deleting a Configuration
- Setting Options and Choosing Columns
- Configuring Permitted Users
- Specifying Workflows
- Exporting and Importing Configurations
Displaying the Dublist Portal Configuration Panel

To display the Dublist Portal configuration panel in the Management Console, select Application Configurations > Dublist Portal in the panel on the left:

![Displaying the Dublist Portal Configuration Panel](image)

Refreshing the Configuration List

When you select the Dublist Portal configuration panel, the Management Console displays the current configurations list and the current workflows. If another administrator is making changes (such as adding Vantage users), you must refresh the display to see those changes. To refresh the display, click the Refresh button.

Creating a New Configuration

To create a new configuration, do the following:

1. Click the New Configuration button (or right-click in the empty configuration list space and select New Configuration).
2. Enter a name in the Name field after the new configuration appears in the Configuration list.
3. Optionally, enter a description of the configuration in the Description text box.
4. Click the Save button.
5. Proceed to Setting Options and Choosing Columns to set up the configuration per your requirements.
Renaming a Configuration

To rename a configuration, do the following:

1. Select the configuration to rename.
2. In the Name text box, enter a new name for the configuration.
3. Click the Save button.

Duplicating a Configuration

To duplicate a configuration, do the following:

1. Select the configuration to duplicate.
2. Click the Duplicate button (or right-click and select Duplicate).
3. In the Name text box, enter a name for the duplicate configuration.
4. In the Description field, enter a description for the configuration (optional).
5. Click the Save button.

Deleting a Configuration

To delete a configuration, do the following:

1. Select the configuration to delete. (Ctrl-click or Shift-click to select multiple configurations.)
2. Click the Delete button (or right-click and select Delete).
3. When the confirmation dialog appears, click OK.
Setting Options and Choosing Columns

You can set Dublist Portal configuration options and columns below the Name and Description fields.

Setting Your Options

To set these options, do the following:

1. Select the configuration you want to modify.
2. **Allow Users to Manually Expire Dublists**—Check to enable users to expire a dublist dynamically, as needed. Clear the checkbox to prevent users from ever manually expiring a dublist.
3. **Allow User to Resubmit Jobs**—Check to enable users to resubmit jobs as required. Clear the checkbox to prevent users from resubmitting jobs.

Displaying Selected Columns

The Columns selections enable you to include or exclude these columns: Dublist, Folder, Workflow, Catalog, Submitted, Ad-ID, House ID, Matched, and Status. The columns you select determine which columns and associated information are visible when using this configuration in the Dublist Portal.

To define which columns display in the Dublist Entries view list in a configuration, do the following:

1. Select the configuration you want to modify.
2. Click on the Dublist Entries View tab.
3. Check the boxes for columns you want to display in this configuration, and uncheck them to hide them. The only current option allows the user to manually expire dublists in addition to any automatic expiration.
4. You can also add other columns, as shown in the previous figure. For each column to add, click the Add/Delete Columns icon. The Management Console displays the Select Dublist Fields for Columns dialog:

5. Select a scheme from the list to display the available fields on the right. Then check the fields that you want to add. (The value in the Columns row of the Dublist Schemes table indicates how many fields are currently included).

6. Click the Save button.

Configuring Permitted Users

When user administration is enabled, you can set a configuration to be available to individual users or all users (Public).

If you plan to use the Dublist Portal web application, you must enable user administration to provide a layer of security for web application usage.

**Note:** The Permitted Users tab is displayed only if User Administration is enabled in Settings & Options.

Users with administrative privileges always have access to configurations.

To specify which Vantage users can access a configuration, do the following:

1. Select the configuration you want to update.
2. Click the Permitted Users tab (see the figure below).
3. To make the selected configuration available to all Vantage users, do the following:
   a. Check the Everyone check box.
   b. Click the Save button.

4. To make the configuration available to certain Vantage users, do the following:
   a. Clear the Everyone check box.
   b. In the Available panel, select the users who should have access, and click Add.
   c. In the Permitted Users panel, select the users who should not have access, and click Remove.
   d. Click the Save button.

**Specifying Workflows**

Use the Dublist Monitor Workflows tab to specify which workflows are accessible to the Dublist Portal operator. The operator can submit jobs to these workflows directly from Dublist Portal.

**Note:** Only workflows beginning with a Dublist action are usable in Dublist Portal.

To specify which workflows are accessible in a configuration, do the following:

1. Select the configuration to modify.
2. Click the Dublist Monitor Workflows tab (as shown in the figure, below).
3. Select a workflow in the Available panel and click Add to add it to the configuration. Click a workflow in the Included panel and click Remove to delete it.
4. Click the Save button.
Exporting and Importing Configurations

Vantage allows you to export configurations to XML files, which you can then use to import the same configurations into another Vantage domain.

To export configurations, do the following:

1. Select the configuration(s) to export. (Ctrl-click or Shift-click to select multiple configurations.)

2. Click the Export button to export the configurations (or right-click and select Export, or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported configurations.
   The default file name is the configuration name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the configuration defined by the XML file.

To import configurations, do the following:

1. Click the Import button.

2. Use the file system dialog to locate and select the configuration file to import, then click Open.

**Note:** If you try to import a configuration that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Creating Dublist Schemes

Dublist schemes contain dublist parsing patterns you can create for each type of dublist you plan to use with Vantage TrafficManager or Ingest Manager. Each scheme provides the specification that Dublist actions use in a workflow for extracting the correct data fields from the dublist you used.

The advantage of dublist schemes is that you don’t have to set up the parsing pattern for the dublist each time you use a Dublist action in a workflow. Instead, you set it up once as a scheme in the Dublist Schemes panel in the Management Console and then specify that scheme by name in a Dublist action. Different broadcast systems use different dublist formats, so you can create a scheme for each one. The dublist files themselves can consist of comma-separated values (CSV), column-based files, and formats provided by supported dublist databases.

When configuring a Dublist action, you can use one of the default dublist schemes provided in Vantage or create one or more dublist schemes to meet your requirements.

You can set up a scheme to extract any data fields you need so that your workflows can find and process media files and include their metadata. For example, you might extract the Advertiser, Title, Ad-ID/ISCI code, and Duration and pass those along to the traffic workflow for further action.

- Displaying the Dublist Schemes Panel
- Creating a New Dublist Scheme
-Renaming a Scheme
- Duplicating a Scheme
- Deleting a Scheme
- Configuring Dublist Scheme Fields

**Note:** If you are using an XML-based dublist (such as BXF, Eclipse, or Novar), the dublist must be saved with the appropriate encoding relative to the content in the file. For example, if your dublist contains non-ASCII characters (such as German or French), you must save the file with UTF-16 encoding. In XML files, the encoding type is generally indicated in the header line: `<?xml version="1.0" encoding="utf-16"?>`. 
Displaying the Dublist Schemes Panel

To view the Dublist Schemes panel in the Management Console, open Fulfillment Schemes in the side panel and select Dublist Schemes. The Vantage Management Console displays the panel shown in the figure below.

Creating a New Dublist Scheme

To create a new dublist scheme, follow the steps below. At a minimum, each dublist scheme requires an Ad-ID/ISCI qualifier and a house qualifier.

1. Click the Create a new dublist scheme button (or right-click in the empty schemes list space and select New Dublist Scheme).
2. Choose Column-based | CSV | Eclipse | Wide Orbit BXF in the dialog that appears.
3. Enter a scheme name in the Name field.
   When naming your dublist schemes, you probably want to use the type of dublist in the name, so a scheme for BXF dublists might be called "BXF Dublist Scheme" to make it easy to identify.
4. Optionally, enter a description of the scheme in the Description text box.
5. Skip Lines—Enter the number of header lines to skip at the top of a file before dublist parsing starts.
6. Click the Save button .
Renaming a Scheme

To rename a scheme, do the following:
1. Select the scheme to rename in the scheme list.
2. In the Name text box, enter a new name for the scheme.
3. Click the Save button.

Duplicating a Scheme

To duplicate a dublist scheme, do the following:
1. Select the scheme to duplicate.
2. Click the Duplicate button (or right-click and select Duplicate).
3. In the Name text box, enter a name for the duplicate scheme.
4. In the Description field, enter a description for the scheme (optional).
5. Click the Save button.

Deleting a Scheme

To delete a dublist scheme, do the following:
1. Select the configuration to delete. (Ctrl-click or Shift-click to select multiples.)
2. Click the Delete button (or right-click and select Delete).
3. When the confirmation dialog appears, click OK.
Configuring Dublist Scheme Fields

You can set up your dublist scheme fields using the panel below the field Name and Description. These options determine which data columns, lines, and fields in a particular type of dublist are extracted and forwarded for use in TrafficManager workflows and which are ignored. Typical data to extract from a dublist might include the advertiser, the media title, the Ad-ID/ISCI code, the length of the media in hours/minutes/seconds/frames, and so on.

The following figure shows a typical dublist with data arranged in columns, each of which will be described and extracted by a field in your dublist scheme.

<table>
<thead>
<tr>
<th>Order</th>
<th>Advertiser</th>
<th>Order Complete Date</th>
<th>Type</th>
<th>Ad-ID</th>
<th>Title</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1494666</td>
<td>JCPenney</td>
<td>10/17/2012 21:17:49</td>
<td>Video</td>
<td>RJCF8375</td>
<td>WR39 Sale</td>
<td>00:00:15:00</td>
</tr>
<tr>
<td>1495125</td>
<td>FedEx</td>
<td>10/17/2012 23:37:27</td>
<td>Video</td>
<td>FJXX-6383</td>
<td>PREVIOUS</td>
<td>00:00:30:01</td>
</tr>
<tr>
<td>1495707</td>
<td>Dodge</td>
<td>10/18/2012 20:45:04</td>
<td>Video</td>
<td>CDA-7006B</td>
<td>ROADTRIP</td>
<td>00:00:30:00</td>
</tr>
<tr>
<td>1496038</td>
<td>Mercedes</td>
<td>10/19/2012 21:56:32</td>
<td>Video</td>
<td>DZNA-6347</td>
<td>JCHAMMER</td>
<td>00:00:30:00</td>
</tr>
<tr>
<td>1495935</td>
<td>Advance</td>
<td>10/20/2012 1:47:27</td>
<td>Video</td>
<td>AAST0751</td>
<td>LOW PRICE</td>
<td>00:00:30:00</td>
</tr>
<tr>
<td>1495935</td>
<td>Advance</td>
<td>10/20/2012 1:47:27</td>
<td>Video</td>
<td>AAST0753</td>
<td>LOW PRICE</td>
<td>00:00:15:00</td>
</tr>
</tbody>
</table>

Creating a Field List

The field list shows the fields you create as part of a scheme. You can add and delete fields as needed. Each field in a scheme is created and configured to extract data from a particular element in the dublist when a dublist is parsed. The data extracted from a dublist is published as a variable in the job.

Note: Given that various types of dublists are in use (column-based | CSV | Eclipse | Wide Orbit BXF), how you define the field varies by type.

Adding New Fields

Click Add Field to add a new data field to extract from dublists. Specify the following information:

Field Name—Enter a name for the field.

Description—Optionally, enter a description of the field.

Value Type—Enter the type of value to search for and extract from the field. Available values are True/False, Integer Number, Size, Decimal Number, Date, Text, Path, Timecode, and Mail Address. See the following table for descriptions of these values.

The following table presents Value Type descriptions.
<table>
<thead>
<tr>
<th><strong>Value Type</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>True or false</td>
</tr>
<tr>
<td>Integer Number</td>
<td>Signed 32-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Size</td>
<td>Signed 64-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Decimal Number</td>
<td>Double-precision floating point decimal number</td>
</tr>
<tr>
<td>Date</td>
<td>Date specified according to local standards: MM/DD/YYYY or DD/MM/YYYY</td>
</tr>
<tr>
<td>Text</td>
<td>Any text string; use when your data does not fit any other value type</td>
</tr>
<tr>
<td>Path</td>
<td>Windows or UNC path. Must follow this pattern: [Drive Letter]:</td>
</tr>
<tr>
<td>Timecode</td>
<td>Timecode value in this pattern: HH:MM:SS:FF@FR</td>
</tr>
<tr>
<td></td>
<td>HH is hours, MM is minutes, SS is seconds, FF is the frame number, and @FR is the frame rate. Examples: 00:00:30:04 or 01:00:30:00@29.97 or 00:02:30:00@25. A frame rate of 29.97 is assumed if not specified.</td>
</tr>
<tr>
<td>Mail Address</td>
<td>Email address consisting of an @ sign with a string before and after—email@domain. Example: <a href="mailto:name@telestream.net">name@telestream.net</a></td>
</tr>
</tbody>
</table>

**Qualifier**—Set to the type of field being extracted: an Ad-ID/ISCI identifier, a House ID, or other General qualifier.

Next, specify extraction criteria. How you set it up depends on the type of dublist you’re working with. Proceed to the topic appropriate to your type of scheme.

After entering your selections for each item described previously, click the Save button  to save the field and scheme.

**Specifying Column-based Extraction Criteria**

**Starting Column**—Set this to the number of the column in which to start extracting data, starting at column 1. That is, counting from the left margin, how many characters to the right should the parser count before starting to extract data for this field?

**Width**—Set this to the width of the data to be extracted. That is, counting from the starting column (above) how many characters to the right should the parser count before ending extraction of the field?

**Stop at white space**—Check this option to stop parsing the Ad-ID/ISCI column at the first space character. That is, if this field contains multiple words or character groups separated by spaces, parsing stops after the first group.
Specifying CSV Extraction Criteria

CSV Index—Specifies the number of the column in which to start extracting data. This value is 1-based; the first column is identified as column 1.

Specifying Eclipse Extraction Criteria

CSV Index—Specifies the number of the column in which to start extracting data. This value is 1-based; the first column is identified as column 1.

Specifying Wide Orbit BXF Extraction Criteria

XPath—indicates the field/node position in the hierarchy of the XML file. The XPath begins with the root node, followed by any additional nodes in the hierarchy, leading to the node being defined. For example: /ROOT/Node_Level_1/Node_Level_2.

Deleting Fields

Click Delete Field to delete the highlighted field from the field list.

Testing Dublist Portal Schemes

The Test button in the center of the Dublist Schemes panel enables you to test a scheme on actual dublists to verify that the scheme works correctly—that the dublist has been parsed correctly—extracting the metadata that the workflow requires.
To test a scheme, follow these steps:

1. Select a dublist scheme in the scheme list.
2. Press the Test button.
3. Examine the Test Results table for proper extraction: verify that each field contains the correct data, as shown in the figure below.

![Test Results Table]

4. Adjust each field of the scheme until a test produces correct output.
Configuring Catch Server Schemes

This chapter explains how to use the Vantage Management Console Catch Schemes feature. The Catch Schemes feature gives you the flexibility to create your own custom catch server definitions from a general purpose scheme type. Additionally, the Vantage Catch action includes many common catch server definitions, as shown in the figure below.

You implement a scheme in a Catch action (in Workflow Designer) by selecting a specific type (or general purpose) catch server and then selecting the scheme that you want to use.

A catch scheme allows Vantage to parse XML sidecar files accompanying ad media coming into a watched catch server and pass the sidecar metadata along with the media to other actions for processing in a Vantage workflow.
Note: Sidecar XML files must be valid, properly-formatted XML (for example, an embedded ampersand or other reserved/escape sequence characters in a value), otherwise it can not be interpreted and no job will be submitted.

Using the Vantage Management Console Catch Schemes configuration window, you can create configurations, which define the information users see when configuring a General Purpose Catch action.

- Displaying the Catch Schemes Configuration Panel
- Creating a New Configuration
- Renaming a Configuration
- Duplicating a Configuration
- Deleting a Configuration
- Setting Options and Defining Fields
- Exporting and Importing Configurations

Displaying the Catch Schemes Configuration Panel

To view the Catch Schemes configuration window in Vantage Management Console, open Fulfillment Schemes in the side panel and select Catch Schemes. The Vantage Management Console displays the Catch Schemes configuration window shown here.
Creating a New Configuration

To create a new configuration, do the following:
1. Display the Catch Schemes configuration window.
2. Click the Create a New Configuration button (or right-click in the empty configuration list space and select New Configuration).
3. Enter a name in the Name field after the new configuration appears.
4. Enter a description of the configuration in the Description text box (this is optional).
5. Click the Save button.
6. After you create a new configuration, configure it by proceeding to Setting Options and Defining Fields.

Renaming a Configuration

To rename a configuration, do the following:
1. Display the Catch Schemes configuration window.
2. Select the configuration to rename in the Configuration list.
3. In the Name text box, enter a new name for the configuration.
4. Click the Save button.

Duplicating a Configuration

To duplicate a configuration, do the following:
1. Display the Catch Schemes configuration window.
2. Select the configuration to duplicate.
3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate configuration.
5. In the Description field, enter a description for the configuration (optional).
6. Click the Save button.

Deleting a Configuration

To delete a configuration, do the following:
1. Display the Catch Schemes configuration window.
2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiple configurations.)
3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.
Setting Options and Defining Fields

You can set Catch Schemes configuration options and define fields for catch processing below the Name and Description. The fields area lets you add a new field for each node in the XML catch server configuration file that you want to include. The XML file and your catch server definition can include any fields you prefer, but these three fields are required for each catch scheme: Ad-ID/ISCI, Start Time, and Play Length.

To define fields in a configuration, do the following:

1. Display the Catch Schemes configuration window.
2. Select the configuration you want to modify from the Configuration list.
3. In the fields table toolbar, click the New Field button to add a field.
4. Enter a field name and description, usually the name of a node in the XML file. (A node is text surrounded by pointed brackets, such as <ISCI_CODE>.)
5. Select a Qualifier from the drop-down menu to define the function of the field/node. At a minimum, you must include one Ad-ID/ISCI, one Start Time, and one Play Length field.
6. Select a Value Type for the field. This specifies what kind of data the field will contain, such as text, timecode, numbers, paths, etc.
7. Enter an XPath, which indicates the field/node's position in the hierarchy of the XML file. The XPath begins with the root node, followed by any additional nodes in the hierarchy, leading to the node being defined. For example: /ROOT/Node_Level_1/Node_Level_2.
8. Click the Save button.
9. Click the Test button above the field area, and browse for the XML file you are using to define your catch server. If you successfully defined the fields, the Test Results window opens and shows the fields as headings with the correct data from the XML file.

Field Options

Each field in a scheme is created and configured to extract data from a particular node in the catch server definition XML file when the file is parsed. The following options are available for defining a field:

Skip Lines—Enter the number of header lines to skip at the top of a file before parsing starts.

Add New Field—Click Add Field to add a new data field.

Delete Field—Click Delete Field to delete the highlighted field from the field list.

Field Name—Enter a name for the field.

Description—Enter a description of the field.

Qualifier—Set to the type of field being extracted: an Ad-ID/ISCI identifier, Start Time, Play Length, or a Variable.
Value Type—Enter the type of value to search for and extract from the field. Available values are True/False, Integer Number, Size, Decimal Number, Date, Text, Path, Timecode, and Mail Address. See the table below for descriptions of these values.

Extraction Criteria, XPath—Set this to the path leading to the node defined by the field. Start at the root level and descend to desired node: /ROOT/Node1/Node2.

After entering your selections for each item described previously, click the Save button to save the field and scheme.

Use the Test button to view the Test Results window, showing your catch server definition.

The following table presents Value Type descriptions.

<table>
<thead>
<tr>
<th>Value Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>A true or false value</td>
</tr>
<tr>
<td>Integer Number</td>
<td>A signed 32-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Size</td>
<td>A signed 64-bit integer (decimals are rounded)</td>
</tr>
<tr>
<td>Decimal Number</td>
<td>A double precision floating point decimal number</td>
</tr>
<tr>
<td>Date</td>
<td>A date specified according to local standards: MM/DD/YYYY or DD/MM/YYYY</td>
</tr>
<tr>
<td>Text</td>
<td>Any text string; use this when your data does not fit any other value type</td>
</tr>
<tr>
<td>Path</td>
<td>A valid Windows or UNC path. Must follow this pattern: [Drive Letter]:\ Or this pattern: \Device\path</td>
</tr>
<tr>
<td>Timecode</td>
<td>A video timecode value in this pattern: HH:MM:SS:FF@FR HH is hours, MM is minutes, SS is seconds, FF is the frame number, and @FR is the frame rate. Examples: 00:00:30:04 or 01:00:30;00@29.97 or 00:02:30:00@25. A frame rate of 29.97 is assumed if not specified.</td>
</tr>
<tr>
<td>Mail Address</td>
<td>A valid email address consisting of an @ sign with a string before and after—email@domain. Example: <a href="mailto:name@telestream.net">name@telestream.net</a></td>
</tr>
</tbody>
</table>
Testing Schemes

The Test button in the center of the Catch Schemes window lets you test your schemes on actual catch server definition files to verify that the scheme works correctly.

To test a scheme, follow these steps:

1. When you finish defining a catch scheme, press the Test button.
2. Examine the Test Results display for a clean output as shown in the figure below. The figure shows the defined catch scheme, the XML data to be parsed, and the test results.
3. Adjust each field of the scheme until a test produces a satisfactory output.
Refreshing the Catch Schemes List

In the Catch Schemes window, the Vantage Management Console displays the current list of catch schemes. If another administrator adds or changes schemes, you need to refresh the display to see those changes.

To refresh the display, click the Refresh button.

Exporting and Importing Configurations

Vantage allows you to export catch scheme configurations to XML files, which you can then use to import the same configurations into another Vantage domain.

To export configurations, do the following:

1. Select the configurations to export. (Ctrl-click or Shift-click to select multiple views.)
2. Click the Export button to export selected configurations (or right-click and select Export, or select Export all from the Export button drop down menu).
3. Use the file system dialog to save the exported configurations.

   The default file name is the configuration name, but you can change the file name.

   **Note:** Changing the name of the XML file does not change the name of the configuration in the XML file.

To import configurations, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the configuration file to import, then click Open.

   **Note:** If you try to import a configuration that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Configuring Job Status Views

Job Status Views is a Web Application that provides operators and managers with job status information that focuses on jobs, rather than the comprehensive system point of view offered by the Web Dashboard. Using the Vantage Management Console, you can configure views, which define what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows. You can create additional views that represent a single workflow, and those views can be configured as public or private. Public views are available to all Vantage users, and private views are available only to approved users.

Note: For a comprehensive overview of the Job Status Views Web application program, see the Vantage User Guide.

The following topics provide information on view configuration tasks:
- Displaying the View Configuration Panel
- Enabling and Disabling the All Workflows View
- Creating a New View
- Renaming a View
- Duplicating a View
- Deleting a View
- Selecting and Changing the Workflow for a View
- Displaying All Jobs or Only Jobs in Process
- Enabling Options
- Choosing the Display Columns
- Configuring Permitted Users
- Refreshing the View List
- Exporting and Importing Views
Displaying the View Configuration Panel

To view the view configuration window, open Application Configurations in the component panel and select Job Status Views. The Vantage Management Console displays the Job Status Views detail panel shown here:

Enabling and Disabling the All Workflows View

When you enable the All Workflows view, any Vantage user with access to this view sees information on all workflows in the domain. When this view is disabled, no user can view information on all workflows.

To enable or disable the All Workflows view, do the following:

1. Display the Job Status Views details view.
2. Select the All Workflows view.
3. Check (enable) the Enable checkbox below the Description to enable viewing all workflows, or uncheck Enable to allow viewing only selected workflows.
4. Click the Save button.
Creating a New View

To create a new view, do the following:
1. Display the Job Status Views details view.
2. Click the Create Configuration button (or right-click in the empty workflow list space and select New Configuration).
3. When the Select Workflow dialog appears, select workflows for the view (Ctrl-click to select multiple workflow), and click OK.
4. If you want, enter a description of the view in the Description text box (this is optional).
5. Click the Save button.

Renaming a View

To rename a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to rename.

Note: You cannot rename the All Workflows view.

3. In the Name text box, enter a new name for the view.
4. Click the Save button.

Duplicating a View

To duplicate a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to duplicate.

Note: You cannot duplicate the All Workflows view.

3. Click the Duplicate button (or right-click and select Duplicate).
4. In the Name text box, enter a name for the duplicate view.
5. In the Description text box, enter a description for the duplicate view.
6. Click the Save button.
Deleting a View

To delete a view, do the following:

1. Display the Job Status Views details view.
2. Select the view to delete. (Ctrl-click or Shift-click to select multiple parameters.)

**Note:** You cannot delete the All Workflows view.

3. Click the Delete button (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.

Selecting and Changing the Workflow for a View

To change the workflow for a view, do the following:

1. Display the Job Status Views details view.
2. Select the view to modify.

**Note:** You cannot change the workflow displayed in the All Workflows view.

3. Click the Workflows tab, and select workflows to move. Move workflows from the right panel to the left to remove them from the view, or left to right to add them.
4. Click the Save button to save the changed view.
Displaying All Jobs or Only Jobs in Process

You can configure each view to display all jobs or only the jobs that are currently in process. When configured to display only in process jobs, jobs that are in any other state (completed, failed, stopped by user, etc.) do not display. Some people might prefer to view all jobs, while others prefer to view the shorter list of in process jobs.

To configure the scope of jobs for a view, do the following:
1. Display the Job Status Views details view.
2. To display in process jobs only, check the Show Only “In Process” Jobs checkbox.
3. To display all jobs, clear the Show Only “In Process” Jobs checkbox.
4. Click the Save button.

Enabling Options

You can configure each view to permit operators to use Job Status Views to control jobs with the Stop, Restart, and Delete functions or restrict access to those functions.

To enable or disable Stop, Restart, and Delete for jobs in a view, do the following:
1. Display the Job Status Views details view.
2. Check Options checkboxes as preferred to enable (checked) or disable (unchecked): Show Only In Process Jobs, Allow Stop, Allow Restart, Allow Delete, and Allow Set Priority.
3. Click the Save button.

Choosing the Display Columns

Every view displays the Job and State columns. You can configure views for individual workflows to include columns, such as workflow name, progress, started, updated, and to allow users to perform actions such as stop, restart, delete, and so on.

When you choose to display a column for a workflow action, the column displays the state of that action. This can help you use Job Status Views to view the state of actions during workflow processing.

To define which columns appear in a view, do the following:
1. Display the Job Status Views details view.
2. Select the view in the Configuration list to modify.
3. In the lower panel, select the workflow to which you want the view to apply.
4. In the Columns row, check (display) the columns you want to display: Workflow, Total Progress, Started, Updated, and Expires.
5. Click the Save button.
Configuring Permitted Users

You can configure a view to be available to individual users or Everyone (public).

**Note:** Users with administrative privileges will have full access whether or not they are given permission.

To define which Vantage users can access a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to modify.
3. Select the Permitted Users tab.

**Note:** The Permitted Users tab is available only if you select Enable User Administration in the Vantage Management Console Settings & Options.

4. To make the view available to all Vantage users, do the following:
   a. Check the Everyone (Public View) check box.
   b. Click the Save button.
5. To make the view available to select Vantage users, do the following:
   a. Clear the Everyone (Public View) check box.
   b. In the Available panel, select the users who should have access, and click Add.
   c. In the Visible to user panel, select the users who should not have access, and click Remove.
   d. Click the Save button.
Refreshing the View List

When you open the Job Status Views detail panel, the Vantage Management Console displays the current view configuration. If another administrator is making changes (such as adding Vantage users), you must refresh the display to see those changes. To refresh the display, click the Refresh button.

Exporting and Importing Views

Vantage allows you to export views to XML files, which you can then use to import the same views into another Vantage domain.

To export views, do the following:
1. Select the view to export. (Ctrl-click or Shift-click to select multiple views.)
2. Click the Export button to export selected views (or right-click and select Export, or select Export all from the Export button drop down menu).
3. Use the file system dialog to save the exported views.
   The default file name is the view name, but you can change the file name.

**Note:** Changing the name of the XML file does not change the name of the view in the XML file.

To import views, do the following:
1. Click the Import button.
2. Use the file system dialog to locate and select the view file to import, then click Open.

**Note:** If you try to import a view that is already in this Vantage domain, Vantage prompts you to cancel or confirm replacement.
Setting up Workflow Portal

The Workflow Portal is a Vantage client (implemented as a Windows program and a web application) which provides a customizable user interface for operator-driven media processing.

The interface is configurable in the Vantage Management Console to set up panels according to the options you have bought and the media processing functions you need.

Among the several available configurations, these are included in separate products built on the Vantage platform:

- **VOD/DAI Portal**—included in VOD Producer DAI, for producing VOD assets, with optional provisioning for dynamic ad insertion.
- **Tempo Portal**—included in Tempo, for adjusting the running time of media assets.
- **DPP Portal**—part of our Digital Production Partnership (DPP) product for producing television program packages, ready for broadcast or distribution.
- **Syndication Portal**—manages ingesting and processing of long and short-form syndicated broadcast content (multi-segment material) using TrafficManager.

All other Workflow Portal configurations are available for use in various editions and licensed options in Vantage.

This chapter describes Workflow Portal, explains how its licensing works, and explains how to create portal configurations using the Vantage Management Console.

These topics are covered:

- Introduction to Vantage Workflow Portal
- Vantage Workflow Portal Licensing
- Introduction to Vantage Workflow Portal Configurations
- Managing Vantage Workflow Portal Configurations
- Vantage Workflow Portal Deployment Tips
- Vantage Workflow Portal Tours
Introduction to Vantage Workflow Portal

Two versions of the Vantage Workflow Portal are available—a Windows client and a web application. Both perform very similar functions. The Windows client supports all configurations but requires client installation on the desktop. The web application supports a limited set of configurations but can be accessed by either Mac OS or Windows computers with a web browser.

To enable the Workflow Portal, a Vantage Administrator must first create one or more Workflow Portal configurations to define the Workflow Portal feature set.

Workflow designers must also create workflows that permit operator intervention in media processing.

Operators use the Vantage Workflow Portal to manage media and metadata, and intervene in workflow processing in ways such as these:

- Browse Vantage catalogs for media (saved in binders) from completed jobs:
  - Preview/scrub media or proxies.
  - Determine that all required files are present.
  - Review associated metadata labels.

- Update metadata and submit media to workflows for further processing:
  - Enter or edit metadata.
  - Configure variables for use in the next workflow.
  - Mark in/out trim points on an asset’s timeline.
  - Mark the media as approved or rejected.
  - Submit to the next Vantage workflow.

- Create an Edit Decision List (EDL) of clips for stitching with a Flip action workflow (Windows client only).

- Create a Composition (CML) file of clips for stitching with a Post Producer Conform action workflow (Windows client only).

- Create a DPP 4.1 XML file and a CML file to allow the production of the program media file (with Post Producer) and transcoding to AS-11 with DPP metadata (Windows client only).

- Re-time media assets to meet specific time limits for broadcast/IPTV/VOD.

- Process media assets in preparation for use in IPTV/VOD systems.

- Process syndicated media assets in preparation for broadcast.

- Browse Windows servers for media and submit it to a workflow, updating metadata and variables during submission (Windows client only).

Note: For more information about the Vantage Workflow Portal, please see the Vantage User Guide.
Vantage Workflow Portal Licensing

Each Vantage Workflow Portal license supports a single user or a single computer, depending on your Vantage configuration. Under certain conditions, a single user or computer can host multiple instances of a license, and these instances are called sessions. When a license is in use by a user or a computer, it is unavailable to other users or computers. To support multiple users or computers, you must purchase additional licenses. The following topics provide additional information on Vantage Workflow Portal licensing:

- User-Based Licensing
- Machine-Based Licensing
- Viewing andResetting Vantage Workflow Portal Sessions

Note: For information on VWP license management, see Managing Licenses in the Vantage Domain Management Guide.

User-Based Licensing

When Vantage user administration is enabled (see Managing Vantage Users in the Vantage Domain Management Guide), each Vantage operator reserves a single Vantage Workflow Portal license when starting the program. That operator can open additional portal sessions on other computers without reserving additional licenses, provided that the operator uses the same user name on all computers. However, no other user can use the reserved license until the first operator closes all portal sessions that use the first operator’s user name.

Machine-Based Licensing

When Vantage user administration is disabled (see Managing Vantage Users in the Vantage Domain Management Guide), a Vantage operator reserves a single Vantage Workflow Portal license when starting the program on a computer. That operator or other operators can open additional Vantage Workflow Portal sessions on the same computer without reserving additional licenses. However, no other computer can use that license until all sessions are closed on the first computer.

Viewing and Resetting Vantage Workflow Portal Sessions

When a license is in use by a user or a computer, it becomes unavailable to other users or computers. If all licenses are in use and another license is needed, you might need to do one or more of the following:

- Reset all sessions for a license that is now idle due to a lost network connection or sudden program termination.
- Reset all license sessions for a lower priority user or computer to make a license available for a higher priority user or computer.
• Purchase more licenses.

To view the Vantage Workflow Portal license and session usage, select Licenses in the components panel, and click on the Portal Sessions tab. The Management Console displays the Portal Sessions details panel:

The Portal Sessions list displays a row for each portal session in use. When user administration is enabled (see Managing Vantage Users in the Vantage Domain Management Guide), a single Vantage user can open multiple Vantage Workflow Portal sessions, and each session is represented by a row in the session list. When user administration is disabled, a single computer can host multiple portal sessions, and each session is represented by a row in the session list.

When user administration is enabled, the User column displays the username of the operator using a license session. When user administration is disabled, the Machine column displays the computer name of the computer that is using a license session.

The Status column displays Licensed when the session is using a valid license, and it displays Demo when the session is unlicensed and open in demo mode.

To reset a license session for a user or computer, select the session and click the Stop button.
Introduction to Vantage Workflow Portal Configurations

As a Vantage domain administrator, you can create and configure Vantage Workflow Portal configurations, which control which portal features an operator can use. While portal operators do have some control over the application display, most features are controlled by the Vantage domain administrator using the Vantage Management Console.

Vantage administrators must create and configure at least one Vantage Workflow Portal configuration before operators can use the portal to access binders.

Tasks such as the following must also be completed to support media processing by operators using the Workflow Portal:

• Preparation of an ingest workflow, which can analyze source media, produce media for evaluation, and register media into Vantage catalogs to enable access from the Workflow Portal. The ingest workflow is optional for some applications.

• Preparation of at least one Vantage Workflow Portal configuration, which enables and supports the tasks you want operators to do when working with workflows.

• Installation of Vantage Workflow Portal to test portal configurations.

• Preparation of a target workflow to process the media submitted by operators. The target workflow prepares media for distribution, broadcast, and other uses.

For guidelines on creating workflows for use with the Vantage Workflow Portal, see the “Using Workflow Portal” topic in the Vantage User Guide.
Managing Vantage Workflow Portal Configurations

Note: If you are creating a store to hold proxy files viewed in the Vantage Workflow Portal, Telestream recommends that you reference the store with a UNC path. Some SAN clients do not allow frame-accurate representation of proxies when using shared drives.

The following topics describe configuration tasks for Vantage Workflow Portal configurations:

- Creating and Editing Vantage Workflow Portal Configurations
- Selecting and Setting Up a Configuration Mode
- Specifying Catalog Access for a Configuration
- Hiding and Displaying the Media List (Nicknames)
- Managing Asset Requirements for Ingest Workflows
- Enabling and Disabling Binder Deletions
- Enabling and Disabling Binder Filtering
- Defining the Controls and Display Items in Binder View
- Managing Metadata Label Configuration Options
- Managing Variable Configuration Options
- Controlling Workflow Forwarding
- Defining Storage
- Specifying Content Branding and Ratings Graphic Settings
- Specifying Embedded Metadata Settings
- Managing Variable Configuration Options
- Managing Permitted Users of Portal Configurations
- Specifying DPP Metadata and DPP Options
- Deleting a Configuration
- Saving a Configuration
- Duplicating a Configuration
- Exporting and Importing Configurations
- Refreshing the Configuration List
Creating and Editing Vantage Workflow Portal Configurations

To create or edit a Vantage Workflow Portal configuration, do the following:

1. Start the Vantage Management Console and connect to the appropriate Vantage domain.

2. Select Application Configurations > Workflow Portal.
   As shown below, the Workflow Portal panel displays the options for Vantage Workflow Portal configurations.

3. To create a new configuration, click the Create configuration button in the tool bar (or right-click in the empty configuration list space and select New Configuration) and name the new configuration.

4. To make changes to an existing configuration, select the configuration in the Configuration list.

5. If you have created a new configuration, or if you have made changes to an existing configuration, click the Save button to save your changes.
Selecting and Setting Up a Configuration Mode

When creating a new configuration, select the type of Workflow Portal configuration from the Mode menu, which displays directly below the Name and Description fields:

- Browse Catalogs (Copy Binder) Mode
- Browse Catalogs (Forward Binder) Mode
- Browse Windows Network (Create Binder) Mode
- Create EDLs from Catalogs (Create Binder) Mode
- Create CML from Catalogs (Create Binder) Mode
- Create DPP from Catalogs (Create Binder) Mode
- Create VOD from Catalogs (Create Binder) Mode
- Re-time Asset from Catalogs (Create Binder) Mode
- Syndication

These configurations customize portal operation to fit the kind of workflow processing operators will do. As you read about each configuration, remember that catalogs organize binders, and binders organize media and attachments produced by workflows.

**Note:** Some configurations are for features that require separate licensing. All configurations are available in the desktop application, but only the Copy Binder and Forward Binder configurations are available in the Web Workflow Portal.

Setting Dropframe or Non-dropframe Duration

Some Workflow Portal configurations display media durations. The duration timecode can be dropframe or non-dropframe, depending on the setting of the Use dropframe notation for duration when appropriate checkbox in the Vantage Management Console Workflow Portal Configurations panel. By default (unchecked), durations are always shown in non-dropframe. When checked, durations match the dropframe setting of the in/out values. (The Web Workflow Portal uses non-dropframe notation only.)

Pass Username As

The Pass Username As feature allows you to set the username of the portal operator as a variable that you can use in workflows. This can be helpful, for example, if you want to address a message to a particular operator based on the results of a workflow.
Choosing a Configuration

This summary may help you decide which Workflow Portal configuration to use:

- The *Browse Catalogs (Copy Binder)* configuration mode *copies* the binder for downstream processing and leaves the original binder unchanged. This configuration allows operators to examine workflow results in the portal and take action on a copy (accepting/rejecting, forwarding, etc.) while preserving the original binder.

- The *Browse Catalogs (Forward Binder)* configuration mode *forwards* the binder, allowing it to be modified by downstream processing. This configuration also allows operators to examine workflow results and take action, but the action is on the original binder, possibly changing it.

- The *Browse Windows Network (Create Binder)* configuration mode allows browsing for single or multiple files on a Windows network. Operators can then submit the files to a workflow.

- The remaining *Create Binder* configuration modes create new binders from existing binders or media files for specialized purposes. These purposes can include stitching media and creating EDL, CML, or DPP files, creating VOD files in VOD Producer, or re-timing files in Tempo.

Each of the configuration modes is described in detail on the following pages.
Browse Catalogs (Copy Binder) Mode

This configuration mode (see the figure below) enables an operator to browse the selected Vantage catalog for binders. They can then select one binder, and submit it to one or more workflows. When the submission occurs, the original binder is copied, and the copy is submitted to the workflow—the original binder remains in the catalog and remains unchanged.

Note: A binder contains metadata labels, and references to media files and attachments. When a binder is copied, the metadata labels are also copied and thus may be different from the original. Any media files or attachments in the original binder are not copied, and are referenced by both the original and the new copy.

The Browse Catalogs configuration is ideal when:
1. You want the original binder to remain in the catalog
2. You do not want to change the original binder's metadata
3. The original media files are not affected by the target workflow, and
4. You want operators to be able to submit the same asset multiple times.

Target Workflow Considerations

The target workflow must include a Receive action. Remember that any media files or attachments present in the original binder will also be referenced in the copy. As a result, the target workflow should not delete any of those original files; the original binder would then have missing files.
Example Workflows

- Operator marks an in point, and an out point for a highlight; multiple highlights can be extracted from the same input.

- Operator marks trim points around a promo from a captured satellite feed, and marks a branding entry point on the timeline; the target workflow then trims the promo and applies graphics for multiple distribution channels.

Browse Catalogs (Forward Binder) Mode

This configuration mode (see the figure below) enables an operator to browse the selected Vantage catalog for binders. The operator can select a binder, and either edit its metadata, or submit it to one or more workflows. When the submission occurs, the original binder is forwarded to the workflow (and optionally removed from the catalog, if configured that way by the administrator).

**Note:** Because the binder is directly affected by the target workflow, if the binder remains in the catalog, any changes to the binder will appear in the catalog as the workflow processes media files.

---

The Browse Catalogs (Forward Binder) configuration mode is ideal when:

- You want to use the catalog as a task list for the operator, automatically removing binders from the catalog when they are forwarded

- You want the workflows to update binders that remain in-place in the catalog

- You want operators to edit metadata in-place.

Target Workflow Considerations

The target workflow must include a Receive action. Remember that if the binder is not removed from the catalog, any changes made by the target workflow will be apparent in the catalog.
Example Workflows

- Operator reviews an asset, marks it as approved/rejected, and forwards to a workflow that responds to that metadata. The asset is removed from the catalog.

- An ingest workflow detects quality issues and places an asset in a catalog for review. An operator reviews the asset, using a proxy to review the video at error timecodes published by the ingest workflow. If the asset is unacceptable, the operator forwards to a workflow for quarantine; otherwise the operator forwards to the appropriate next step for the asset.

- Operator edits asset metadata in-place in the catalog. When the asset is ready for distribution, the operator chooses distribution channels and forwards to the target workflow. The target workflow responds to the operator choices and forwards for distribution.

- Operator reviews black segments detected by Vantage, and confirms black removal points. The target workflow uses those timecode parameters to remove black from the original media.
Browse Windows Network (Create Binder) Mode

If a project requires operators to browse network locations to locate files to submit to workflows, they will use the Browse Windows Network configuration mode (see the figure below). As discussed previously, this configuration mode allows multiple files to be submitted simultaneously. Each submitted file becomes a separate job with its own binder. During submission, the operator can add metadata labels (as permitted by the Vantage Workflow Portal configuration). For a batch submission (of multiple media files), each media file receives a copy of the same metadata label in its binder.

The Browse Windows Network (Create Binder) Mode is appropriate when:

- Operators manually submit files instead of copying files to a hot folder.
- No ingest workflow is required before operator involvement.

To select the Browse Windows Network configuration mode, do the following:

1. Display the Workflow Portal configuration panel as described in Creating and Editing Vantage Workflow Portal Configurations.

2. Click the Browse Windows Network (Create Binder) radio button.

3. Click the Save button to save your changes.

Media files are submitted directly, so there is no ingest workflow. However, submitted media files must be accessible to Vantage services. For example, files on a local drive (for example, C:\media\myvideo.mpg) are not accessible to a remote Vantage server.

The target workflow must include a Receive action. Each media file is assigned the nickname Original when it is submitted.
Create EDLs from Catalogs (Create Binder) Mode

This configuration mode changes Vantage Workflow Portal operation to include a tab that enables an operator to stitch assets using an EDL (edit decision list). An operator can use the EDL to stitch multiple assets in the catalog together or to trim a clip.

The EDL is stored in a TSEDL file, which can be stored with other media files in a Vantage store or folder, or it can be stored in a special Vantage store or folder, designated for EDL files. (For more information, see Defining Storage.)

After an operator has created an EDL, the operator can forward that EDL to a target workflow to create the output defined by the EDL. To support EDL processing, you must modify the configuration to support forwarding to a workflow that contains a Receive action. (For more information, see Controlling Workflow Forwarding.)

Target Workflow Considerations

The target workflow must include a Receive action. It will receive a TSEDL file with the nickname Original and can then transcode—or direct convert—this list into an output file (or multiple output files).

**Note:** If MPEG-2 is the EDL source format, a Direct Convert mode can be used to avoid a full transcode. Any timeline cut that breaks GOP structures is replaced with I-Frame material, otherwise original GOPs are preserved. If the output file is not MPEG-2, a full transcode can be performed. In either case, the VANC, captions, and audio are correctly stitched during the processing of the EDL.

Example Workflows

- Operator creates a list of syndication segments that are stitched together into a single program.
- Operator selects a bumper, a clip, and a trailer, enters metadata, chooses distribution channels, and submits the package for distribution. The target Vantage workflow uses distribution channel choices and metadata to generate the correct formats and deploy to the chosen distribution channels.
Catalog Mode Considerations

Assets must be registered into a Vantage catalog using an ingest workflow before they will become visible in the catalog and available for use in a target workflow. A thumbnail image and a QuickTime H.264/AAC MOV or x264/AAC MP4 proxy file should also be registered in the binder and given the nicknames *Vantage Thumbnail* and *Vantage Proxy*, respectively.

For *Create EDL from Catalogs* mode, EDL processing requires Program Stream or Transport Stream MPEG-2 video, and such a file should be provided in the binder with the nickname *Vantage EDL*. Vantage provides support for MXF DV, IMX, and XDCAM HD video formats as well.

**Note:** All assets in the EDL list must have the same frame size and frame rate; operators are not allowed to combine mixed media.

Create CML from Catalogs (Create Binder) Mode

The Create CML workspace displays in the Workflow Portal window when a Create CML from Catalogs configuration mode is selected. Using this workspace to create a Post Producer composition, an operator can mark start and end points to clip one or more media files, and stitch the clips together.

As with the Copy Binder and Forward Binder configurations, the Create CML configuration allows users to open and view binders for completed workflows. The Create CML configuration allows creating a Composition (CML) file to submit to a Post Producer workflow with a Conform action, which can process the composition and stitch the clips together. As the administrator, you must select catalogs, labels, variables, workflows, binders, and storage to use with this configuration.

For operational details, refer to the *Using Create CML Configurations* topic in the *Using Workflow Portal* chapter of the *Workflow Designer User's Guide*. 
Create DPP from Catalogs (Create Binder) Mode

The Create DPP from Catalogs configuration mode (see the figure below) applies to users who are involved in the creation of DPP packages. This configuration allows users to do the following:

- Create a DPP program containing one or more segments.
- Enter DPP metadata to accompany that program.
- Create a DPP 4.1 XML file and a Post Producer CML file to allow the construction of the program media file (using Post Producer) and transcoding to AS-11 with DPP metadata (using Vantage Transcode Pro).

As the administrator, you will need to prepare the DPP portal configuration, assign permitted users, select a catalog for viewing media, and select workflows, binders, and storage. Additionally, the administrator can specify the default and allowed values for the DPP metadata fields, and can control which fields the operator can edit.

For details of administration and operation, refer to the Using Create DPP Configurations topic in the Using Workflow Portal chapter of the Workflow Designer User's Guide. Also refer to the Creating DPP Packages in Vantage App Note.
Create VOD from Catalogs (Create Binder) Mode

This configuration mode sets up Workflow Portal to enable VOD operators to browse catalogs to select VOD assets, set options, and add content branding, rating, metadata, and variables required for dynamic ad insertion for video on demand assets and submit them to a publishing workflow for generating CableLabs compliant VOD content and optional CableLabs-compliant VOD that is provisioned for Dynamic Ad Insertion (DAI).

Note: In Vantage 7.0, the VOD DAI Workflow Portal was improved to provide new variables for Group Contiguous Ads and enable Local Column Headers. Local Ad Descriptors were added, and available combinations of ad insertion types and descriptors were changed.

To make use of these features, portal configurations created with prior Vantage versions must be recreated in Vantage 7.0 or later. VOD Workflow Portal project files should also be recreated (if the Vantage 6.3 customer-only VOD DAI Local Ad Portal patch has not been applied) to make use of Local ad descriptors.

If configurations and project files are not recreated in Vantage 7.0 or later, existing portal configurations and project files will continue to operate as before, but the new features will not be available.

The following tabs identify the workspaces provided in a VOD configuration. In each tab, you’ll configure the options as required for your specific application.

Browsable Catalogs—This is a required tab for VOD Portal applications. Configure this tab to specify one or more catalogs the operator can browse to select VOD assets for processing, and enable the necessary options for your application. For details, see Enabling and Disabling Access to Catalogs.

Labels—Configure this tab to specify which labels the operator can select and update. For Digital Ad Insertion (DAI), an industry-standard label (CableLabs DAI) is required. For details, see Managing Metadata Label Configuration Options.
**Forward to Workflows**—Configure this tab, specifying one or more publishing workflows to which the operator can forward VOD assets for processing. Check each workflow to indicate whether it is a required or optional publishing workflow. If you have multiple, optional workflows you can display the Forward to Workflows panel in VOD Portal, so the operator can select specific workflows for each job. For details, see *Controlling Workflow Forwarding*.

**Binder Details View**—Configure this tab to specify the details about each binder to display to the operator. For details, see *Defining the Controls and Display Items in Binder View*.

**Storage**—Configure this tab to set up storage options for the files created as the operator prepares jobs for processing. There is no visible indication of this store in the Portal. For details, see *Defining Storage*.

**Graphic Settings**—Configure this tab to specify display options for branding and ratings systems bugs for this asset. For details, see *Specifying Content Branding and Ratings Graphic Settings*.

**Timeline Navigation**—Configure this tab to set timeline default values. The Silence settings determine the default definition of silence in db and minimum duration. These values are displayed in the VOD/DAI Portal Timeline tab, where their values can be changed from the default values set here.

**Embedded Metadata Settings**—Configure this tab to specify copy protection options and the ratings system and rating for this asset. For details, see *Specifying Embedded Metadata Settings*.

**Variables**—Configure this tab to set up variables that will be propagated from the ingest workflow or portal settings to the output workflow. For details, see *Specifying Content Rating Variables*.
Re-time Asset from Catalogs (Create Binder)

This configuration mode converts the Workflow Portal into a Tempo Portal that allows operators to browse catalogs to select and re-time media assets, increasing or decreasing their running time. Tempo configuration is covered here generally and in specific detail in the Tempo Guide available by searching the Telestream.net web site.

The following tabs identify the workspaces provided in a Re-time configuration. In each tab, you’ll configure the options as required for your specific application.

**Browsable Catalogs**—This is a required tab for Tempo Portal applications. Configure this tab to specify one or more catalogs the operator can browse to select assets for re-timing, and enable the necessary options for your application. For details, see *Enabling and Disabling Access to Catalogs*.

**Labels**—Configure this tab to specify which metadata labels the operator can select and update. For details, see *Managing Metadata Label Configuration Options*.

**Forward to Workflows**—Configure this tab, specifying one or more re-timing workflows to which the operator can forward media for processing. Check each workflow to indicate whether it is required or optional. If you have multiple, optional workflows you can enable the Show Forward to Workflows panel in the Tempo Portal, so the operator can select specific workflows for each job. For details, see *Controlling Workflow Forwarding*.

**Binder Details View**—Configure this tab to specify the details about each binder to display to the operator. For details, see *Defining the Controls and Display Items in Binder View*.

**Storage**—Configure this tab to set up storage options for the XML (CML) composition files created by the portal as the output of the re-timing editing process. There is no visible indication of this store in the Portal. For details, see *Defining Storage*.
Graphic Settings—Configure this tab to specify display options for station branding and ratings systems bugs. For details, see *Specifying Content Branding and Ratings Graphic Settings*.

Timeline Navigation—Configure this tab to set timeline default values. The Silence settings determine the default definition of silence in db and minimum duration. The Artifact quality threshold sets a default value for defining artifacts noted on the preview player timeline. These values are displayed in the Tempo Portal Timeline tab, where their values can be changed from the default values set here.

Embedded Metadata Settings—Configure this tab to specify the ratings system and rating metadata. For details, see *Specifying Embedded Metadata Settings*.

Variables—Configure this tab to set up the use of default content rating system variables. For details, see *Specifying Content Rating Variables*.

Tempo Settings—Configure this tab to include and re-time or exclude embedded or file-based closed captions. A field is provided to browse for SCC closed caption files, and a timecode entry and +/- selection allow you to adjust caption start timing forward or backward to match associated media timing. The tab also includes default timecode and re-timing settings. A checkbox beside the settings can be checked to make them Read Only to prevent operator intervention. Alternatively, you can uncheck Read Only to allow operators to replace default values in the Tempo Portal at their discretion. For details, see *Configuring Tempo Settings*. 
Syndication

The Syndication configuration sets up the portal as a TrafficManager Syndication Portal. This portal allows operators to manage ingested syndicated content and show timing metadata. Operators can preview, trim, add, and delete segments and create templates for automated management of shows that follow a predictable format. The portal allows submitting the modified show media to publishing workflows with included show timing metadata, both of which can be published to broadcast or playout servers.

The following tabs identify the workspaces provided in a Re-time configuration. In each tab, you'll configure the options as required for your specific application.

**Browsable Catalogs**—This is a required tab for Syndication Portal applications. Configure this tab to specify one or more catalogs the operator can browse to select assets for management, and enable the necessary options for your application. For details, see Enabling and Disabling Access to Catalogs.

**Labels**—Configure this tab to specify which metadata labels the operator can select and update. For details, see Managing Metadata Label Configuration Options.

**Forward to Workflows**—Configure this tab, specifying one or more syndication workflows to which the operator can forward media for processing. Check each workflow to indicate whether it is required or optional during a submit. If you have multiple, optional workflows you can enable the Show Forward to Workflows panel in the portal, so the operator can select specific workflows for each job. For details, see Controlling Workflow Forwarding.

**Binder Details View**—Configure this tab to specify the details about each binder to display to the operator. For details, see Defining the Controls and Display Items in Binder View.

**Storage**—Configure this tab to set up storage options for the XML (or CML) composition files created by the portal as the output of portal operations. There is no visible indication of this store in the Portal. For details, see Defining Storage.
Variables—Configure this tab to set up variables that will be propagated from the ingest workflow or portal settings to the output workflow. For details, see Managing Variable Configuration Options.

Syndication Settings—Configure this tab to select a Default template to apply to shows in the portal to display show segments. Template permissions allow portal operators to Create and modify templates, Create only, or None (cannot create or modify templates).

The Syndication mode setting allows outputting a show in one of these ways:

- **Segmenting** outputs the show in segments with XML and CML files for each segment.
- **Stitching** produces a complete show with one XML and one CML output.
- **Pass-Thru** outputs the original XML attachment and does not output a CML file. Use Pass-Thru mode if you want to retain the structure of the original media file.

Segment naming allows appending a number or a letter to the show name, or doing nothing. See Configuring Syndication Settings for details.
Specifying Catalog Access for a Configuration

For catalog-based configurations, Vantage allows you to specify how operators access those catalogs and the binders they contain, as described in the following topics:

- Enabling and Disabling Access to Catalogs
- Hiding and Displaying the Catalog List
- Hiding and Displaying the Media List (Nicknames)
- Managing Asset Requirements for Ingest Workflows
- Enabling and Disabling Binder Deletions

Enabling and Disabling Access to Catalogs

All modes except Browse Windows Network support catalog access control on a per-configuration basis. When you configure a Vantage Workflow Portal configuration, any users who have access to the configuration have access to any catalogs supported by that configuration and to the binders the catalogs contain.

The default setting for each catalog-based configuration enables access to all catalogs for all users who have access to the configuration. To limit access to one or more catalogs, you add the catalogs to the Visible to user list as described in the procedure below. When the list is empty, all catalogs are available to all permitted users. Once a catalog name is added to the Visible to user list, the permitted users can view and access only catalogs in the list; all other catalogs are hidden for that configuration.

Note: Vantage provides one catalog named Default Catalog. If you use only the Default Catalog, you can add that catalog to the Visible to user list to prevent future catalogs from automatically becoming available to configuration users, or you can leave the Visible to user list empty to enable automatic access to future catalogs for all users. For instructions on creating catalogs, see Managing Catalogs in the Vantage Domain Management Guide.
To enable or disable operator access to a catalog, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To add a catalog to the list of available catalogs, select the catalog in the *Available* list and click Add.
4. To remove a catalog from the list of available catalogs, select the catalog in the *Visible to user* list and click Remove.
5. Click the Save button to save your changes.
Hiding and Displaying the Catalog List

If your domain uses only one catalog, you can simplify the Vantage Workflow Portal operator interface by hiding the list of catalogs, which is also called the catalogs browser. If operators need access to multiple catalogs using a single Vantage Workflow Portal configuration, you should display the catalogs browser so that operators can select a catalog to work with.

The design and choice of catalogs has an impact on how easily operators can perform their tasks. For example:

- The Forward configuration can be set to automatically remove the binder from the catalog when it is forwarded. The catalog can serve as a task list for operators.
- In the Copy configuration, binders are not removed from the catalog by the operators. As a result, you might want to set appropriate expiration times on the catalogs.
- In all cases, you can use folders to structure how operators see assets. For example, bumper assets may be kept in a Bumpers folder, separate from Primary Assets, in a Primary Assets folder.
- You might have multiple ingest workflows all providing binders to a target catalog.

To hide or display the catalogs browser, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To hide the catalogs browser, clear the Show Catalogs browser checkbox.
4. To display the catalogs browser, check the Show Catalogs browser checkbox.
5. Click the Save button to save your changes.

Hiding and Displaying the Media List (Nicknames)

The media list displays the media files for a binder/job that you select in the binder list. For example, the media list might include the original media submitted to a workflow and the output media from that workflow. When the media list is visible, operators can play the media or view the contents of the folder that contains the media.

To hide or display the media list, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To hide the media list, clear the Show media nickname list checkbox.
4. To display the media list, check the Show media nickname list checkbox.
5. Click the Save button to save your changes.
Managing Asset Requirements for Ingest Workflows

When you create a catalog-based configuration, Vantage allows you to define whether or not media files, labels, and attachments referenced in the target workflow are required in the ingest workflow. If you require these assets, Vantage does not process ingest workflows that are missing these items. If you do not require these assets, Vantage does not check the ingest workflow for the assets and attempts to process the ingest workflow regardless of any specific assets.

**Note:** A target workflow can fail if required assets are not provided by the ingest workflow.

To configure asset requirements for ingest workflows, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To require assets in the ingest workflow, check the *Require all expected nicknames* checkbox.
4. To make reference assets optional, clear the *Require all expected nicknames* checkbox.
5. Click the Save button to save your changes.

Enabling and Disabling Binder Deletions

When configuring a Vantage Workflow Portal catalog-based configuration, you can enable or disable the manual binder deletion by operators. Some modes also give you the option to enable or disable automatic binder deletion. The following topics provide more information on binder deletion:

- Configuring Binder Deletions
- Configuring Automatic Binder Deletions

**Note:** Vantage provides several levels of control over binder deletion. For more information, see *Understanding Binders* in the *Vantage Domain Management Guide*. 
Configuring Binder Deletions

In some modes, you can enable or disable manual deletion of binders by checking the Allow Binder Delete check box. When enabled, this feature allows operators to remove binders from the catalog after the associated jobs are submitted, leaving only binders that have not yet been processed. This effectively makes the catalog a manually-managed task list that operators can control at their discretion.

If you prefer to save binders and do not want operators to delete them, uncheck the Allow Binder Delete check box.

Note: Binder deletion is also controlled by expiration times defined in the workflow Register action or catalog configuration.

To enable or disable operator binder deletions, do the following:

1. Select the Workflow Portal Configuration to change.
2. Select the Browsable Catalogs tab.
3. To enable binder deletions, check the Allow Binder Delete checkbox.
4. To disable binder deletions, clear the Allow Binder Delete checkbox.
5. Click the Save button to save your changes.

Configuring Automatic Binder Deletions

Several modes allow you to enable or disable the automatic deletion of binders. When automatic binder deletion is enabled, the binder from the source workflow is removed from the catalog when the operator submits a job to a target workflow. This effectively makes the binders in a catalog an automatically managed task list that removes each binder after the operator takes action on it.

Note: Binder removal from the catalog is also controlled by expiration times defined in the workflow Register action. Removing the binder from the catalog after job submission does not actually delete the binder, since the binder is being used in the job that was just submitted.

To enable or disable automatic binder deletions, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To enable automatic binder deletions, check the Auto Delete Binder checkbox.
4. To disable automatic binder deletions, clear the Auto Delete Binder checkbox.
5. Click the Save button to save your changes.
Enabling and Disabling Binder Filtering

You can use the binder filtering feature to enable or disable operator control of the binder contents that are submitted to a workflow with the Vantage Workflow Portal. When binder filtering is enabled, the portal Submit Jobs dialog displays the Media Files and Attachment tabs.

The Media Files and Attachments tabs list all media and attachments associated with the job. Vantage Workflow Portal operators can use the controls on these tabs to filter (not submit) select assets and change nicknames. If you disable this feature, neither tab is visible to the operator, and each submission includes all binder assets.

To enable or disable binder filtering, do the following:

1. Select the configuration to change.
2. Select the Browsable Catalogs tab.
3. To enable binder filtering, check the Allow Binder Filtering checkbox.
4. To disable binder filtering, clear the Allow Binder Filtering checkbox.
5. Click the Save button to save your changes.
Defining the Controls and Display Items in Binder View

Vantage allows you to control what Operators see in the Vantage Workflow Portal binder list. The standard features that you can display for each binder are:

- Binder name
- Binder creation date
- Binder expiration date
- Play button
- Submit button (not available in all modes)

You can also display parameters for any of the metadata label parameters that are defined in the domain.

Note: Vantage allows you to hide all columns and controls in the binder list, which means that no items appear in the binder list. At least one display or control item should be configured to display so that binders appear in the binder list.

The following topics describe how to configure what appears in the binder list:

- Defining the Standard Feature Settings
- Adding and Deleting Columns for Metadata Parameters

Defining the Standard Feature Settings

To enable or disable the standard binder display components, do the following:

1. Select the configuration to change.
2. Select the Binder Details View tab.
3. Check each feature checkbox to display the information or control, or clear the checkbox to hide the feature. The following are standard features:
   - Binder name. Displays the name assigned to the binder when it was created.
   - Created. Displays the date and time the binder was created.
   - Expiration. Displays the date and time the binder expires.
   - Play button. Displays a button that the operator can use to play or pause the selected job.
   - Submit button. Displays a button that the operator can use to submit a job to another workflow.

Note: The play button operates only when the workflow has generated and registered a proxy file (see the Using Workflow Portal topic in the Vantage User Guide). The Submit button appears only when target workflows are selected on the Forward to Workflows tab.

4. Click the Save button to save your changes.

Adding and Deleting Columns for Metadata Parameters

To add or delete metadata parameter columns for the binder list, do the following:

1. Select the configuration to change.
2. Select the Binder Details View tab.
3. Click the Column button.
4. Do the following for each metadata label parameter for which you want to display a column:
   a. Select a metadata label in the Labels panel.
   b. In the Parameters panel, check the checkbox for the metadata label parameter you want to display.
   c. When you are done making changes, click OK.
5. For each metadata label parameter column that you want to remove from the binder view, do the following:
   a. Select the parameter in the parameter list.
   b. Click the Delete button to delete a parameter from the parameter list, and then confirm the delete.
6. To change the displayed order of parameters, select a parameter in the parameter list (Ctrl-click or Shift-click to select multiple parameters) and use the green up and down arrow buttons to move the variable in the list.
7. Click the Save button to save your changes.
Managing Metadata Label Configuration Options

Vantage allows operators to view and set metadata labels when they submit jobs to a workflow. These labels can be used by the workflow to customize job processing.

*Note:* For an introduction to metadata labels, see *Understanding Metadata Labels* in the *Vantage Domain Management Guide*.

When an operator views metadata labels in Vantage Workflow Portal, the labels that appear in the binder are only those labels that are set in the workflow and configured to be visible for the portal configuration. If the portal configuration supports it, operators can add and delete labels in the binder for the target workflow.

Trim groups can be configured in metadata labels. A trim group consists of three timecode controls for trimming media proxies: In point, Out point, and Duration. Creating multiple trim groups allows operators to trim multiple times along the video timeline, for example, to remove multiple black separators between video segments.

Vantage also allows you to configure hotkeys for setting the time code values. When an operator locates a frame and wants to set a label parameter to the time code for the specified frame, the operator simply presses the appropriate hotkey for Mark In, Mark Out, or Duration, and the timecode is recorded in the label parameter.

The Options button opens a dialog for selecting a label parameter display mode. Label parameters can be set to be visible (normal), hidden, or read-only to portal operators.

To configure metadata label usage for operators, do the following:

1. Select the configuration to change.
2. Select the Labels tab.

*Note:* Before a metadata label can be made available to an operator, it must be defined using the Vantage Management Console as described in *Creating Metadata Labels* in the *Vantage Domain Management Guide*. 

![Image](image_url)
3. To enable or disable operator viewing of all metadata labels in the portal, check (enable) or clear (disable) the *Show Metadata Labels* checkbox.

4. To allow or disallow operators to add and delete metadata labels to binders, check (allow) or clear (disallow) the *Allow Add/Delete* checkbox.

**Note:** The *Allow Add/Delete* checkbox is not provided in Browse Windows Network mode because you are viewing files, not binders. You must run a job in a workflow to create a binder before you can add labels to the binder.

5. To make an individual metadata label accessible in the portal, do the following:
   a. Select a label in the *Available* panel. (Ctrl-click or Shift-click to select multiples.)
   b. Click Add.

6. To remove previously accessible metadata labels from the portal, do the following:
   a. Select labels in the *Visible to user* list. (Ctrl-click or Shift-click to select multiple labels).
   b. Click Remove. This moves the labels back to the Available list (not accessible in the portal).

7. To change label order, select labels in the *Visible to user* list (Ctrl-click or Shift-click to select multiples) and use the green up and down arrows to move the labels.

8. Add Trim Groups (if desired) to labels that include time code. Trim groups allow operator trimming of media by setting timecode in and out points and clip duration at multiple locations in the media timeline (as many locations as the number of trim groups):
   a. Select the label in the *Visible to user* list.
   b. Click Trim. This opens a Trim Groups dialog.
   c. Select Add New Trim Group in the Trim Groups dialog.
   d. Use the add Mark In, Mark Out, and Mark Duration drop down menus to add those trim controls to the Workflow Portal display for that label.
   e. Click OK to save your changes (or Cancel).

9. You can define hotkeys for each of the timecode controls:
   a. Select the metadata label in the *Visible to user* list.
   b. Click the dropdown menus and select hotkeys corresponding to the Mark In, Mark Out, and Duration controls.
   c. If you want to clear all hotkeys, you can click the Clear button and then click OK to confirm the clear.
   d. Click OK to save your changes (or Cancel).
10. To change how individual label parameters are displayed:
   a. Click a label in the Visible to user column.
   b. Click Options... The Label Parameter Display Options dialog opens.
   c. Select the label parameters one at a time and set the drop-down menu to *normal* to make the label visible and editable, *hidden* to make the label invisible, or *read-only* to make the label visible but uneditable.
   d. Click OK to confirm your choices and close the dialog.

11. Click the Save button to save your portal configuration changes.

**Note:** When testing your Vantage Workflow Portal configuration, the metadata label display is different for the different configuration modes. For the Browse Windows Network mode, labels are only visible to operators after they select a media file and target workflow and click Submit. For Browse Catalogs (copy binder) mode, labels are only visible to operators after they select a binder and target workflow and click Submit. For Browse Catalogs (forward binder) mode and Create EDL from Catalogs mode, labels are visible to operators as soon as they select a binder.

**Note:** The duration timecode can be dropframe or non-dropframe, depending on the setting of the *Use dropframe notation for duration when appropriate* checkbox in the Vantage Management Console Workflow Portal Configurations panel. By default (unchecked), durations are always shown in non-dropframe. When checked, durations match the dropframe setting of the in/out values.
Managing Variable Configuration Options

Vantage allows operators to save values and settings in the portal as variable values. These values may then be passed to the workflows specified in the Forward to Workflows tab to affect downstream processing.

**Note:** For an introduction to Vantage variables, see *Understanding Variables* in the Vantage Domain Management Guide. Also note that the Variables tab differs for VOD and Tempo modes—see *Specifying Content Rating Variables* below.

To enable or disable operator use of variables, do the following:

1. Select the configuration to change.
2. Select the Variables tab.

3. To make a variable available to operators, do the following:
   a. Select one or more variable names in the in the Available panel. (Ctrl-click or Shift-click to select multiple names.)
   b. Click Add.
4. To hide variables from operators, do the following:
   a. Select one or more variables in the Visible to user panel. (Ctrl-click or Shift-click to select multiple variables.)
   b. Click Remove.

**Note:** When all variables are hidden from operators, the Variables tab does not show.
5. To change the displayed order of variables, select a variable in the *Visible to user* panel and use the green up and down arrow buttons to move the variable in the list. (You can Ctrl-click or Shift-click to select multiple variables and move them.)

6. Click the Save button to save your changes.

**Note:** If you are testing your Vantage Workflow Portal configuration, variables are only visible to operators after they select a binder and target workflow and click Submit.

---

**Specifying Content Rating Variables**

VOD and Tempo mode configurations offer a different set of variables. These modes allow you to specify the variables you need for your particular application.

To specify variables, do the following:

1. Select the configuration to change and display the Variables tab.

2. Check each item of information (Rating System, or CGMS-A, for example) that you want to supply to the workflow, and then select the variable to use. Typically, you’ll choose the variable of the same name.

3. Click the Save button to save your changes.

---

**Controlling Workflow Forwarding**

With the appropriate permissions, Vantage operators can forward binders to one or more target workflows for further processing. As a Vantage administrator, you can control the following:

- Whether operators can view the Forward to Workflows tab in the portal.
- The target workflows to which operators can forward binders.
- Whether operators are required to forward to a target workflow.

When workflow forwarding is enabled in a Vantage Workflow Portal configuration, operators can forward to any visible target workflow by selecting the workflow on the Forward to Workflows tab and clicking Submit. If a target workflow is required, it is automatically selected on the Forward to Workflows tab and the binder is forwarded to the required workflow when the operator clicks Submit.

To enable or disable binder forwarding to other workflows:

1. Select the configuration to change.
2. Select the Forward to Workflows tab.

3. To enable or disable operator viewing of target workflows, check (enable) or clear (disable) the Show Forward to Workflows checkbox.

**Note:** If you disable operator viewing of target workflows, you also disable operator forwarding to target workflows, if “Req’d” is not checked. When “Req’d” is checked, operators can submit to the required workflows even though they can’t see them.

4. To make target workflows available to operators, do the following:
   a. Select workflow names in the Available panel. (Ctrl-click or Shift-click to select multiple workflow names.)
   b. Click Add.

**Note:** To accept forwarded binders, the target workflow must contain at least one Receive action. The Available panel only displays workflows that contain a Receive action.

5. To specify whether a target workflow is required for forwarding or optional, check (required) or clear (optional) the Req’d checkbox next to the workflow in the Visible to user panel.

6. To hide workflows from operators, do the following:
   a. Select one or more users in the in the Visible to user panel. (Ctrl-click or Shift-click to select multiple workflows.)
   b. Click Remove.

7. Click the Save button to save your changes.
Defining Storage

EDL, CML, and XML files specified in the EDL, CML, DPP, VOD, and Tempo mode configurations can be stored in any Vantage store or folder, or they can be stored in a special Vantage store or folder, designated for these files.

**Note:** The Microsoft User Account Control (UAC) feature may deny access to Vantage stores or folders that are placed in protected locations. If Vantage users report that access to a Vantage store or folder is denied, do one of the following:
1. Place the store or folder in a directory that is not protected by UAC.
2. Use the procedure below to specify a different store or folder.

To specify a storage location, do the following:

1. Select the configuration to change.
2. Select the Storage tab.
3. To store files in any available Vantage store, select Available Vantage Store.
4. To store the files in a specific Vantage store or folder, select Vantage Store/Folder radio, and select a Vantage store or folder in the drop down list.
5. Click the Save button to save your changes.

This completes storage configuration. There is no visible indication of storage locations in the Portal, but the assigned storage location will be used when needed.
Specifying Content Branding and Ratings Graphic Settings

VOD and Tempo mode configurations allow you to specify up to five layers of content branding and also to specify rating system graphics display options for jobs you’re preparing for publication.

Select the configuration to change and select the Graphic Settings tab.
Setting Up Content Branding Layers

To specify content branding options, do the following:

Under Content Branding, check each layer you’ll need in your output, and for each layer, set the following controls. (For every layer you check, it is displayed in the VOD Portal.)

- Layer Name: Specify a logical name for this layer (displays in the VOD Portal to identify the layer for the operator; does not affect output).
- Overlay: Browse to select (or manually enter) the fully-qualified path to the graphic you want to use as the branding bug. Also check Read Only if you don’t want the operator to use another file. See the list of supported formats, below.
- Specify the XY position of the top, left corner of the graphic on the frame, and the width and height of the viewing rectangle.
- Specify the opacity of the graphic.
- Check Entire Segment to display the bug continuously, or uncheck and specify the time for the display. For either setting, specify the frequency of display and the fade duration in and out.

<table>
<thead>
<tr>
<th>BMP</th>
<th>EMF</th>
<th>EXIF</th>
<th>GUID</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICON</td>
<td>JPEG</td>
<td>Memory BMP’</td>
<td>PNG</td>
</tr>
<tr>
<td>TIFF</td>
<td>TGA</td>
<td>WMF</td>
<td>Single-layer Photoshop (PSD)</td>
</tr>
</tbody>
</table>

Setting Up Rating System Options

To specify Ratings System options, do the following:

1. Under Rating, set the following controls.
   - Placement and Duration: Select Use Defaults (See the Advisory element topic in the Post Producer Developer’s Guide for default settings) or select Custom and set the following controls.
   - First and Subsequent Segments: Specify the XY position of the top, left corner of the graphic on the frame, and the width and height of the viewing rectangle.

2. Click the Save button to save your changes.
Specifying Embedded Metadata Settings

VOD and Tempo mode configurations allow you to specify default copy protection options (VOD only), OTT Black Duration (VOD only) and ratings system settings (both VOD and Tempo) for jobs you’re preparing for publication.

In the VOD portal, the OTT Ad insertion type causes the number of selected frames to be replaced with black. In the portal configuration, the OTT Black Duration setting determines the default length of the black replacement. The VOD Portal operator can override this default by setting a different value for OTT Black Duration in the portal Embedded Metadata tab.

To set the default OTT Black Duration, enter a timecode value, and set the drop-down menu to the frame rate. Using Time allows you to set the value in seconds instead of a frame rate and makes the setting frame rate independent. Checking the Read Only option prevents portal operators from changing this default value.

To specify default copy protection and ratings system settings, follow these steps:

1. For copy protection (VOD only), select one option from the CGMS-A menu:
   - Not Set
   - Copy Freely (0,0)
   - Copy No More (0,1)
   - Copy Once (1,0)
   - Copy Never (1,1)

2. Read Only: Check to show the settings to the operator without allowing changes.

3. For Ratings Systems, select the ratings system from the Ratings menu.

4. Read Only: Check to show the settings to the operator without allowing changes.

5. Specify the rating to apply, and the justification for this content.

6. Click the Save button to save your changes.
Managing Permitted Users of Portal Configurations

When the User Management feature is enabled, you can use the Vantage Management Console to define which Vantage users can access each Vantage Workflow Portal configuration. You can enable access for one, some, or all users.

Note: For more information on the user management feature, see Managing Vantage Users in the Vantage Domain Management Guide.

To define which users can access a Workflow Portal configuration, do the following:

1. Select the configuration to change.
2. Select the Permitted Users tab.

3. To grant access to all users, check the Everyone checkbox.
4. To grant access to one or more Vantage users, do the following:
   a. If the Everyone checkbox is checked, clear the checkbox.
   b. Select one or more users in the in the Available panel.
      To select multiple names, you can press Control and click multiple non-contiguous names, or you can click one name, then press Shift and click another name to select a contiguous series.
   c. Click Add.
5. To remove access for one or more Vantage users, do the following:
   a. Select one or more users in the in the Permitted users panel.
      You can use the Control and Shift keys to select multiple users as described in the previous step.
   b. Click Remove.
6. Click the Save button to save your changes.
Specifying DPP Metadata and DPP Options

Using the DPP Metadata and DPP Options tabs and panels available when the Create DPP from Catalogs (create binder) option is selected, you can specify DPP metadata to be included in DPP processing. Many fields are available in the Editorial, Technical, Audio, Access Services, Additional Metadata, and Contact Information fields.

Additionally, the DPP Options tab includes options for adding 2 frames of white and tone, treating the last segment as a Textless Element (not part of the programme), ending a part with black, and specifying default, custom, or no slate, etc. For information about how the many metadata fields and option selections are used, refer to the DPP user documentation. DPP is a separately licensed product.
Configuring Tempo Settings

The Tempo Portal includes a tab and panel for Tempo Settings where you can specify standard settings to use for increasing or decreasing media duration:

1. Select the Tempo Portal configuration in the configuration mode list.
2. Select the Tempo Settings tab.

3. Select re-timing default settings in the Tempo Portal:
   a. Select *Preserve and re-time captions* to include captions in the re-timing process.
   b. To include a subtitle or caption (.SCC or .STL) file that plays with the re-timed media file, browse for and specify the file in the Subtitle/caption file field.
      The starting timecode in the caption/subtitle file must match the starting timecode of the media file.
   c. To adjust the start time of caption/subtitle file timecode, select Subtitle/caption offset, enter the amount of offset in timecode, and set Subtitle/caption offset sign (+ or -) to adjust the offset forward or backward.
   d. Use *Set timecode at* to determine where to start timecode for the re-timed output. You can preserve existing source timecode, start timecode at the first or last frame of the program, or the first or last frame of the output file.
   e. Select *Re-Time* to increase or decrease media duration by the *Amount* selected or to match an overall target duration for the entire program. An amount specified here becomes the default setting in the Tempo Portal Segment List tab.
   f. Use *Amount* to set the amount of re-timing in frames per second. The display shows the hours, minutes, seconds, and frames setting.

**Note:** Checking Read Only for each of the above options displays the default setting but disallows changing the setting in the Portal. The default setting is always used.
4. Select the Timeline Navigation tab to check and set Tempo timeline default values. The Silence settings determine the default definition of silence. The Artifact quality threshold sets a default value for defining artifacts noted on the preview player timeline. These values are displayed in the Tempo Portal Timeline tab, where their values can be changed from the default values set here. See the Tempo User Guide for details.

5. Click the Save button to save your changes.

Configuring Syndication Settings

The Syndication Portal configuration includes a tab and panel for Syndication Settings where you can specify standard settings that control portal operation:

1. Select the Syndication configuration in the configuration Mode list.

2. Select the Syndication Settings tab.

3. Select Default template to choose the template that will automatically be applied to shows in the portal. (If you select << No Template >>, the Syndication Portal creates a Segment List from the source XML file processed by the Syndication action.)

4. Set the Template permissions to define whether portal operators can Create and modify templates, Create only, or do nothing (None) with templates.

5. Set the Syndication mode to output segments (Segmenting), a complete show (Stitching) or a complete show with Syndication attachment consisting of the original XML sidecar file modified for timing only (Pass-Thru).

6. Set Segment naming to Append a number to the show file name for each segment, or Append a letter, or not do anything to file naming.
Deleting a Configuration

To delete a Vantage Workflow Portal configuration, do the following:
1. Select the configuration to delete.
2. Click the Delete button \( \times \) in the tool bar.
3. Click OK to confirm the delete or click Cancel to abort the delete.

Saving a Configuration

Changes that you make to a Vantage Workflow Portal configuration are not applied or saved until you save the configuration as follows:
1. Select the configuration to save.
2. Click the Save button \( \text{save} \) in the tool bar.

Duplicating a Configuration

If you need a new configuration that is similar to an existing configuration, it might be easier to duplicate the configuration and modify the duplicate, instead of creating a new configuration. When you duplicate a configuration, the console creates a new configuration with \( \text{Copy of} \) prepended to the source configuration name.

To duplicate a Vantage Workflow Portal configuration, do the following:
1. Select the configuration to duplicate.
2. Click the Duplicate button \( \text{duplicate} \) in the tool bar.

Exporting and Importing Configurations

Vantage allows you to export one or all Vantage Workflow Portal configurations to XML files, which you can then use to import the same configurations into another Vantage domain.

Export

To export one or all configurations, do the following:
1. If you are exporting a single configuration, select the configuration to export.
2. Click the Export button \( \text{export} \) to export a single configuration, or select \text{Export all} from the Export button drop down menu.
3. Use the file system dialog to save the exported configurations.
   The default file name for each configuration is the configuration name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the configuration in the XML file.
Import

To import a configuration, do the following:

1. Click the Import button.
2. Use the file system dialog to locate and select the configuration to import, then click Open.

**Note:** If you try to import a configuration that is already in this Vantage domain, Vantage prompts you to overwrite the record (click Yes) or cancel the import (click No).

Refreshing the Configuration List

The configuration list is a static display that is automatically updated when you add or delete configurations. However, if other administrators add or delete configurations, you must refresh the configuration list to display the changes.

To refresh the configuration list, click the Refresh button in the tool bar.
Vantage Workflow Portal Deployment Tips

As a Vantage domain administrator, you can make it easier for operators to start using Vantage Workflow Portal by doing the following:

• Install the Vantage Workflow Portal program on the operator’s computer.
• Launch the Vantage Workflow Portal for the first time and pre-select the following:
  – Vantage domain
  – Vantage Workflow Portal configuration
  – Binder catalog

**Note:** If you deploy the web version of the Workflow Portal, please note that operation of the Web Workflow Portal preview player may vary depending on the browser. The functioning of controls, appearance of captions, and other aspects depend on the browser’s implementation of the web video player. You may want to try different browsers to find the one that works best for you.
Vantage Workflow Portal Tours

This topic contains examples of how to set up portals allowing operators to perform certain tasks. These tours assume that you are familiar with Vantage; they provide high-level design guidelines only.

Vantage Workflow Portal Tour: Operators Submit an EDL

This tour describes how to configure the ingest workflow, target workflow, and Portal configuration, to allow operators to stitch assets together by specifying an EDL, and create an MPEG-2 Transport Stream output file.

Step 1: The Ingest Workflow

This workflow watches a hot folder for incoming media files.

When new files are detected, the workflow will:

1. Generate a proxy at 29.97 fps, with the nickname Vantage Proxy.
2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.
3. Create a Transport Stream MPEG-2 file to be used for stitching, with the nickname Vantage EDL.
4. Register the binder in the catalog named Assets.
Step 2: The Target Workflow

The desired output format is MPEG-2 Transport Stream. Because the EDL inputs are also MPEG-2 Transport Stream, the Direct Convert container type is implemented.

Video from the input files is re-wrapped without transcoding, and I-Frames are inserted at any GOP breaks.

This workflow:

1. Receives the TSEDL file from the Vantage Workflow Portal with the nickname *Original*.
2. Uses the TSEDL file to stitch MPEG-2 from the source assets using *Direct Convert* to MPEG-2 Transport Stream.
3. Uses the TSEDL file to transcode the media into a Windows Media output file.
Step 3: Vantage Workflow Portal Configuration

The Vantage Workflow Portal configuration is set up as follows:

1. The *Create EDL from Catalogs configuration* mode is selected.
2. The *Assets* catalog is selected.
3. The target workflow is made available to the operator.
Vantage Workflow Portal Tour: Extracting Highlights

This tour describes how to configure the label design, ingest workflow, target workflow, and Portal configuration, to allow operators to mark in/out points on a master asset for highlight extraction, and also choose distribution channels and enter metadata.

Step 1: Label Design

In this workflow, the operator provides the following information:

- What timecodes should be used for the highlight start, end, and keyframe
- A description and title for the highlight
- To which distribution channels the highlight should be sent

The label is designed accordingly, as illustrated here.
Step 2: The Ingest Workflow

This workflow watches a hot folder for incoming media files.

When new files are detected, the workflow will:

1. Generate a QuickTime H.264/AAC MOV or x264/AAC MP4 proxy at 29.97fps, with the nickname Vantage Proxy.
2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.
3. Populate the Highlight label in the binder, with the default values.
4. Register the binder in the catalog named Assets.
Step 3: The Target Workflow

The following figure shows an example of a target workflow.

The target workflow uses the metadata provided by the operator as follows:

1. Receives from the Portal, and expects the *Original* asset to be available.
2. Uses the Populate action to extract the timecodes and metadata from the label, as variables.
3. Trims the original to a short, mezzanine format that can be used for multi-channel transcoding, using the Start/End timecodes specified by the operator.
4. Creates a JPEG keyframe at the time specified by the operator.
5. Uses the Populate action to extract the true/false values specified by the operator checkboxes for distribution channels.
6. Uses those true/false values to determine whether each branch of the workflow should execute.
7. Encodes the appropriate output formats, embedding the metadata information provided by the operator into the output files, and deploying to the target.
**Step 4: The Portal Configuration**

The Portal configuration is set up as follows:

1. Choose the Browse Catalogs (Copy Binder) configuration mode.
2. Select the appropriate catalog.
3. Make the Highlights metadata label visible to the user.
4. Make the target workflow available to the user.
Using the Vantage Dashboard Web App

Vantage Dashboard is a Web application that you can use to monitor and manage your domain from any computer, anywhere on your network, as long as that computer has a compatible browser.

**Note:** Vantage Dashboard is an option available with the Vantage System Web Dashboard license. Vantage Dashboard access requires that you enable the user management feature (see Managing Vantage Users in the Vantage Domain Management Guide).

The following topics describe how to use the Vantage Dashboard:

- Overview
- Managing Vantage Dashboard Sessions
- Monitoring a Domain
- Managing Health of a Domain
- Administering the Domain

**Note:** For instructions on how to install the Vantage Dashboard on your IIS server, see Installing and Configuring Vantage Web Applications in the Vantage Domain Management Guide.
Overview

Vantage Dashboard is designed to help domain administrators manage the entire Vantage domain, as opposed to other tools which allow management of domain components, such as jobs.

The Vantage Dashboard pages are designed to help you quickly assess the health of the domain and progressively dig into deeper detail as needed. For example, the Summary Status page allows you to quickly see the workflow completion success rate and the error rate on domain servers. The information on the Summary Status page can help you determine if it is more appropriate to troubleshoot a problem or evaluate system performance.

Other Vantage Dashboard pages allow you to view the status of servers, services, and jobs. When troubleshooting, it can be very helpful to determine if problems are system wide or confined to a server, a service, or a particular workflow. Vantage Dashboard provides the Web pages that allow you to quickly assess your domain from any Web client that has connectivity to your domain.

Managing Vantage Dashboard Sessions

When you start Vantage Dashboard in a Web browser, you establish a session with the Vantage domain. The following topics describe how to manage a Vantage Dashboard session:

- Vantage Web Applications Browser Requirements
- Starting the Vantage Dashboard
- Understanding the Vantage Dashboard Display
- Hiding and Displaying the Header Panel
- Managing the Menu Panel
- Sorting Lists in the Status Panel
- Logging Out
- Changing Your Vantage User Password
- Changing Vantage Domains
- Displaying Product Version Information
- Displaying Help
- Returning to the Welcome Page
- Troubleshooting Tip
Vantage Web Applications Browser Requirements

Telestream supports a number of browsers for use with the Web Apps. For the current list, see the Before You Install chapter, Vantage Web Applications Browser Requirements in the Vantage Domain Management Guide.

**Note:** To use Vantage Dashboard with Internet Explorer, configure Explorer as described in the Vantage Web Applications Browser Requirements topic of the Before You Install chapter in the Vantage Domain Management Guide.
Starting the Vantage Dashboard

To start the Vantage Dashboard, open your web browser and navigate to the location of the Vantage Dashboard on an IIS server. There are 2 URLs that you can use to access the Vantage Dashboard:

- http://<ServerName>/Vantage
- http://<ServerName>/Vantage/Dashboard

The first URL displays links for all Vantage Web Applications (including the Vantage Dashboard), and the second URL directly starts the Vantage Dashboard. Replace <ServerName> with the name of the Vantage Dashboard host server (or its IP address). If you do not know the URL of the Vantage Dashboard, obtain it from your Vantage administrator or IT department.

Note: To access Vantage Dashboard, you must enable user administration as described in Enabling and Disabling User Administration in the Vantage Domain Management Guide.

The following topics describe how to connect to the Vantage domain after you enter the URL:

- Connecting for the First Time
- Reconnecting to Vantage Dashboard
Connecting for the First Time

The first time you connect to the Vantage Dashboard, you are asked to select a domain to which the Vantage Dashboard should attach (see the figure below).

Click the Search button to search for and list available Vantage domains.

Select a domain and click OK.

If the Vantage domain database has a custom password, or if the Vantage domain you seek is not listed, click Advanced.

In the Advanced window, you can enter a domain Name or IP address and connection settings (following figure), including the Vantage Instance Name, and database login credentials.

If your Vantage database uses the default Vantage credentials, you can leave Use default credentials selected, and just click OK to log in.
If your Vantage database has unique credentials, click *Use custom credentials* and enter a *Login* and *Password* before clicking *OK* (or *Basic* to return to the basic domain selection window or *Cancel* to cancel the domain selection.)

![Select Vantage Domain](image)

After you click *OK*, Vantage Dashboard logs into the selected domain, and prompts you for your Vantage user login information.
When the login dialog box displays (see the figure below), enter the User Name and Password assigned by your Vantage Administrator, and then click Log In.

These are the default user name and password, which remain the same until changed:

- User Name: Administrator
- Password: <none> (no characters entered)

**Note:** User passwords are encrypted in the Vantage domain database. Users have the option of changing their password (see Changing Your Vantage User Password).

Check *Remember me next time* to store the authentication token in a persistent cookie in the browser. This keeps you authenticated if you close your browser and reopen it.

**Reconnecting to Vantage Dashboard**

After you connect to the Vantage Dashboard for the first time, the Vantage Dashboard remembers the domain to which you connected and displays the Dashboard Login prompt (see the When the login dialog box displays (see the figure below), enter the User Name and Password assigned by your Vantage Administrator, and then click Log In. figure). Enter the User Name and Password assigned by your Vantage Administrator, then click Log In.

**Note:** Cookies should not be disabled by either browser settings or group policy. If cookies are disabled, the Vantage domain will not be remembered.
Understanding the Vantage Dashboard Display

Upon successful login, Vantage Dashboard displays the welcome screen shown in the figure below.

Vantage Dashboard displays information and controls in three panes: header, menu, and status. The header panel displays controls for session management, and the left menu panel displays menu selections, which are described in the Welcome page in the status panel when Vantage Dashboard starts. The status panel displays information about your domain, based on the selection you make in the menu panel.

Hiding and Displaying the Header Panel

The header panel displays the Vantage user name you are using and the Vantage domain to which you are connected. The header panel also displays controls you can use to change your Vantage user password, change the selected Vantage domain, or log out from the Vantage domain. To hide or display the header panel, click the display/hide button shown in the figure.
Managing the Menu Panel

You can collapse or expand the items in the menu panel, and you can hide or display the menu panel.

You can collapse menus by clicking the up arrow to the right of the menu name (the Upon successful login, Vantage Dashboard displays the welcome screen shown in the figure below. figure), and you can expand menus by clicking the down arrow, which displays for collapsed menus.

To hide or display the menu panel, click the display/hide button shown in the Upon successful login, Vantage Dashboard displays the welcome screen shown in the figure below. figure.

Sorting Lists in the Status Panel

Most pages that appear in the status panel contain lists, which can be sorted based on the content of any of the columns. To do this, click on any column heading. The first click sorts the list rows in ascending order of the information in the selected column. The second click sorts them in descending order. A third click removes sorting and displays the default sort order.

Logging Out

When you are logged in to the Vantage Dashboard, anyone with access to your computer has access to the Vantage Dashboard reports and controls. To prevent unauthorized access to Vantage Dashboard when your computer is unattended, log out by clicking Logout in the Vantage Dashboard header.

After log out, the log in window displays again.

Changing Your Vantage User Password

To change your Vantage password, do the following:

1. Click Change Password in the Vantage Dashboard header.
   Vantage Dashboard displays the dialog to change your password.

2. Enter your current password in the Password field.

3. Enter your new password in the New Password field, and confirm it by re-entering it in the Confirm Password field.

4. Click Save when finished.
Changing Vantage Domains

Vantage Dashboard can monitor just one domain at a time. To change the domain you are monitoring, do the following:

1. Click Change Domain in the Vantage Dashboard header.
2. If you are logged into Vantage Dashboard, you are prompted to log out. Click OK to log out.
3. Select a domain name in the domain list that displays (see the figure below), and click OK.
4. When the Vantage Login dialog appears, enter a user name and password, and click Log In.

Displaying Product Version Information

To display the Vantage Dashboard version number, click Help > About in the menu panel. Vantage Dashboard displays the version information as shown in this figure:

Displaying Help

Vantage Dashboard provides help (the user’s guide you are reading) in two different formats: PDF format and HTML.

To display this user guide in PDF format, click Help > User Guide in the menu panel.

To display context-sensitive help, click the Help button in Vantage Dashboard.

To display this user guide in HTML format, click Help > Web Help in the menu panel.
This HTML online help system consists of two panels:

- The left panel displays the following tabs:
  - Contents tab—This tab displays a hierarchically organized set of chapters and pages. This list provides a wide range of overview and how-to topics that explain how to add, configure, and manage Vantage components.
  - Index tab—This tab provides a list of keywords you can click to display its associated page.
  - Search tab—Looks for specific words or phrases, resulting in a display of topics that match your search criteria.
  - Favorites tab—lists favorite topics that have been saved by adding them to the list. Topics are added by clicking the Add button.
- The right panel displays the page you have selected from one of the tabs on the left.

**Returning to the Welcome Page**

Click Help > Welcome Page in the menu panel to display the welcome page that is presented when the Vantage Dashboard is first started up. This page displays descriptions of all the menu items for the Vantage Dashboard.

**Troubleshooting Tip**

In some situations, if a Vantage administrator modifies (adds or removes) a virtual directory on the IIS server, the Web Dashboard session will close. This does not change the Web Dashboard configuration or operation. To continue using Web Dashboard, start the program as described in *Starting the Vantage Dashboard*. 
Monitoring a Domain

The following topics provide information on monitoring a domain:

- Displaying Domain Summary Status
- Managing Domain Job Status
- Viewing Domain Monitor Status

Displaying Domain Summary Status

The Summary Status page shown in the figure below provides a high-level status of the Vantage domain to which you have connected. To display the Summary Status page, select Monitoring > Summary Status in the menu panel.

Note: The Chart Type menu displays pie charts for action allocation and services.
The pie chart displays the status of workflow operation in the domain. You can hover the cursor over the pie chart segments to display exact percentages for completed, failed, and stopped workflows. This chart automatically updates over time.

If the pie chart shows that all jobs are completing, you might want to use other Vantage Dashboard pages to determine the domain performance level. If the pie chart indicates that there are failed jobs, you might want to use a time filter to define the period for which you want summary status. For example, if you recently fixed a problem in the domain, you might want to use a time filter to limit the display to workflow operation since the fix was applied.

**Note:** The upper and lower panels in the Summary Status panel are separate reports for different views of the Vantage domain. In preceding Domain Summary Status figure, the pie chart displays statistics from Job Status, and the bar graph displays statistics based on service metrics. Be aware that certain events can change the reports to appear inconsistent. For example, once all failed jobs have expired or been deleted, the pie chart might show 100% success, while the bar graph still reports errors. Likewise, if a service is brought in and out of maintenance mode, which resets service statistics, the pie chart can show a larger percentage of errors than indicated by the bar graph.

To specify a time filter, do the following:

1. Click the Time Filter button above the pie chart.

   Vantage Dashboard displays the dialog shown in this figure:

   ![Time Filter Dialog](image)

   - **Start Date/Time**
   - **End Date/Time**
   - **Calendar button**
   - **Clock button**

2. Type a date and time in each text box, or use the calendar and clock tools in the window to select the date and time.

3. Click Apply to close the filter dialog and display the pie chart for the filter period.
Vantage Server Health

The Vantage Server Health panel (see below) on the Summary Status page displays the percentage of errors for each Vantage server in your domain. To display this panel, select Monitoring > Summary Status.

The bar chart displays the error rate for all servers in the domain. You can hover over a bar in the bar chart to display an exact percentage, and you can use the Chart Type dropdown list to display the services that experienced the errors.
Vantage Service Health

When an appropriate chart type is selected in the Summary Status panel, the upper panel displays a pie chart that shows the relationship between queued and running actions for one or all services. When an appropriate chart type is selected in the lower panel, this panel displays a bar chart showing the error rate for services with errors.
Displaying Action Allocation Across Services

When the Action Allocation chart type is selected, the Summary Status page shows a pie chart that shows the relative use of all active services (see below). You can hover the cursor over any chart segment to see the numerical value for that segment.

To display the Action Allocation chart, do the following:
1. Select Monitoring > Summary Status.
   Vantage Dashboard displays the default Summary Statistics page shown below.
2. Click Chart Type in the upper panel and select Action Allocation.

Displaying the Queue and Run Status for a Service

The upper panel of the Summary Status page supports pie chart views for Vantage services. When you select a chart type for a specific service, the Summary Status page displays a pie chart that shows the percentage of running and queued actions for a service (see the figure). You can hover the cursor over any chart segment to see the numerical value for that segment. If no chart appears, there are no active or queued actions for that service.

To display a chart for any service, do the following:
1. Select Monitoring > Summary Status.
   Vantage Dashboard displays the default Summary Statistics page shown above.
2. Click Chart Type in the upper panel and select a service from the list.
Displaying the Error Rate for all Services

The Vantage Service Health chart (see below) displays the percentage of errors for any domain services that have errors. This display is refreshed when services are restarted.

To display the Services Health chart, do the following:

1. Select Monitoring > Summary Status.
   Vantage Dashboard displays the default Summary Statistics page shown above.
2. Click Chart Type in the lower panel and select Service Health.
Managing Domain Job Status

The Domain Job Status page (see below) in Vantage Dashboard allows you to manage jobs throughout the domain.

The Domain Job Status page provides a real time view of Vantage workflow jobs, and it provides controls that you can use to manage job processing. The Domain Job Status page displays two lists: the Job Status list and the Actions list.

The Job Status list presents workflow jobs, the state of each job (such as Complete, Failed, Stopped, In Process, Waiting), and timestamps for job events. Whenever a job is selected, the actions associated with that job are listed in the Actions list at the bottom of the window. The Actions list presents status information for each action and controls for managing the actions.

The following topics describe how to manage the jobs and actions listed on the Domain Job Status page:

- Paging Through the Job List
- Filtering Jobs or Actions
- Highlighting Job or Action Status Rows
- Displaying Job Error Details
- Stopping Jobs
- Restarting Jobs
- Deleting Jobs
- Displaying Action Error Details
- Changing Action Priority
- Restarting Actions

**Paging Through the Job List**

You can navigate to any page by clicking the page number or by clicking the forward (right arrow) and previous (left arrow) buttons (see the figure below). The arrow buttons with the vertical bars navigate to the first and last pages.

You can also enter the number of jobs to be listed on each page using the page size control shown in the following figure.

Page adjustments are useful when adjusting performance with large amounts of data. A smaller page size results in less data sent to the browser, but also displays a smaller amount of all the available data.

**Filtering Jobs or Actions**

The filter feature allows you to selectively limit the row entries in the Job Status list or the Actions list based on the contents displayed in one or more columns. After you apply each filter, the list displays only those rows in which the column entries conform to the filter settings. To remove filters and display more entries, you must change the filter settings to display all items.
To display the filters for the Job Status list or the Actions list, click Show Filters (see the preceding and following figures). Click Show Filters again to hide the filters.

The filter settings fall into three groups, which are listed in the following table and described in the following topics:

- Setting Text Filters
- Setting State Filters
- Setting Period Filters
### Table 1. Filter Types and Descriptions

<table>
<thead>
<tr>
<th>Filter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Text</td>
<td>The name of a workflow action.</td>
</tr>
<tr>
<td>Category</td>
<td>Text</td>
<td>The category to which the workflow is assigned.</td>
</tr>
<tr>
<td>Created</td>
<td>Period</td>
<td>The date and time that an action was created for job processing.</td>
</tr>
<tr>
<td>Description</td>
<td>Text</td>
<td>The description entered for the workflow in the Designer.</td>
</tr>
<tr>
<td>Expires</td>
<td>Period</td>
<td>The date and time that a job expires.</td>
</tr>
<tr>
<td>Job</td>
<td>Text</td>
<td>The name of a job, which is usually the ingress filename.</td>
</tr>
<tr>
<td>Machine</td>
<td>Text</td>
<td>The name of the domain server that is processing the action.</td>
</tr>
<tr>
<td>Progress</td>
<td>Text</td>
<td>The completion percentage for the action.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Text</td>
<td>The amount of time the workflow took to execute.</td>
</tr>
<tr>
<td>Started</td>
<td>Period</td>
<td>The date and time that a job is started.</td>
</tr>
<tr>
<td>State</td>
<td>State</td>
<td>The current state of the job or action.</td>
</tr>
<tr>
<td>Updated</td>
<td>Period</td>
<td>The date and time of the last status update for the job or action.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Text</td>
<td>The workflow that is processing a job.</td>
</tr>
</tbody>
</table>
Setting Text Filters

Text filters allow you to enter text and define a method that defines how the text is applied. For example, you can specify ".wmv" in a Job filter and then select a method to display only rows with that extension or to exclude all jobs with that extension. The following table lists the methods you can use to control text filters.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains</td>
<td>Displays only rows in which the column entry contains the specified text.</td>
</tr>
<tr>
<td>DoesNotContain</td>
<td>Displays only rows in which the column entry does not contain the specified text.</td>
</tr>
<tr>
<td>EqualTo</td>
<td>Displays only rows in which the column entry exactly matches the specified text.</td>
</tr>
<tr>
<td>NoFilter</td>
<td>Removes any existing filter entry for this column.</td>
</tr>
<tr>
<td>NotEqualTo</td>
<td>Displays only rows in which the column entry does not match the specified text.</td>
</tr>
</tbody>
</table>

To set a text filter, display the filters, type text in the text box above the column you want, click the funnel button to the right of the text box, and select the method for the text filter (see the following figure).

Note: When you apply a text filter, be sure to enter a value that actually appears in that column. If the filter text does not match any values in the column, the filter might not exclude any rows, or it might exclude all rows, depending on the method selected.

Setting State Filters

State filters limit the list items to those rows that display a state that is selected in the state list. The default filter selects rows in all states, and displays as All States. If you set the filter to display a subset of all states, the filter displays Custom.
To set a state filter, display the filters, click the down arrow in the State filter column for the appropriate list, and check or clear the checkboxes for each state, as depicted in this figure:

![State Filter]

**Setting Period Filters**

Period filters define start and end times for a period of time for which you want to display rows. When a period filter is applied to a column, Vantage Dashboard only displays rows for which the selected column value falls within the defined period.

To specify a period filter, do the following:

1. Display the filters for a time-oriented column, such as the Updated column.
2. Select the period filter you want to set.
   
   Vantage Dashboard displays the dialog shown in the following figure.

![Period Filter Dialog]

3. Type a date and time in each text box, or use the calendar and clock tools in the window to select the date and time.
4. Click Apply to set the filter, or click Clear to remove the filter.

**Highlighting Job or Action Status Rows**

Vantage Dashboard provides an option to highlight job or action status rows using the color representing the row’s state (such as green=In Process, red=Failed, magenta=Stopped, yellow=Waiting). Highlighting can make particular job states more visible in a long list of jobs.

To change the highlighting for the Job Status list or the Actions list, click Highlight State Rows above the appropriate list. Each time you click this control, the highlighting toggles on or off, to the opposite of the previous state.
Displaying Job Error Details
To display error details for a job listed in the Job Status list, select a failed job and click Show Error Details.

Stopping Jobs
To stop a job, do the following:
1. Select Monitoring > Domain Job Status.
2. In the Job Status list, select a job.
3. Click Options and select Stop (or right-click on the job and select Stop).

Restarting Jobs
To restart a job, do the following:
1. Select Monitoring > Domain Job Status.
2. In the Job Status list, select a job.
3. Click Options and select Restart (or right-click and select Restart).

Deleting Jobs
To delete a job, do the following:
1. Select Monitoring > Domain Job Status.
2. In the Job Status list, select a job.
3. Click Options and select Delete, or right-click on the job and select Delete.

Displaying Action Error Details
To display error details for an action listed in the Actions list, select a failed action and click Show Error Details.
**Changing Action Priority**

Vantage evaluates action priority when multiple actions of the same type are ready for processing. Vantage processes actions with the highest numerical priority value first, and in some cases, Vantage pauses lower priority jobs, processes higher priority jobs, and then finishes processing of the lower priority jobs.

You can change action priority to change the processing order of queued actions. To change the priority of an action, do the following:

1. Select Monitoring > Domain Job Status.
2. In the Job Status list, select a job.
3. In the Actions list, select an action.
4. Select Options > Change Priority, or right-click the action and select Change Priority.
5. Specify a new priority value and click OK.

**Restarting Actions**

To restart an action, do the following:

1. Select Monitoring > Domain Job Status.
2. In the Job Status list, select a job.
3. In the Actions list, select an action.
4. Click Options and select Restart, or right-click on the action and select Restart.
Viewing Domain Monitor Status

When you activate a workflow, the Dashboard automatically displays the Domain Monitor Status panel to show you the status of all origin actions in the Domain. (You can always select any workflow and view its monitor (or job) status, including a record of past jobs.)

Notice that the Watch's action state is listed as *In Process*, which indicates it has started executing, and it is polling for new files. When a new file is discovered, a job is created that executes the workflow. Actions may also be *Waiting*—the state that the transaction enters while Vantage is determining which service should process it. A transaction remains in Waiting state until it is accepted by a service for processing.

If you deactivate the workflow, the Watch service stops monitoring the hot folder, and the record is saved in the database for history. When you re-activate the workflow, a new record is added to the list.

You can right-click a row in the table (or select the Options drop-down menu) and select View Status to display more detailed information. Using the same drop-down or right-click menu, you can also Enable or Disable the workflow.

As with other Dashboard panels, you can click on column headings to sort the display, or click on Show Filters and enter column filter text to filter the display. For example, you can enter a date and time in the Started column to view only those actions that were started after a certain date or time.
Managing Health of a Domain

The following topics describe how you can use Vantage Dashboard to monitor servers in your domain:

- Viewing Array Statistics
- Viewing Service Statistics
- Viewing Machine Metrics

Viewing Array Statistics

The Array Statistics page (see the figure below) displays two panels. The upper panel displays statistics for all servers in the domain, and after you select a server in the upper panel, the lower panel displays statistics for all the services on the selected server.

To display the Array Statistics page, select Health > Array Statistics.
This table describes the columns in Array Statistics and Service Statistics lists.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Failures</td>
<td>Displays the error rate for each server in the domain.</td>
</tr>
<tr>
<td>Avg. Queue</td>
<td>Displays the average number of actions in the service action queue.</td>
</tr>
<tr>
<td>Average Wait Time</td>
<td>Displays the average time that all jobs spend waiting in the queue while the service is saturated and unable to take on new jobs. For example, if the service has processed 10 jobs and the waiting times were 0,0,0,0,0,0,0,0,0,0,10 (the last job waited 10 seconds), an average wait time of 1 second would be reported. This indicator helps to highlight ongoing load imbalances or the need for additional computing power to handle overloads.</td>
</tr>
<tr>
<td>CPU Utilization</td>
<td>Displays the percentage of CPU resources that are currently being used by Vantage services on a server.</td>
</tr>
<tr>
<td>Cur. Queue</td>
<td>Displays the current number of actions in the service action queue. ******</td>
</tr>
<tr>
<td>Input Queue Length</td>
<td>Displays the number of queued actions for all services on a Vantage server.</td>
</tr>
<tr>
<td>Load/Target Load</td>
<td>Displays load balancing status. For session-based load balancing, this displays the current number of sessions for this service (Load) and the configured session limit for this service. For cost based load balancing, this displays the current cost of all active sessions for this service (Load) and the target cost (Target Load) configured for this service. For more information on load balancing, see Managing Load Balancing/Task Scheduling in the Vantage Domain Management Guide.</td>
</tr>
<tr>
<td>Server</td>
<td>Lists the servers in the domain that support the selected service. ******</td>
</tr>
<tr>
<td>Passed/Failed</td>
<td>Displays the number of actions that have successfully completed (passed) and failed.</td>
</tr>
<tr>
<td>Service</td>
<td>Displays the name of a service that is supported in the domain. ******</td>
</tr>
<tr>
<td>Sessions</td>
<td>Displays the current number of active sessions. ******</td>
</tr>
<tr>
<td>State</td>
<td>Displays the current state of each service, either Online or Maintenance. ******</td>
</tr>
</tbody>
</table>
Entering and Exiting Server Maintenance Mode

The Array Statistics page allows you to put the entire server with all Vantage services on the selected server in maintenance mode, or it allows you to put individual services into maintenance mode. You place a server or service into maintenance mode when you want to reconfigure services, delete a license, or make other changes that require a Vantage service or all services to be offline.

**Note:** Placing any or all services in maintenance mode erases the metrics for those services, which affects the services bar graphs.

Server Maintenance Mode

To enter or exit server maintenance mode, do the following:

1. Select Health > Array Statistics.
2. Select a server in the upper panel.
3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

**Note:** Server maintenance puts all services into maintenance mode. If you want to shut down individual services, see the following procedure.

Individual Service Maintenance Mode

To enter or exit service maintenance mode (for a single service), do the following:

1. Select Health > Array Statistics.
2. Select a server to manage in the upper panel.
3. Select a service to manage in the lower panel.
4. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

Resetting Service Statistics on the Array Statistics Page

You might want to reset service statistics after making a configuration change to your Vantage Domain. When you reset statistics, all cumulative values are reset to zero, which allows you to establish a new baseline for the domain.

You can reset statistics on the Array Statistics and Service Statistics pages.

To reset statistics for one or all services using the Array Statistics page, do the following:

1. Select Health > Array Statistics.
2. Select a server to manage in the upper panel.
3. If you want to reset statistics for a service, select the service in the lower panel.
4. Click Options in the lower panel and select either of the following:
   - *Clear (Reset) Selected Service Metrics History*—Clears only the metrics history of the service selected.
   - *Clear (Reset) All Service Metrics History*—Clears the metrics history of all the services.
Viewing Service Statistics

The Service Statistics page (the following figure) displays two panels. The upper panel displays cumulative statistics for all services in the domain, and after you select a service in the upper panel, the lower panel displays statistics for that service for all servers in the domain.

To display the Service Statistics page, select Health > Service Statistics.

The following table describes the columns in Cumulative Statistics and Individual Statistics lists.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. Queue</td>
<td>Displays the average number of actions in the service action queue. Queued actions are actions that are waiting to be processed.</td>
</tr>
<tr>
<td>Average Wait Time</td>
<td>Displays the average time that all jobs spend waiting in the queue while the service is saturated and unable to take on new jobs. For example, if the service has processed 10 jobs and the waiting times were 0,0,0,0,0,0,0,0,0,10 (the last job waited 10 seconds), an average wait time of 1 second would be reported. This indicator helps to highlight ongoing load imbalances or the need for additional computing power to handle overloads.</td>
</tr>
<tr>
<td>Cur. Queue</td>
<td>Displays the current number of actions in the service action queue.</td>
</tr>
</tbody>
</table>
Entering and Exiting Service Maintenance Mode

To enter or exit a service using the Service Statistics page, do the following:

1. Select Health > Service Statistics.
2. Select the service to manage in the upper panel.
3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

**Note:** Placing a service in maintenance mode erases the metrics for that service, and this affects the bar graphs for that service.
Resetting Service Statistics on the Service Statistics Page

You might want to reset service statistics after making a configuration change to your Vantage Domain. When you reset statistics, all cumulative values are reset to zero, which allows you to establish a new baseline for the domain.

You can reset statistics on the Array Statistics and Service Statistics pages.

To reset statistics for one or all services using the Service Statistics page, do the following:

1. Select Health > Service Statistics.
2. Select a service to manage in the upper panel.
3. Select a server to manage in the lower panel.
4. If you want to reset statistics for a single service, select the service to manage in the lower panel.
5. Click Options in the lower panel and select either of the following:
   - Clear (Reset) Selected Service Metrics History—Clears only the metrics history of the service selected.
   - Clear (Reset) All Service Metrics History—Clears the metrics history of all the services.
Viewing Machine Metrics

Selecting Health > Machine Metrics displays key performance information for each Vantage server in the Vantage domain (figure below). This can clarify workloads and bottlenecks at a glance. These are the measurements displayed in each column:

- **Machine**—Lists the name of the machine described by that display row
- **CPU Utilization**—Shows the percentage of CPU capacity in use
- **Network Utilization**—Shows the percentage of network throughput being used
- **RAM Utilization**—Shows the percentage of available memory being used
- **Total RAM**—Shows the total available memory
- **Lightspeed**—Identifies whether this is a Lightspeed server (Yes/No)
- **Database Size**—Lists the size of the domain database

You can sort the list order according to any measure by clicking the column title.
Administering the Domain

The following topic explains how to use the Dashboard to check domain license status:

Displaying Domain License Status

To display the domain license status, select Administration > License Status in the menu panel. Vantage displays the status as shown here:

To update the License Status page, click Refresh. This table describes the columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the license.</td>
</tr>
<tr>
<td>Activated</td>
<td>The state of license activation (true or false).</td>
</tr>
<tr>
<td>In Use</td>
<td>The state of license utilization (true or false).</td>
</tr>
<tr>
<td>Expired</td>
<td>The state of license expiration (true or false).</td>
</tr>
<tr>
<td>Maintenance Expires</td>
<td>Date and time that the maintenance expires.</td>
</tr>
</tbody>
</table>

Note: To view the features supported by a license, use the Vantage Management Console (see Viewing Vantage Licenses in the Vantage Domain Management Guide).
**Glossary**

**action**

An *action* is the smallest unit of work that can be specified in a Vantage workflow. Actions are connected together in a workflow to perform a useful task. Each action must be configured to perform its task in the context of the workflow, using an action Inspector. Action inspectors are specific to each type of action.

Actions are grouped by functional categories: communication, transcoding, file operations, metadata processing, etc. Each action is defined by the specific task it performs. For example, an email action, or a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose limitations on actions in a workflow. For example, you might require action B to depend on action A in a Vantage workflow.

During execution, actions operate on files, binders, variables, and states, and they generate an action state when they complete. Actions are executed by Vantage services, which perform the requirements of the action. In the case of the Transport service and most transcoding services, the services may manage file transfers and transcoding/rendering via an out-of-process resource.

**action state**

The *action state* describes the condition of an action execution in process and after completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After execution, an action’s final state may be Success | Ignore | Fail. Certain actions (Decide/Examine/Compare/Identify, for example) allow the use to specify the post-execution state, including Ignore. For all other actions, the post-execution state is set by the service, and is either Success or Fail. These states display in the Vantage Workflow Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested by the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state (right-click the action, and select Perform On > Success | Fail | Ignore | Any).

If an action fails, then the next action will inherit the Fail state and (in most cases) will not execute. If one action fails, the entire *job* fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the Ignore state and will also likely not execute. Certain special actions, such as Message, can be configured to perform on any state (Fail, for example)—this allows workflows to send an email if they detect a failure.
Action states have precedence when an action receives states from multiple incoming actions (a merge of multiple branches):
- If at least one incoming state is Fail, regardless of other incoming states, the action will inherit the Fail state. Fail has precedence over all action states.
- If there is no Fail state, but at least one Success state, then the action will inherit the Success state. Success has precedence over Ignore states.
- If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has lowest precedence of the three states. If an action receives an Ignore state and does not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state unless it is an action which can emit Ignore, and you have configured it to do so.

**Agility Service**

The **Agility Service** is the Vantage component which executes the actions relating to Agility job submission and interaction with Agility via the Job Profile action, Job XML action, and Process MMF action. Agility features are enabled by the Vantage Agility ECS license.

**All-in-one domain**

An **all-in-one** (or single-node or single-server) Vantage domain is one in which all server components of Vantage—the Microsoft SQL Server database, all Vantage services, and the optional Vantage web applications—are installed and operate on a single computer.

See also **Vantage array**.

**Analyze action**

An Analyze action, which is executed by the Analysis Service, enables you to perform analysis on media using a variety of analysis tools, specifying the result of the analysis in variables, for use in downstream actions.

**Analysis Service**

The **Analysis Service** is the Vantage component which executes the actions relating to the analysis of content: Examine action, Compare action, Identify action, Analyze action, Report action, and MediaInfo action.

**Archive action**

An **Archive action**, which is executed by the Staging Service, uses the selected archiver (TAR, for example) to convert the selected input file to another format, usually in preparation for copying, moving, or deploying a file to a given system that has special file format requirements.

**array**

Another term for **Vantage array**.

**Aspera Service**

An **Aspera Service** implements the Aspera software for Vantage, and provides two-way communication between workflows (and the Faspex Delivery action) utilizing the Aspera software itself.

**Asset Monitor action**

The Asset Monitor is an **origin action**. It uses the Avid Service to monitor the specified Interplay server for new files to ingest and generate output in one or more media descriptor formats [CML (Interplay Metadata) or MPEG 4 Reference files] from the ingested input file. This action is open workflow capable.
When a new file is discovered, the Asset Monitor action submits a *job* for the workflow to process the file.

**Associate action**

An *Associate action* uses the *Monitor Service* to continually (and at regular periods) poll a target location (a directory, for example) on a device or file system (FTP, network folder, etc.) to discover new files, based on some permutation of the name of the file being processed by the current job.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or attachment as the basis for discovering new files. For example, if media file *Vantage.mpg* is currently in the workflow, then the Associate action may look for *Vantage.scc*. This behavior can be configured in the Associate action's *Inspector*.

Associate actions begin executing when a *job* is submitted, and execute until a new file is discovered—subsequent actions do not execute until the file is found. When the new file is discovered, the Associate action makes the file available to the other actions in the workflow.

Configuration is accomplished in the inspector, and is based on the target device/file system being monitored and other requirements.

**attachment**

An *attachment* is a non-media file that is associated with media during execution of a workflow. For example, an attachment may be an XML file that contains metadata, an SCC caption file, or an STL or PAC subtitle file. An attachment may also be a PDF file, Excel spreadsheet, or Word document, for example. Attachments are identified and processed using nicknames for simplicity. Processing is optional—attachments may be simply passed through a workflow for storage with the processed media and registered in a Vantage *catalog*.

**attachment nickname**

An *attachment nickname* is an alias or alternate name that is assigned to an attachment file during Vantage workflow execution. When an attachment file is submitted to a workflow, the actual file name and location is stored in a Vantage *binder* along with a nickname as defined in the workflow. Within the workflow, all references to a file are by nickname. However, when Vantage needs to access a file, Vantage uses the actual file name and location stored in the binder.

See *media nickname* and *nickname*.

**AudioTools action**

An *AudioTools action* is an optional, licensed feature in Vantage. It uses the *AudioTools Service* to enable Vantage workflows to utilize and interact with various AudioTools products from Minnetonka Audio Software. The AudioTools Custom Workflow executes a selected, pre-defined AudioTools Server workflow. AudioTools Loudness Control executes the typical loudness processes, including hitting multiple target parameters using an iterative processing pass.

**AudioTools Service**

The *AudioTools Service* implements the AudioTools Connector and enables Vantage workflows to utilize and interact with various AudioTools products from Minnetonka Audio Software.

**Aurora action**

An *Aurora action* is an optional, licensed feature in Vantage. It uses the *Aurora Service* to enable Vantage workflows to utilize and interact with various QC tests provided by the Digimetrics Aurora...
software. The tests provide the ability to determine whether a particular input media (specified by nickname) either passes or fails a particular QC check. Each test also generates a report file that may be utilized during later stages of the workflow.

**Aurora Service**

The *Aurora Service* implements the Digimetrics Aurora software for Vantage, and provides two-way communication between workflows (and the *Aurora action*) utilizing Aurora and the Aurora software itself.

**Automate action**

The *Automate action*, which is executed by the *Communicate Service*, is similar to the Notify action. It contains system-integration extensions which are relevant to TrafficManager workflows, enabling you to save job or other metadata to a file and interface/integrate with external automation systems. This capability ranges from writing XML-based material to a file system to direct integration with specific automation systems.

In TrafficManager applications, this action is useful to notify automation systems that a commercial has been processed and is available for air. For example, a Notify action can create text or CSV dublists and provide them to automation systems that are capable of processing dublists in that format.

**Avid Service**

The *Avid Service* is the Vantage component which executes the actions relating to use of media on Avid Interplay servers: *Media Creation action* and *Asset Monitor action*. Before you can use these actions in a Vantage workflow with a given Interplay server, you must first create an Interplay connection in the Vantage Management Console and configure it.

**Baton action**

A *Baton action* is an optional, licensed feature in Vantage. It uses the *Baton Service* to enable Vantage workflows to utilize and interact with various QC tests provided by the Baton software. The tests provide the ability to determine whether a particular input media (specified by nickname) either passes or fails a particular QC check. Each test also generates a report file that may be utilized during later stages of the workflow.

**Baton Service**

The *Baton Service* implements the Baton software for Vantage, and provides two-way communication between workflows (and the *Baton action*) utilizing the Baton software itself.

**binder**

A *binder* is a collection of file and metadata information, created for each *job* that Vantage executes. A binder contains media and attachment file references and metadata labels that were ingested or created during the job. While a binder is created for every job, many binders are never used. Therefore, only media processing scenarios which require operator intervention should use the *Register action* in ingest workflows to create binders in a user-accessible Vantage catalog.

You use the Register action to automatically create binders during a job, and you use Exist to determine if a binder of a certain name has already been created. Binders are most often named by some permutation of the name of the file that started the job. Binders that are not explicitly registered are accessible to users only in Workflow Designer, in the Job Status tabs.
Vantage catalogs and their binders are accessible in Workflow Portal. Binders are saved in the Vantage domain database until deleted manually or by job expiration policies. You can also view binders in the Vantage Management Console, and manually create them there—or delete them.

Binders are not file folders and are not part of the Windows file system—they are records in the Vantage database. Thus, binders do not contain the files themselves; they only have the paths to those files.

**Camera Ingest action**

A Camera action is an origin action; it uses the Monitor Service to regularly poll a target location (a directory, for example) on a card reader device or Windows file system to discover new camera files.

When a new file or shot is discovered, the Camera action submits a job for the workflow which it is part of, for processing.

**Capture action**

A Capture action is an origin action; it supports Open Workflows on the outbound side and it is used to capture live SDI inputs and output captured media files to Live Storage using the specified output container and encoder. The Capture action is executed by the Live Services, and only works in a Vantage installation on a Lightspeed Capture Server.

**catalog**

Similar in concept to the folders in a file system, a Vantage catalog is a container that stores binders. Catalog folders are sub-containers that organize binders. To access a binder, Workflow Portal operators search through the visible catalogs and folders, just as they might sort through folders in a file system.

**Catalog Service**

The Catalog Service is the Vantage component that executes the Register action and Exist action.

**Catch action**

A Catch action is an origin action; it is a specialized origin action for ingesting commercials and syndicated media assets (including metadata) from catch servers in TrafficManager applications. It uses the Traffic Service to regularly poll the catch server to discover new files.

When a new file is discovered, the Catch action exposes all relevant metadata and submits a job to the workflow for processing. Typically, the workflow is an ingest workflow which localizes the media, populates a metadata label, creates proxies and thumbnails, and registers the asset in a Vantage catalog. For more details, see the TrafficManager User Guide.

**Cerify action**

A Cerify action is an optional, licensed feature in Vantage. It uses the Cerify Service to enable Vantage workflows to utilize the Tektronix Cerify suite of QC components. Cerify is a fully automated system for verifying and checking file-based content.

**Cerify Service**

The Cerify Service implements the Cerify software for Vantage, and provides two-way communication between workflows (and the Cerify action) utilizing the Baton software itself.

**Chronicle action**

The Chronicle action, along with Colocate, Compose, and Conform actions, are part of the optional, licensed Post Producer feature in Vantage. The Chronicle action uses the Edit Service to convert post-rendered Composition XML files into formats for use in other systems—ad-insertion systems, for example.
Cloud Flip action
The Cloud Flip action is used to submit media to the Telestream Cloud platform from Vantage workflows via the Telestream Cloud API to a particular profile that a user specifies. The Cloud Flip action is executed by the Telestream Cloud Service. As part of the submission, the specified input file is uploaded and then processed according to the rules associated with the specified Telestream Cloud profile.

Colocate action
The Colocate action, along with Chronicle, Compose, and Conform actions, are part of the optional, licensed Post Producer feature in Vantage. The Colocate action uses the Edit Service to ingest Composition XML files with references to non-file-based URLs (for example, Amazon S3), localize the files, and convert the media references in a copy of the CML into paths to the localized files.

common action
Common actions are actions that are implemented in every Vantage Service; they are not restricted execution by a single service. See Receive action, Forward action, Decide action, Compute action, Construct action, Synchronize action.

Communicate Service
The Communicate Service is the Vantage component that executes the actions relating to electronic messaging: Message action, and Notify action.

Compare action
A Compare action uses the Analysis Service to compare media files based on certain metrics (for example, PSNR). These metrics can generally be published as variables or as metadata labels.

Compose action
A Compose action, along with Chronicle, Colocate, and Conform actions, are part of the optional, licensed Post Producer feature in Vantage. The Compose action uses the Edit Service to assemble and optionally transcode multiple video and still image files into a single output file, applying filters as specified by you. The Composition (CML) file
A Composition file is an XML schema that provides the vocabulary to describe media elements and their temporal and spatial relationships on a video timeline. Composition files (or Composition XML objects in a computer program) are submitted to a Conform action in a workflow to render the media file from the description.

Compute action
A Compute action, which is implemented in every Vantage service, performs various arithmetic and string manipulation functions, permitting you to create and modify values in variables, for use in downstream actions. This action is open workflow capable.

Conform action
A Conform action, along with the other Edit actions, are part of the optional, licensed Post Producer feature in Vantage. The Compose action uses the Edit Service to assemble and optionally transcode multiple video and still image files into a single output file, applying filters as specified by you. The
input files and related specifications for the output file are all defined in a Composition XML file. This action is open workflow capable.

**Construct action**

A Construct action, which is implemented in every Vantage service, enables you to construct complex strings, paths, and math expressions from literals, variables, and tokens, for use in downstream actions. This action is open workflow capable.

**Copy action**

A Copy action is executed by the Transport Service and is used to replicate a file from a source target (file system/device and directory) to a destination target (file system/device and directory). It typically performs this task by copying the file to the destination.

Copy actions can be executed on any action state. This action is open workflow capable.

**database**

The term database is the common term used to refer to the Vantage domain database, where all specifications for the domain are stored, along with workflows and job history.

**Change Log**

The Change Log captures changes to the Vantage domain configuration and operation and records the following details: date and time of change, Vantage user who made the change, host computer where the change occurred, change summary message.

**Data Collection Utility**

The Data Collection Utility enables you to collect relevant information about selected services for transmission to Telestream during a troubleshooting session. You can also log point-in-time details about a selected service into a log file for diagnostics purposes.

**Delay action**

The Delay action provides the ability to delay the workflow for a fixed number of seconds before continuing. The Delay action operates in Open workflow mode.

**Decide action**

A Decide action, which is implemented in every Vantage service, is an action which allows you to explicitly set the action state based upon analysis of variable values at runtime. It is most commonly used to determine whether or not subsequent actions (or actions in a given branch) in a workflow should execute.

When the Decide action is used, the state set by the Decide action is passed to the next action. Typically, more than one Decide action is required to support decision branches. For example, if one branch is for HD media, it will start with a Decide action that will set the state to Success for HD content, or set it to Ignore otherwise; if another branch is for all other media, it will start with a Decide action that performs the opposite behavior.

See variable, action state.

**Delete action**

A Delete action is executed by the Transport Service, and is used to permanently remove a file from a source target (file system/device and directory). Delete actions can be executed on any action state.
Deploy action

A **Deploy action** is executed by the **Transport Service**, and is used to save the specified files to a destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, Deploy actions allow multiple files to be operated on simultaneously, and do not maintain a reference to those files in the **binder** after completion.

**distributed domain**
Another term for **Vantage array**.

domain
See **Vantage domain**.

DPP Validate Action

A **DPP Validate** action is executed by the **Analysis Service**. You can use the DPP Validate action to confirm compliance of a DPP metadata XML file. If the XML file passes validation, **TRUE** is generated; otherwise **FALSE** is generated. You can test the results of the action downstream to change the workflow’s actions based on the validation results. Optionally, you can also generate a report.

DRM action

The **DRM action** is part of the Multiscreen group, and is executed by the Multiscreen Service. You use the DRM action to execute a script that utilizes input data and generates a JSON string. The string contains the information required to encrypt streaming media with DRM (digital rights management) in Multiscreen workflows.

Scripts are created externally in a supported language and added to a Vantage domain via the Vantage Management Console > Workflow Design Items > Scripts. The specified script is executed in the DRM action, generating the output into a text variable for use in a downstream Multiscreen action. Multiscreen Flip uses the output of the script when encoding the media.

Dublist action

A **Dublist action** is a specialized **origin action** for ingesting dublist files from a specified server and directory in TrafficManager applications. It uses the **Monitor Service** to regularly poll the server to discover new files.

When a new dublist file is discovered, it is parsed by the specified scheme and new entries are added to the master dublist maintained by Vantage. The Dublist action simultaneously polls the selected Vantage **catalog** for any media files which match entries in the master list; when found, it submits a **job** to a TrafficManager application workflow for processing. The Dublist action uses the **binder** name as the unique identifier for the commercial, so it should be set to the Ad ID.

Typically, the workflow is an on-air processing workflow which transcodes the media, optionally trims the clip and alters audio for compliance. Then, it delivers the media to an on-air server and notifies an automation system. For more details, see the TrafficManager User Guide.

**Dublist Portal**

**Dublist Portal** is a client Windows program provided as part of a TrafficManager license. Dublist Portal enables customers who are performing advertisement processing to define, manage, and process dublists as part of their automated TrafficManager workflows.
**Edit Decision List**

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a target clip. The list entries specify the start and stop of the clip, and Vantage supports list entries from multiple media files. Vantage operators use the Workflow Portal program to create EDLs.

**Edit Service**

The Edit Service executes the Playlist actions: Colocate action, Conform action, Chronicle action, and Compose action. In the case of Conform, the Edit Service may manage the rendering via an out-of-process resource.

**Elastic Domain**

Vantage Elastic Domain is a set of deployment features and a flexible licensing model that allows Vantage Domains to rapidly scale node count. The scaling power of Elastic Domain is intended to leverage the deployment flexibility of virtualized deployments, IaaS (Infrastructure as a Service) deployments such as AWS EC2, and hybrid models. This feature is useful for customers who experience periodic large increases in demand for Vantage services beyond the normal base demand.

**emotion Action**

The emotion action is an optional, licensed feature in Vantage. The emotion action enables Vantage to utilize and interact with Emotion Systems Emotion Engine audio software.

**Error Log**

The Error Log utility captures Vantage errors and records the following details: date and time of error, error source (Vantage service), host computer where the error occurred, type of error (Info or Error), and error message.

**Examine action**

An Examine action uses the Analysis Service to evaluate the video and audio of a media file to measure certain characteristics, such as audio loudness, or to detect characteristics, such as the presence and size of curtains. You can configure it to publish metadata or variables containing the results of analysis.

**Exist action**

An Exist action uses the Catalog Service, and allows you to determine if a binder of a given name (or name fragment) is present in a specified catalog.

**Extract Action**

The Extract action, executed by the Metadata Service, is used to extract specific values from element attributes in XML or key-value pairs in JSON metadata. The Extract action identifies and extracts specific values from structured metadata and populates variables for use in downstream actions. The Extract action enables you to browse a sample file and identify the location in the structured data where the value is located.

The workflow can ingest an XML or JSON file during job execution or by making web service calls. The Extract action automatically generates XPATH or JSONPath references from the structured metadata in these files to extract the data, and populates a variable with the value. During execution, each extraction path is evaluated against the input and the associated variables are populated for use in downstream actions.

This action is open workflow capable if the Open Workflows license is installed.
**Faspex Delivery action**

A *Faspex Delivery action*, which is executed by the *Aspera Service*, is used to deliver files to Aspera Faspex servers. Upon delivery, recipients are notified and can download the package.

**FileCatalyst action**

The *FileCatalyst action* is an optional, licensed feature, which enables Vantage workflows to access and deliver files to FileCatalyst servers via integrated FileCatalyst client software. It is executed by the *FileCatalyst Service*.

**FileCatalyst Service**

The *FileCatalyst Service* implements the FileCatalyst action for Vantage.

**Flip action**

A *Flip action* is executed by the *Transcode Service*, and implements the specified codec, which is used to transcode decoded digital baseband media into another media encoding format. The Telestream Media Transcode and Analysis Engine performs the transcode on behalf of Vantage. The Flip action has an Export command, which allows you to save the configured Flip action as an XML file, for use in SDK applications. This action is open workflow capable.

**Flip64 action**

The Flip64 action is a 64-bit multicore-optimized encoder running under the *Transcode Service* that transcodes media from one or more input files into another format as specified by the output configuration. Available resolutions extend from SD to UltraHD and 4K in a broad range of file formats, from QuickTime to MPEG-4 and TIFO, and including encoding for x264, x265 (H.265 HEVC), MXF, and many more. This action is open workflow capable if the Open Workflows license is installed.

**Forward action**

A *Forward action*, which is implemented in every Vantage service, forwards a *binder* and all current variables to another workflow, starting a new *job* with the target workflow. A Forward action may be added to the end of a workflow, and requires that the target workflow have a *Receive action* as its first action.

Typically, workflows are created with a Receive action when they are intended for execution by another workflow that immediately precedes this one. This ability to chain workflows enables you to create comprehensive, intelligent run-time switching workflows consisting of smaller workflows used as building blocks.

See *Receive action*.

**Gather action**

A *Gather action* is implemented by the *Staging Service*, and collects one or more files from a specified server and directory (and optionally, its subfolders), and brings them into the workflow as attachments. Use of a file matching pattern allows you to select only certain types of files.

**hot folder**

A *hot folder* is a directory on a server that has been identified as a directory for storing media to be processed by a workflow in Vantage. When the workflow monitor identifies new media in this folder, it is submitted for processing.
Identify action
An Identify action uses the Analysis Service to determine certain properties of a media file, such as codec type, video bit rate, or file size. This information can then be published as a metadata labels or variables.

Inspector
An inspector is a series of one or more panels in Vantage Workflow Designer that facilitate the setup and configuration of a given action. Inspectors are unique to each action—for example, configuring a Watch action is very different than configuring a Flip action.

IPTV Flip action
The IPTV Flip action is included with the Cable / IPTV version of TrafficManager. IPTV Flip actions are executed by the IPTV VOD Transcode Service which can optionally run on a Lightspeed Server for GPU-enhanced x264/x265 encoding and video processing. The IPTV Flip action and IPTV VOD Service supports the features required to handle varying IPTV, set-top box and cable encoding requirements, and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box environments. This action is open workflow capable.

IPTV VOD Transcode Service
The IPTV VOD Transcode Service is the Vantage component that executes the IPTV Flip action. This service (which can optionally run on a Lightspeed Server for H264 and HEVC encoding and video processing), supports the features required to handle varying IPTV, set-top box and cable encoding requirements, and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box environments. Transcoding is performed by the Telestream Media Framework on behalf of Vantage. Rendering may be performed by an out-of-process resource managed by the IPTV VOD Transcode service.

job
A job is each execution of a Vantage workflow. Jobs have a state (separate from action states), and jobs are comprised of actions that are executing. Jobs, like actions, may be in-process or they may be complete.

As a job executes, each action may be performed by any service (on any computer) in the Vantage domain that is capable of performing it. The capability of a service to perform a specific job depends on its current operating state, its workload, and its suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by selecting the workflow in the Workflow Designer panel and displaying the Job Status tab. Alternatively, all in-process and failed jobs within a Vantage Domain may be viewed in the Status details panel of the Management Console.

Job Profile action
Use the Job Profile action (which is executed by the Agility Service) to submit jobs to Agility for processing; definition of the job is provided directly in Vantage by configuring the action.

Job XML action
Use the Job XML action (which is executed by the Agility Service) to submit jobs to Agility for processing; definition of the job is provided in an XML file.

job routing
See qualification rule and run on rules.
job state
A job state is the current status of a job. Keyword values are In Process | Paused | Complete | Failed | Waiting | Stopped by User | Waiting to Retry.

Job Status Views Web Application
The Vantage Job Status Views web application is installed on a Vantage web server and enables you to view real-time information about jobs in the domain from anywhere on your network with a web browser.

label
A label or metadata label defines a set of metadata by use of name/value pairs associated with content. For example, a spot label may contain Agency, Author, or Ad-ID and other metadata values; this set of metadata is collectively called a Spot metadata label. Metadata labels can be stored in binders with the associated media and attachment files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you can create and modify labels for your use using the Management Console (Workflow Design Items > Metadata Labels).

license
A Vantage license is stored in the Vantage domain database and enables one or more Vantage features within a Vantage domain. Licenses are delivered as XML files and imported into the database and activated via the Vantage Management Console.

Lightspeed Server
A Vantage Lightspeed Server is a 1RU, GPU-enabled, multi-core CPU server used to host Vantage services and accelerate video processing and x264 transcoding. Lightspeed Server accelerates compute-intensive image processing, including scaling, deinterlacing, frame rate conversion, motion vector calculation, and other tasks that require computation and analysis to modify or create new video frames.

Live Services
Part of the Vantage Media Processing Platform on a Lightspeed Live Server, the Vantage Live Service is listed in the Management Console Services list and includes the Capture action. In total, there are four “Live” services on the Lightspeed Live server:

- The Telestream Live Persistence Service handles the persistence of source material.
- The Telestream Live Service corresponds to the Live Manager capability and arbitrates resource allocation for Lightspeed Live Capture.
- The Telestream Live Source service manages the acquisition of material from a specific source (spawned by the Telestream Live Service).
- The Vantage Live Service which includes the Capture action, depends on the three other services above to achieve the full functionality of the service.

Management Console
The Management Console enables Vantage system administrators to effectively configure Vantage domains, and scale domains across multiple servers to meet their operating requirements and perform effectively in their environment.
**MediaInfo action**

The *MediaInfo action*, which is executed by the *Analysis Service*, performs 2 tasks, based on its analysis of the media file and its streams:

- Creates variables from properties, using the MediaInfo API
- Creates a report of the properties and their values.

In each category, you can produce variables of selected metrics with the results the analysis.

**Media Creation action**

The Media Creation action uses the *Avid Service* to deliver new media to the specified Interplay server and issue the Interplay commands necessary to check the file into the Interplay server. This action is open workflow capable.

**media nickname**

A *media nickname* is an alias or alternate name that is assigned to a media file during Vantage workflow execution. When a media file is submitted to a workflow, the actual file name and location is stored in a Vantage binder along with a media nickname as defined in the workflow. Within the workflow, all references to a file are by media nickname. However, when Vantage needs to access a file, Vantage uses the actual file name and location stored in the binder.

See attachment nickname and nickname.

**MediaMate action**

A *MediaMate action* uses the MediaMate Service to enable Vantage workflows to utilize and interact with the Subtitling capabilities of Screen MediaMate. Each subtitling option provides different capabilities that relate to the subtitle process.

**Note:** The MediaMate action is only supported on 64-bit Windows Server 2008.

**MediaMate Service**

The *MediaMate Service* implements the MediaMate Screen software for Vantage, and provides two-way communication between workflows (and the MediaMate action) utilizing the MediaMate Screen software itself.

**Message action**

A *Message action* is implemented in the Communicate Service and enables you to generate and transmit an electronic Message—an email, for example. A Vantage administrator must configure Vantage to use an SMTP server (Vantage Management Console: Settings & Options > Email) before email can be utilized.

**Metadata Service**

The *Metadata Service* Vantage component executes the actions the extract metadata values, and perform conversions between attachment files, metadata labels, and variables. Metadata Service actions include the Extract Action, the Populate action, and the Transform action.

**Metric Service**

The *Metric Service* gathers and supplies machine-level information about a specific Vantage node. It monitors CPU, network, and RAM utilization and reports these to Vantage. On a Lightspeed server, it also monitors the GPU activity. The bulk of the information that the Metric Service presents is visualized
in the Machine Metrics section of the Vantage Console. By convention, a Metric Service should be installed and running on every node in a Vantage domain. If you do not have a Metric service running on a specific machine, then that machine will not appear (will not have an entry) in the Machine Metrics section of the Vantage Console.

**Monitor Service**

The Monitor Service is the Vantage component that executes Watch actions and Associate actions, Camera Ingest action and the Workorder action, all relating to the discovery of files and starting jobs.

**Move action**

A Move action is executed by the Transport Service, and is used to move a file from a source target (file system/device and directory) to a destination target (file system/device and directory). It performs this task by copying the file to the destination, then deleting the source. The copy first, delete last process insures that the move completes normally before deleting the source file.

Move actions can be executed on any action state.

**Multiscreen Flip action**

Multiscreen Flip actions are an optional, licensed feature. Multiscreen Flip actions are executed by the Multiscreen Service, which is used to perform adaptive bit-rate encoding and simultaneous packaging of decoded digital baseband media into multiple bit-rate variants of H.264/HEVC video and containers in adaptive rate streaming formats, including Adobe HDS, Apple HLS, Microsoft HSS, and players that support MPEG DASH. You can configure the Multiscreen action to perform transcoding on a standard Vantage server or on a Lightspeed Server. This action is open workflow capable.

**Multiscreen Service**

The Multiscreen Service is the Vantage component that executes the Multiscreen Flip action and the DRM action. This service (which can optionally run on a Lightspeed Server for H264 and HEVC encoding and video processing), supports the features required to handle varying adaptive bit-rate encoding and packaging requirements. Transcoding is performed by the Telestream Media Framework on behalf of Vantage. Rendering may be performed by an out-of-process resource managed by the Multiscreen Transcode service.

**Nexidia Action**

The Nexidia action is an optional, licensed feature in Vantage. It uses the Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. The specified input files are passed to the Nexidia QC software where they are analyzed using the test profile selected.

**Nexidia Service**

The Nexidia service is an optional, licensed feature in Vantage. It executes Nexidia actions.

**nickname**

A nickname is an alias or alternate name that is assigned to a media or attachment file during Vantage workflow execution. When a media or attachment file is submitted to a workflow, the actual file name and location is stored in a Vantage binder along with a nickname as defined in the workflow. Within the workflow, all references to a file are by nickname. However, when Vantage needs to access a file, Vantage uses the actual file name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only allow the use of certain nickname types. For example, a Flip action only allows media file nicknames to be used as the
inputs and outputs. However, other actions (such as the Move and Copy actions) operate on any type of file and allow the use of any nickname.  
See attachment nickname and media nickname.

**Notify action**

A Notify action is implemented in the Communicate Service, and is an action which saves job information to a file to interface with an external system. You can configure a Notify action to produce an XML file, and you can also use it to invoke a Web Service. 

TrafficManager-centric extensions are presented here for backward compatibility.

**Open Workflows**

An option to Vantage workflow functionality, Open Workflows enhance the processing speed of workflows by enabling most actions to begin processing before the previous action has completed.

**origin action**

An origin action is a specific type of action, which must be used to start a workflow. A workflow without an origin action as its first action is not properly designed, and cannot be activated. The origin actions include the Capture action, Watch action, Workorder action, and Receive action, as well as the Catch action and Dublist actions (optional TrafficManager actions).

**Original nickname**

The media nickname Original is a reserved nickname that is typically assigned to media files in a workflow by the origin action.

See media nickname.

**Pipeline**

Pipeline is a network-based video capture and playout device for moving SD & HD SDI video & audio in and out of MacOS X and Windows file-based workflows, with a wide variety of industry-standard encoders.

**Populate action**

A Populate action uses the Metadata Service to read and write metadata labels. During ingest, metadata labels can be added to ingested media and generally include trim information, audio levels, file properties, and commercial metadata. The metadata labels can then be reviewed and modified by operators using Workflow Portal. At any stage of a workflow, Vantage can extract information from labels using the Populate action, allowing Vantage for example to use trim points during a transcode, or audio level information when creating the final broadcast asset. This action is open workflow capable.

**Post Producer**

Post Producer is a specially-licensed set of actions and functionality in Vantage that enables iterative, template-driven assembly and encoding of assets for publication. Post Producer workflows automate assembly and reduce production costs by producing multi-layer video deliverables with transition and image effects, graphic overlays, and conformed for IPTV and cable VOD production, news or weather updates, international localization, promo assembly and insertion and advertisement insertion.

**Process MMF action**

A Process MMF action (which is executed by the Agility Service) processes an attachment as an MMF file and generates variables from it.
**Pulsar Action**
The Pulsar action is an optional, licensed feature which enables broadcasters to integrate the Pulsar suite of content verification components directly in Vantage workflows. It is executed by the Pulsar Service.

**Pulsar Service**
The Pulsar service implements the Pulsar action for Vantage.

**qualification rule**
A qualification rule influences or controls the routing and execution of actions among Vantage services of the same type in a distributed Vantage domain. Qualification rules can be used to ensure that jobs are routed to services that are best suited for the task. Vantage uses values contained in variables to determine the suitability of a given service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any actual machine analysis. As a result, it is up to the system administrator to correctly set up variables and qualification rules, and apply variables to the appropriate actions to ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: Services. See also run on rules.

**Receive action**
A Receive action is an origin action which is implemented in every Vantage service. Receive actions are designed to receive files from other systems: workflows, SDK-based applications, and Workflow Portal, for example. Files can also be automatically submitted to a workflow starting with a Receive action from another workflow using the Forward action.

See Forward action.

**Register action**
A Register action uses the Catalog Service to add the binder created by each job to a Vantage catalog. Register actions can be executed on any action state.

See also Vantage catalog.

**Remove action**
A Remove action is executed by the Catalog Service, and is used to permanently remove a binder from the catalog and set the associated file resources to expired. If the action succeeds, it emits an action state of Success; otherwise, Failure.

**Report action**
A Report action, which is executed by the Analysis Service, generates a list of variables and their values and saves them in a file format specified by you.

**resource cost**
A resource cost is an integer value, implemented in the Vantage Management Console on each action type to specify a relative computer resource consumption value in relation to all other action types. This value enables Vantage to maximize resources and optimize transactions, so that you can tune your Vantage system for the highest possible throughput on your particular hardware.
retry rules

Retry rules are rules that you can specify on certain actions, to re-execute actions that fail primarily due to platform access and network latency problems. The retry rules you set on a given action override the default retry rules established in the Management Console.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have the characteristics that enable them to execute this action. Rules are set up by specifying variables which have been bound to a given Vantage service and values set. After configuration, the action can test each rule by comparing its run time value to the value in the service's copy and determine if there is a match before attempting to execute it.

See also qualification rule.

SDK Service

The SDK Service is the Vantage component which enables integration with third-party or custom-developed client programs, for submitting jobs, tracking status, etc.

Session Log

The session log is a function of the Job Status and Domain Job Status panels in the Workflow Designer. This log displays session activity entries, if any, including which variables have been provided to each action and which ComponentPac was used to run an action. This information can be helpful when debugging the use of variable, or when working on an issue with Telestream Customer Service.

Signiant Delivery action

A Signiant Delivery action, which is executed by the Signiant Service, is used to deliver files to servers controlled by Signiant file transfer products.

Signiant Service

The Signiant Service is the Vantage component which enables integration with third-party or custom-developed client programs, for submitting jobs, tracking status, etc.

The Signiant Service implements the Signiant file transfer product for Vantage, and provides two-way communication between workflows (and the Signiant Delivery action) utilizing the Signiant software itself.

Staging Service

The Staging Service is the Vantage component which executes Archive actions and Gather actions.

Secured Version Control

The Secured Version Control feature provides the ability to install the latest software and begin building workflows that utilize new ComponentPac libraries (software libraries), while keeping the existing workflows untouched and operating off a previous ComponentPac version. When the user desires to upgrade a workflow or action within a workflow, it can be done at a convenient time. For a detailed description of Secured Version Control, search the Vantage Domain Management Guide.
**Synchronize action**

A *Synchronize action* is a connector action, for the sole purpose of uncluttering workflow connectors. In workflows where there is a many-to-many relationship (for example, 6 Flip actions connecting to 6 Deploy actions, which connect to 6 Deletes), instead of drawing connection between them all, you simply connect them to a common Synchronize action. There is no Inspector for the Synchronize action, because no configuration is required.

**Syndicate Action**

The Syndicate action processes and can apply a template to metadata accompanying syndicated content from providers like Pitchblue and generic providers. It is executed by the **Traffic Service**. The purpose of this is to automatically rearrange segments according to the template, or to mark specific segments as “not included” in the final program. Use the Syndicate action in syndicated media ingest workflows to convert sidecar metadata XML files to a mezzanine format for use in downstream actions in the workflow, or for use in Syndication Workflow Portal applications. The Syndicate action is part of TrafficManager, an optional, licensed feature of Vantage.

**Telestream Cloud Service**

The *Telestream Cloud Service* is the Vantage component which executes the Telestream *Cloud Flip* action.

**Telestream Media Framework**

The *Telestream Media Framework* is a software framework developed by Telestream for reading, writing and analyzing many different kinds of media files. Telestream Media Framework is used across many Telestream products, including Vantage.

**Timed Text Flip action**

A *Timed Text Flip action* is part of the Timed Text group. It is executed by the **Timed Text Service**. The Timed Text action is executed by the Timed Text service. The Timed Text Flip action automates caption file-type conversions, extracts caption data from media with embedded captions, creates subtitle overlay graphics, and manipulates the timecode of caption data to match media.

**Timed Text Service**

The *Timed Text Service* is the Vantage component which executes the **Timed Text Flip action**.

**Tempo action**

A *Tempo action* is part of the Edit group. All actions in the Edit group are executed by the **Edit Service**. The Tempo action is included in Tempo, a time-adjusting encoding solution built on the Vantage platform. The Tempo action uses the Edit Service for re-timing file-based content and intelligently decreasing or increasing the running time of shows and segments. This action is open workflow capable.

**Traffic Service**

The *Traffic Service* is the Vantage component which executes the **Catch action** and **Dublist action**.

**TrafficManager**

*TrafficManager* is an optional, licensed feature which enables automated advertisement and syndicated media processing from catch server to automation systems and on-air servers, serving both the broadcast and cable industry. It includes the **Catch action** for catch servers and the **Dublist action** for dublist management. It also includes the **Syndicate Action** for processing syndicated media.
**Glossary**

**transcode**

Transcode means the process of decoding media in one format (MPEG2, for example) down to digital baseband and then encoding it in another media format (MPEG4, for example).

**Transcode Service**

The Transcode Service is the Vantage component that executes the Flip action—transforming media from one format to another. Transcoding for the Flip action is performed by the Telestream Media Transcode and Analysis Engine on behalf of Vantage.

**Transform action**

A Transform action uses the Metadata Service to transform metadata between XML files (attachments) and labels. XSL style sheets are used to perform these transformations; style sheets can be managed in the Vantage Management Console: Workflow Design Items > Style Sheets. This action is open workflow capable.

**Transport Service**

The Transport Service is the Vantage component that executes (or manages the execution via an out-of-process resource) the actions relating to file operations: Move action, Delete action, Copy action, and Deploy action. File transfers may be performed by an out-of-process resource managed by the Transport service.

**Vantage array**

A Vantage array is a domain whose software components are distributed among multiple computers for durability and scalability, instead of installed and operating on a single computer (often referred to as a distributed domain). A typical array has the Vantage domain database installed on a dedicated server, and all Vantage services installed on another computer, and additional Transcode services each installed on other computers for high-performance, parallel transcoding.

**Vantage catalog**

Formal name for catalog. Similar in concept to the folders in a file system, a Vantage catalog is a container that stores binders. Catalog folders are sub-containers that organize binders. To access a binder, Workflow Portal operators search through the visible catalogs and folders, just as they might sort through folders in a file system.

**Vantage Cloud Manager**

The Vantage Cloud Manager enables Vantage system administrators to effectively configure cloud service provider accounts, start, stop, and configure domains, and monitor domain status.

**Vantage domain database**

A Vantage domain database is a Microsoft SQL Server database which contains all workflows, actions, jobs, binders, licenses, and configuration information for a Vantage domain.

**Vantage domain**

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage services, jobs, binders, and configuration settings, all known to and interacting with each other, stored in a database. This collection constitutes a Vantage domain. Vantage domains may exist on a single computer or they may be distributed across many computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the Vantage domain database.
Multiple Vantage domains may exist on a network, but they are independent entities that do not communicate with each other. They are not bound together and do not share resources or work. The purpose of storing an entire domain in a database is to provide an easy way to create and manage the domain and to provide access to all the details about each resource in the domain to any other resource that needs it.

**Vantage EDL nickname**

The nickname *Vantage EDL* is a reserved nickname that is typically assigned to media files that are created in catalog ingest workflows, to identify the ingest files of an Edit Decision List in Workflow Portal, during Stitch and Trim operations. See media nickname.

**Vantage folder address**

A *Vantage folder address* is an alias to a local or remote file folder. You can create and manage Vantage folder addresses in the Vantage Folder Address Book dialog, in Copy and Move actions in Vantage Workflow Designer, and in the Vantage Management Console.

After you create a Vantage folder address, you can specify the destination directory in any workflow simply by selecting the Vantage folder address. Changes to a Vantage folder address—such as updating an IP address or a password—immediately affect all workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution are not automatically deleted from Vantage folders according to job expiration settings.

**Vantage Proxy nickname**

The media nickname *Vantage Proxy* is a reserved nickname that may be assigned to media files encoded using the QuickTime encoder in H.264/AAC as QuickTime movies or MP4 files with x264/AAC, which enables previewing with the media viewers provided in Vantage programs such as Workflow Designer, Workflow Portal, and the Vantage Management Console.

Alternatively, the Workflow Portal Windows Client QuickTime Media Player supports MP4 with x264-encoded H.264/AAC, provided that QuickTime 7.7.6 or later is installed.

See media nickname.

**Vantage services**

The term *Vantage services* refers to the collection of Windows services in a Vantage domain, which are responsible for executing all of the actions in a workflow as it executes.

**Vantage store**

A *Vantage store* is a directory on a Windows file system that stores temporary files. Stores are managed by the Vantage domain for the purpose of centralizing large directories for reading and writing files. Unlike a Vantage folder, temporary files placed in a Vantage store are deleted when the binder is deleted. Vantage stores are generally used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Storage. Services that create temporary files, such as the Transcode Service, can be configured to use specific stores.

**Vantage Thumbnail nickname**

The media nickname *Vantage Thumbnail* is a reserved nickname that is typically assigned to output media files that are created to display thumbnail images instead of binder names in Vantage programs such as Workflow Portal.
See media nickname.

**variable**

In Vantage, a **variable** is a container for temporary **job** information—a symbolic name (or identifier) which contains some known or unknown quantity or element of information; a value. You use the variable name to reference the current value; this separation of name and content allows the name to be used independently of the exact information it represents. The variable can be bound to a value (that is, you can set a variable to a given value) during run time, and the value of the variable may change during the course of workflow execution.

A variable identifies temporary job metadata. Variables have a name (such as *Number of Audio Channels*), a type (such as *Integer Number*) and a default value (such as 50). Variables values can be set inside a job in a variety of ways: through analysis, through metadata population, in the Watch and Associate actions, as a property of an action, or by a service as it executes an action.

Variables are used by Vantage services and actions to control workflow execution. Many settings in actions can be bound (or attached) to variables, allowing the workflow to dynamically update values on a job-by-job basis.

For example, a variable may be assigned a value by an Analysis action to determine how many lines of black are at the top of a video frame; a crop filter later in the workflow can bind to that variable, ensuring that every crop in every job is appropriate to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a FibreRequired=TRUE variable must pass this condition to a service which evaluates the condition to determine if it can successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items > Variables) or in Vantage Workflow Designer, and assigned for use in workflows and services.

**VidChecker action**

A **VidChecker action** is an optional, licensed feature in Vantage. It uses the **VidChecker Service** to enable Vantage workflows to utilize and interact with various QC tests provided by the VidChecker software.

**VidChecker Service**

The **VidChecker Service** implements the VidChecker QC software for Vantage, and provides two-way communication between workflows (and the **VidChecker action** actions) utilizing the VidChecker software itself.

**Watch action**

A **Watch action** is an origin action; it uses the **Monitor Service** to regularly poll a target location (a directory, for example) on a device or file system (FTP, Windows network folder, etc.) to discover new files. This action is open workflow capable.

When a new file is discovered, the Watch action submits a **job** for the workflow which it is part of, for processing the file—typically, a media file.

**Web Dashboard**

The **Web Dashboard** is an optional, licensed web app which displays important domain information from anywhere on your network in a web browser. The Web Dashboard is installed on the IIS server on your Vantage domain database server.
**Workflow**

A *workflow* in Vantage is a set of actions designed to perform an automated process. Vantage workflows are created using the Vantage Workflow Designer by adding and configuring actions and connecting them together. Workflows are stored in the Vantage domain database, and executed by Vantage services.

**Workflow Designer**

*Vantage Workflow Designer* is a client program that enables you to create and edit workflows, activate and deactivate workflows, monitor job status, and review and delete jobs that have completed.

**Workflow Portal**

*Workflow Portal* is a client program that features a customizable set of functionality to support various operator-related tasks: selecting media and submitting jobs, updating variables and metadata, forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when Vantage administrators construct the user interface and functionality they want for a given task, then save it. When operators launch Workflow Portal, they select the configuration appropriate to the task at hand, and Workflow Portal dynamically display the user interface components specified in the configuration file.

**Workflow Portal Web Application**

The *Workflow Portal web app* is a limited implementation of Workflow Portal, for use in a web browser over a network or Internet connection.

**Workorder action**

A *Workorder action* is an origin action; it uses the Monitor Service to regularly poll a target Windows directory for new workorder files to process. The Workorder action provides a simple and highly effective method of submitting multiple similar jobs without using the SDK.

When a new file is discovered, the Workorder action submits one job for each row in the file.

**Workorder file**

A *workorder file* is a comma-separated value (CSV) text file containing one or more work orders, or job descriptions. Each row in the CSV file specifies a job, and each column specifies either an input file for the job, or value for run-time use; typically assigned to a variable in the workflow. Workorder file configurations are specified in the Domain Management Console. At least one workorder scheme must be created in order to use a Workorder action.